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Introduction 

MIAC 
ClASSIC 
R 11 ll K 

n the years since the introduction of the o riginal Macintosh 
computer, one complaint was consistently leveled against Apple. 
The Macintosh cost too much. This criticism was only partially 

valid. PC-style machines-especially third-party IBM clones-definitely 
are less expensive. 

For the average user, however, this cost savings can be an illusion. Many 
people find the PC difficult to learn and use. They find the text-oriented 
operating system obscure and filled with commands that require 
memorization or frequent reference to a manual. Making changes to 
hardware or software often requires extensive knowledge of the 
machine's hardware and operating principles o r the services of a person 
with such knowledge. 

These issues are being addressed on the PC side of the industry with tl1e 
introduction and evolution of the Microsoft Windows operating system 
and IBM's OS/2 operating system, which hold the promise of creating PC 
environments that are easier to use and learn. Both systems use many of 
the graphics-based ideas incorporated in the Macintosh operating 
system. Ironically, PC users are now discovering what Macintosh users 
have known for almost a decade: creating a friendly, general-purpose 
machine requires a greater investment in hardware. 

Although the Macintosh has fo r years been easier to learn and use, the 
higher cost of the Macintosh has been a hindrance to many prospective 
buyers. In 1990, Apple addressed this problem by introducing the Mac 
Classic along with two orher, lower-cost machines. The combination of 
ease of use and lower cost has made the Mac Classic one of the hottest 
selling computers in Apple history. 



The day is coming when aJJ computers will be accessible to the average 
user. The advantage of the Mac Classic is that it enables those of us who 
do not wish to be bothered with the technical aspects of computers to 
bring home a powerful and useful machine for a modest investment 
today. 

A Brief History of the Mac Classic 
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any people have heard the story of Apple Computer's household 
garage beginnings. What you may not know is that the history of 
the Macintosh begins much further back in history. The concepts 

on which the Macintosh rests began evolving in the 1950s and 1960s. 
Computers of that time were room-filling number crunchers that few 
people could understand and operate. They were innovative for their 
time but held no promise of direcdy helping the individual. 

Several people began to talk of interactive computer systems: computers 
that you could sit down and work with as you might a co-worker. In 
1960, J.C.R. Licklider published a paper entided "Man-Computer 
Symbiosis," which proposed the goal of creating a computer system that 
could provide d1is manner of interaction. 

The idea of interactive systems began to spread. In 1963, Ivan 
Sutherland created a program called Sketchpad. It was a simple graphics 
program but was revolutionary in a time when d1e normal output of 
computers was litde more than a series of printed numbers. About the 
same time, the first-known arcade-style computer game, Spacewar, was 
created. 

Douglas Engelh;trt contributed one of the most notable parts d1at would 
enable the Macintosh. In 1964, he invented the X-Y Position Indicator 
for a Display System. This small , hand-sized device enabled the com
puter user to point at items on a screen and select them by pressing a 
button. That makes the mouse more than 27 years old now. 

By 1970, the drive to make computers accessible to anyone was in full 
swing. Xerox Corporation founded the Palo Alto Research Center (PARC) 
in that year and gathered somt: uf the most innovative thinkers in 
computer science-many of whom are still preeminent in the field. Alan 
Kay, inventor of the Small talk computer language, summed up the goal 
of the time. He vowed never to design a computer program that was uot 
simple enougb for a cbild to use. 



The foundation of the grapbical user interface (today called GUI and 
pronounced goo-ey) was laid at Xerox PARC in the early to mid-1970s. 
The desktop, icons, overlapping windows, and pop-up menus were all 
first developed at PARC. 

Unfortunately, many of the people working to bring computer power to 
the average person could not be convinced that the personal computer 
revolution had already begun. As early as 1974, hobbyists were building 
and programming their own small computers. The introduction of the 
famous Apple II computer, born in that well-known garage, occurred in 
1977. 

Apple Computer's commitment to creating powerful, easy-to-use 
computer systems was attractive to many at PARC. In the late 1970s to 
early 1980s, programmers determined to change the way people worked 
with computers started a migration to Apple. 

The result was a small, beige box that came with two software programs 
and a funny-looking little pointer called a mouse. Computing hasn't 
been quite the same since. 

Although the ideal of the computer as co-worker and companion is still 
years ahead, the graphical user interface has brought us much closer to 
its realization. The Macintosh is the latest step towards that goal and the 
culmination of 30 years of the dreams and innovations of those deter
mined to change the computer intO a tool rather than an arcane, box
shaped oracle. 

By using the modestly priced Mac Classic, you can bring those years of 
dreams and innovation into your home and put them tO work for you 
on your desk. 

Who Should Use This Book 
his book is intended primarily for the new Mac Classic owner
especially those new to the Macintosh world. The book's purpose 
is to teach and explain the graphic user interface as it exists on the 

Mac Classic. The book also gives the new user a basis for understanding 
the many software and hardware options available for the Mac Classic 
computer. 

Intermediate users-those familiar with the Macintosh but new to the 
Mac Classic-also can benefit from this book. Reading the book may 
shed new light on the interface and help in choosing software and 
hardware for the new machine. 
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Finally, the individual considering a compU£er purchase can use this 
book to learn how a Macintosh differs from a PC and why the Mac 
Classic deserves serious consideration. Although you will spend time 
learning regardless of which computer system you buy, this book shows 
that with the Macintosh, more time is spent learning how to put the 
computer to work rather than learning how to make it work. This 
distinction is important. 

The book's usefulness does not end after your Mac Classic is up and 
working for you. The convenient, reference-guide format makes the 
book worth keeping as a handy reference. 

How To Use This Book 
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he book is divided into three main parts. Part I deals with the 
basics of d1e Mac Classic itself: hardware and included System 
software. Part I, "Using Your Mac Classic," comprises the following 

chapters. 

Chapter 1, "Setting Up the Mac Classic," covers the initial setup of the 
machine from taking it out of the box to installing System software. 

Chapter 2, "Getting Started wid1 d1e Mac Classic," for the user unfamiliar 
to the Macintosh, is a hands-on tutorial designed to help you gain 
familiarity with how the machine and interface work. 

Chapter 3, "Using the Finder DesktOp," explores the basic work area of 
the Macintosh, the desktop, and the use of d1e mouse, keyboard, icons, 
windows, and menus. 

Chapter 4, "Working with Disks," discusses types of disks, their proper 
care, and setup. 

Chapter 5, "Working with Documents and Folders," covers the basic 
arrangement of dat:l in the Macintosh system and how to organize your 
dat:l. 

Part ll, "Putting the Mac Classic To Work," covers the topics you need to 
know to use your Mac Classic for various work tasks. Part II comprises 
the following chapters. 

Chapter 6, "Working with Software Programs," discusses the basics of 
installing and using application software. The chapter covers basic text 
editing and printing, and addresses desk accessories, which are small, 
specialized applications. 



Chapter 7, "Configuring the Mac Classic," discusses various ways you can 
tailor the Mac Classic to suit your needs. This chapter includes such 
topics as setting the time and date, changing d1e Apple menu, and using 
sounds. 

Chapter 8, "Using Advanced Configuration Options," covers control 
panel devices (CDEVs) andlNITs, called System Extensions in System 7, 
which are small, software items that enhance and tailor the operation of 
the System software. Also covered are the System 7 features of control
ling icon views, labeling, aliasing, and sharing icons. 

Chapter 9, "Using Multitasking," explores the capability of the Macintosh 
System software to run more than one software program at a time. This 
includes installing and using the System 6 MultiEnder and the built-in 
multitasking capabilities of System 7. 

Chapter 10, "Working with Printers and Fonts," covers setting up a 
printer, installing printer drivers, selecting printers, installing and using 
fonts, and using background printing. 

Part III, "Adding Software and Hardware," discusses software and 
hardware options for the Mac Classic. Part Ill comprises the following 
chapters. 

Chapter 11, "Selecting System Software," covers the basic operating 
system included with the Mac Classic and discusses the differences 
between System 6 and the new System 7. The chapter also presents 
system utilities that are available for d1e Mac Classic. 

Chapter 12, "Selecting Application Software," considers the software 
included wid1 and available for the Mac Classic. This chapter helps you 
choose which programs are best suited for your needs. 

Chapter 13, "Expanding Your Mac Classic," describes the types of 
hardware available for the Mac Classic to help you decide wh ich you 
might need and suggests sources for locating hardware. 

Que's Mac Classic Book also includes several appendixes and a glossary 
that you will find useful. 

Appendix A, "System 7 Issues," discusses issues you should consider 
before purchasing the new System 7. 

Appendix B, "Troubleshooting," covers problems you might encounter 
and suggests ways they can be solved. 

Appendix C, "Macintosh Resources, " lists magazines, books, user groups, 
and other sources of Macintosh information. 

Introduction 
Que's Mac Classic Book 



The System 7 Icon 

Introduction 
Que's Mac Classic Book 

Appendix D, "Command Quick Reference," gives you quick access to the 
features and keyboard short cuts of Systems 6 and 7. 

The Glossary defines general computing terms used in the Macintosh 
world and this book. 

special icon has been created for this book to indicate infom1ation 
that pertains to the new System 7 software and d iffers from System 
6 procedures. Often, the procedures for both Systems are identi-

cal. In cases where the procedures are not the same but similar, System 7 
variations are identified and often placed in parentheses. When System 7 
differs markedly from System 6, or when e>..'tra information is required 
for those users, you will see the System 7 icon. 
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Setting Up the 
Mac Classic 

etting up a Mac Classic is a simple process that requires little time. 
The setup process should take approximately one hour for 
hardware and System software, although you should plan an 

afternoon or evening in which to work and familiarize yourself with the 
machine. 

This chapter discusses selecting a location for your Mac Classic and 
presents ways of protecting your investment. You also learn to connect 
the hardware and install the System software required for basic opera
tion of the Mac Classic. 

Protecting the Mac Classic 

MAC 
ClASSIC 
B 0 0 K 

Before opening the box and taking out the machine, take a moment to 
consider the location for your computer. You have invested money in 
your Mac Classic and, to ensure long life, should place it in an area 
where it will be protected. 

The Mac Classic cannot be damaged easily, but you should prmect it 
from certain heat and climate conditions. The machine should not be 
placed in direct sunlight for extended periods of time. Long-term 
exposure to direct sunlight can generate excessive heat and damage the 
computer. 
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You should not place the Mac Classic where it will be subjected to high 
heat. Computers generally prefer cool environments. Room temperature 
or slightly cooler is the best setting. Conversely, extreme cold should be 
avoided. 

Water is perhaps the most damaging element of aU. Your Mac Classic 
should not be subjected to high humidity or liquids. To avoid acci
dental spills and food crumbs, you should not eat o r drink close to the 
machine. 

Large amounts of dust and smoke can cause problems in the long term 
by clogging such mechanical parts as the disk drive. The computer area 
does not need to be as dust-free as an operating room, but it should be 
free of dust clouds. 

Although these seem to be simple considerations, you should take some 
time to tl1ink them over. Consider a customer I tried to help when I 
worked in the technical support department of a software company. 
After many futile questions, I finaJly discovered that his computer was 
located in a barn where the temperature would rise to as much as 120 
degrees-not to mention the dust and dirt. Needless to say, he had disk 
failures on a regular basis. 

You should plug the Mac Classic into a three-prong outle t because the 
machine needs t11e grounding provided by this type of receptacle. If you 
have two-prong outle ts only, you should consult an electrician to make 
certain that your Mac Classic is properly grounded. You should avoid 
using the three-prong-to-two-prong adapters that connect three-prong 
plugs to two-prong outlets. 

For additional protection, you should purchase a power-surge protector 
to plug the Mac Classic into. Be careful when purchasing surge protec
tors. Many power strips do not offer much protection to your computer 
but merely act as multiple outlets. 

Power-surge protectors guard against sudden, momentary increases in 
the voltage level, called power spikes. Verit)• with your dealer that the 
power-surge protectOr you purchase reacts quickly to clamp (stOp) these 
equipment-damaging voltage increases. You also should check that the 
surge protector meets the Institute of Electrical and Electronics Engi
neers (IEEE) standards for RFI (Radio Frequency Interference) and 



EM1 (Electro-Magnetic Interference). These types of imerference in your 
electrical power can cause your Mac Classic to behave strangely and 
reduce the life span of the computer. 

These standards should be clearly marked on the box or advertised in 
mail-order catalogs. You will note a specified clamping voltage, which is 
the highest level that the surge protector permits the voltage to rise. A 
typical response time, which indicates how quickly the device reacts to a 
power surge, usually will be stated in nanoseconds, \Vhich are billionths 
of a second. The lower these numbers are, the better the protection. 
UndeJWriter's Laboratory approval and IEEE conformity ·will be clearly 
stated. 

lfyou live in an area with violent thunderstorms, a surge protector 
will not protect your computer from lightning strikes. Only 
unplugging the machine can protect your Mac Classic from 
thunderstorms. Lightning strikes can burn out equipment that is 
plugged into the outlet, even when the machine is turned off and 
despite power-surge protection. Consider checking with your local 
power company to determine whether you have lightning arrestors 
on your power lines and how you can add them if you do not 

Finally, if you have a Mac Classic with a hard drive or are adding a h;u·d 
drive to your Mac Classic, do not place the machine where it will be 
subjected to strong vibrations or jolts. 

Viewing the Mac Classic 
efore discussing the specifics of hooking up the Mac Classic and 
installing the System software, you shou ld take a moment to 
become familiar with the hardware of the Mac Classic System. 

The basic Macintosh system has changed little in appearance since its 
introduction in 1984. Despite all the advances in the internal hardware 
and software, the Mac Classic retains the simplicity of the original 
Macintosh. You need to recognize only a few components to use the 
Mac Classic (see fig. 1.1) . 
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Fig. 1.1. 
The Mac Classic system 

with a left-handed setup. 
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-I-- t----screen 

Keyboard 

The screen is a 9-inch diagonal, black-and-white CRT (cathode ray tube) 
similar to those in portable televisions. Here, the Mac Classic displays the 
results of your work, the contents of disks, and the menu controls. 

You will , from time to time, need to save or reu·ieve information from 
disks. Chapter 4 explores the various types of disks and how they are 
used . For now, you only need to know the location of the disk drive. The 
drive usually is called a SuperDrive. This name refers to the 1.4 million 
characters the SuperDrive can store on a single disk and its capability to 
use IBM PC format disks. 

Keyboards have changed little since tl1e invention of the typewriter 
about a century or more ago. If you have never used a computer before, 
you will notice that several keys have been added to the old Q\VER1Y
keys layout used witl1 typewriters. These keys will enable you to perform 
various special fuqctions, such as opening documents, quitting programs, 
and moving tlte cursor. The keyboard is discussed in greater depth in 
Chapter 3. 

Look at the mouse. If you turn it over, you will no tice a small ball that 
enables the mouse to roll on the desk o r table top and send information 
concerning its movements to the Mac Classic. On top is a single button 
that enables you to control various functions of tl1e Mac Classic. 



The most important part of the Mac Classic is inside the machine. The 
case hides the power supply, the CPU (central processing unit), the 
memory, the hard drive if you bought one, and other mysteries of 
silicon contained in small, integrated circuits, which also are called !Cs 
or chips. You can learn about chips, buses, access times, and other terms 
d1at technical people use. With the Macintosh, however, you also can 
shrug your shoulders, say "Who cares?" and go on to do productive 
work. 

Connecting the Mac Classic 

Fig. 1.2. 
The back of the 

Mac Classic. 

ou need to make only a few connections to set up the Mac Classic 
for use. You will find two cords and the mouse, which total five 
plugs, included with the Mac Classic. Study figure 1.2 to familiarize 

yourself with the back of the machine before proceeding. 

ADB - -+tl-101 

pon 

Floppy drive _j 
pon 

t-1-t----h"------- Power 
switch 

Ht--t-- ---h'h'-.1'-- -- Power 
socket 

1-1-~>"-------- Audio 
jack 

'---- - - - -- Telephone 

Printer pon 
pon 
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The most obvious necessary connection is the power cord. The socket 
end of the cord is the rubber end with no metal prmrusions. This plugs 
into the Mac Classic directly below the power switch. The opposite end 
plugs into a power outlet or a surge-prmected power strip, which is the 
preferred method. 

The keyboard is connected to the Mac Classic by the short cord with 
round plugs on both ends. This cord is partially curled just Like a 
telephone handset cord to enable it to stretch. 

One end of the cord plugs into the ADB (Apple Desktop Bus) outlet on 
the back of the Mac Classic (refer to fig. 1.2) . The plug and outlet have 
matching symbols to help you identify them. The plug can be inserted 
only one way. The flat top with the ADB symbol should be upward. 

The other end of the cord plugs into one of the round outlets at the top 
of the keyboard with the same symbol. Which of these outlets you use 
depends on whether you are right- or left-handed. Left-handed individu
als should use tl1e outlet on the right. Right-handed people use the left 
outlet. This configuration enables the opposite outlet to be used for the 
mouse. Again, the flat top of the plug should be upward and the symbol 
on it visible when you attempt to insert it. 

The mouse has a single plug. This goes into the unused outlet at the top 
of the keyboard, opposite the plug of the keyboard itself. Again, they 
have matching symbols to help you locate them. 

Installing the System Software 

TIP: 
Lf you are a new user, 

skip to Chapter 2, 
"Getting Staned with 

the Mac Classic," to 
familiarize yourself 

with Mac basics. The 
Macintosb Basics disk 
provided by Apple also 

is an excellent introduc-
tion. Return to this 
chapter to create a 

working Startup Disk. 
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he Mac Classic needs the System software to function. System 
software is a unique form of software that tells the computer, "This 
is what kind of computer you are; this is what you do; and this is 

how you do it." The System software is provided by Apple and is 
included with your Mac Classic. At tl1is writing, it consists of two disks: 
System Startup and System Additions. 

In most cases, hard drive users find that the System software already is 
installed on their hard disks. If this is true, you can skip this section. If 
not, you need to install t11e System software on the hard disk. 

Floppy drive users must create a disk called the Sta1'tup Disk. This disk 
contains the System software, which is copied to it by a special progr-Jm 
called the Apple Installer. The steps fo r making this copy are Listed in 
this section. 



Fig. 1.3. 

To create a Starrup Disk, perform the foUowing steps: 

1. Turn on the Mac Classic. 

On the back of the Mac Classic is only one switch. The switch is 
near the power-cord receptacle. On this switch are a 1 (one) and a 
0 (zero). The 1 represents on and the 0 represents off. Press the 1 
and rock the switch upwards. The screen lights and you hear a soft 
ding. 

2. Insert the System Startup disk provided by Apple. 

Take a careful look at figure 1.3, which shows the proper orienta
tion for inserting a disk into the Mac Classic's disk drive. Inserting 
a disk improperly can damage your Mac Classic. Pay close atten
tion to the orientation of the disk. 

Metal shuuer 

Cut edge 
Inserting a disk. Direction of 

insertion arrow 

NOTE: 
The metal slmtter goes 
into the drive first. The 

two, square holes on 
the edge of tl1e disk 

should be facing you. In 
the upper left corner is 

an arrow pointing in 
the direction of 

insertion. The upper 
right corner has a 

cut edge. 

The disk label is upside 
down bur clearly visible. 
Finally, there is a small, 
round opening on the 
underside of the disk, 

which contains a metal 
bub. If you can see tl1is 

hole, you have rhe 
wrong side up; turn the 

disk over. 

Write-protect 
slider 

High-density 
indicawr 

3. The drive spins and you see a Welcome to Macintosh message. 
Soon the desktop appears (see fig. 1.4). The System Startup disk 
icon is in the upper right corner. Hard drive users will also see the 
icon for their hard drive appear below the System Startup disk. 
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Fig. 1.4. 
The Mac Classic desktop. 

TIP: 
You may not see the 

desktop appear. 
Sometimes Apple ships 
disks that proceed into 

the install program at 
startup. If a Welcome to 

the Apple Installer 
message appears after 
step 2, skip to step 7. 

Fig. 1.5. 
The System Startup 

disk window. 
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As you move d1e mouse around on your desk, the small, black 
anow on the screen moves with it. Move the mouse until the 
small, black arrow is on the System Startup disk icon on me 
suct::n. 

4. Press d1e mouse button Lwice quickly. 

A window opens and you will see something similar to figure 1.5. 

• File Ed i t Uiew Special 

~D System Startup 011 
71lems I ,24 1K In disk 1751( available 

cru ~ [jJ Q 
-

Sys tem Folder Installer lns tollor Sor lpt 

~ 
c:::::J ~ 

Apple HD SC Sttup Disk Fkst Aid 

~ !l 
TuchTt><t R .. dMt 

0 
101 IQ 121 



Fig. 1.6. 
The Easy Install window. 

5. Move the mouse until the small, black arrow is on the Inscaller 
icon, which is shown in the upper middle of the window in 
figure 1.5. 

6. Press the mouse button twice quickly. 

A Welcome to the Apple Installer message then appears. 

7. Press d1e return key on the keyboard. 

You then see the Easy Install window (see fig. 1.6) . 

Easy Install :···----------------------------------------------------------------------·---·-------,. 
Click Install to place 

lln update to Uersion 6.0.7 of 
• Macintosh (Uniuersal) System So ftwore 
• llny etlisllng Printer Software (( Install J) 

on the hord disk named 

L--~---~-~~-~~~~-----··--·· ............................................. - .......................... ------------------------.. ·----

3.0.1 
Help 

( £}<!< t Oisl: J 

[Switch Disk J 

[ customize J 

Quit 

From here, you follow different procedures depending on whether you 
install the software on a floppy drive or a hard drive. The following 
sections describe each process. 

Floppy Drive Users 

Floppy drive users receive a message saying they cannot install on the 
Installer disk. This is not a problem; follow d1ese steps: 

1. Move the mouse until the small, black arrow is on the words 
Eject Disk. 

2. Press the mouse button. 

Chapter 1 
Setting Up the Mac Classic 



Fig. 1.7. 
The initialization window. 

NOTE: 
Floppy drive users need 

a new, blank, high· 
density disk to make a 

Startup Disk. Your 
dealer probably sold 

you at least one box of 
these disks when you 
purchased your Mac 
Classic because you 

cannot do work widtout 
mem. If you do not 

have any of these disks, 
you must purchase a 

box immediately. 

When you purchase 
disks, choose high· 

density disks. Double· 
density disks cost less 
but have more man a 

third less storage space 
on each disk. Because 
the System software is 
so large, you will find 
that the slightly more 

expensive high-density 
disks are worth me 

eJ.:tra cost for easier use 
of the Mac Classic. 
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3. The System Startup disk ejects from the Mac Classic. 

Remove the disk. 

4. Insert a new, blank disk. 

A message tells you that this disk is unreadable and asks whether 
you want to initialize it (see fig. 1.7). 

Eosy l nstoll ---·-----------·-·-·---------------------------
Click Ins 111 tn niAr. R 

An up 
• Moe 

This disk is unreodoble: 

• Any Do you wont to initialize it? nstall Jl 

on the hi n Eject J] [ I nitio lize J 

___ =:_~~~-~.!~=~~~=====~;;;;;;;;;;~~" ·-·-·--

3.0.1 
Help 

5. Place the mouse pointer on the word Initialize. 

6. Press the mouse button. 

( r: )<l< t Oisk I 
[ Switch Disk J 

( Customize I 
Quit 

You are notified that you are about to erase the contents of the 
disk. Because d1e disk is new and blank, this is not a problem. 

7. Place the mouse pointer on the word Erase. 

8. Press the mouse button. 

The disk will be initialized, which prepares it for use. You then are 
prompted to type a name for the disk (see fig. 1.8). 

9. Type Startup Disk. 

10. Move the mouse pointer onto the word OK. 



Fig. 1.8. 
Naming the disk. 

Fig. 1.9. 
The System Startup 

disk is requested. 

-~-~-s-~--~~-~~~!! __________________________________ ·-·--·---·--·-··----·-------------·- -·---·------·---
i 

Click Ins oil In nl"~" 

Pleose n ome this disk: An up 
• Moe 
• Any I Sto r tup Disk nsto ll JJ 

L.---~--;~~;_b===~~:Qi~o~K~~~J~===·· ;;;;;: .... d. ......... ·-------···-------j 

3.0 .1 
Help 

11. Press the mouse button. 

( t: j<H t Olsl:: J 

[ Switch Disk ) 

( Customize J 

Quit 

The disk is formatted and verified. After this process is complete, 
you are ready to install the System onto this disk. 

12. Place the mouse pointer onto the word Install (refer to fig. 1.6) . 

13. Press the mouse button. 

The installer determines the disks needed and asks for them in 
turn (see fig. 1.9). 

Eosy I nstoll 
~--rr===========================~--i c 
i Dele ITI;n;nn mh;rh <H ~It~ .,;u hn nnarlarl 

I 
I Pleose Insert the disk: 
i 

i System Stortup 

i 0 
i 

L. .. ~ 
I nstolllng onto the disk "Stortup Disk" 

Preparing to instoll ... 

J 

J 
J 

.__ ___________ ___.] [ Concel ) 

J 
3 .0 .1 

l lh>lll J l l)ult J 
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Rg. 1.10. 
The Special menu. 
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14. When the installer is finished, it notifies you. Floppy drive users 
may want to make another startup disk so that they have a backup 
copy if the first fails. 

To do so, place the mouse pointer over the word Continue, and 
press the mouse button. Then return to step 1 and follow the 
same procedure. 

15. When you wish to quit, place the mouse pointer over the word 
Quit, and press the mouse button. You are returned to the 
desktop. 

16. Move the mouse until the black arrow is over the word Special at 
the top of the screen. 

17. Press and hold the mouse button. 

The Special menu appears (see fig. 1.10). 

~ ~ 
~pplt HD SC Sttup Disk First Aid 

18. Move the mouse down until the black band is around the word 
Restart. 

19. Release the mouse button. 



Installing System 7 

The Mac Classic ejects the disk from the floppy drive. Floppy drive users 
should now insert the newly created Startup Disk into the drive. 

Hard Drive Users 
After displaying the Easy Install screen (refer to fig. 1.6), follow these 
steps to install the System software on a hard disk 

1. Place the mouse pointer onto the word Install. 

2. Press the mouse button. 

The installer determines the disks needed and asks for them in 
turn (refer to fig. 1.9). 

When the installer is finished, it notifies you. 

3. Place the mouse pointer over the word Quit, and press the mouse 
button. You are returned to the desktop. 

4. Move the mouse until the black arrow is over the word Special at 
the top of the screen. 

5. Press and hold the mouse button. 

The Special menu appears (refer to fig. 1.10). 

6. Move the mouse down until the black band is around the word 
Restart. 

7. Release the mouse button. 

The Mac Classic ejects the disk in the floppy drive. 

sers who have the System 7 upgrade kit should follow the same 
basic procedures fo r installation. One difference is that the 
desktop does not appear. Rather, the installation program starts 

immediately. 

You must have a hard disk and at least 2 megabytes of memory to install 
and use System 7. Apple does not recommend installing System 7 on a 
floppy-disk-only Mac Classic. 
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Chapter Summary 
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his chapter covered choosing a location for your Mac Classic, 
setting up the hardware, and installing the software. Your Mac 
Classic is now ready to begin work. 

In the next chapter, you will work through a hands-on tutorial, where 
you perform various basic fu nctions with the System software to become 
fam iliar with how the Mac Classic works. 



Getting Started 
with the Mac Cl 

his chapter takes you on a quick, hands-on test drive of the Mac 
Classic. In this chapter, you perform such tasks as formatting a 
disk, creating a folder, and creating a document. This chapter is 

intended to familiarize you with the basic operations of the Mac Classic. 
If you have used a Macintosh before, you may want to skip this chapter. 

If your Mac Classic does not have a hard drive, you need the Startup Disk 
created in Chapter 1. You may, if necessary, use the System Starn1p disk 
provided by Apple, but you should create a Startup Disk as soon as you 
can. You should avoid using original disks of software when possible. 
This way, your original disk acts as a backup copy if your working disk 
fails. 

Starting the Mac Classic 

MAC 
CLASSIC 
B 0 U K 

Turning on the Mac Classic is a simple operation. As stated in Chapter 1, 
the power switch is the toggle-style switch on the back of the machine. 
Press the upper part of the switch so that the switch rocks upwards. The 
machine comes on and you hear a tone. 

If you have a hard drive, you see the Welcome to Macintosh message 
appear almost immediately. Then the desktop appears (see fig. 2. 1). 



Fig. 2.1. 
The Mac Classic desktop. 
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Your desktop may appear different than the one in the figure; you may 
have d ifferent software packages installed. If you do not have a hard 
drive, you insert the Startup Disk you created in Chapter 1 before d1e 
Welcome to Macintosh message and the desktop appear. 

Mac Classic users wiiliou t a hard drive always need to insert d1e Startup 
Disk after turning on the machine. Those with hard drives need to insert 
a disk only if d1ey want to work with its contents or copy information 
to it. 

The meta.l shutter of a d isk always goes into d1e Mac Classic's 
floppy drive first. You should not see a small, metal circle in the 
center of ilie disk. If you do, you have the disk upside down; turn 
it over. 

Aliliough disks are called double-sided, they cannot be turned over 
like a record. Computer d isks are more like compact disks. If you 
turn d1em over, you get naming. Worse, you can damage the 
floppy drive of the Mac Classic. 

The disk icon in the upper right corner of your screen may vary from the 
one in d1e figures. Floppy disk users see a small floppy d isk. Hard disk 
users see a small rectangle. The icons operate the same. 



Fig. 2.2. 
Selecting the Startup Disk. 

Hard disk users should skip the following steps and proceed to the next 
section, "Initializing a Disk." Floppy disk users should read the fo llowing 
steps. 

After the desktop has appeared, follow these steps to eject the Startup 
Disk: 

1. Move the mouse until the small arrow, the mouse pointer, is 
directly over the Startup Disk icon (see fig. 2.2) . 

2. Press the mouse button once and release. The Startup Disk icon 
darkens. 

3. Move tl1e mouse until the mouse pointer is on the word File in the 
upper left corner of the screen. 

4. Press and hold the mouse button. The File menu appears. 

5. Continue to hold down the mouse button. Move the mouse so 
d1at me mouse pointer moves down me menu. As you do so, a 
dark band appears around each command that you pass. 

6. Move the mouse pointer co the Eject command-the dark band 
will be around d1e word Eject as in figure 2.3-and release the 
mouse butcon . 

Chapter 2 
Getting Started with the Mac Classic 



Fig. 2.3. 
Selecting the Eject 

command. 

Initializing a Disk 

NOTE: 
The Mac Classic may 

periodically eject a disk 
and display a message 

that tells you to insert a 
different disk. The Mac 
Classic asks for disks by 

name. Simply remove 
the ejected disk and 

insert the one 
requested. 
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The Startup Disk is ejected from the Mac Classic. Remove the d isk and 
insert a new disk that has not been used previously. You are ready to 
proceed with the next section, "Initializing a Disk." 

fyou have not already done so, insert an unused floppy d isk into 
the disk drive. Anytime you insert a disk that has never been used, 
you see a message on the screen as in figure 2.4. 

The Mac Classic is info rming you that it cannot read this d isk and is 
asking what you want to do. You should see this message only after 
inserting a new disk. If you ever see it after inserting a disk that you have 
previously used, something is wrong with the d isk. See AppendLx B, 
"Troubleshooting," fo r suggestions if you encounter th is problem. 

Because this is a new disk, you must initialize it, which prepares it for 
use on your Mac. To initialize a disk, fo llow these steps: 

1. Click the appropriate initialize button. 

The Mac Classic then asks whether you are certain you want to 
erase the disk (see fig. 2.5) . 



Fig. 2.4. 
The initialization screen. 

Fig. 2.5. 
Initializing a disk. 

This disk is unreadable: 

Do you want to initialize it? 

n Eject D (One-Sided) (Two-Sided) 

This process will erase all 
information on this disk. 

Cancel ~ Erase ~J 

2. If you are cen ain that the disk you inserted is a blank disk, d ick 
the Erase button. If you are not certain, click the Cancel button to 

eject the disk. Then insert a blank disk. 

Next, you are asked to name the disk. Any name not containing a 
colon (:) is fine. For now, keep it simple and follow the remaining 
steps. 

3. Type The Disk. 

4. Press the return key on the keyboard. 

The Mac Classic then formats the disk for you. You see a message that 
the disk is being prepared. Wlhen the disk is ready for use, the floppy 
disk icon appears on the desktop (see fig. 2.6). 

The figure shown is for hard drive users. Floppy drive users will see 
the icon for their Startup Disk in place of the Hard Disk icon. 
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Fig. 2.6. 
The icon for the newly 

initialized disk. 

Opening a Disk Icon 
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o see the concents of a disk, you must open its icon, which is the 
picture representing it. This procedure is the same for hard and 
floppy disks. In ti1is example, you should work with the d isk you 

just formatted. To open a d isk icon, fo llow these steps: 

1. Move ti1e mouse until the mouse pointer is on the icon of The 
Disk. 

2. Press the mouse button twice quickly. This is called double· 
clicking. The disk icon opens as in figure 2.7. 

The appearance of the disk icon changes. Instead of being a clear 
p icture, it is now gray. For disks, ti1e gray indicates that the disk is 
open. In general, any gray icon indicates an open element. 

The newly fo rmatted disk contains nothing. At the top of the window, 
the name of the disk, The Disk, is shown in the title bar. Because you 
can have more than one window open on the Mac Classic, the title bar 
indicates which element is which. 

Below the disk name is some information about the disk. On the left , 
you see the notation 0 items. This indicates the number of items stored 
on the disk: none. In ti1e center, you see ti1e amount of information on 
the disk measured in kilobytes: 12K. 



Fig. 2.7. 
Opening a high-density 

disk icon. 

NOTE: 
l K is 1,024 bytes or 

characters of informa
tion. K is an abbrevia

tion for kilo, which 
usually indicates 1,000. 
In the computer world, 
however, everything is 

done in powers of 2. 
1,024 is 2 multiplied by 

itself 10 times. 

Creating a Folder 

You see that even an empty d isk has some information on it. The Mac 
Classic srores an invisible fiJe to track the items you store on the d isk. 
You will never see a disk with OK on it. 

To the far right is the amount of space remaining on the disk. The 
amount depends on the type of disk you are using. Figure 2.7 shows the 
window of a high-density disk. An 800K floppy probably reads something 
like 776K available. 

The numbers may not add up because some space is used by the 
formatting process itself. Don't be concerned about this discrepancy. 

System 7 users will see a slightly different notation used for disk space. 
M, which stands for megabytes, represents 1,0241(, approximately one 
million characters. A high-density disk has 1.4M available. 

a lders in the Macintosh world are similar in concept to folders in 
an office. A fo lder or disk can hold documents, application 
programs, and otl1er folders. 

Folders are discussed in greater depth in Chapter 5. In this chapter, you 
perform only some simple steps. Creating a folder is a simple task. To 
create a folder, follow these steps: 
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Fig. 2.8. 
Selecting the New Folder 

command. 
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1. Move the mouse pointer to the word File. 

2. Press and hold the mouse button. The File menu appears. 

3. Move the mouse down until you reach the New Folder command. 
A black band follows the mouse pointer until it encompasses the 
New Folder command (see fig. 2.8). 

17t~t lnlll >)(<J 
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4. Release the mouse button. 

The File menu disappears and an Empty Folder appears in the 
window of The Disk as in figure 2.9. 

The number of items indicator has been increased to 1 (one). The 
folder 's name can be changed if you wish (see Chapter 5). 

New folders in System 7 appear with the name Untitled Folder rather 
than Empty Folder. 



Fig. 2.9. 
A new Empry Folder. 

Copying a Folder 
opying an item on a disk is done by using the Duplicate com
mand. This applies to any item, not just folders. To copy the 
folder just created, follow these steps: 

1. Move d1e mouse until the mouse pointer is on the folder. 

2. Press d1e mouse button once. The folder darkens to indicate that it 
is selected. 

3. Move the mouse until the pointer is on the word File. 

4. Press and hold the mouse button. The File menu appears. 

5. Move the mouse down; the dark, highlighting band follows until it 
reaches the Duplicate command. 

6. Release d1e mouse button. 

A second folder appears next to d1e first (see fig. 2.10). 
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Fig. 2.10. 
A duplicate folder. 

Deleting a Folder 
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Any item on a disk may be duplicated in this manner. The window now 
indicates 2 items. 

Duplicated icons in System 7 do not use the phrase Copy of preceding 
their names. Instead, the word Copy is added to the end of the icon 
name, such as Untitled Folder Copy. 

eleting an item from a disk also is a simple procedure. To delete 
the folder just created, fo l.low these steps: 

1. Move the mouse until the mouse pointer is on the folder called 
Copy of Empty Folder (Untitled Folder Copy in System 7). 

2. Press and hold the mouse button. The folder darkens to indicate 
that it has been selected. 

3. Continue pressing the mouse button and move the mouse to the 
lower right corner, toward the icon of the Trash. An outline of t11e 
folder moves with the pointer (see fig. 2.11). 



Fig. 2.11. 
Moving Copy of Empty 

Folder to the Trash. 

4. Move the mouse until the folder is over the Trash. The Trash icon 
darkens when the folder is in the proper position. 

5. Release the mouse button. 

The folder then disappears. If it appears over the Trash, you did not wait 
until the Trash icon darkened before releasing the mouse button. If this 
happens, repeat the preceding steps. 

The Trash icon enlarges to indicate that it now contains something (see 
fig. 2.12). 

To empty the Trash, follow these steps: 

1. Move the mouse poinrer to the Special menu , and place the 
pointer directly on the word Special. 

2. Press and hold the mouse button. The Special menu appears. 

3. Move down to the command Empty Trash. 

4. Release the mouse button. 

The Trash icon returns to normal, which indicates that it is empty. 
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Fig. 2.12. 
The Trash containing a 

deleted item. 

Closing a Disk Icon 
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LJ 
Empty Foldrr 

These extra steps are necessary because items in the Trash are not 
deleted from the disk until the Trash is emptied; you can retrieve an 
item from the Trash before it has been emptied-in case you change 
your mind about throwing something away. Chapter 3 discusses 
reu·ieving items from the Trash. 

o close the window of the disk, you use the close box, which is 
located in the upper left corner of the window. To close The Disk, 
follow these steps: 

1. Move the mouse until the tip of the mouse pointer is in the close 
box (see fig. 2.13). 

2. Press the mouse button once. 

The disk icon no longer has the gray appearance that indicated it was 
open. 



Fig. 2.13. 
Using the close box. 

Ejecting a Disk 
ou can use several methods to eject a disk. One method is 
explained here; d1e others are discussed in Chapter 4. Follow 
these steps to eject the disk called The Disk: 

1. Move the mouse until the mouse pointer is on the icon for 
The Disk. 

2. Press and hold the mouse button. 

3. Move the mouse down toward the Trash icon until the Trash icon 
darkens. 

4. Release the mouse button. 

The disk ejects. Although this is the same procedure used to delete an 
icon, it does not erase any information from the disk. This may seem 
somewhat confusing and, indeed, it is not consistent with other uses of 
the Trash icon. You are not deleting the disk, only ejecting it from the 
Mac Classic. This is the only time that placing something in the Trash 
does not delete it. Erasing a disk requires choosing the Erase Disk 
command, which is discussed in Chapter 4. 
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Shutting Down 

Chapter Summary 
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The shutting down procedure is used any time you want to stop using 
the Mac Classic and wish to turn it off. You must do this before turning 
off the machine. If you do not, you might damage your floppy or hard 
drive. To shut down your Mac, foUow these steps: 

1. Move the mouse pointer to the Special menu. Place the pointer 
directly on the word Special. 

2. Press and hold the mouse button. 

3. Move the mouse down until the dark, highlighting band is over the 
Shut Down command. 

4. Release the mouse button. 

A message appears shortly and States: You may now turn off your 
Macintosh safely. 

5. Turn off the Mac Classic. 

ow you should have some idea of how the Mac Classic operates. 
In d1is chapter, you learned how a disk is inserted, formatted, 
opened, closed, and ejected. You created a new folder and 

duplicated and deleted an icon, which, in this case, was a fo lder. 

Not all of this information may be clear to you yet. Do not worry. The 
foUowing chapters cover these operations in greater depth. This chapter 
just gets you ready to explo re in depth the Finder Desktop, which is the 
main work space of the Mac Classic. 
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o understand the Finder desktop, you must fLrSt understand the 
Finder. The Finder is part of the Macintosh System software. It is a 
program that the Mac Classic runs just as it might run your copy of 

the MacWrite II word processing program. Unlike MacWrite II, however, 
the Finder is a necessary part of the System software and runs at aU 
times. 

The Finder's primary function is to manage the desktop . Finder finds 
and manages the icons and menus that appear on the Mac Classic screen 
when you first start the machine. The Finder is the part of the System 
sofuvare that copies icons, opens the windows, and duplicates docu
ments. In Chapter 2, you worked with d1e Finder as you issued com
mands. 

The desktop that the Finder manages is the primary work area of the 
Mac Classic. The menus and icons you work widl in the Macintosh 
system appear on the desktop. Understanding the desktop is crucial to 
understanding the Mac Classic and all other Macintosh computers. 

The desktop uses familiar symbols in a computer interface. The desktop 
corresponds to d1e top of a desk. It is the area where you place items 
you work widl. Of course, a computer and a desk can have only so many 
similarities. Desks do not come with menus nor do they need disks. 
However, using familiar symbols and understanding d1e desktop as a 
work area can help you learn d1e Macintosh interface more quickly. 



Defining Desktop Components 
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he desktop itself is a simple work area like the top of an ordinary 
desk. However, several of the important parts of the Macintosh 
interface are linked wid1 the desktop. The menu bar, ilie Mac 

Classic's command center, always appears with the desktop. The Trash 
and disk icons reside on ilie desktop. Although these items are not 
actuaUy pan of the desktop, d1ey are closely related and are discussed in 
this section. 

The Desktop 
If you worked through Chapter 2, you have seen the desktop and 
worked wid1 it. This section explores the desktop in greater depth. 

The work area is the biggest part of the desktop. This area is available to 
you to organize and work wiili as you like. Most of the screen is blank, 
just as a new desk has no papers or office tools on it. 

The desktop usually is a neutral, gray pattern. You can modify the 
desktop, if you choose (see Chapter 7). lnitiaUy, only the following items 
appear on d1e desktop: d1e menu bar along the top, ilie Startup Disk 
icon-your hard disk or floppy-at ilie upper right corner, and d1e Trash 
icon at the lower right corner. 

The Menus 
At the top of the desktop is the menu bar. This collection of menus 
contains the basic commands of the program currently running. When 
you first stan the Mac Classic, only the basic operating system is running, 
and the menu bar contains commands that apply to the Macintosh 
system itself. The commands are grouped into the categories you see on 
the menu bar. The following list defines d1e menus: 

Apple menu. This menu contains d1e small programs referred to 
as desk accessories, such as calculators, address books, and 
dictionaries. 

Under System 7, ilie Apple menu also can contain oilier items, 
such as frequently used documents and folders. 

File menu. This menu contains commands related to operations 
with documents and disks. 

Edit menu. This menu contains d1e commands that are used for 
editing text and graphics. 



View menu. This menu contains the commands that control the 
manner in which items within windows on the desktop are listed. 

Label menu. New for System 7, this menu is used for labeHng 
icons. You do not see this menu unless you are running the new 
System. 

Special menu. This menu contains several commands that con
cern the operating system only, such as the Shut Down command 
you used in Chapter 2. You do not see this menu when running 
other programs. 

In a later section, this chapter considers each menu and the commands it 
contains. For now, you should note only the location of the menu bar 
and generally understand what type of commands are located in each of 
the menus. 

The Icons 
Icons are pictures used to represent an item in the Mac Classic environ
ment. An icon may represent a disk, a folder, a document, an application 
program, or other such item. 

You see many icons in your use of the Mac Classic. Two basic icons 
appear on the desktop: disk icons and the Trash icon. 

The Disk Icon 

If you worked through Chapter 1, you saw that an icon of a disk- the 
built-in hard drive or an inserted floppy-appears in the upper right 
corner of the desktop. Figure 3.1 shows how disks appear as icons on 
the desktop. 

The upper right icon is that of a hard drive. Users of the Mac Classic with 
a hard drive always see the hard drive icon appear in this position. 

Below the hard drive icon is a typical floppy disk icon. Users of the Mac 
Classic without a hard drive always see their Startup Disk appear as a 
floppy disk icon in the upper right corner, where the hard drive icon 
appears in figure 3.1. 

The upper right position is where the Mac Classic places the icon of the 
disk drive-floppy, hard, or otherwise-from which it starts. This is the 
disk where the System software resides. 
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Fig. 3.1. 
Disk icons on the desktop. 
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The icons of other disks are placed below the Startup Disk icon. In fig
ure 3.1, a floppy disk icon named Data appears below the hard drive 
icon. This represents a disk in the floppy drive and ready for use. The 
d isk Data is an example; your disk may be named differently. 

Working with a disk icon is how you obtain access to the information 
contained on the disk itself. Chapter 2 introduces you to openjng an 
icon. L1ter in d1is chapter and in Chapter 4, the various ways to work 
with disks and disk icons are explored in greater detail. 

The Trash Icon 
The Trash icon is unique. The trash-can symbol was chosen to represent 
its purpose: disposing of items. If you worked through Chapter 2, you 
saw how the Trash icon is used to remove a folder. This same procedure 
can be used for any icon whether it represents a document or a pro
gram. Anything you want deleted, you place in the Trash icon. 

Other Icons 
You see many kinds of icons as you work with the Mac Classic. Some 
sample icons are shown in figure 3.2. They will become more familiar as 
you work with them. 



Fig. 3.2. 
Various Icons in d1e 

Macintosh System. 
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Application icons can vary considerably. Each software company has 
developed the icons for their products in a distinctive manner. This 
variety has created many different icons and makes them hard to 
categorize. However, most application icons suggest the program they 
represent quite well . 

he mouse is not actually part of the desktop but is so closely 
related that it is included in this chapter. The mouse is used to 
work with all parts of the desktop. By using the mouse, you may 

choose commands from the menu, open and close icons, and drag 
documents to the Trash. 

This small device has a simple design. On d1e bottom of the mouse is a 
ball that rolls across your desk top. On the top of the mouse is a single 
button. Signals are sent to the Mac Classic through the wire that extends 
from the top of me mouse. 

As you move the mouse, you see that the mouse p ointer, the small, black 
arrow on the Mac Classic screen, moves with it. By moving this pointer 
across the on-screen desktop and pushing the mouse button at various 
times, you communicate your commands to the Mac Classic. 

Despite d1e simplicity of me mouse, you may perform several different 
functions with it, as described in the following sections. 
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Fig. 3.3. 
The Data disk after being 

selected by clicking. 
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Clicking 
Selecting an icon is done by a process called clicking. Clicking is a term 
used frequently in the Macintosh world, usually as a verb. You will see it 
mainly in such sentences as, "Click the document icon." 

You click an icon to indicate to the Mac Classic that the next command 
you issue is to affect that icon. Clicking is simple. Use the following steps 
to click on any icon: 

1. Move the mouse pointer until it is directly on the icon. 

2. Press the mouse button once. The icon darkens ro indicate that it 
has been selected (see fig. 3.3). 

Dragging 
You move an icon by a procedure called dmgging. In Chapter 2, you saw 
how dragging is used to place an item in the Trash. To move an icon, 
fo llow these steps: 

1. Place the mouse pointer on the icon ro be moved. 

2. Press and hold the mouse button. The icon darkens. 



Fig. 3.4. 
Moving che Data disk icon. 

3. Move the mouse to d1e new location. Note that an o utline of the 
item moves alo ng with the mouse (see fig. 3.4). 

4. Release the mouse button. 

The item then appears at the new locatio n. 

Selecting Groups of Icons 
At times, you will need to select mo re tl1an just one icon. Perhaps you 
wish to copy several icons fro m o ne disk to ano ther or delete a group of 
icons. You can select more than one icon in rwo ways: shift-clicking, a 
variation o f clicking, and dragging. 

Shift-clicking is ilie same basic procedure as clicking but witl1 a slight 
change. Fo llow these steps for selecting icons by shift-clicking: 

1. Press and ho ld the shift key o n the keyboard. 

2. Move tl1e mo use pointer to the item robe selected. 

3. Press the mouse button once. 

4. Repeat steps 2 and 3 until all items are selected . 
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Fig. 3.6. 
Dragging to select a group 

of icons. 
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You also can drag to select a group of icons, usually icons close to one 
another. Icons that are widely separated or are mixed with other icons 
should be selected by shift-clicking. To use dragging to select a group of 
items, use the following steps: 

1. Place d1e mouse pointer to the upper left of the group of icons. 

2. Press and hold the mouse button. 

3. Move the mouse pointer diagonally to the lower right of the group 
of icons (see fig. 3.5). 

A box is drawn as you move. In drag selecting, you include in-or 
at least touch with-the box all of the icons you want to select. 

4. Release d1e mouse poi mer. All of the selected icons will then 
darken. 

Dragging also is used to select te>..'t in all word processing applications. 
Chapter 6 covers dragging to make text selections in more detail. 

Double-Clicking 
Opening an icon is done with a variation of clicking called double
clicking. Double-clicking is the same as clicking except that you press 
the mouse button t\',rice in rapid succession. 



NOTE: 
Triple-clicking is a 

variation on clicking 
used in some word 

processing programs. 

Fig. 3.6. 
The Data disk after being 

double-clicked . 

Using Icons 

If you worked through Chapter 2, you used double-clicking to open the 
disk icon. To open an icon by double-clicking, foUow these steps: 

1. Move the mouse pointer to d1e item to be opened. 

2. Press d1e mouse button twice quickly. The disk is opened (see 
fig. 3.6). 

Usually, an icon mat has been double-clicked has a gray appearance to 
indicate it is open. In figure 3.6, the Data disk is gray. An icon returns to 
its previous state after it is closed. 

cons play a major part in the Macintosh interface . Much of me 
work you do on d1e Mac Classic involves using icons. This section 
discusses the basic operations mat can be performed with icons. 

Defining Icons 
Icons are pictures representing an element, such as an application 
program or a document. Icons were developed to help d1e user recog
nize the various components of a computer software system by meir 
appearance on-screen. 

Chapter 3 
Using me Finder Desktop 



Fig. 3.7. 
Sample Macintosh 

application program icons. 

Fig. 3.8. 
The MacWrite II Icons. 
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You have seen examples of the various kinds of icons used in the 
Macintosh interface. The following sections discuss the main categories 
of icons in greater depth. 

Application Icons 
AppHcation icons represent a software package, such as Microsoft Word 
or MacWrite 11. Figure 3.7 shows some of the icons used in the Macin
tosh software world. 

~~ .. : ~ ~ ~ 
Applf<>ation 'o'ord Mac'o'rit•ll MacLinkPlus Hyp•rCard FastCopy Oisinf•ctant 

Other d1an the general Application icon shown in the figure, application 
icons do not follow any pattern. Each software company designs its icon 
as wanted. This variance is not a problem, however, because each 
company has made its icon distinctive and unique. 

Many companies design icons related to their software in ways that make 
dtem easy to recognize. Figure 3.8, for example, shows the icons in the 
MacWrite 11 package. 
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The icons have a similar design that helps you identify them as being 
related to the main icon. Another way to help you identify icons is 
discussed in the section, "Getting Information about Icons," later in this 
chapter. 



Fig. 3.9. 
Sample document icons. 

Fig. 3.10. 
The main system-related 

icons for System 6. 

Document Icons 
Documenrs are closely related to applicatio n software and are covered in 
depth in Chapter 5. They contain the information, or data, that you work 
wid1 in an application. 

Document icons have an appearance that suggesrs a paper document 
(see fig. 3.9). Many also have identifying marks mat relate mem to me 
application icon. 
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One special document icon you need to identify is me Stationery 
document icon shown in figure 3.9. This icon represents a document 
d1at behaves like a statio nery pad. That is, you may tear off copies to 
\.vork wim. Statio nery documents also are discussed in Chapter 5. 

System Icons 
Many system-related icons are used in me Macintosh world, and many 
are changing appearance as System 7 replaces System 6 . The main icons 
used in System 6 are shown in figure 3.10. 
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You don't need to worry about most of d1ese icons at this point. You 
should identify, however, the icons o f me System, Finder, and 
Multifinder. 
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Fig. 3.11. 
S}'Stem 7 icons. 
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System 7 users see a differenr set of system icons. Some examples of 
System 7 icons are shown in figure 3.11. 
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It is not important to know or understand all of these icons. Rather, they 
are presented to help you become more familiar with the icon menag
erie of the Macintosh world. 

Naming Icons 
When you create your own documents, you create at the same time 
icons to represent them. The application program contro ls the appear
ance of the icon, but you can name d1e icon. 

All programs on the Macintosh ask you for a name of the document you 
have created. The initial naming is handled within the applicatio n. This 
process is discussed in Chapter 6. In this section, you learn to name an 
icon on the desktop. 

Consider figure 3.12, where a MacWrite II document icon is shown on 
the deskto p. 

As you can see, the document's name, Memo to Danna, is shown 
beneath the icon. Suppose that you want this document icon to be 
named Policy Memo to Danna. To change the name of the icon, follow 
these steps: 

1. Place the mouse poimer o n the icon. 

(System 7 users should place the mouse pointer on the icon 
name.) 

2. Click the icon. 

3. Type the name. 

4. Move the mouse pointer off the icon, and press the mouse button 
again. 



Fig. 3.12. 
A MacWrite II document 

icon. 

Fig. 3.13. 
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The old name disappears and is replaced by the new name. This 
procedure applies to all icons, not just document icons. Usually, you 
have no need to rename icons other than document icons, but you can 
make the changes. 

You can rename the Microsoft Word icon, Madonna, fo r example; but 
this change serves no purpose. Renaming system-related icons is not 
wise. Changing the names of system-related icons can result in the 
System software being unable to locate a needed icon and result in 
software errors. 

Disk icon names may be a maximum of 27 characters in length; other 
icons can be up to 31 characters. They may contain almost any character 
except the colon(:). You cannot type a colon(:) when you type an icon 
name. Instead, a hyphen(-) appears. 

If you attempt to use a name assigned to another icon, you wiU be 
notified by a message box (see fig. 3.13). 

Click OK. Then type another name for the icon. 

The message that your ~ 
requested name has been '-I That name is already tal<en. Please use 

a different name. taken. 

tt OK 
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Fig. 3.14. 
The message that the Copy 

of name is too long. 
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Copying Icons 
Any icon can be copied to the same disk on which it resides or from one 
disk to another. Copying to the same disk is usually referred to as 
duplicating the icon and is a different operation than copying an icon 
from disk to disk. 

If you worked through Chapter 2, you saw how a folder icon might be 
duplicated. To duplicate any icon, follow these steps: 

1. Place the mouse pointer on the icon to be duplicated. 

2. Click the icon. 

3. Move the mouse pointer to the File menu. 

4. Press and hold the mouse button. The Fi.le menu appears. 

5. Move down the menu until the black highlighting band is over the 
Duplicate command. 

6. Release the mouse burton. 

The icon is then duplicated. The Mac Classic names the icon Copy of 
followed by the name of the original. Therefore, Policy Memo to Danna 
becomes Copy of Policy Memo to Danna. 

In System 7, a duplicate is named after the original icon but with the 
word Copy appended. Subsequent duplicalions result in a number being 
added, such as Copy 1 and Copy 2. 

lf the Copy of name is greater than 31 characters, which is the longest an 
icon name can be, the Mac Classic notifies you and asks for a different 
name (see fig. 3.14). 

This name is too long or missing. Please 
enter a new name. 

If the Copy of name is roo long, follow these steps: 

1. Click OK. 



Fig. 3.15. 
Copying the Policy Memo 

to Danna icon. 

2. Type a new name, 31 characters or less in length. 

Copying an icon from one disk to another is a simple process that 
involves dragging, which is discussed in the previous section, 
"Dragging." The same basic process is used to move icons. 

Suppose that you want to copy an icon from a hard disk to the floppy 
disk. Use these steps: 

1. Place the mouse pointer on the icon to be copied. 

2. Press and hold the mouse button. The icon darkens. 

3. Move the mouse to the floppy disk icon; an outline of the item 
moves along with the mouse (see fig. 3.15). 

4. Release the mouse button. 

A window appears and verifies that the icon is being copied. You do not 
need to drag the icon being copied to the disk icon. If the disk icon is 
open, you can drag the icon from one window to the other, as in fig
ure 3.16. 
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Fig. 3.16. 
Dragging the icon from 

window to window. 
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Getting Information about Icons 
As you work with the Mac Classic, the number of icons you work with 
increases. After a while, you may need a way to obtain and make notes 
on information about them. 

The Get Info command enables you to compile this information. To use 
this command, perform the following steps: 

1. Click the icon on which you want information. 

2 . Move the mouse pointer to the File menu. 

3. Press and hold the mouse button. 

4. Move the mouse pointer to the Get Info command. 

5. Release the mouse burron. 

A window appears with information about the icon (see fig. 3.17). 



Fig. 3.17. 
The Get Info window. 

c=J Hard Disk 

Kind : disk 
Sin : 25,926,656 by Its USfd, 25,3 191< 

on disk, for 500 mu 
'l'horo : SCSI 0 

Cnatod : 1-/td, Apr 10, 199 1,9 :07 
Modified : Mon, Jun 24, 199 1, 14 :24 

Kind: application 
Size : 460,811 by tt s ustd, 451K on disk 

'l'hon : Hard Disk, SCSI 0 

Cruted : Thu,Stp29, 1999, 17 :00 
Modified : Fri , Jun 2 1 , 1991, 17 :25 
Version : Mac't'rlto 11 1.1 vi 

SPptomber 1989 

MaoWrito 111 .1v1 , Sf!>ttmbtr 1989 
a> 1989 Clarls Corporotlon 
All Rights Rtsorv•d 
:5201 Patrick Ht nry Drivt, Santa Clara, CA 
(409) 987-7000 

Suggested Memory Size (K) : 900 

Application Memory Sin (K) : ~ 

The Get Info window gives you the following information: 

Kind. What kind of icon this is: application, disk, etc. 

Size. Size in bytes (characters) and K (1,024 bytes). If the icon is a 
disk icon, Get Info also tells you how many files are on it. 

Where. Location of the icon. In figure 3.17, the icon is located on 
the disk named Hard Disk. The SCSI number identifies certain Mac 
peripherals and is discussed in Chapter 4. 

Created. When the icon was first created . 

Modified. The last time the icon was changed in any way. If the 
icon is a document, this option tells you the last time you made 
changes to it. 

Version. Applies only to application icons; gives you the 
application's version number as assigned by the developing 
company. 

Suggested Memory Size (K). The amount of memory an applica· 
tion needs to run; shows only on application icons. 

Application Memory Size (K). The amount of memory alloned to 
an application. How you can change this and whether you should 
is discussed in Chapter 6. 

Chapter 3 
Using the Finder Desktop 



Part I 
Using Your Mac Classic 

In the lower part of the window is a box in which you can type desired 
informatio n about the icon. To enter information in this box, follow 
these seeps: 

1. Place the mouse pointer in the box near the upper left corner. 

2. Press the mouse button once. 

3. Type the desired information. 

You may edit the text in the Get Info box at any time. To close the Get 
Info box, click the close box-the small box in the upper left corner. 

locking and Unlocking Icons 
You may want to protect an icon and prevent it from being placed in the 
Trash and deleted or to prevent changes from being made to the 
information within it. 

To protect any icon, you use the Get Info command discussed in the 
preceding section. The Get Info window contains a Locked option. 

The box to the right of the word Locked aces as a cbeck box. If an X is 
present in d1e box, d1e icon is locked; if not, the box is unlocked. To 
lock an icon, use the following steps: 

1. Place the mouse pointer in the Locked option box. 

2. Press the mo use button once. 

An X appears in the box and the icon locks. Removing the X and 
unlocking d1e icon requires the same seeps. Pressing the mouse button 
removes the X and unlocks the icon. 

Deleting Icons 
Chapter 2 shows how to delete a folder. This same procedure applies to 
icons of any type: document, application, or otherwise. You might delete 
an icon when you are finished with it or to make room o n a disk. To 
delete an icon, usc the following steps: 

1. Click on the icon. 

2. Move the mouse pointer and drag the icon to the Trash (see 
fig. 3.18). \Vhen d1e icon is in d1e proper place, the Trash icon 
darkens. 



Fig. 3.18. 
Deleting the Policy Memo 

ro Danna icon. 

Fig. 3.19. 
Screen confirming the 

deleting of an application 
program. 

TIP: 
If you want to avoid this 

message, hold down 
the option key before 

dragging the icon to 
the Trash. 

3. Release the mouse button. 

The icon is moved into the Trash. If you place an application icon or 
system-related icon in the Trash, a warning message appears and asks 
you to confirm the action (see fig. 3.19). 

Are you sure you want to remoue the 
application "MacWrite II "? 

n OK » ( Cancel ) 

If you are certain you want the icon removed, dick OK. Clicking Cancel 
returns the icon to its previous position. 

Your Mac Classic displays another message if you attempt to delete an 
icon that is locked or currently in use (see fig. 3.20) . In this case, your 
only option is to click OK. A locked icon can be unlocked and then 
placed in the Trash. 
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Rg. 3.20. 
Screen informing you that 
an icon cannot be deleted. 
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K OK ~ 

That item is locked or in use and can't 
be remoued. 

If you want to delete an icon in use, you must determine what applica
tion program is using it and quit the program (see Chapter 6). The 
system may be using the icons; those items should not be deleted. 

Retrieving Items from the Trash 
When you put an icon in the Trash, it is not deleted immediately. Under 
System 6, the Trash is emptied and the icons within it deleted in the 
following cases: 

• When an application program starts 

• When the Mac Classic is shur down 

• When you choose the Empty Trash command from the Special 
menu 

Thereto re, you can retrieve an icon from the Trash if none of the 
preceding events has occurred since you placed it there. You retrieve 
an icon by performing the fo llowing steps: 

I . Place the mouse pointer on the Trash icon. 

2. Double-click on the mouse button. The Trash icon opens (see 
fig. 3.21). 

3. Place the mouse pointer on the icon you want to retrieve. 

4. Press and hold the mouse button. 

5. Drag the icon out of the Trash window. The icon may be dragged 
to any place you choose. 

6. You can close the Trash by clicking on the close box, the small box 
in the upper left corner of the Trash window. 



Fig. 3.21. 
The opened Trash icon. 

In System 7, the Trash never empties unless the Empty Trash command 
is chosen from the Special menu. A full Trash uses disk space, so you 
should empty it periodically. 

Emptying the Trash 
Users of either system can empty the Trash by performing the following 
steps: 

1. Place the mouse pointer over the Special menu. 

2. Press and hold the mouse button. 

3. Move the mouse pointer down until you reach the Empty Trash 
command. 

4. Release the mouse button. 

As you place items in the Trash, the sides of the icon bulge. When the 
Trash is emptied, it returns to its normal appearance. 
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Using Windows 

Fig. 3.22. 
The System Folder window 

in System 6. 

indows are an integral part of the Macintosh interface. They are 
appropriately named, as they enable you to see into documents 
and applications. You see windows throughout your use of the 

Mac Classic and do most of your work in a window. 

Defining Windows 

You have seen some examples of windows so far in d1is book. When you 
open any kind of icon, you open a window. Several kinds of windows 
and variations of each type are used in d1e Macintosh interface. This 
section covers the window type you will see most often but can be 
applied to alJ other windows. 

Figure 3.22 shows the window you see when you open the System 
Folder in System 6. 

Close - -l!-.....1 
box 

Part I 

Scroll 
box 

Scroll 
bar 

Using Your Mac Classic 

The following list defines the parts of d1e System Folder window: 

Title bar. Contains the name of d1e window. Usually is the name 
of the document or other open icon. 

Size 
box 



Close box. Enables you to close the window by clicking it. 

Zoom box. Window may be made larger or smaller size by 
clicking in this box. 

Scroll arrows. Clicking one of these arrows causes the windows 
contents to move in the direction the arrow points. 

Scroll bars. Enable you to move the contents of the window more 
quickly by clicking them. 

Scroll box. Dragging this box enables you to exercise greater 
control over the moving of the window's contents or move it 
quickly. Sometimes called the thumb or elevator. 

Size box. Dragging this box enables you to change the size and 
shape of the window. 

You can follow the examples in this section by using your System Folder 
window. To open your System Folder, follow these steps: 

1. Double-dick on your Startup Disk or Hard Disk icon. 

2. Locate the System Folder. The System Folder is labeled and has a 
small picture of a Mac on it 

3. Double-dick on the System Folder. 

You should not disturb the icons contained within the folder; changes 
can cause your Mac Classic to run strangely. 

Moving Windows 
To move a window, perform the following steps: 

1. Place the mouse pointer anywhere on the title bar of the window, 
except the close box and zoom box. 

2. Press and hold the mouse button. 

3. Move the mouse pointer to the desired location; a gray outline 
follows the mouse pointer (see fig. 3.23). 

4. Release the mouse button. 
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Fig. 3.23. 
Moving a window. 
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If you are moving a window and the gray outline disappears, you are 
attempting to move the window off the screen. Keep ho lding the mouse 
butto n and move back into the screen. The outline should reappear. 

Changing Window Size 
You can change the size of a window in two ways. You can drag the size 
box, o r you can click the zoom box. These rwo work together; after you 
enlarge the size of a window by using the size box, you can reduce it to 
its previous size by using the zoom box. 

To change the size of a window by using the size box, perform the 
following steps: 

1. Place the mouse pointer in the size box. 

2. Press and hold the mouse button. 

3. Move the mouse to change the window to the desired size. You 
wiJI see an outline of the window moving with the mouse pointer 
(see fig. 3.24). 

4. Release the mouse button. 



Fig. 3.24. 
Reducing the size of a 

window. 

The window is redrawn in its new size. Windows do have a limit to how 
smaU they may be. If you are changing the size of a window and the 
outline stops moving, you have reached the window's limit. 

After you change the size of a window, you may zoom back to its 
previous size by clicking in the zoom box. Each time you click in the 
zoom box, the window changes to tl1e alternate size. 

In System 7, tl1e zoom box alternates between the last size you made the 
window by dragging and a size that displays all icons up the limit of the 
screen size in the window. 

Closing a Window 
Closing a window is a simple but important operation. In any window 
that has a close box in the upper left corner, you can close the window 
by clicking in this box. 

Many application programs also enable you to close d1e front-most 
window by choosing the Close command from the File menu. 
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Fig. 3.25. 
A window that does not 

need scrol.ling. 

Fig. 3.26. 
A window with active 

scroll bars. 
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Scrolling Window Contents 
Often a window may nor be large enough to display all of the items it 
contains. When this happens, you need to scroll-move-the contents of 
the window. The scroll arrows, scroll bars, and scroll box enable you to 
move through d1e contents of a window in various ways. 

You firs t must consider whed1er a window contains more items than it 
can display. Figure 3.25, for example, does not need to be scrolled. You 
can tell that d1e window shows all its items by examining the scroll bars. 
In figure 3.25, the scroll bars are empty, or inactive; if you click o n 
them, nothing will happen. 

Memo Folder 
511•ms 25 ,425K In disk 13,940K available 

Agenda Welcome New Agenda Gtn. Memo 

~ 
Memo Stat ionery 

101 

Figure 3.26 shows the System Folder window. This window contains 
more items d1an can be displayed at one time; d1ese hidden items are 
indicated by d1e active state of the scroll bars. The scroll bars are filled 
with a pattern that results in a gray look, and the scroll box is present. 
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,,:·~~" ' ·1

1

.i
1 

~ li:i!• 
DA Handltr Backgrounder Easy Accus General Keyboard Key Layout ~ 

~ 
Finder 

e (!g)·:·· 
L...J -

MulliFinder Finder Startup 

(g 
System 

10 L J :il:!·:i!Jltl :I i! :i'l:!:iu::;::i)!ii i!i!Hi:i'i!(i\! i!:iiii!l :1!1 iHI!i'II1H tiitlitlii!!Hi!iiii':Hiiiii'!!iiii:ifitii:Hlii'l!iU Q '21 



Fig. 3.27. 
Using the scroll bar. 

The scroll bar along the right of the window is used to move the 
contents up or down. The scroll bar along the bottom is used to move 
the contents left or right. The scroll arrows enable you to move the 
contents a small amount by clicking on the arrow. 

The contents of the window shift and enable you to see part of the 
previously hidden items. If you click on the arrow and the contents do 
not move, you are on the edge of the window contents and cannot scroll 
further in that direction. 

Imagine that the contents of a window reside on a flat surface. The 
window enables you to see some of the items that reside on this surface. 
When you click on one of the scroll arrows, you actually move the 
window over this surface. When you click on the arrow pointing to 
d1e right, the window moves to the right. \Vhen you click d1e up arrow, 
the window moves up. 

If you find that clicking arrows and pushing the mouse button over and 
over is inconvenient, you can use od1er ways to scroll through a window. 

You can use the arrows to scroll continuously, repeating the scrolling 
action of the arrows without pressing the mouse button repeatedly. To 
scroll continuously, follow these steps: 

1. Place the mouse pointer on the arrow. 

2. Press and hold the mouse button. 

The window scrolls as long as you hold down d1e mouse button, as if 
you are clicking the mouse button repeatedly. 

You can use the scroll bars to move even more quickly through the 
windows contents. Follow these steps: 

1. Place the mouse pointer in the scroll bar. Do not place it in the 
scroll box. Rather, place the pointer in the direction you wish to 
move (see fig. 3.27). 

S s te m Folde r -- ----- ~-

66 1toms ~ ,4S3K in disk 

~ ~ !2) ~ [9):•"" l:.!:,_J -(2) 
f inder Multif indor findor Startup S~ s ttm Clipboard Fil• Sorapbook f ilo 
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2. Press the mouse button. 

By clicking the scroll bar, you move more quickly through the contents 
of the window. 

The scroll box moves as you scroll a window. You can use the scroll box 
to indicate where you are in the contents of a window (refer to fig. 3.27). 

The scroll box is at the top of the scroll bar. This indicates that you are at 
the top of the contents of the window. If you click and hold in the down 
arrow, the scroll box moves down as the contents move up. When the 
scroll box is halfway down the scroll bar, you are halfway through the 
contents of the window. When the scroll box reaches the bottom of 
the scroll bar, you are at the bottom of the contents. 

The scroll box is more than an indicator. You can use the scroll box to 
scroll immediately to any point in the contents. To use the scroll box to 
move to a specific point in the window, perform the following steps: 

1. Place the mouse pointer in the scroll box. 

2. Press and hold the mouse button. 

3. Drag d1e scroll box to the desired position. 

4. Release the mouse button. 

he menu bar at d1e top of the Mac Classic is your command 
center. The menu bar contains the various commands you use to 
operate the Mac Classic and your application software. 

The menu bar is not static; you see it change as you use various software 
on the Mac Classic. Menus appear, disappear, and change their contents 
as you move from one software package to the other. However, the 
Apple, File, and Edit menus are present in virtually every software 
package. Although the exact commands in the File and Edit menus 
change, the basic commands and operations remain the same. For 
example, in every software package, the Quit command is present at the 
bottom of the File menu. 

Other menus change often. The View, L-.bel (in System 7), and Special 
menus relate specifically to the Macintosh operating system. You see 
other menus take their place in different software packages. 



Fig. 3.28. 
Gray, unavailable 

commands. 

Choosing Options 
You always use the same methods to select commands from the menu 
bar. You can use the mouse or keyboard shortcuts. Not all menu 
commands have keyboard shortcuts, so this section covers using the 
mouse. Keyboard shortcuts are discussed in a later section. 

To select any command from a menu, perform the following steps: 

1. Place the mouse pointer on the menu name-File for example. 

2. Press and hold the mouse burton. The menu commands appear. 

3. Move the mouse pointer down until you reach the desired 
command. A dark band follows the mouse pointer and highlights 
each command as it is touched by the pointer. 

4. Release the mouse button. 

The dark band blinks to indicate the command was chosen. 

Recognizing Unavailable Commands 
Sometimes a command is unavailable-usually because the command 
does not apply to any item currently on the Mac Classic screen. Some 
commands require you to select an item before choosing the command. 
When a command is not available, it is grayed (see fig. 3.28). 

:)(<2 

1: ut :)(:({ 

Copy ace 
l>ns1 H :]~IJ 

1: h~llr ~ 
Select Rll 3CR 

Show Clipboard 

In figure 3.28, the Undo, Cut, Paste, and Clear commands are gray and 
unavailable. 
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Fig. 3.29. 
A Font menu requiring 

scrolling. 

TIP: 
Do not release the 

mouse button until you 
are on the item or 

command you wish to 
choose. 
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Using Scrolling Menus 
You may occasionally encounter a menu that contains too many items to 
fit on-screen. When this happens, the menu changes to provide a way for 
you to scroll to the items not displayed. Figure 3.29 displays a Font menu, 
which is the most likely menu to need the scrolling feature, within 
a word processing application program. 

Coiro 
Coldwell 
Calgary 
Calligraphy 
Cambridge 
Camelot 
Canterbury 
Canton 
Cope Conoueral 
Carmel 
Cartoon 
Castlefont 
CastleGreyFont 
Chicago 
Colullle 
Copenhagen 
Courier ... 

An arrow appears at the bottom of the menu to indicate that more items 
are below the last one displayed. To reach these items, you drag the 
mouse pointer past the bottom of the menu. Keep the mouse button 
pressed, and move down until the mouse pointer is below the menu. 
The menu contentS scroll upwards. Then you can move the mouse 
pointer back onto the menu and select the option you want. 

When you scroll a menu in this manner, an arrow appears at the top to 
indicate items are above those displayed. You can scroll the menu back 
down by moving the mouse pointer up past the arrow. 



Fig. 3.30. 
A hierarchical menu. 

Fig. 3.31. 
The Graphics submenu. 

Using Hierarchical Menus 
As software grows more complex, the menu bar becomes more crowded. 
To address this issue, Apple added an enhancement to the basic menu. 
These menus comain submenus that are attached to a command. 
Selecting the command retrieves a second menu neX£ to the command. 
One such hierarchical menu is shown in figure 3.30. 

Special. .• 
l. o( nliz•~--
File Control ... 

G cs 

The small arrow pointing to the right of the Graphics command in the 
figure indicates that a submenu is imbedded within. Follow these steps 
to use this hierarchical menu : 

L Place the mouse poimer on the menu, the Preferences menu in 
figure 3.30. 

2. Press and hold the mouse button. The menu appears. 

3. Move the mouse pointer down to the command containing the 
submenu, Graphics. The submenu appears (see fig. 3.31). 

Special •.. 
l.o( !~liz•~ ... 
File Control... 

Graphics ~ Drawing Size •.. 
PCH Colors ... 

Clipboard .•. 

4. Move the mouse pointer imo the submenu while still holding 
down the mouse button. 

5. Move the mouse poimer to the desired item or command. 

6. Release the mouse button. 
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Hierarchical menus are becoming more common in the Macintosh world 
as software becomes more complex. You probably will use one or two, 
even if you use only a few software packages. 

Reviewing the Finder Menus 
The Finder part of the System software provides several menus that are 
available whenever you are at the desktop. You see these menus when 
you first start your Mac Classic. You use these menus for such basic 
operations as opening documents, starting applications, and shutting 
down the Mac Classic. 

Some of these menus also appear within application programs but in a 
slightly different form. The Apple, File, and Edit menus appear in almost 
every Macintosh application with the same basic functions . This consis
tency aids you in learning new application programs because you are 
already familiar with at least tluee of the menus, even if it is your first 
time to run tl1e application. 

Each of the Finder menus is discussed separately. Many of their func
tions are explored in greater depth later in this book, and some you saw 
in tl1e first two chapters. Use tl1is section as a guide to help you become 
familiar with the organization of tl1e menu system of the Finder. 

The Apple Menu 
The Apple menu is on the left side of the menu bar. This menu is special, 
because you can change its contents to suit you. 

Under System 6, tl1is menu is tl1e home of miniapplications called desk 
accesso1·ies (see Chapters 6 and 7). A few utilities in the form of IN/Ts 
(see Chapter 8) also add commands to the menu. 

Figme 3.32 shows two versions of the Apple menu. On the left is t11e 
standard System 6 Apple menu. On the right is the same menu under 
MultiFinder but still in System 6. 

The main d ifference between the two menus is that MultiFinder adds tl1e 
names of the currently running application packages. This feature 
enables you to switch quickly between running applications; Chapter 9 
discusses MultiFinder. 



Fig. 3.32. 
The Apple menus available 

in System 6. 

Fig. 3.33. 
The Apple menu in 

System 7. 

File Edit Uiew Special File Edit Uiew Special 

About the Finder ... About the Finder ... 

Suitcase II 
Al arm Clock 
Cal culator 
Chooser 
Control Panel 
Find File 
Key Caps 
Scrapbook 
SmartScrap "' 
Word Finder® + 

3eK Suitcase II 
Alarm Clocl< 
Calculator 
Chooser 
Contro l Panel 
Find File 
Key Ca ps 
Scrapbool< 
Smort Sc rap ... ' 
Word Finder® + 

../ I5J Finder 

Ill MacWrite II 

About M ult iFinder ... 

Figure 3.33 shows the Apple menu under System 7. As you can see, it 
looks different than the Apple menu for System 6. The difference is that 
under System 7, you may install nearly anything you want in the Apple 
menu: applications, documents, and folders. Chapter 7 discusses this 
feature. 

About This Macintosh ... 

~#Startup Disl< 
~$Contro l Panels 
.& +America Online 1.0 
~ +Apple File EHchange 
~ +Macllni<Pius/ PC 
IIJJ +MacWrlte II 
i +M icroPhone'H 
~ +Microsoft Word 
+ +Noulgot or 
'A. +SuperPaint 1.1 MS 
~ -Chooser 
~ -Scrap bool< 
~ ?Al arm Clocl< 
[ill ?Calculator 
..... 
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Fig. 3.34. 
Selecting the Calculator 

desk accessory. 
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Whether you use System 6 with or without MultiFinder or System 7, the 
Apple menu functions in the same manner as any o ther menu. 

To choose the Calculator desk accessory, use the following steps: 

1. Place the mouse pointer on the Apple menu. 

2. Press and hold the mouse bunon. 

3. Drag through the menu until reaching the Calculator (see 
fig. 3.34). 

0 File Edit Uiew Special 
About the Finder ... 

Suitcase II XK 
Alarm Clock 

Chooser ~ 

Control Panel 
Find File 
Key Caps 
Scrapbook 
SmartScrap 'M 
Word Finder® • 

../ ~ Finder 

About MultiFinder ... 

4. Release the mouse button. 

The Calculator appears (see fig. 3.35) . You may then use the mouse to 
press the buttons in a similar way that you use a regular calculator. 

To d ose the Calculator, click in the close box you see in the upper left 
corner. 

The File Menu 
This menu primarily contains commands that apply to documents and 
other icons and the basic operation of applications. The File menu may 
change somewhat in different application programs, but many of the 
commands remain the same (see fig. 3.36). 



Fig. 3.35. 
The Calculator desk 

accessory. 

Fig. 3.36. 
The File menu. New Folder 88N 

Open 3€0 
Print 
Close 3CW 

Get Info 3€ 1 
Ouplicate 3€0 
Put Away 

Page Setup ..• 
Print Directory ••• 

Eject 3€E 

The File menu contains the following commands: 

New Folder. Creates a new folder in the active window; if more 
than one is open, only d1e active folder has lines in the title bar. 1 

This command is gray if no window is open. 

Open. Opens the selected icon, as if you double-clicked the icon. 
This command is gray if no icon is selected. 
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Fig. 3.37. 
The System 7 File Menu. 
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Print. Orders the application program that created the icon to 
start and print the icon's contents. Gray if the icon cannot be 
printed or if no icon is selected. 

Close. Closes the active window; gray if no window is open. 

Get Info. Opens the Get Info window for the icon. If no icon is 
selected, this option is gray. 

Duplicate. Duplicates the selected icon; gray if no icon is selected. 

Put Away. If you have moved an icon, select it and choose this 
command. The icon is returned to its original location. Command 
is gray if no icon is selected. 

In System 7, selecting a disk icon then choosing the Put Away 
command will eject the disk. 

Page Setup . Enables you to determine how a page is printed on 
your printer; see Chapters 6 and 10. 

Print Directory. Prints a directory of icons in the active window in 
the current way it is being used. 

Eject. Ejects the selected d isk. Command is gray if no disk is in the 
floppy drive, no disk icon is selected, or if you have selected a hard 
drive icon; hard drives cannot be ejected. 

In System 7, some commands have been added to the File menu and 
one has been moved to another menu . Figure 3.37 shows the System 7 
File menu. 

New Folder 3CN 
Open :!CO 
Print 3CP 
Close Window 

Get Info 3C I 
Sharing ... 
Duplica te :lCD 
Make Rlias 
Put Rway :ICY 

Find ... 3CF 
Find Rgain 3CG 

Page Setup ... 
Print Window ... 



Fig. 3.38. 
The Edit men u . 

The following commands are those added ro the System 7 File menu: 

Sharing. Enables you to share folders and folder contents over a 
net\vork if you are connected to one; see Chapter 8. This com
mand is gray if the File Sharing option is not turned on or if no 
folder icon is selected. 

Make Alias. Creates an alias of the selected icon. An alias is a 
form of a copy that behaves like the original icon. Aliases are 
explored in Chapter 8. This command is gray if no icon is selected. 

Find. Retrieves the Find window that enables you to search for 
icons. See Chapter; . 

Find Again. Repeats the last search you performed with the Find 
command. 

The Eject Disk command is missing from the File menu in System 7. This 
command has been moved ro the Special menu in the new System 
software. 

Most application programs add to this menu. Generally, the New, Open, 
and Close commands remain. The Save command, which enables you to 
save your work tO disk, appears in this menu. Printer-related commands 
also appear here. The Quit command also is always in the File menu . 

The Edit Menu 
The Edit menu (see fig. 3.38) contains text-related commands. As with 
the File menu, application programs alter this menu somewhat, but the 
basics will remain. 

Undo 3€2 

Cut :!C H 
Copy aec 
Paste 3CU 
Clear 
Select Rll oon 

The figure shows the commands you see when you are not in any 
application program-when you are at the desktop. The Edit menu 
contains the following commands: 
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Undo. Reverses the effect of the last text or other editing opera
tion. If unavailable, d1e last command cannot be reversed. 

Cut. Cuts the current selection and places it in a storage facility 
called the Clipboard. 

Copy. Copies the current selection and places it in the Clipboard. 

Paste. Copies the content~ of the Clipboard and inserts it at the 
location of the cursor. 

Clear. Cuts the current selection but discards it instead of placing 
it in the Clipboard. 

Select All. Selects all icons or text in the active window. 

Show Clipboard. Opens a window that displays the current 
contents of the Clipboard. 

Two of these commands may be useful to you already. Sometimes when 
you are renaming an icon, you may accidentally hit a key and erase the 
entire icon name. To reverse this mistake, immediately select Undo from 
the Edit menu. 

The Select All command can be useful when you want to copy a group of 
icons. Instead of shift·clicking each icon, choosing Select All selects every 
icon in the current disk or folder window. 

The View Menu 
The View menu controls the way a window displays its contents. Fig
ure 3.39 shows the View menu options in System 6. 

by Smoll Icon 
./by Icon 

by Nome 
by Dote 
by Size 
by Kind 

The check mark next to the by Icon option in the figure indicates that 
the elements in d1e active window are displayed as icons. This option 
and the by SmaU Icon option are the only two options that display the 
window contents as icons. The by Small Icon option shows the contents 



Fig. 3.40. 
A window display using the 

by Name option. 

in reduced-size icons, which enables more items to be displayed in the 
same space. Although the icons are smaller, they operate the same as 
their larger counterparts. 

The last four options of the menu, by Name, by Date, by Size, and by 
Kind, all display the contents of the window primarily in text. Fig-
ure 3.40 shows a window that has been changed to display its contents 
by Name, which shows the icons in alphabetical order according w 
their name. 

:o Memo Folder 0 
Name Sizo Kind Last Modified 

D Agenda 13K MacWrite II docu ... Tue,Oct 10, 1989 16 :00 Q 
D Epilogue 6K Microsoft Word d ... Mon, Apr S, 1991 18 :27 

D Gen. Memo 13K Mac Write II doeu ... Tue, Oct 10, 1989 16 :00 

D Memo Stationery 13K Mae 'Write II doeu ... Mon, Jun 24,1991 14:00 

D New Agenda 13K Mac 'Write 11 docu. .. Tue , Oct 10, 1989 16 :00 

D Schematic 8K SuperPaint 1.1MS ... Fri,Jun21, 1991 18 :18 

D Tex t 9K document Sun, Dec 2, 1990 14 :28 

D Welcome 13K MacWrite II docu .. . Tue, Oct 10, 1989 16:00 10 
01 10 Q] 

The other options show d1e same display but in different orders. The by 
Date option sorts the icons in order of the date they were created. To 
display icons in order of d1eir size, you choose d1e by Size option. 
Finally, choosing the by Kind option displays d1e icons in order of their 
type; they will be grouped alphabetically according to whether the icon 
is an application program, a document, or a folder. Documents will be 
grouped according w the application program that created them or that 
d1ey were designed to work with. 

In any of these four options, the window displays the name of the icon, 
the size in K (1024 characters), what kind of icon it is, and the date and 
time the icon was last changed. 

System 7 users have additional View options. Most of these are con
trolled by use of the Views control panel device (see Chapter 8). The 
View menu itself has only one addition (see tlg. 3.41): the by Label 
option. The contents of the window are displayed in text format and 
sorted in the order of the labels you assigned to d1e icons by way of the 
Label menu. The windows of System 7 display an additional column for 
the label (see fig. 3.42). 
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Rg. 3.41. 
The System 7 View menu. by Small I con 

by Icon 
./by Name 

by Size 
by Kind 
by Label 
by Date 

Rg. 3.42. ~ID~~~~~~~~~~[BM~e~m~oJF~o~ld~e~r~~~~~~~~~~~~!! 
A S)'Stem 7 window's ~ Size Kind Labol Last Modlfiod 

additional Label column. D Aqenda 13K MaoWrit• II docum... Essontial 

Fig. 3.43. 
The System 7 Label menu. 
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D Epiloquo 

D G•n. Mtmo 

D M•mo Stationery 

D lltw Aqtnda 

D Schem•tlo 

D Tex t 

The Label Menu 

6K Microsoft Word do.. . In Proqress Men, Apr· 8, 1991 , 18 :27 

13K MacWr itt II docum... Cool Tut, Oot 1 0 , 1989, 16 :00 

13K MaoWril• II docum ... Esnntiol Mon, Jun 24, 1991, 14 :0 

13K Mao..,r llo II dO<:um. .. In Proqrtss Tut, Oot I 0 , 1989, 16 :00 

8K SuptrPaint I.I MS ... Projfcl I Fri, Jun 21, 1991, 18:18 

9K docum•nt Projecll Sun, Dec2,1990, 14 :28 

13K Tut ,Ooi iO, 1989, 16 :00 <} 

The Label menu is a System 7 addition and does not appear in System 6. 
This menu enables you to assign one of seven labels or no label at all to 
an icon. This label appears in any of the text views discussed in the 
previous section. 

Figure 3.43 shows the Label menu. The None option is checked to 
indicate that the currendy selected icon has no label. 

·If;···· ./None 

Essential 
Hot 
In Progress 
Cool 
Personal 
Project 1 
Project 2 



Fig. 3.44. 
The Special menu in 

System 6. 

Because you can sort icons and search for them based on their labels, 
this feature is useful for grouping related icons. For example, a writer 
might label documents and pictures according to the project to which 
they belong. 

To label an icon, use the following steps: 

1. Select the icon by clicking on it. 

2. Choose the desired label or the None option for no label. 

You may use these steps to change an icon 's label as many times as you 
wish. Choosing the by Label option in the View menu lists a window's 
contents sorted alphabetically within the groups dictated by the labels 
you use on each icon. 

The Label menu can be customized. That is, you can change the labels to 
suit your needs. To do this, you need a control panel device called 
Labels. How to use this and orher control panels is covered in Chapter 8. 

The Special Menu 

This menu contains a few special commands that apply only to the 
System software. Figure 3.44 shows the Special menu in System 6. 

Clean Up Selection 
Empty Trash 
Erase Disk 
Set Startup ... 

Restart 
Shut Down 

The Special menu contains the fo llowing commands: 

Clean Up. This command will change somewhat based on what is 
selected. When a window is active, the command reads Clean Up 
Window. When one or more icons is selected, the command reads 
Clean Up Selection. Selecting the Clean Up command organizes 
the icons in the active window o r the icons you have selected. This 
organization arranges the icons so that they do not overlap. 
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The Special menu in 

System 7. 
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Empty Trash. You have seen this command before in earlier 
sections. Selecting it deletes the items you have placed in the 
Trash icon. Once you have selected this command, the icons are 
gone and cannot be recovered. 

Erase Disk. Erases the selected disk; Chapter 4 covers this and 
other d isk commands. 

Set Startup. This command enables you to choose whether you 
want the Finder or MultiFinder to run when the Mac Classic is 
starred and start applications and desk accessories (see Chapter 7). 

Restart. Causes the Mac Classic to shut down, eject all floppy 
d isks, and quit all application software. The Mac Classic then 
restarts as if first turned on. 

Shut Down. Same as Restart except that the Mac Classic does no t 
start back up again. Use this command befo re turning off the Mac 
Classic. 

Figure 3.45 shows the System 7 version of the Special menu . Only two 
changes are evident. In System 7, the Set Star tup command has been 
eliminated. In System 7, the Set Startup command has been replaced by 
the Startup Items folder in the System Folder. The Eject Disk command 
has been moved to the Special menu from the Hie menu . 

The Balloon Help Menu 

Eject Disk 3&E 
Er as e Disk ... 

Restart 
Shut Down 

This new, System 7 addition gives the Macintosh a convenient help 
facility. Three commands are in d1e Balloon help menu (see fig. 3.46). 



Fig. 3.46. 
The System 7 Balloon Help 

menu. 

Fig. 3.47. 
The System 7 Application 

menu. 

About Balloon Help ... 

Show Balloons 

The first command, About Balloon Help, tells you how to use the 
Balloon Help menu. Choosing the second command, Show Balloons, 
activates the help facility. The third command, Finder Shortcuts, gives 
you a window that lists the keyboard commands that you may use in the 
System software. 

After choosing the command Show Balloons, you acquire help about an 
item merely by pointing to it with the mouse pointer. A balloon appears 
with a brief explanation of the item. 

At this writing, not all applications provide balloon help. Check your 
application manual. Balloon help is, however, available for the desktop 
and other Finder components. 

You can leave on the balloon help as you use the Mac Classic. However, 
doing so may slow the operation of the machine. When you tire of the 
balloons, choose the Hide Balloons command, which replaces the Show 
Balloons command. 

The Application Menu 
This System 7 menu holds commands dealing with the capability of the 
System software to run more than one application package at a time. 
System 6 users have this capability with MultiFinder, but the System 7 
Application menu adds a few useful options not found in the older 
System (see fig. 3.47). 

Hide Finder 
Hide Others 
Show fil l 

../~ Finder 
MacWrite II 
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The Application menu contains the following commands: 

Hide Finder. Temporarily hides aU open windows d1at corre
spond to the Finder-disk windows and o ther windows associated 
with the desktop, for example. This command changes to reflect 
whatever program you are in. 

Hide Others. Temporarily hides all open windows except those 
belonging to the application you are currently working in. 

Show All. Shows all hidden windows. 

The lower part of the menu shows all d1e running applications. The 
Finder is listed first because it is the System software that manages the 
desktop. To rerurn to the desktop, select Finder. To switch to any 
running application, Mac Write II for example, select the name of that 
application. 

The check mark indicates d1e software program you are currently in
the Finder desktop in figure 3.47. 

Using Other Menus 
From time to time, other menus may be added to the menu bar by a 
software program. This usually is done by desk accessories (see Chap
ter 6) or I NITs. These menus afford you additional functions but do not 
change the other menus. Commands are chosen from these menus in 
d1e same manner as any o d1er. 

MacroMaker, which is included in your System software package, is one 
such desk accessory. In figure 3.48, you can see the MacroMaker menu 
to the immediate right of the Special menu. 

he keyboard is not technically part of the Finder desktop but, like 
the mouse, is used to work with the desktop. In many cases, you 
can use it in place of the mouse. Many commands in the Finder 

menus can be chosen from the keyboard. In System 7, you can use many 
keyboard shortcuts to move about and work with the desktop. 

Figure 3.49 shows the keyboard that comes with the Mac Classic. The 
le tter and number keys are laid ou t in d1e standard QWERTY format 
used by typewriters. 



Fig. 3.48. 
The MacroMaker menu 
added to the menu bar. 

Fig. 3.49. 
The Macincosh Classic 

keyboard. 

bl [] D D 
[J [J [J [] 
[J [J [J [] 
[J[J GJ D D 0 

Some keys are special and apply only to computers, and particularly to 
the Macintosh. Others function slightly differently than they do on a 
typewriter. The following definitions explain how special keys function 
on a Macintosh keyboard: 

Caps lock. Similar to the Shift Lock key on typewriters, except that 
pressing the shift key on the Mac Classic keyboard does not release 
the caps lock key. You must press the caps lock key again to 
release it. 

Shift. Functions the same as on a typewriter-enables uppercase 
letters rather than lowercase. Also used in conjunction with tl1e 
mouse to do multiple or contiguous selections. 
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Ctrl. The control key, a standard computer functio n key. Used 
only rarely on the Macintosh and usually in programs that commu
nicate with other computers through a modem. You use the 
control key by pressing and holding it, then pressing a second key. 
For example, a control-M is generated by ho lding down the ctrl 
key and pressing the le tter M. 

Option. The option key is used in various ways in different 
application programs and by the Finder in System 7. Also used to 
generate special characters, such as the Spanish tilde (-). 

Command. A four-leaf clover and an apple symbol ( ):() appear 
on this key. The command key is important in the Macintosh 
world. Its primary use is choosing menu commands from th e 
keyboard; see the section "Selecting Commands" later in this 
chapter. 

Esc. The escape key is a standard computer key used only rarely in 
the Macintosh world . Usually you see it used by communication 
programs. Escape has a special meaning to many computers other 
than the Macintosh. 

Arrow keys. Usually used to move about text in word processing 
programs but also used by System 7 to select ico ns. 

Return. Functions similarly to a re turn key on a typewrite r when 
you are working with text. The key is also used to confi m1 actions 
and may substitute for a mouse click at times. 

Delete . Functions like a backspace key o n a typewrite r except that 
when you backspace over text in the computer world, it is de leted. 

The numeric keypad enables you to enter numbers in 10-key style as you 
may have do ne with a calculator. The keypad also has the most common 
math functions, such as multiplication (*) and equals(=) . The enter key 
usually confirms your numeric entry, but different application programs 
may respond differently ro this key. Check the manual of the ap plication 
for more information . The clear key usually clears or deletes a numeric 
entry, but different application programs may respond d ifferently. 

Selecting Commands from the Keyboard 
By now, you may have noticed that some menu commands have a four
leaf clover symbol ()::() and a le tter to the right o f them. Th is corre
sponds to a keyboard command that can be used to choose the menu 
command. You will note that d1e clover symbol is o n the command key 
on your keyboard and corresponds to that key (see fig. 3.50). 



Fig. 3.50. 
The file menu options and 
corresponding command

key sequences. 

To the right of the New Folder command is ~ N. This indicates to you 
that the option can be chosen by using a ):( - N key sequence by 
pressing the command key and the key for the letter N instead of using 
the mouse. To choose this command, for example, use these steps: 

1. Press and hold the command key with the and ~ symbols. 

2. Press the letter N key. 

Open 
Print 

WN 
3€0 

Close WW 

Get Info :le i 
Duplicate :!CD 
Put Away 

Page Setup ... 
Print Directory ... 

Eject :ICE 

This is called command-N. Other keys can be used with the command 
key in the same way. 

Although the letters are capitalized in the menus, you do not need to use 
the shift key; lowercase letters work fine. In fact, using the shift key with 
a command-key sequence usually performs a different function. The 
manuaJ of your application program should tell you more about this. 
Only a couple of shift-command-key combinations are used by the 
Finder. These are discussed in Chapter 4. 

Typing Optional Characters 
Many more characters can be typed with the Mac Classic keyboard than 
you migh t think by the number of keys. Some of these special characters 
are the Spanish tilde(-) , the mathematical symbol for pi (n), and the 
symbol for the British pound sterling (£). 

Accessing these characters requires the use of the option key. Usually, 
you hold down the option key and press one of the letter or number 
keys. Sometimes, a third key is pressed. 
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The Ker Caps desk 

accessory. 
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The available symbols vary from o ne font to the ne>..'t (see Chapter 10) , 
but Apple has provided the desk accessory Key Caps for you to view the 
special characters in a font set. 

To use Key Caps, perform the fo llowing steps: 

1. Place the mouse pointer on the Apple menu. 

2. Press and hold the mouse button. 

3. Move the mouse down until the black, highlighting band is o n the 
words Key Caps. 

4. Release the mouse button. 

The Key Caps desk accessory then appears (see fig. 3.51). 

The Key Caps desk accessory dis plays a simplified version of the Mac 
Classic keyboard. It displays the character that is generated for each key 
that is pressed. The keyboard in the figure shows the regular, lowercase 
letters. If you press the shift key while Key Caps is on-screen, the letters 
become uppercase. 

In a similar fashion, pressing the option key while Key Caps is on-screen 
shows you an entirely new set of characters (see fig. 3.52), including 
such symbols as the British pound (£)and the symbol for pi (7t). 



Rg. 3.52. 
The optional characters in 

Key Caps. 

Key Caps shows you the symbols that take the place of the regular lette rs 
and numbers when the o ption key is pressed . You must keep holding 
the optio n key in order to type these symbols. For example, to type the 
symbol for the British pound (£), hold down the optio n key and press 
the number 3 key. The symbol appears in the small window above the 
keyboard in Key Caps. 

Yet another set o f symbols can be accessed by holding down the option 
and shift keys. At this point, however, many of the keys have empty 
boxes d isplayed o n them, w hich indicates that this particular key 
combination has no symbol associated with it. 

lf you were o nly able to display these symbols in the Key Caps desk 
accessory, they would be of little use. But Key Caps is simply a guide to 
help you locate the symbols. Once you see the location of the symbol 
you need, you may close Key Caps and then use the key combination to 
place the symbol in your text. The key combination option-3 generates a 
British pound (£) whether you are in Key Caps or not. 

A few symbols require an additional key press. These are usually such 
things as the tUde over the Span ish letter ii. Note that in figure 3.52, the 
tilde (- ) takes the place of the letter N when the optio n key is p ressed . 
Apple placed the symbol in this location as it is most frequently used to 
generate the letter ii. 

To create the lette r ii for example, use the fo llowing steps: 

I. Press and hold the optio n key. 

2. Press the N key. 

3. Release both keys. 

4. Press the N key again. 
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Five of the symbols on the keyboard shown in figure 3.52 act in this 
manner. These are the acute accent (') , d1e grave accent ('), the umlaut 
("), the circumflex("'), and the tilde (-). They are used in the same 
manner as the tilde in the previous example. 

Different fonts also have different symbols available. You may choose to 
display a particular font in d1e Key Caps desk accessory by use of the Key 
Caps menu that appears when the desk accessory is on-screen. To 
display Key Caps with a different font, perform the following steps: 

1. Place the mouse pointer on the Key Caps menu . 

2. Press and hold the mouse button. 

3. Move the mouse down until d1e desired font name is highlighted. 

4. Release the mouse button. 

The Key Caps desk accessory d1en displays that font. 

To quit Key Caps, place the mouse pointer in the close box in the upper 
left corner of the desk accessory, and press the mouse button once. 

Using Easy Access 
As you have seen, many keyboard operations require holding down 
more than one key at a time. Recognizing that this may be difficult for 
some, Apple has provided the Easy Access control panel device. This 
software device acts as an aid to bold down keys for you. Easy Access 
also enables you to use the numeric keypad to work the mouse pointer if 
you find the mouse difficult or need to make very precise movements 
with d1e mouse in an application program, especially graphics programs. 

You use the sticky keys feantre to bold down modifier keys for you. The 
modifier keys are the shift, ctrl (control) , option, and command keys. To 
ntrn sticky keys on, press d1e shift key five times in a row without 
moving the mouse at all. You see the sticky keys icon appear in the 
upper right corner of your screen (see fig. 3.53). Sticlq· 

keys 
.-~~~~~~--~--~------------------------------hicon 



Fig. 3.54 . 
The Sticky Key icon when a 

key is held. 

After the icon is visible, you can select any key combination by using the 
modifier keys sequentially rather than holding the keys down at the 
same time. To choose a ;}::t; -N for the New Folder command, for example, 
fo llow these steps: 

1. Press and release the command key. 

2. Press and release the letter N key. 

This sequence achieves the same as holding down the command key and 
letter N key at the same time. To tell you when a key has become stuck, 
the sticky key icon changes (see fig. 3.54). 

A modifier 
key is 

r-"L""-=-::--=-::~=---=---::-:-----------------h being held 

A modifier 
key is 

r-.-~-~--:~-~:-:-~---------------------------h l~ed 

=-.- ....=::;--
- --------

LJ 
Homo Foldtr 

The top window shows how the Sticky Keys icon indicates that a 
modifier key is being held. The arrow appears to tell you that the last key 
you pressed is being held down for you , and you may proceed to press 
the next key. Note that more than one key can be held for you. If you 
need to press, for example, d1e command key, the shift key, and the 
number one (1) key at the same time to execute a command, sticky keys 
enables you to press each of the three keys in order, holding down each 
in order until you complete the sequence. 

The lower part of figure 3.54 shows you how the sticky keys icon shows 
that a key is locked. This acts like a lock for the modifier keys. Pressing 
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the shift key, the ctrl (control) key, the option key, or the command key 
twice in a row causes them to be held down until they are pressed again. 

This function enables you to reduce the number of steps you might 
need. For example, if you were to need to do a command-N followed by 
a command-V followed by a command-S, you may reduce the number of 
keystrokes by using the following steps: 

1. Press and release the command key twice. 

2. Press and release the letter N key. 

3. Press and release the letter V key. 

4. Press and release the letterS key. 

5. Press and release the command key. 

Sticky Keys is turned off by pressing the shift key five times or by holding 
down more than one of the modifier keys together. 

You also can turn the numeric keypad into a mouse keypad if you find 
the mouse hard to use or not as precise as you need. Do this with a 
command-shift-clear. With Sticky Keys on, you may press the command 
key, shift key, and clear key each separately in sequence. The numeric 
keypad then changes each key's meaning to the following actions: 

7 key moves the mouse pointer up and left diagonally. 

8 key moves the mouse pointer up. 

9 key moves the mouse pointer up and right. 

6 key moves the mouse pointer right. 

3 key moves the mouse pointer down and right. 

2 key moves the mouse pointer down. 

1 key moves the mouse pointer down and left. 

4 key moves the mouse pointer left. 

Lf you press and hold any of these keys, the mouse pointer moves 
continuously in that direction. Two keys have been provided to perform 
the function of the mouse button: 

5 key presses the mouse button. 

0 key presses and holds the mouse button. 

To click like the mouse button, press the 5 key. To double-click, press 
the 5 key t\vice. To press and hold the mouse button, press the 0 key 
once. To then release the mouse button, press the 5 key. 



Chapter Summary 

For example, ro choose the New Folder command from the File menu, 
you could perform the following steps: 

1. Move the mouse pointer by pressing and holding the 7 key or 
whatever key is in d1e direction of the File menu. 

2. After the pointer is on the word File, press the 0 key. 

The menu appears and remains. 

3. Move the mouse pointer down the menu by use of the 2 key until 
New Folder is highlighted. 

4. Press the 5 key. 

The New Folder command is then selected. 

his was a long chapter because much material was presented. You 
were introduced to the Finder desktop, the work area of the Mac 
Classic. This chapter also explored the use of icons, windows, and 

menus with the mouse and keyboard. 

You should now have a basic understanding of the way work is done on 
the Mac Classic. If you find any of the concepts unclear, you should 
review. Do not be afraid to experiment; it's d1e best way to learn. 
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Working with 

isks are the primary storage agem for most computer systems; 
even the largest mainframe systems use disks in some form. The 
new optical disks, which essentially are the same as musical 

compact disks, are gaining popularity, but the most common type of 
disk is magnetic. 

The disk container, whether hard or floppy, is rectangular in shape, but 
the disk itself, which carries the medium, is disc-shaped. The disk is 
coated with a material that records information in the same way as a 
cassette: by holding a magnetic charge. 

This chapter explains floppy disks and hard disks, which are the two 
main disk systems currently in widespread use, and covers the handling, 
preparation, and use of both. You also learn about the special handling 
of hard disks and how to prevent the fragmentation of stored informa
tion. This chapter also presents ways to guard against computer viruses. 

Comparing Disks and Memory 

M,AC 
ClASSIC 
R U 0 K 

Understanding the difference between disks and memory is important. 
Disks represent off-line storage, which is information not needed for 
immediate use by the computer. Memory consists of small silicon chips, 
which are tiny black rectangles with metal leads, that hold the informa
tion the computer is using. 



Using memory is much faster than using disks. The time required to 
access information in memory is measured in billionths of a second, 
and disk access is measured in milliontbs. This distinction may seem 
unimportant until you realize that a computer with only disks for 
memory would be 10 to hundreds of times slower than current 
machines. 

When you use an application program or other information, the com
puter reads the data from the disk and stores it in memory for use. The 
size of the program and the amount of information you can use simul
taneously are Limited primarily but not completely by the amount of 
memory in your computer. This fact explains why you see computers 
advertised with 2 megabytes of RAM and a 40-megabyte hard disk, for 
example. The two types of storage are separate and perform different 
functions. 

The size of a hard or floppy disk represents d1e amount of information, 
including application programs, that you can store or save. 

You wiU use disks constantly witl1 your Mac Classic to store and load 
applications and information. The next sections discuss how to prepare 
your d isks for use and protect the information stored on them. 

Working with Floppy Disks 
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ecause the Mac Classic uses hard-shell, 3 1/2-inch disks, the term 
floppy may seem odd, but the word refers to the internal medium 
of the disk, not the casing. If you open a disk and remove the 

medium, you find that the disk is floppy. This experiment isn't recom
mended, however. Opening a disk destroys d1e disk and the stored 
information. 

Defining Floppy Disks 
Macintosh primarily uses two types of floppy disks, which differ mainly 
in the amount of information stored. You may have heard the terms 
single-sided, double-sided, and high-density and wondered about the 
difference. A brief history lesson may help you to understand. 

In the early days of floppy disks, manufacturers coated both sides of a 
disk with a magnetic surface, but the disk drives of the time used only 
one side. The manufacturers tested and verified that one side of each 
disk was good, ignored the other side, and used the term single-sided 
disk. 



In the Macintosh, single-sided disks stored only about 400,000 charac
ters of information and were called 400K disks; the disk drive in the 
computer was called a 400K drive. 

As making drives that use both sides of a disk became less expensive, 
disk manufacturers began to test and verify both disk sides and sell the 
disks as double-sided. The only difference between double-sided and 
single-sided disks was that both sides of the double-sided disks were 
tested to verify d1at they stored and retained information. 

Because the Macintosh stores approximately 800,000 characters of 
information on double-sided disks, these disks and the drives that use 
them are called BOOK 

High-density disks are double-sided, but the manufacturing process 
increases d1e density of information stored to 1.44 megabytes per disk. 
Apple calls the drives using high-density disks SuperDrtves, but other 
manufacturers call d1em 1.4 megabytes or 1.44-megabyte drives. 

The 3 1/2-inch disk is used in many devices, including Macintosh, IBM 
PCs, and many other computers, as well as typewriters, music synthe
sizers, and video-editing equipment used in the creation of1V shows. 

Disk manufacturers use generic notation to describe the types of disks. 
Double-sided, double-density disks, 800K disks, are abbreviated DSDD. 
The BOOK notation is not used because these disks store only 720K in 
an IBM standard machine and different amounts in other machines. 
Double-sided, high-density disks, abbreviated DSHD, store 1.44 mega
bytes in Macintosh format and other amounts in different computers. 

Which disk you use depends on your needs. DSDD disks are cheaper 
than DSHD but store less infom1ation. Users of the Mac Classic without 
a hard disk need DSHD disks to provide more room for information 
storage. Hard disk users can choose either type of disk, depending on 
how much additional storage they need. 

A small physical difference exists between the DSDD and DSHD disks. 
The DSDD disk has a small square hole wid1 a sliding plastic piece; see 
the section of this chapter called "Locking and Unlocking a Floppy Disk" 
for details. The DSHD disks have the same item, but also include a 
second square hole without the plastic slider. The second hole tells the 
disk drive that the disk is high-density. 
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Fig. 4.1. 
A disk inside a disk drive 

viewed from the side. 
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Devices are available that punch a square hole in the casing of a 
DSDD disk to fool the disk drive into treating the double-density 
disk as a high-density disk. Do not use these devices. You may 
temporarily turn an 800K disk into a 1.44-megabyte disk, but you 
probably also will lose y0ur information. The manufacturing 
processes of the DSDD and DSHD djsks are very different, and the 
disks are not interchangeable. 

Floppy Disk Formats 
The amount of information a machine can store on a disk varies, 
depending on the djskformat. To understand disk format, as well as the 
process of initializing or formatting a disk, you need to understand 
how a computer uses disks. Figure 4.1 shows a simplified version of a 
disk inside a disk drive viewed from the side. 

~~~~~~-f:_*J =J ~I I ~ ~~c='========~ 
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Hub Read-write heads 

Magnetic medium 

Figure 4.1 is a greatly simplified look at how a disk appears when 
inserted in the disk drive. The two read-·write heads touch the disk 
medium as it turns beneath them. The heads can move across the 
medium, toward the center, or toward the outer edge. They magnetize, 
or read d1e magnetic pattern of, the medium-something of a cross 
between LP records and a cassette player. 

The disk formarting helps the disk drive mechanism locate the informa
tion stored on the disk. Unlike LP records, where the groove spirals 
continuously inward, the disk is broken into segments that form rings 
called tracks or cylinders. Figure 4.2 shows a simplified version of the 
disk tracks. 



Fig. 4.2. 
An initialized disk 

displaying its tracks. 

Each segment, or sector, can contain a certain amount of information. 
This division of a disk, the format , determines how much information 
the disk can hold within its maximum limit. The format takes some space 
on the disk, which explains why an BOOK disk actually stores about 779K. 
Different types of computers perform this formatting division differently, 
which explains why a double-sided, double-density disk stores BOOK in a 
Macintosh and 720K in an IBM PC. The format is different. 

The following analogy may help you understand disk format. Think of 
the last time you parked your car in a lot with no dividing lines, and 
recall how chaotic the parking was. A disk's format is like the dividing 
lines in a well-planned parking lot, which organize and store efficiently. 
The dividing lines in the lot actually use space and reduce the number of 
cars that can fit in the lot; some storage space is sacrificed to gain 
organization. 

Disks come out of the box completely blank, except from companies that 
sell formatted disks. To prepare the disks for use, you must initialize or 
format them. The procedure for initializing disks is discussed later in this 
chapter. 

Since the advent of the SuperDrive, which is standard with the Mac 
Classic, the Macintosh can initialize and use disks in IBM PC format. This 

Chapter 4 
Working with Disks 



Part I 
Using Your Mac Classic 

formatting capability is djscussed Iacer in this chapter. Software that 
helps you exchange information with IBM PC standard machines is 
discussed in Chapter 13. 

Proper Handling of Floppy Disks 
loppy d isks are delicate; you can lose information from your disks 
if you aren't carefuL Keep the fo llowing guidelines in mind to 
protect your disks: 

• Heat: Floppy disks are intended for room-temperature use. 
Because high temperatures can damage disks, you shouldn't store 
them in direct sunlight or near any source of heat. Most disk 
manufacturers recommend that you score and use d isks at room 
temperature; specific recommended temperatures can be found 
on d1e disk box. 

• Liquid: Water, sodas, coffee, and other beverages can destroy a 
disk. Don't place disks anywhere that they may get wet. Don' t 
store or use them in very humid areas; disks that sweat also lose 
data. 

• Dust: Never open the met.11 shutter. Dust and other particles in 
the air can hurt the disk medium and also the drive when you use 
the damaged disk. Opening the shutter and touching d1e disk is a 
quick way to lose information. 

• Magnetism: Like cassettes, disks store information by the use of 
magnetism and can be erased by the same force . Unlike cassettes, 
however, disks are more sensitive to stray magnetic fields. All 
electrical equipment emits a magnetic field. Fortunately, the 
strength of this field falls off quicldy as you move away from the 
device. Keep your disks away from aU electrical equipment. 

The last item is probably the most insidious. Keeping a disk cool, clean, 
and d ry is simple; watching for sources of magnetism is not. Even your 
telephone and your Mac Classic generate magnetic fields that can 
destroy data. The field is not strong or dangerous, but disks are highly 
sensitive. Disk d rives wiiliin the Mac Classic are shielded to protect disks 
from the magnetic field of the power supply. Placing a disk on or near 
your Mac Classic, however, may cause the disk to be erased. 

Inserting and fjecting Floppy Disks 
A few important points about disk usage, which is discussed earlier in 
this book, are worth repeating. 



Only one way exists to insert a disk. If you can see a round metal hub in 
the center of the disk, the disk is upside-down. Remember that the cut 
corner belongs on the right side of the disk as it enters the Mac Classic. 
Insert disks gently and smoothly. The Mac Classic grabs the disk and 
pulls it into place when you have inserted it part-way. 

If a disk doesn't go into the drive easily, don 't force it. The d isk 
may be turned incorrectly or another disk may be in the disk drive. 
Disk drives can be damaged if you force a disk into them. 

You can eject a disk in one of several ways. One way to eject is to drag 
the disk icon to the Trash icon. To use this method, follow these steps: 

1. Place the mouse pointer on the disk icon. 

2. Press and hold the mouse button. 

3. Drag the disk icon to the Trash icon. When the mouse pointer is in 
the proper position, the Trash icon darkens. 

4. Release the mouse button. 

To use the menu to eject a disk, follow these steps: 

1. Click the disk icon by moving the mouse pointer to the disk icon 
and pressing the mouse button once. 

2. J>Jace the mouse pointer on the File menu (the Special menu in 
System 7). 

3. Press and hold the mouse button. 

4. Move the mouse pointer down until the Eject command is 
highlighted . 

5. Release the mouse button. (In System 7, you also can use the Put 
Away command in the File menu to eject a disk by menu com
mand.) 

To use the keyboard method, fo llow these steps: 

1. Press and hold the command key and the shift key. 

2. Press 1. 

A distinct difference exists between the three metl1ods for ejecting the 
disk. When you insert a d isk into the Mac Classic, the computer reads the 
disk and stores information about it in memory. This information aids 
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NOTE: 
Because the Startup 

Disk contains the 
System software, it 

remains mounted no 
matter which of the 

three ejecting methods 
you use. 

Fig. 4.3. 
Two mounted disks. 
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the Mac Classic in knowing what kind of disk is present, what kind of 
information it holds, the name of the disk, and other information. The 
disk is said to be mounted. 

A disk that is not physically in the drive still can be mounted. You can 
te ll that a disk is mounted by the icon o n the desktop. If the icon is 
present, the disk is mounted and ready for use. The icon disappears if 
you eject a disk by dragging it to the Trash. Essentially, the Mac Classic 
forgets d1at Lhe disk exists. 

If you eject a disk by using the other methods, the disk remains 
mounted, although it isn 't in the Mac Classic. You can tell d1at a disk is 
mounted but outside ilie drive by the gray appearance of the disk icon 
(see fig. 4.3). 

In figure 4.3, the Data Disk is mounted and in the Mac Classic's disk 
drive. The Memo Disk is mounted but not in the drive. The difference is 
subtle; whether it matters to you depends on your work habits. The Mac 
Classic may ask fo r a disk that is mounted but not in the disk drive. The 
Mac performs this oper.ttion to verify and update information used in 
tracking disks and the information contained on them. 



TIP: 
To save time and 

memo!)' space, drag the 
disk icon to the Trash 

when you finish 
working with a disk. 

This d ismount 
procedure keeps d1e 

Mac Classic from asking 
you to reinsert a disk 
you no longer need . 

Sometimes you may need to switch disks temporarily-if you are using 
o ne disk and need a file from another, fo r example. You can eject the 
first disk but leave it mounted . After you finish using the second disk, 
use the Trash method to eject and dismount it, and then reinsert the first 
d isk. This procedure saves time because the Mac Classic doesn't have to 
reread the disk, mount it, and redraw the windows you were using. 

Users of the Mac Classic witho ut a hard disk sho uld pay particular 
attentio n to how mounting and dismounting disks affects their work. 
When you switch disks, watch how the Mac Classic treats mounted disks 
to learn whether leaving a disk mounted saves time. 

Initializing Floppy Disks 
You can initialize DSDD disks in one of the following formats: 

Single-sided (400K) . Use this format only if you need to share 
information with an old Macintosh with single-sided disk drives. 

Double-sided (SOOK). Because this fo rmat is the most common, 
you will use it frequently. 

MS·DOS or IBM PC-compatible format (720K). To format a disk 
in this manner requires using the Apple File Exchange utility 
included with your Mac Classic or another utility (see Chapter 12 
for mo re information). 

ProDOS: Use this format to transfer files between the Macintosh 
and Apple II machines. The Apple File Exchange p rogram is 
required to use the ProDOS fo rmat. 

You can initialize double-sided , high-density disks in 1.44-megabyte 
Macintosh format or 1.44-megabyte MS-DOS fo rmat by using the Apple 
File Exchange utility discussed later in this chapter. 

Initializing in Macintosh Format 
To initialize a double-density disk, fo llow these steps: 

1. Insert the disk. A dialog box appears, as shown in figure 4.4. 

2. Click the Two-Sided button. The Mac Classic asks you to verify 
your choice (see fig. 4.5). 
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Fig. 4.4. 
The Ooppy disk 

initialization options. 

Fig. 4.5. 
Verifying the 

initialization process. 

Fig. 4.6. 
Naming the new disk. 
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This disk: is unreadable: 

Do you want to initia liz e it? 

n Eject D (One-Sided) (Two- Sided) 

Thi s proce ss will erase all 
information on this disk:. 

Cancel n Erase D 

3. Click the Erase button. The system prompts you to name the d isk 
(see fig. 4.6). 

Please name this disk:: 

OK 

4. Type the disk name. You may use up to 27 characters, but you 
cannot use the colon (:). For this example, type Memo D isk. 

5. Click OK. 

The Mac Classic initializes the d isk, and the new disk icon appears on the 
desktop. 

When you initialize DSHD disks, the Mac Classic doesn't prompt you for 
a choice of format. The system detects the disk type and automatically 
chooses d1e 1.44-megabyte high-density format. To initialize a high
density disk, follow these steps: 

1. Insert the disk. The system displays the prompt shown in 
figure 4.7. 



Fig. 4.7. 
The initialization dialog 

box for high-density disks. 
This disk is unreadabl e: 

Do you want to initialize it? 

[ Eject D ( Initialize ) 

2. Click the Initialize button. 

3. Click the Erase button. 

4. Type the disk name. For this example, type Memo Disk. 

5. Click OK. The computer initializes the disk, and the new disk icon 
appears on the desktop. 

Occasionally, you may need to reuse a disk containing unnecessary 
information you no longer need. You can use the Trash to delete the 
information from the disk, but an easier method is to re-initialize the 
disk. Follow these steps: 

1. Click the disk icon. 

2. Place the mouse pointer on the Special menu. Press and hold the 
mouse button. 

3. Move the mouse pointer down and choose the Erase Disk com
mand; drag the highlight to it and release the mouse button. 

4. Click the Two-Sided button for a DSDD disk or the Initialize 
button for a DSHD disk. 

When a d isk is re-initialized, the information on it is erased and 
cannot be recovered. 

Initializing in IBM PC Format 
The SuperDrive in your Mac Classic can format and transfer information 
from IBM PC disks. For information on software to enhance this feantre, 
see Chapter 12. Initializing a disk in IBM PC format is slighdy more 
complicated than initializing disks in Macintosh fonnat because you 
use the Apple File Exchange utility included in your System software 
package. 
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Fig. 4.8. 
Installing the Apple File 

Exchange Folder. 

TIP: 
Floppy disk users must 

copy the folder to !he 
Startup Disk, but you 
can create a separate 

Stanup Disk for 
initializing disks in PC 
format. Then use the 
new Stan up Disk to 
start the Mac Classic 
when you need the 

Apple File Exchange 
program. 
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The Apple File Exchange program is on the Systems Additions disk (the 
Tidbits disk in the System 7 package) included with the Mac Classic. To 
install the program, drag the Apple File Exchange Folder to the disk on 
which you want to inst.111 the program. Figure 4.8 shows the folder being 
installed on a hard disk. 

LJ 
Font/DA Movor Foldor 

LJ LJ 
MacroMalcor F o ldor Printing Folder 

LJ 
App~ Color 

,§! 
Rt-sponder 

CloseVtew 

The Apple File Exchange program translates files back and forth between 
the Macintosh and other computers. For this example, however, you use 
only the formatting capability; see the Macintosh reference manual 
included with your Mac Classic for more information on translating fi les. 

After the folder is on your disk, follow these steps: 

1. Open the disk icon by double-clicking it. 

2. Open the Apple File Exchange Folder by double-clicking it. The 
Apple File Exchange icon appears, as shown in figure 4.9. 

3. Start the Apple File Exchange program by double-clicking its icon. 
The Apple File Exchange window appears, as shown in figure 4.10. 



Fig. 4.9. 
The Apple File 
Exchange icon. 

Fig. 4.10. 
The Apple File 

Exchange window. 
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4. Insert the disk you want to fo rma t. A dialog box appears, as shown 
in figures 4.11 (DSDD disk) and 4. 12 (DSHD disk). 
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Fig. 4.11. 
The initialization 

options dialog box 
for a DSDD disk. 

Fig. 4.12. 
The initialization 

options dialog box 
for a DSI-10 disk. 
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Q400K 

@ BOOK 

0720K 

@ 1440K 

Rpple File EHchange cannot 
read this disk. Do you wish to 
initialize it? 

( Initialize ) n Eject B 

Rpple File EHchange cannot 
read this disk. Do you wish to 
initialize it? 

( Initialize 1(( Eject D 

5. Select the desired format. 

For DSDD, click the desired size option: 400K for single-sided, 
BOOK for double-sided, or 720K for IBM format. Then choose 
the format option: Macintosh, MS·DOS, or ProDOS. 

For DSHD, the 1440K option is already highlighted. Click on 
Macintosh for Macintosh format or MS·DOS for IBM PC format. 

6. Click the Initialize button to format the disk. 

7. Select Quit from the File menu to exit the Apple File Exchange 
program. 

Even if you initialize a disk in IBM PC format, your application software 
may not be able to use the disk. Check your software manual and 
Chapter 11 of this book for more information on using IBM PC· 
formatted disks. 



Renaming Floppy Disks 
You can rename disks that you named in the initialization process. 
Perhaps you named a disk Memos, and later found that you need more 
than one disk to store your memos. You can rename the disk according 
to the date range of the memos. 

To rename a disk, follow these steps: 

1. Insert the disk into the drive. The disk icon appears on the 
desktop. 

2. Click on the disk name. System 6 users can click anywhere on the 
disk icon. (In System 7, you must click directly on the disk name.) 

3. Type the new name; for example, type Memos 1/91 to 4/91. 

4. Press Enter. 

5. Eject the disk unless you want to continue using it. 

Copying Floppy Disks 
You may need to copy disks occasionally. Hard drive users copy informa
tion stored on floppy disks to the hard disk; hard disk users and floppy 
disk users must make backup copies of important disks. 

Checking for System Software 
Some application software packages include copies of System software 
on one or more of the software disks. You can have only one copy of 
System software on your hard disk; having multiple copies can cause 
your Macintosh to behave strangely, with possible disastrous results for 
the documents and software on the hard disk. 

Follow these steps to check for System software: 

1. Insert the disk you want to copy. The disk icon appears on the 
desktop. 

2. Open the disk icon by double-clicking it. 

3. Look carefully at the contents of the disk to see whether a System 
Folder is present. System software usually is in a folder called 
System Folder. Regardless of the name, however, a folder contain
ing System software has a small Macintosh displayed on it (see 
fig. 4.13). 
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Fig. 4.13. 
Disk contents rhat 

include a System Folder. 
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~ 
Optimiur Rtscut 

If the scroll bars are active in the disk window, scroll the contents of d1e 
disk to be certain that no System Folder is present; see Chapter 3 for 
information on scrolling windows. If no System Folder is present on the 
disk you want to copy, you can continue with the copy procedure. 

If you find a System Folder, follow the copy procedure described in the 
section of this chapter named "Copying a floppy Disk Containing a 
System Folder." 

Copying Floppy Disks to Hard Disks 

Copying the contents of a floppy disk to a hard disk is a simple opera
tion. To copy the disk, fo llow these steps: 

1. Place the mouse pointer on the floppy disk icon. 

2. Press and hold the mouse button. 

3. Drag the floppy disk icon to the hard disk icon. When d1e hard 
disk icon darkens, the floppy disk icon is positioned properly. 

4. Release the mouse button. An information message appears, as 
shown in figure 4.14. (Note that d1e message doesn't appear in 
System 7; the Mac Classic just copies d1e floppy disk contents into 
a fo lder on the hard disk.) 



Fig. 4.14. 
An information message 

that appears when 
you copy a floppy disk 

to the hard disk. 

The two disks are different types, so 
the contents of " Optimizer" will be 
placed in a folder on " Hard Disk" . 

n OK ll ( Cancel ) 

5. Click OK. Mac Classic gives the new folder the same name as the 
copied disk. 

When you drag one disk icon to another, the Mac Classic understands 
that you want to replace the contents of the second disk with the first. Of 
course, an BOOK or 1.44-mcgabyte disk cannot replace the contents of a 
20-megabyte or 40-megabyte hard disk. In this case, the Mac Classic 
correctly interprets tl1e command to mean that you want to copy the 
contents of the floppy to the hard disk. 

System 6 users must wait for the Mac Classic to complete the copy 
operation before continuing to work. System 7 users can continue 
working while copying because the copy is performed in the back
ground. With either System, however, you cannot start an application 
program during a copy operation. 

Copying a Floppy Disk Containing a System Folder 
When tl1e disk you want to copy contains a System Folder, a different 
copy procedure is required. This procedure also may be used as an 
alternative to the copy procedure described in the preceding section. 
This procedure uses windows and menus; for more information on 
working with windows and menus, see Chapter 3 of tl1is book. 

To copy a floppy disk containing a System Folder, fo llow these steps: 

1. Open the floppy disk icon by double-clicking it. 

2. Open the hard disk icon by double-clicking it. 

3. If necessary, move or resize the windows to see the contents of 
both. The Mac Classic gives the win dows the same names as the 
disks; this action helps you know which disk belongs to which 
window. 
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Fig. 4.15. 
Copying the selected Illes. 
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4. Click the title bar of the hard disk window, or double-click the 
hard disk icon. 

5. Choose the New Folder command from the File menu. An empty 
folder appears in the hard disk window. 

6. Type a new name for the folder immediately after the folder 
appears; for example, type Optimizer Folder. 

7. Click the title bar of the floppy disk window, or double-cl ick the 
floppy disk icon. 

8. Choose the Select All command from the Edit menu. All the icons 
on the floppy disk darken to indicate that they are selected. 

9. The Select All command also selected tl1e System Folder, which 
you don't want. To deselect the folder, press and hold tl1e shift 
key and click on the System Folder. The System Folder Lightens 
to indicate that it is no longer selected. 

10. Move the mouse pointer to any of the selected icons. 

11. Press and hold the mouse button. 

12. Drag the icon to the new folder (the Optimizer Folder folder, in 
this example) until the new folder darkens. Outlines of all the 
selected icons move with the mouse (see fig. 4.15). 



13. Release the mouse button. The Mac Classic copies the files. 

Use this procedure when you want to copy most-but not all-of the 
fi les o n a floppy disk. For each file you don't want to copy, shift-click the 
icon, as in step 9 of this procedure. 

Copying between Floppy Disks 

ne important purpose of copying floppy disks is to make backup 
copies of the disks. When you purchase software, you should back 
up the disks immediately. Disks and drives are very reliable, but 

backup copies can save you trouble when a disk goes bad at an inconve
nient time. 

Before copying a floppy disk, you need to initialize a new flo ppy disk to 
hold the copy. The procedure for initializing disks was covered earlier in 
this chapter. If you copy a high-density floppy disk (DSHD), be sure to 
use a high-density disk for the copy so that you have enough space to 
hold ali the files . If you copy an BOOK disk (DSDD), you can copy to an 
BOOK disk or a high-density disk. 

To copy o ne floppy disk to another, follow these steps: 

1. If you have a disk in the drive, eject it by holding down the 
command and shift keys and pressing 1. 

2. Insert the initialized disk that you want to hold the copied files, 
which is the target disk. The disk icon appears o n the desktop. 

3. Eject the target disk by pressing command-shift-1. The new disk 
remains mounted , although it isn't in the disk drive, which enables 
you to work with the icon. 

4. Insert the disk you want to copy, which is the source disk. The disk 
icon appears o n the deskto p. 

5. Place the mouse pointer on the source disk icon. 

6. Press and hold the mouse button. 

7. Drag the source disk icon to the target d isk icon. The target d isk 
icon darkens when the mouse pointer is in position. 

B. Release the mo use button. A prompt appears and asks whether 
you want to rep lace the target disk contents- in this example, 
none exist-with that of the source disk (see fig. 4.16). 
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Fig. 4.16. 
Copying from one 

disk to another. 
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9. Click OK. 

nre you sure you want to completely 
replace contents of 

"New Memo Disk" (not In any driue) 

with contents of 
"Memo Disk" (internal driue)? 

The Mac Classic copies the disk. 

Periodically, the Mac Classic may eject the disk in the drive and ask for 
the other disk by name. l11is process is called disk swapping. 

After copying is complete, you can eject the disks by dragging them to 
the Trash or leaving them mounted and continuing to work with them. 

Locking and Unlocking Floppy Disks 
Some floppy disks may be important enough that you need to protect 
them from changes by locking or write-protecting the disks. You can use 
locked floppy disks to copy or read from the disk, but you cannot delete, 
add to, or change the files on the disk. \"XThen a disk is locked, the 
computer cannot write to the disk. All the original copies of your 
software should be locked at all times. 

locking a floppy disk doesn't involve the Mac Classic at all. To lock the 
floppy disk, move the disk lock slider up until you can see through the 
square hole. To unlock the disk, push the slider down to block the 
square hole. Figure 4.17 shows the back of a high-density floppy disk 
that isn't write-protected. When you use a locked disk, a tiny lock icon 
appears in the upper left corner of the disk's window (see fig. 4.18).lf 
you attempt to delete an icon from the locked disk, a warning message 
appears (see fig. 4.19). 



Fig. 4.17. 
A DSHD floppy disk with 
the write-protect slide r in 
the unprotected position. 

Fig. 4.18. 
A locked disk in use, 

indicated by the lock icon 
in the upper left corner of 

the window. 

Fig. 4.19. 
Warning message 

appearing when you 
attempt to delete items 

from a locked disk. 
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An item belonging to a locked disk can't 
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he hard disk was a welcome addition to computers that provided 
large amounts of fast storage and saved users from piles of floppy 
disks. As technology advanced, hard disks grew larger in storage 

capacity but smaiJer in physical size. In the past, a 40-megabyte hard 
drive was the size of a washing machine, but now the same capacity disk 
easily fits in a laptop computer. 

lfyou do n't have a hard drive on your Mac Classic, you can skip this 
section, but read Chapter 13 if you p lan to add a hard drive to your 
computer. 

Defining Hard Disks 
The term bard disk was coined in contrast to the floppy disk; the 
magnetic medium in a hard disk is more rigid than the floppy disk 
medium. l·Iard disks sometimes are caiJedfixed disks, as opposed to the 
removable floppy disk. This term is losing favor, however, due in part to 
the rise in popularity of removable hard disks. lronicaUy, some remov
able hard disks are made of floppy material. 

Internally, hard disks fu nction much Like floppy disks. Both types of 
disks are made of magnetic material , and the heads that read from and 
write to the disks operate much like those of a cassette recorder. Hard 
disks differ from floppy disks primarily in greater storage space and 
increased speed of accessing informatio n. 

Hard Disk Types 
Hard-disk capacity usually is measured in megabytes. The typical 
20-megabyte hard disk is roughly equivalent to 14-15 high-density 
floppy disks o r 25-27 double-density disks. The 40-megabyte drive is 
standard now, although 20-megabyte drives still are available. The Mac 
Classic in hard-disk configuration comes with a 40-megabyte drive. 

Hard d isks range in capacity from the modest 20-megabyte to as much as 
a gigabyte, one billion characters of storage, which is equivalent to more 
than 700 DSHD flo ppy disks. The typical user employs a disk from 40 to 
100 megabytes in capadty. 

The other distinguishing difference between hard disks and floppy disks 
is the han! disk's o peration speed. This speed is expressed in seek time, 
the amo unt of time the head takes to locate data on the hard disk. Seek 



TIP: 
Hard disk users in 

earthquake-prone areas 
should be sure to keep 

regular backups. 

time is measured in thousandths of seconds (milliseconds) and ranges 
from numbers in the high teens to the mid-40s. Low seek time rates are 
fastest, but remember that the difference is only thousandths of a 
second. You may not want to spend hundreds of dollars to save a few 
thousandths of a second. 

SCSI Hard Disks 
The primary type of hard disk in the Macintosh world is d1e SCSI 
(nicknamed scuzzy) hard disk. SCSI is an acronym for Small Computer 
System Interface; dlis interface is the standard used by many other 
products for the Macintosh in addition to hard disks. 

SCSI offers a much faster information transfer than the older serial hard 
disks. 

Care of Hard Disks 
The same basic rules for disk care apply to hard disks as to floppy 
disks. Avoid placing the disk or the computer containing the 
disk in direct sunlight or in temperatures higher than room 

temperature. 

Protect the machine from high humidity and liquids. Using a dust cover 
is a good idea when the machine is not in use. 

An internally-mounted hard disk is less subject to magnetism than a 
floppy disk, but be careful not to place power cords or other electrical 
equipment close to your Mac Classic; a few inches of clearance usually is 
sufficient. External hard disks usually are shielded; you can place them 
close to or under the Mac Classic, but avoid placing them close to power 
cords or power strips. 

Because hard disks spin at a high rate and can be delicate, movement of 
the equipment while it is turned on is a major concern. The read-write 
heads of a hard drive hover above the surface of d1e hard disk as it spins. 
Moving the equipment while the disk is spinning can cause the heads to 
touch the surface of the disk and scratch it. The gap benveen the heads 
and the surface of the disk is too small to pass a human hair through; 
therefore, even minor jolts are dangerous. Accordingly, don't move the 
Mac Classic when it's turned on, and don 't use ilie machine where 
bumps and jolts are likely. 

The same rule applies to external hard drives. Because these drives have 
separate power switches, be certain to shut off ilie power and enable the 
disk to stop spinning before moving an external drive. 

Chapter 4 
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Always use the Shut Down command from the Special menu before 
turning off the power switch. This command causes the Mac Classic to 
perform some basic housekeeping functions chat can prolong the life of 
the hard disk and the information stored on it. 

External hard disk users need to exercise additional caution in caring for 
their SCSI drives. Because SCSI components are delicate and very 
susceptible to static electricity, be careful nor to touch the SCSI ports on 
the back of the Mac Classic and the hard drive or the metal connectors 
on the ends of the cable. 

Follow the termination instructions that come with your hard drive. 
Termination prevents electrical noise in the cables and connectors of 
SCSI devices. Improper termination of the drive can distort its function
ing. 

Carefully guard your SCSI cable. Although the cable is shielded, you 
should not let it get tangled with power cords. 

Initializing Hard Disks 
If you purchased your Mac Classic with an internal hard disk, your dealer 
may have initialized the hard disk. If you bought an external drive, 
however, or if your dealer didn't initialize the internal hard disk, you 
may need to initialize the disk. 

You also may need to initialize a hard disk if you have a problem with 
the disk: if the hard disk icon no longer appears on the desktop, or the 
Mac Classic refuses to start from the hard drive, for example. 

Before initializing a hard disk containing data, contact your 
computer dealer. You may be able to solve the problem without 
initializing the disk, which erases the information contained on 
the disk. 

Initializing an internal Apple hard disk requires the Apple HD SC Setup 
program, which is located on the System Startup disk (the Disk Tools 
disk for System 7) included with your Mac Classic. To initialize the hard 
disk, follow these steps: 

1. Start your Mac Classic by inserting the System Startup disk (Disk 
Tools disk for System 7) into the drive. 



TIP: 
Make a backup copy of 

your System Startup 
disk (the Disk Tools 

disk for System 7) 
before beginning this 

procedure, and use rhe 
backup copy rather 

than the o riginal disk. 

Fig. 4.20. 
The Apple HD SC 

Setup window. 

2. Double-click the Apple HD SC Setup program icon. The program 
window appears, as shown in figure 4.20. 

3. The program displays your hard disk's SCSI device number and 
volume name. If the number and name are not displayed, click the 
Drive button. lf the number and name still don't appear, dick Quit 
and contact your dealer. 

4. Click the Initialize button. The Mac Classic asks fo r confi rmation 
that you want to initialize the disk. 

5. Click the Init button. The initialization process begins; a few 
minutes may be required to complete the initialization. 

6. Click the Test button to run a test on the hard disk and its format
ting. Lf the rest fa ils, contact your dealer for assistance. 

7. Click the Update button. This procedure places on the disk a copy 
of the driver softwa re that the Mac Classic needs to work with the 
hard disk. 

8. Click the Quit button. 

Apple HD SC Setup u2.0.3 

( Initialize J 
( Update ) 

( Par tition ) 

( Test J 

t Quit n 

scsI Deuice: 0 

Driue 

I J~J The uolume name is Hard Disl< 

lf you have a hard d isk from a manufacturer other than Apple, 
don 't use the Apple HD SC Setup program, which was written 
specifically for Apple disk drives. Your hard disk should come with 
a disk containing the equivalent program for that equipment. 
Consult the manual for instructions. 
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After the initialization process ls complete, reswre your programs and 
documents to the blank disk. 

Backing Up Hard Disks 
he imponance of backing up the information on your hard disk 
cannot be overstated. How much of the information stored on 
your hard disk could you re-create if that data disappeared? 

Despite the reliability of computer equipment today, problems occur. 

One method of backing up a hard disk is to drag-copy the various 
documents and programs to floppy disks. This method requires quite a 
few disks, is rather tedious, and may cause trouble fitting items onto a 
disk because of their size. If your programs and documents total less 
than 10 megabytes, however, this method may work well for you if you 
follow these guidelines: 

• Keep backup copies of the System Startup disk (or System 7 
upgrade disks) provided by Apple; this procedure enables you 
to reinstall the System software if necessary. 

• Keep other System Folder components, such as INITs, fonts, and 
desk accessories, on backup disks. 

• Store each important application or utility program on a separate 
disk. 

• Copy your documents and other work to three sets of disks. Make 
a floppy disk copy of each changed document at the end of the 
day, and rotate the disk sets so that you have two previous 
versions if one set of disks fails. 

Consider purchasing a hard disk backup program to aid you in keeping 
backups. Many programs are available; some external hard disks include 
backup programs. One popular program is MacTools Backup, part of the 
utility package MacTools, by Central Point Software. Figure 4.21 shows 
the main screen of the MacTools Backup program. 

Using a backup program to make floppy disk backups offers the follow
ing advantages over the individual disk backup method described earlier: 

• A backup program can compress the information on your hard 
disk w fit on fewer disks. 

• Large documents and folders can be broken up by the program to 
make the best use of floppy disk space. 



Fig. 4.21. 
The MacTools Backup 

program. 

• Choosing which files you want to back up or restore is easier with 
a backup program's window. 

• Backup programs track which files have been backed up and 
automatically select items that need to be backed up when you 
choose the incremental backup option. 

If you have a large amount of information on your hard disk (20 mega
bytes or more}, or your information changes rapidly, a backup program 
may save time. See Chapter 11 for a sampling of available programs. 
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Handling Hard Disk Fragmentation 
Fragmentation is the splitting of information into various areas on the 
hard disk. The results aren't disastrous but can be annoying. The spaces 
on a disk used to store information are of a set size. Documents, 
application programs, and other data are broken into pieces of the 
specified size, stored separately on the hard disk. The System software 
maintains a table to reassemble the information when you request it. 

As you delete and add information, finding spaces that are contiguous, 
next to each other, on the hard disk becomes increasingly difficult. This 
problem results in pieces of information being scattered or fragmented. 
This can result in progressively longer amounts of time needed to 
assemble the information and slow your Mac Classic's operation. 
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Fig. 4.22. 
The MacTools 

Optimizer \Vtndow. 
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One solution fo r this problem is to copy the contents of your hard disk, 
erase the hard disk, and copy the information back on to the disk. Unless 
you have a second hard disk for this purpose, this process is tedious and 
time-consuming. 

The best method for handling fragmentation is to use a hard disk 
optimizer that sorts all the information and stores it in contiguous 
locations. Many external hard disks come with an optimizer so that you 
do n't have to purchase additional software. After using your Mac Classic 
for a while, consider purchasing an optimizer if you didn 't get one with 
your hard disk. 

Central Point Software's MacTools Optimizer is one popular optimizer 
program. As with any hard disk optimizer, you begin by creating a start
up floppy disk (see the "Installing the System Software" section in 
Chapter 1), and then copy the optimizer program to the floppy Startup 
Disk. 

Because the optimizer program moves information on your hard 
disk, none of the material stored on your hard disk can be open or 
in use when the optimizer is running. 

After starting the Mac Classic with the floppy disk, open the Startup Disk 
by double-clicking its icon, and then start the optimizer program in the 
same manner. The MacTools Optimizer window is shown in figure 4.22 . 
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Optimizer formats vary, but these programs generally have the fo iJowing 
options shown in figure 4.22: 

• Volume. This option enables you to specify the hard disk you 
want to optimize. 

• Check For Bad Blocks. Many optimizers run tests on the hard 
disk medium. A bad block on a hard disk doesn't prevent you from 
using the disk; the software marks the bad part of the drive as 
unusable, and the System software skips that area when storing 
information. 

• Unfragment Files. This option consolidates documents and 
applications into contiguous spaces on the hard disk, which 
enables quicker access to the information. 

• Consolidate Free Space. This option places the empty space on 
your disk in one contiguous block, which helps to slow future 
fragmentation. 

• Prioritize Applications. Many optimizers organize the most-used 
applications into areas where the computer can access them 
quickly. 

• Erase Free Space. This option erases the empty space on your 
hard disk. Deleted information remains on the hard disk until the 
space it occupies is used. The Erase Free Space option erases all 
deleted documents and other information from your hard disk. 
This option usually is needed only by people who work with 
sensitive information. 

• Erase Entire Disk. Use this option only when you sell your hard 
disk or Mac Classic containing a hard disk. This option erases all 
traces of any materials once stored on your hard disk. 

• Analyze. The optimizer checks your hard disk and indicates the 
amount of fragmentation on the disk (see fig. 4.23). 

• Optimize. This command starts the optimization process. 

Optimi.zers also may indicate o ther information, such as the number of 
tiles (documents and applications) on the disk, the amount of free space, 
and the amount of time to optimize. 

The most important number disclosed by the optimizer is the fragmenta
tion percentage. In figure 4.23, the fragmentation percentage appears in 
the right side of the report window. The amount noted is 0.88 percent, 
which indicates that less than one percent of the stored material on the 
disk is fragmented. Optimize your disk when the fragmentation percent
age rises to five percent or more. 

Chapter 4 
Working with Disks 



Fig. 4.23. 
The Optimizer Heport. 
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When you optimize a hard disk, the stored information is being 
moved; never turn off your Mac Classic or attempt to stop the 
optimization process unless the program provides an interrupt 
option. Always back up your hard disk before optimizing. A power 
failure or other problem during the optimization process can 
cause irretrievable loss of much of the information on your hard 
disk; you can use the backup to restore your data. 
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computer virus is a program designed to inject itself into System 
software, documents, application programs, or other software. In 
most cases, viruses are written as pranks and don 't cause great 

harm, but some viruses can damage your software and hard disk. Even 
some of d1e most benign viruses have mutated into potentially-damaging 
programs. 

This chapter discusses viruses because disks are the primary method of 
transmission of d1ese programs. If you purchase software and blank 
disks from stores or by mail order and you don't share disks with other 
users, your chances of acquiring a virus are slim. Even if you share 
information with others by disk or modem, viruses are rare, but preven
tion stiU is important. 



Fig. 4.24. 
The Disinfectant window. 

Disinfectant is perhaps the best virus-prevention program and was 
written by John Norstad of Northwestern University, who has graciously 
offered the program to the Macintosh community for free. 

The program includes an I NIT (see Chapter 8 fo r more information on 
INITs), installed by the program into your System Folder to watch for 
viruses. The Disinfectant program is easy to use and comes with exten
sive instructions and suggestions on ways to identify and handle viruses. 

The main Disinfectant window is shown in figure 4.24 . 
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To use Disinfect:mt, specify the disk you want to check with the pop-up 
menu in the upper right corner of the window-Hard Disk is selected in 
fig. 4.24- or click the Drive button until the desired disk is displayed. 

Click the Scan button to check for viruses. If Disinfectant finds a virus, a 
report appears in the left window. Click the Disinfect button to attempt 
to remove the virus. You can get further suggestions and help by 
choosing the Disinfectant Help option from the Apple menu. 
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Keeping a backup of your hard disk and most important floppy d isks can 
help you recover from a computer virus. To get rid of some viruses, you 
may need to erase your hard disk and restore from a backup. Before 
taking drastic action, however, check with your dealer or a local users' 
group for help. 

Disinfectant can cure many of the more common viruses, but a backup 
copy of your important dam still is essential. Because viruses tend to 
infect System software, keep your disks containing this sofcware locked. 
Viruses cannot infect locked disks. 

Other virus-prevention programs are available commercially, but 
Disinfectant is free and effective. Consider using other programs if you 
work in an environment where you share disks constantly, or if you are 
connected to other computers tl1rough a modem or network. (See 
Chapter 11 for more info rmation.) 

Disinfectant is available tl1rough many user groups and on-line services, 
such as CompuServe. 

his chapter discussed tl1e most common information storage 
devices: magnetic disks. You learned how magnetic disks work; 
how to use disks; rules fo r the proper care and maintenance of 

your disks; and how to handle fragmentation, backup, and virus protec
tion. 

The next chapter the process covers of storing information on disk in 
documents and folders. 
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he primaL)' storage unit on the Mac Classic-and on all Macintosh 
computers-is the document. Documents are created and 
modified by using application programs. The information you 

create and use on the Mac Classic is stored in documents . 

The term document was chosen to correspond closely to the concepts of 
an office environment and to continue the desktop metaphor. To 
understand documents on the Mac Classic, remember that the docu
ments of any ordinary office- office documents, such as financial 
spreadsheets, memos, letters, reports, diagrams, and so on- also are 
documents on the Mac Classic. 

Continuing the office parallel, documents usually are-although they do 
not have to be-stored in folders. Consider a filing cabinet; think of a 
disk as a file-cabinet drawer that contains folders that in turn hold 
documents. The Macintosh interface expands on this analogy; folders 
also may contain application programs and other folders . 
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This chapter deals with the basic functions that are available to you when 
working with documents. These basic functions include opening and 
closing documents, copying and deleting them, and locking them to 
prevent deletion or accidental changes. This chapter also discusses using 
search features to locate documents and d1e special, stationery docu
ment. 

Folders also are discussed in this chapter. The creation, naming, and 
deletion of folders is discussed as well as opening, closing, and viewing 
the contents of folders. You also explore using folders to organize your 
icons. This chapter also covers moving and copying icons between 
folders, nesting folders within other folders, accessing folder contents 
from within applications, and new folder features available in System 7. 

Working with Documents 

Part I 
Using Your Mac Classic 

hjs section is a core element in understanding the Mac Classic. 
When you work with the Mac Classic, you work with docu-
ments. When you write a letter, you create a document. When you 

build a spreadsheet to establish a household budget, you generate a 
document. Documents contain the data, or information you create. 
Understanding how you work with documents in the Macintosh world is 
an important factor in becoming proficient with the computer. 

Defining Documents 
The basic definition of a document was previously touched on: a 
document is an item containing information, which parallels a paper 
document in an office. 

In the Macintosh world, this definition is a good basis from which to 
work, but note that here the definition is expanded upon. 1f you create a 
memo, d1e memo is a document. The dictionary of a program mat 
checks spelling also is considered a document, although the office 
parallel is a book. Other items also are documents. Your preference 
settings for an application program usua.lly are stored in a document, 
although not the kind you can open and read. 

In general, a document stores information. Many documents are created 
by me System software or application programs without your interven
tion. You may occasionally encounter these documents and know you 
did not create them. These documents usually are not anything to be 
concerned about because the document probably was created by an 



Fig. 5.1. 
Sample document icons. 

application software program (word processor, spreadsheet, and so on) 
or by the System software to contain information needed for the 
software's operation. 

You can use icons on the Mac Classic to recognize documents. Figure 5.1 
shows some examples of document icons. 

Documont 

0 
0 

Teach Text Documtnt 

Navigator Docum.nt 

MacWtit• II Docunwnt 

I 
SuperPalnt Document 

& 
~ 

[J 
Stuffit Document 

Amtrica Online- Mail Documt nt 

Usually, documents resemble the upper left icon, named Document. As 
you can see, the icon resembles a paper document. Many documents 
created by application software carry a picn1re that suggests the program 
where the icons were created, which usually resembles the application 
software program's icon, to help you identify the program that created 
the document. 

Some application documents vary from the standard document icon. As 
you can see, the MS Word document icon does not show the single sheet 
with dog-eared corner design. Rather, the icon suggests a stack of 
papers. The America OnLine document icon deviates the most from the 
standard but at least carries the program's logo (the smaU, triangular 
symbol) and suggests an office mail tray. 

You also encounter a special document known as stationery. Statione1y 
is a kind of document that already contains info rmation. A word process
ing program's stationery may contain a company letterhead. A spread
sheet program's stationery may have columns, rows, and formulas 
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Sample stationery icons. 
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already defined for use. In System 6, only some application programs, 
such as MacWrite II, create stationery. 

With the advent of System 7, most documents can be turned into 
stationery. This procedure is discussed in a following section of this 
chapter. Figure 5.2 shows examples of stationery icons. 
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Compare this figure with figure 5.1, and you see that stationery icons 
are similar in appearance to d1e corresponding document icons. The 
primary difference is that stationery looks like a pad of paper rather than 
a single sheet. 

Although you may encounter other icons that represent different forms 
of a document, stationery and the standard document are the most 
important icons and are the two covered in this chapter. 

Opening a Document 
Four ways are available to open a document. The first three are ad
dressed in turn, beginning with the most common method. The last 
method, a new way available only in System 7, is then discussed. 

Double-Clicking the Document's Icon 
When you double-dick an icon, the Mac Classic understands that you 
want to open the disk, application, or file. With disk icons, this action 
opens a window to display the disk's contents. This effect is essentially 
what happens to a document icon, although the Mac Classic performs an 
additional step: To open a document and start the application, double
click the document icon. 



Fig. 5.3. 
The message box that 

announces the document 
cannot be opened or 

primed. 

Each document carries an invisible signature that identifies the 
document's creator. For example, a Mac\'<' rite II document carries an 
embedded code that tells the Mac Classic that the Mac\"X' rite 11 word 
processing application program created the document. 

\Vhen you double-click a document icon, the Mac Classic reads this 
signature and then searches the disks for the appropriate application 
program. After the program is found, the application program starts and 
the document is opened. You then can see and work with the contents 
of the document. 

You may encounter a situation where you have a document whose 
creator is not on the disk. This situation results in the error message 
shown in figure 5.3. 

The file "Memo to JRG" could not be 
opened/ printed (the application is busy 
or missing). 

If you encounter this message, click the OK button; the message 
disappears from the screen. Then, if you own a copy of the application 
program, install this program on the hard drive (see the section "Install
ing Application Programs" in Chapter 6) or copy the document to the 
floppy that contains the application. 

From the appearance of the document icon, you may be able to deter
mine the application program that created the document. You also can 
use the Get Info command to determine the name of the creator 
application program by first selecting the document by clicking once on 
its icon then choosing Get Info from the File menu. Figure 5.4 shows 
you the resulting Get Info window. 

The Kind field uses the name of the creator application program. This 
approach may not always work because you sometimes see the word 
document in the Kind field. At these times, you must contact the person 
who gave you the document because the Kind field doesn't tell you the 
application that created the document. 
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The Get Info window. 
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§0 Info 

~:: Diagram 

Locked 0 

Kind : MacDraw II document 
Size: 4,909 bytes used, 5K on disk 

Yhere: Hard Disk, SCSI 0 

Created: Sat, Jun 23, 1990, 22 :53 
Modified: Sat, Jun 23, 1990, 22 :53 
Version: not available 

Not having the creator application program does not mean you cannot 
open and use a document. Many application programs can translate the 
documents of others. Mac Write II is a good example of an application 
with this capability. Claris has provided the MacWrite n word processor 
with the capability of translating and opening the files of several different 
application programs. You also can add translators to the MacWrite 11 
program to enable the translation of an even greater variety of docu
ments. Chapter 11 discusses some translation options open to you. 

Using the Open Command 

The other most common way to open a document is from within the 
application program. This action usually is done through the Open 
command in the File menu. 

After an application program is started, usuallr by double-clicking on its 
icon (see Chapter 6), you can open documents by perfonning the 
following steps: 

1. Place the mouse pointer on the File menu. 

2. Press and hold the mouse button. 

3. Drag down to the Open command. 



Fig. 5.5. 
The Open Document 

dialog box. 

4. Release the mouse button. 

The Open Document (or Open File) dialog box appears. Figure 
5.5 shows an example of the System 6 dialog box from within the 
MacWrite TI word processing application. 

D Read Me :!1 = Hard Disk 

Document - -tt-+ 
list box 

f: j<!( t 

n Open )J 
( Cancel J 

Show rinfii1l1 aai;IJailiiiillaiibilleel-------------U- Document 
type menu 

5. Click the desired document. 

6. Click the Open button. 

Figure 5.5 shows a special kind of window called a dialog box, which is a 
window with no scroll bars, zoom, or close boxes. Dialog boxes cannot 
be moved or resized and are intended to present controls for specific 
situations. 

This dialog box has several operations you can use to locate and open 
documents. These options include the following: 

Folder menu. Enables you to select a folder on the current disk. 
Folders are discussed in a following section of this chapter. 

Current Disk indicator. Shows the current disk from which you 
can open documents. 

Eject button. Ejects the current disk. This button is grayed and 
unavailable when a disk you cannot eject, such as a hard disk, is 
selected. 

Drive button. Switches from viewing the documents on one disk 
to viewing documents on another disk. Hard disk users can use 
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Because this method of 

opening a document 
accomplishes the same 

result as double-clicking 
but with more steps, 

users rarely employ this 
method. 
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this button to switch between a hard d isk and a floppy disk. This 
button is grayed and unavailable when only the current disk is 
available. 

Open button. Opens the document highlighted in the document 
list box. May be grayed when no document is selected. 

Can cel button. Cancels the open operation. 

The additional Show menu at the bottom of figure 5.5 is specific to 
MacWrite II . 

In System 7, this dialog box is slightly d ifferem. Rather than using a Drive 
button, tl1e dialog box uses a Desktop button, which displays the 
documems on the desktop and the icons for all mounted disks. This 
action enables you to select an element- including which disk's contents 
you wish to view-by double-clicking on the element. 

Using a Third Method 
The third way to open a document is perhaps the least used but still is 
worth knowing. This method is a more complicated double-pick and 
appears to be a holdover from the old Xerox Star computer interface on 
which the Macintosh interface is based. 

To use this method, perform the following steps: 

1. To select the document, click the document. 

2. Place the mouse pointer on the File menu . 

3. Press and hold the mouse button. 

4. Move the mouse pointer to the Open command (see fig. 5.6). 

5. Release the mouse button. 

The application program that created the document starts, and tl1e 
document is opened. 

Dragging the Document 
System 7 supports anotl1er way to open documents. To use this method, 
you drag the documem you want to open onto tl1e application 
program's icon (see fig. 5.7). 



Rg. 5.6. 
Opening a document by 

using the Open command. 

Fig. 5.7. 
Opening a documem by 

dragging. 

0 
7 items 

Mac \-trite II Hyphenation 

i "f ! 
l.~~~~-~~~~. 1 

Claris HPlp SystE.>m 

¢ 1 

MacWrite II f 
35.7MB in disk 

Main Dictionary 

6! 
Mac\-/ritP II HPlp 

2.6 MB available 

r-"""'! 
:0: 
L~.! 

User Dictionary 

After the application program's icon darkens, you release the mouse 
button. The application starts, and the document opens ready for work. 
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Rg. 5.8. 
Closing a MacWrite II 

document. 
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The application program's icon will not darken if the document's creator 
type does not match the application. The application program stiH may 
open the document, although you must use the Open command. Many 
application programs now can open documents created by other 
applications. Check the manual that accompanies the application 
program for further information. 

Closing a Document 
After you open a document, you can view, print, and do other work with 
the document's contents. Of course, you also need to be able to close 
the document. The following procedures dose only the document, not 
the application software you are using. You can use two methods to 
close a document: use the File menu, or use the window's close box. 

You can close a document by selecting the Close command from the File 
menu. Most Macintosh programs that work with documents have a Close 
command in the File menu. Figure 5.8 shows how you close a document 
within the MacWrite II application program. 

StUll~ 
Soue As ... 
fi<W<!I1 to SOUI~d 

Insert File... ofr i!C I 
1---------------------~ I I,Version I . I 

Open Merge Ooto File ... 
lnwrt Mt.>rg•• Field ... ofr 
M<li"~JH ... 

Included In the l18cJJirile 1(. Version 
Gill de. 

te® II Help disk) Is referred to on 
~,..;.,.......,.........,_..., ..... ..,..,..,....,.,..,.,...,....,........!i'Wre8tllres 6tlide6s Cl6rls Help. The 

I ·r!. i . ! :!· !: !; ·: j! ,: 

The other way to close a document is to click in the close box of the 
document window. Figure 5.9 shows the process of closing a document 



in this manner. The close box is always located in the upper left corner 
of any window that you can close this way. 

Fig. 5.9. • File Edit Font Size Sty le Formet Spelling Uiew 

Clicking the close box of a a - --- 9 MocWrlte II Document 
document. 

Fig. 5.10. 
The Save Changes 

dialog box. 

After a document is first created within an application program, the 
document does not yet exist on disk. You must save the document or, if 
you quit the application program, the document is lost. 

Saving a Document 
To avoid accidental loss of work, you cannot close a document on a 
Macintosh without specifying whether you want to save the document to 
disk. After closing a document, you see a warning on the screen similar 
to the warning shown in figure 5.10. 

Saue changes to "Document 1 " 
before closing? 

([ Yes D 
( No ) Cancel 

This dialog box offers the following three choices: 

Yes. Also may be labeled Save in some applications. This button 
retrieves a second dialog box, which enables you to save the 
document. 
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The Save Current Docu

ment dialog box. 
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No. Also may be Labeled Don't Save or a similar wording. Enables 
the document to close wid1out saving to the disk. All changes 
made since opening d1e document are lost. 

Cancel. Cancels the quit operation and returns you to the 
document. 

If you click the Yes or Save button, you are presented with a dialog box 
similar to the Open Document box shown in d1e preceding section. The 
exact appearance varies from application to application but is similar to 
the MacWrite U dialog box shown in figure 5.11. 

~~iOCunleiiltF'Oid"E;rlf---------ft- Folder menu 

D flrn<~ri< a Onl. in<~ M<l ... 
l'.) rio< unu~n t 
D M<H !H ri t ~~ II Oo cmn '" 
t',) MS UJord OoeUHH~n1 
D NtwiiJI~ tor OocurrHm1 

c:> Hard Disk Current 
disk drive 

0 Statio -i;!"'*-------ft- File/folder 
list box 

Saue current document as:, -~'F~s~a~u;e~~ll~ll-
:1- Document Documentl 

name box 

Many application programs provide you with a name for the document. 
This name usually is generic, such as Untitled or Document. If you do 
not want to bod1er with naming the document, you may simply click the 
Save button. 

Other applications may require you to provide a name before saving the 
document. To name the document, type the name you want on the 
keyboard. Remember, documents can use only 31 or fewer characters in 
a document name. The name cannot include a colon (:). 

The Save Document dialog box includes the following parts: 

Folder menu. Enables you to select a folder to save the document 
(folders are covered in the next section) . 

Current disk indicator. Shows the current disk to which docu
ments can be saved. 



Eject button. Ejects the current disk. The current disk drive (Hard 
Disk) in figure 5.10 cannot be ejected; therefore, d1e command is 
unavailable. 

Save button. Saves the document to disk with the name in the 
document name box. In some applications this button is grayed 
and unavailable until a name is typed for the document. 

Cancel button. Cancels me close operation and returns you to 

d1e document. 

File/folder list box. Lists me documents and folders (see a 
following section for more information about folders) on me 
current disk or in me current folder. You may display the contents 
of a folder by double-clicking on the folder's name wimin this 
window. 

Document name box. Enables you to type a name for me 
document. 

System 7 users again see a Desktop button in place of the Drive button. 

Copying a Document 
You may occasionaJly want to copy a document, perhaps to a floppy disk 
to give to a coworker or to the same disk to make a working duplicate. 
Copy procedures are essentially the same for documents and icons 
because documents are represented by icons. 

Making a Copy 

The steps for making copies of documents are presented here without 
discussion. For more information, see me section "Copying an Icon" in 
Chapter 3. 

To duplicate a document, take the following steps: 

1. To select a document, click on me icon. 

2. Choose the Duplicate command from the File menu. A copy 
message is posted as in figure 5.12. 

You see a Cancel button in the copy message window. To cancel a copy 
oper.ttion, click mis button. Of course, a single document copy often 
occurs so quickly mat the button may not be on the screen long enough 
for you to click. Cancel is mainly intended for use during longer copy 
operations. 
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Fig. 5.12. 
The document copying 

message window. 
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Flies/Folders remaining to be copied: CJJ 
Wr iting: Copy of MacWrlle II Document 

(Cancel J 

The copy of the document is named essentially the same as the original 
except that Copy Of is added to the beginning of the name. 

System 7 users see a welcome difference here. The duplicate 's name is 
the original with the word Copy added to the end of the name. In 
System 6, if you duplicate a document while viewing the disk window by 
Name, the duplicate is placed in the list of documents in alphabetical 
order, which usually meant that the copy appeared far from the original. 
In System 7, the copy appears close to the original document. 

Ano ther change is that instead of adding Copy Of to each duplicate
resulting in names like Copy Of Copy Of Copy Of Document-System 7 
adds a number to d1e end of the duplicate's name, which results in the 
more simple name, sud1 as Document copy 3. 

Copying to Another Disk 
You can copy a document to another disk by performing the following 
steps: 

1. Place d1e mouse pointer on the document to be copied. 

2. Press and ho ld d1e mouse button. 

3. Drag the document icon onto the d isk icon. 



The same copy window appears as for the Duplicate command, and the 
document is copied to the disk. 

Deleting a Document 
Deleting documents requires the same procedure as deleting all other 
icons. Perform the following steps: 

1. Place the mouse pointer on the document icon to be deleted. 

2. Press and hold the mouse button. 

3. Drag the document to the Trash icon; after the Trash icon darkens, 
you are at the correct position. 

4. Release the mouse button. 

Select Empty Trash from the Special menu to delete the document from 
the disk entirely. 

Until the Trash is emptied, you may retrieve the document from the 
Trash by performing the following steps: 

1. To open the Trash, double-dick the Trash icon. 

2. Place the mouse pointer on the document icon. 

3. Press and hold the mouse button. 

4. Drag the document out of the Trash and back onto the disk, the 
window of the disk, or the disk icon itself. 

System 6 users may want to remember that the Mac Classic at various 
times empties the Trash even if the Empty Trash command is not 
selected. The following list shows these times: 

• Shutdown. When you use the Shutdown command before turning 
the Mac Classic off-you always should. 

• Application launch. \Vhen a program starts. 

• Copying. Copying an icon empties the Trash, which is intended to 
prevent duplicate names for documents. 

The contents of the Trash are lost at all these times. 

System 7 users do not need to worry about the preceding processes 
because the Trash is emptied only when the Empty Trash command is 
selected. 
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Fig. 5.13. 
Locking a document. 
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An easier way to re trieve a document from the Trash is to perform the 
following steps: 

1. Double-click to open the Trash icon. 

2. To select the document to re trieve, click on the icon. 

3. Choose the Put Away command from the File menu. Put Away 
re turns all selected icons to their original positions. 

After you complete the process, close the Trash window by clicking in 
the Trash's close box. 

Locking and Unlocking a Document 
You saw how you can lock an icon to prevent an acciden tal deletion. 
This process also is true of document icons. You lock or unlock a 
document by using the following steps: 

1. To select the document, click the document icon. 

2. Choose the Get Info command from the File menu. 

3. Click the check box to the right of the word Locked (see fig. 5.13). 

~ 
~ 

Info 

Mao'vr'rite II Document 

Kind : Mac 'Write II document 

locked 

Size : 12,544 byt es us ed , 13K on disk 

Yhere : Hard Disk, SCSI 0 

Cr eate d : Tue , Oct 10 , 1989, 16 :00 
Modified : Tue, Oct 1 0 , 1989, 16 :00 
Vers ion : not available 



Fig. 5.14. 
A warning message that the 

locked document cannot 
be changed. 

4. Close the Info window by clicking the Close box. 

These steps also are used to unlock a document. An X in the Locked box 
indicates that a document is locked; no X indicates the document is 
unlocked. 

Locked icons (document or otherwise) cannot be deleted or changed. If 
you open a locked document, you receive a warning message (see 
fig. 5.14). 

The document " MacWrite II Document" 
is locked; you will not be able to saue 
any changes. 

[ OK ll ( Cancel ) 

Click the OK button to open the document or the Cancel button to stop 
the document from opening. If you open the document, you can use the 
Save As command (see Chapter 6) to save your work in a copy of the 
document. 

You can use Lock to protect important documents and prevent acciden
tal changes. You still can copy locked documents by using the Duplicate 
command, and these duplicates are not locked. You can keep 
templates-a letterhead for example-or partially ftlled out documents 
and work only with copies. The original document is locked and cannot 
be changed unless you unlock the document by using the Get Info 
window. 

When you copy a locked document to another disk, the copy remains 
locked until you unlock the document with the Get Info command. 

The Lock feature is an imitation of the Stationery pad option of System 7, 
which is discussed in a later section of this chapter. 

Locating Documents 
If you own a hard disk, you may one day discover you have so many 
documents and other icons on the disk that you misplace an icon. At last 
count, the author's hard disk has more than 1,000 icons, and finding one 
icon is often as trying as the proverbial search for a needle in a haystack. 
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Fig. 5.15. 
Selecting rind rile from 

the Apple menu. 
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Fortunately, Apple provides methods of locating icons on any disk 
drive-hard disk users need this feature more than floppy disk users. 
System 6 users have the Find File desk accessory, which is included in 
the System software. 

System 7 users have even greater search capabilities by using the Find 
command, which is built into the System software. 

Using Find File 
System 6 users can use the Find File desk accessory to locate documents 
and other icons. System 7 users can refer to the following section. If you 
installed the System software in the standard way (as in Chapter 1 of this 
book), the Find File desk accessory is already installed. Should you 
discover that Find File is not installed, refer to the section "Using the 
Apple Menu" in Chapter 7. 

Find File is a desk accessory and is, therefore, located in the Apple 
menu. Use these steps to locate a document (or any icon): 

1. Select Find File from the Apple menu (see fig. S. l S). 

Rbout the Finder ... 

Suit case II seK 
Rlarm Clock 
Calculator 
Chooser 
Control Panel 

Key Caps 't 
Scrapbook 
SmartScrap'M 
Word Finder® + 

./~Finder 
~ MaclinkPius/ PC 

>A_ SuperPaint 1. 1 MS 

Rbout MultiFinder ... 

2. Type the name of the document in the Find File window (see 
fig. S.l6). 



Fig. 5.16. 
Searching for an icon 

named MacWrite II 
Document 

Fig. 5.17. 
The document is found in 

the Find File window. 

Disk drive being searched 

Found icon 
List box 

Infom1ation 
on selected 
icon 

::o Find File 

=Hard Disk 

Search for: I M~tcWrite II Document 

I 1.3 

3. Press the return key. 

find File searches for the document and-if found-tells you the 
document's location (see fig. 5.17). 

Hard Disk 

MacWrite II Document 

• 00 
Q 

0 
Q 

K> 

Stop 
button 

Go 
button 

~1111111111111111111111111111111111111111111111111111~ Name 
Mac..,.rlte II Document copy 

Size: 

find File located more than one document because the search finds all 
icons whose name contains the chamcters you typed. If you type Mac 
and then press return. Find File locates the icons that contain Mac in any 
part of the name. In this example, Find File locates icons, such as 
MacWrite II , A Macintosh Document, Macintyre Folder, Financial figures 
(Mac version), Emac, Promac, and so on. 
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Fig. 5.18. 
The Find File menu. 
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Consider the following search rules: 

• To find one icon (document or otherwise), type as much of the 
name as you can remember to narrow the search. 

• To find a group of icons, type a string of letters that all the 
document names have in common. 

• Find File ignores upper- and lowercase letters designations. 
Searching for MAC, Mac, or mac results in finding the same icons. 

You click on a found icon to display information about the icon's 
location. The left box displays general information about the icon, which 
is the same information you see with the Get Info command. The right 
box displays the location of the icon. Locations are displayed graphically, 
beginning with the lowest level folder and moving up to the disk drive. 
The example in figure 5.17 tells you that the selected icon is in the 
Document Folder which is in tu rn located on the disk Hard Disk. 

Find File places a new option on the menu bar (see fig. 5.18). This menu 
has three commands. 

Rbout Find File ... 

Search Here... SCH 
Moue to Desk:top SCM 

The Find File commands perform the following tasks: 

• About Find File. Displays the name of the Find File author and 
brief instructions on using the desk accessory. 

• Search Here. Brings up a dialog box similar to the Open Dialog 
box. You can specifY a disk drive or folder in which to perform the 
search. 

• Move to Desktop. Moves the selected icon to the desktop. 

Move to Desktop is a useful command that moves an icon from the 
present location to the desktop where you may work with the document. 
To do so, perform the following steps: 

1. Click on the name of the found icon. 

2. Choose Move to Desktop from the Find File menu. 



Fig. 5.19. 
Selecting the Find 

command from the File 
menu. 

The icon appears on the desktop. You may then copy, open, or do other 
work with the icon. To return the icon to its original location, perform 
the following steps: 

1. Click on the icon to select the document. 

2. Choose Put Away from the File menu . 

To close Find File, click in the close box in the upper left corner ofthe 
window. 

Using the Find Command 
In System 7 , Apple incorporates a new Find command that replaces the 
old Find File desk accessory. Although it performs essentially the same 
function, the Find command greatly enhances the old Find File features . 

To use the Find command, you first select Find from the File menu (see 
fig. 5.19). This action retrieves the Find window (see fig. 5.20) . 
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Fig. 5.20. 
The Find window. 

Fig. 5.21. 
The disk Hard Disk is being 

searched. 

Fig. 5.22. 
The No matching items 

were found message. 
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Find 

Find: 

( More Choices ) Cancel ) n Find D 

In its simplest form, you use the Find window by typing the name of the 
icon you want to locate and pressing the re turn key or clicking in the 
Find button. The Cancel button dismisses the window wid1out perform
ing a search. 

While a search is in progress, you may see a window similar to the 
window shown in figure 5.21. Note that a Stop button is provided. Stop 
the search by clicking on rnis button. This window appears only if me 
disk you are searching is large and rnerefore takes some time to search. 

Find 

Searching on "Hard Disk" ... 

'''''''''''~ Stop 

If a match is not found, a message is posted (see fig. 5.22). Click the OK 
button to dismiss d1e window. 

No matching items were found. 

n OK ' 

After an icon is located d1at matches the search request, the Find 
command opens the folder o r disk on which the icon is located and 
displayed. The located icon is highlighted. 



Fig. 5.23. 
The expanded Find 

window. 

Search by menu 

Collapse window 
bun on 

Repeating the Search 
U the located icon is not the one you wanted to find , use the Find Again 
command in the File menu. The Mac Classic searches for and displays 
the next icon whose name contains d1e string of letters you ryped in the 
Find window. 

Repeat the Find Again command as many times as you want until me 
Mac Classic beeps, indicating that me last icon matching me string you 
ryped has been found. If you have nor yet located me icon you want, 
select Find one more time and type a different string of letters. 

The Find command searches all mounted disks. That means that if you 
have a floppy disk inserted in me disk drive, me floppy is searched as 
well as all hard drives in, or attached to, me Mac Classic. 

The Find command pays no attention to upper- and lowercase letters. 
Searching for MAC, Mac, or mac locates me same icons. 

Narrowing the Search 
The Find window has an option that enables you to narrow the searches. 
This is me More Choices button you saw in figure 5.20. Clicking in d1is 
button expands d1e Find window (see fig. 5.23). 

Search by constraint menu 

~~~~~~~~~~~~QF~i~nd~~~~~~~~~~~~~ I~ Search 
Find and select items whose 

name ..-

range or 
t~"tbox 

Show aU 
located 
icons 

Fewer Choices 

Search 
.------. t;""""""""!;;;!!!~-if location 

The many options offered in this expanded window are controlled by 
pop-up menus. Each of me three shaded boxes in me window is a 
menu. Placing the mouse on any menu and pressing the mouse button 
causes the menu to appear (see fig. 5.24). 
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Fig. 5.24. 
The Menu pops up . 

Fig. 5.25. 
Four of the Search By 

options. 
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Find 

Find and select items whose ·==·····! contains size ~ 
Jcind 
label 
dat e creat ed 
dat e modified 
uersion 
comments 

""" loclc 

dislcs 

... 111!--11 _ ___ __,I 

0 all at on ce 

Cancel J U Find U 

You then can drag to a selection and release the mouse button to select, 
just as you select menus in the menu bar . 

The first pop-up menu is the Search By menu . This menu gives you a 
choice of what type of search is to take place. After you make a selection 
in the first me nu, the upper part ofthe Find window changes. Figure 
5.25 shows you how the command looks fo r four of the Search By 
options. 

Find nnd se lec t Items whose 
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Is not 

opplicotion 
document 
f older 
s ta tionery 



Table5.1 
Search By Criteria 

The pop-up menus that appear for these options are shown open to give 
you an idea of what search constraints are available in each search type. 

Table 5.1 defines all the search criteria available in this window. 

Search By 

Name 

Size 

Kind 

Label 

Date created 

Date modified 

Version 

Comments 

Lock 

Constraints 

Contains 
Starts with 
Ends wid1 
Is 
Is not 
Doesn't conmin 

Is less man 
Is greater than 

Contains 
Doesn't contain 

Is 
Is not 

Is 
Is before 
Is after 
Is not 

Is 
Is before 
Is after 
Is not 

Is 
Is before 
Is after 
Is not 

Contain 
Do not contain 

Is 

Range or search text 

All text 

Some number of K 

Alias 
Application 
Document 
Folde r 
Stationery 
(any kind) 

Any of the labels 
you have defined 

Any date 

Any date 

Any version 
(number or text) 

Any text 

Locked 
Unlocked 
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Fig. 5.26. 
Searching for documents 

that begin \vith Mac. 

Part I 
Using Your Mac Classic 

Having so many different search options can confuse you. A few 
examples may help clear the confusion. The simplest is a search by 
name. Suppose that you are looking for a document that begins with 
Mac but you do not want to find documents, such as Emac or Pro mac. If 
the expanded Find window is already on the screen, you perform the 
following steps: 

1. Select Name in the first pop-up menu, if Name is not already 
chosen. 

2. Select Starts With from the second pop-up menu. 

3. Type Mac on the keyboard. 

The Find window appears as shown in figure 5.26. 

Find 

Find ond select items whose 

._l_n_o_m_e ____ .......... ll storts with 

Seorch I on oil disks 0 allot once 

[Fewer Choices) Concel J ~ Find n 

4. Click the Find button, or press return. 

Another example may be to locate every file that you changed today. 
Assuming that the Find window is already on-screen, take the following 
steps: 

1. Select Date Modified in the first menu. 

The Find window appears as shown in figure 5.27. 

2. Click on the Find button, or press return. 

Find then locates all documents and other icons modified today. 

You can change the date part of the search by clicking on the month, 
day, or year. A small control appears (see fig. 5.28). 



Fig. 5.27. 
Searching for documents 

modified today. 

Fig. 5.28. 
Adjusting the date. 

Fig. 5.29. 
Searching for documents 

modified after June 30. 

NOTE: 
To find documents 

modified july 1, select 
june 30. The constraint 

is after excludes 
documents modified 

on date selected. 

Find 

Find and select items whose 

I date modified ,.ll._i_s ______ ,._,l 7/ 7/ 91 

Search I on all disks 0 all at once 

(Fewer Choices) Cancel ) n Find B 

Find and select items whose 

I date modified,.! ._l_i_s ______ ..... __,l E l 7191 

You can increase the selected pan of the date by clicking on the small up 
arrow. You also can decrease the selected part of the date by clicking on 
the small down arrow. Finally, you can click on any other part of the line 
to change the date in the same manner. 

Suppose that you want to search for aU documents (and other icons) 
modified since the beginning of July. Figure 5.29 shows the search 
window with the appropriate entries. 

Find 

Find and select items whose 

I date modified ,.I ._l_i_s_a_f_te_r ____ ,.__,l 

Search I on all disks 0 all at once 

( Fewer Choices ) ( Can cel ) n Find )J 
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Fig. 5.30. 
The Search menu. 

Part I 
Using Your Mac Classic 

In the previous sections, you saw searches that take place on all 
mounted disks. With the Search menu, however, you also may narrow 
the choice. In figure 5.30, you see the contents of the Search menu. 

The Search menu varies according to the Mac Classic's hardware. The 
first option, On All Disks, is always present. The n~1 two options are 
shown because two hard drives are attached to rhe Mac Classic, and no 
disks are in the floppy drive. Each mounted disk is displayed, enabling 
you to choose the disk you want to search. If a disk is inserted in the 
floppy drive, this disk also appears in the menu. 

The On The Desktop option enables you to search for icons on the 
desktop. The lasr option, The Selected Items, enables you ro search 
through a group of icons you previously selected or icons you found and 
selected by a previous search. 

Search 

on "System 7 Disk" 
on "Hard Disk" 

on the desktop 
the selected Items 

You also can combine the various types of searches. You can, for 
example, search for all documents creared this year with the Mac Write II 
program. 

This search requires using the All At Once option and the Search menu. 
You must perform this search in srages, one search for each criterion you 
wanr ro use. To find the previously mentioned MacWrite II documents, 
perform the following steps: 

1. Choose Kind from the first pop-up menu . 

2. Choose Contains from the second pop-up menu. 

3. Type Mac\Vrite ll document in the range box. 

4. Click the AllAr Once check box, which causes an X to appear. 

After you click the All At Once box, the Search menu changes. 
When you use All At Once, you may search only one disk at a rime. 

5. From the Search pop-up menu, choose the disk you want to 
se;trch. 



Fig. 5.31. 
The Find Window is set. 

Fig. 5.32. 
The Located documents. 

NOTE: 
This window is 

discussed later in th is 
chapter. For now, note 

that only documents 
that meet the search 
criteria-documents 
created by Mac Write 
II-are selected and 

indicated by the dark 
highlighting. 

The Find window appears as shown in figure 5.31. 

Find 

Find and select items whose 

._I _l<_i_n_d ____ ... _,II contains ... J jl;miiDIQIIit.Iiila]E} 

Search I on " Hard Disk" [81all at once 

(Fewer Choices I Cancel I n Find I) 

6. Click the Find button. 

Now, instead of d isplaying the located icons one at a time, the Mac 
Classic displays a text listing (see fig. 5.32) . 

'V CJ Memo Folder 

• rm!l 
[) Diagram 

[) Epilogue 

tlMID 
• ilfWI.iWfbMIII 
[) Memo to JRG 

[) Schematic 

[) Text 

• mmmn 
CJ Misc. 

• IDI!Il!ll 

13K 

SK 

6K 
13K 
13K 

2K 

13K 

SK 

9K document 

13K 

- folder 

10K 
10K 
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Fig. 5.33. 
The Find window set for 

the second search. 

Part I 
Using Your Mac Classic 

7. Choose Find from the File menu (not Find Again). 

8. Choose Date Created from the first pop-up menu. 

9. Choose Is After from the second pop-up menu. 

10. Click o n the month part of d1e date. 

11. Click o n the up (or down) arrow until the month reaches 12 (you 
may ho ld the mouse down to cause d1e number to change 
continuously). 

12. Click o n d1e day part of the date. 

13. Click o n d1e up (or down) arrow until the day reaches 31. 

14. Click on the year part of the date. 

15. Click on the down arrow to reduce the year by one. 

16. Choose The Selected Items from the Search menu. The Find 
window appears (see fig. 5.33) . 

Find 

Find and select items wllose 

I dote creo ted ""'ll._i_s _o_ft_e_r ____ ... _,l 12/0)/91 

Seorctal tile selected items""' I 

( Fewer Clloices J Cancel ) [ Find JJ 

17. Click the Find button. 

Again, located documents (if any) are displayed, as shown in figure 5.32. 

Because all d1e documents are selected, when you drag one of the 
icons to a disk or to another location, you drag the icons as a 
group. In this window view, be careful to place the mouse pointer 
directly on the small icon of one of me selected documents before 
pressing and holding me mouse. Od1erwise, aU the located 
documents are deselected, and you must repeat the search. 



You can select Find again and proceed with more searches to narrow the 
selection of icons. Be sure that you leave the Search menu set to The 
Selected Items option. 

The Find command has too many possibilities to explore in the scope of 
this book. Be adventurous and expetiment. You cannot hurt data by 
searching with the Find or Find Again command, so try some search 
combinations to get a feel for the true power of this option. 

Working with Stationery Documents 
Another System 7 feature is the capability to turn any document into a 
stationery pad. This feature enables you to create template documents 
that contain data, such as letterheads, predefined financial spreadsheets, 
graphics, and so on. You can store frequently used information in a 
stationery pad document, from which copies can be tom off and used to 
create new documents. 

After you design a document, such as a letterhead, that you want to use 
over and over, you may want to turn the document into a stationery pad. 
This way you automaticaUy copy the document when you double-click its 
icon and at the same time protect the contents from accidental changes. 

To change a document into a stationery pad, perform the following 
steps: 

1. Select the document by clicking the icon once. 

2. Choose Get Info from the File menu. 

In the Info window, you see a Stationery pad option in the lower 
right corner. 

3. Click the Stationery pad check box. 

This step places an X in the box. Note that the icon of the docu
ment and the Kind information Listed in the Info window has 
changed (see fig. 5.34). 

4. Click the close box tO dismiss the Info window. 

The icon of the document on the disk now also appears as a 
stationery pad. 

To change a stationery pad back into a regular document follow the 
same steps. This time, the X is removed from the Stationery pad check 
box, and the icon returns to the previous state. 
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Fig. 5.34. 
The Icon and Kind change. 

Fig. 5.35. 
The Type a name for the 

new docume nt dialog box. 

Part I 
Using Your Mac Classic 

~D~ MacWrite II Document Info~ 

I] MacWrit.:o II Docum.:ont 

Kind: Mac Write II stationery pad 
Size: 13K on disk ( 12 ,544 byt.:os us.:od) 

's'here: Hard Disk: Docum.:ont Fold.:or : 

Created: Tu.:o, Oct 1 0 , 1989 , 4 :00 PM 
Modified : Tu.:o, Oct 1 0 , 1989, 4 :00 PM 
Version: n/ a 

Comments: 

D Locked l8J Stationery pad 

The one obvious difference you notice when using stationery pads is that 
after you double-click a stationery pad, a dialog box appears and asks 
you to name the copy of the document (see fig. 5.35) . 

You haue opened a stationery pad, so a 
new document will be created. 

( Saue ln ... ) 

Type a name for the copy of the stationery pad document, and click the 
OK button or press rentrn. The application program then starts with d1e 
new copy open and ready to be worked on. 



Fig. 5.36. 
The Save New Document 

As dialog box. 

The Save In button enables you to select a location for the new copy to 
be stored. Normally the copy is stored in the same folder on the disk 
with the stationery pad. If you click Save In, a dialog opens to enable you 
to save the copy elsewhere (see fig. 5.36). 

Current folder indicator/menu 

D Hm~~li< <I OnUn<~ Mail nocwmmt 0 
L) Ooeurnen1 
~·~ M!H:Hiri1e l l no< unu~nt 
D MS Word no< unu~n t 
D N<n1i9a1 or no< unu~n t 
0 Stationery 

Saue new document as: 

New document name box 

Current disk 

c::lHard Disk 

[j~~c1 ) 

Desktop ) 

New D) 

( Cancel ) 

E Saue D 

This dialog box is best left explained in the following section on folders. 
Briefly, however, the following list explains the options: 

Current folder menu. Displays currently open folder and enables 
you to choose any folder that contains the current one (see a 
following section of this chapter for more information on folders). 

Current disk. Displays current disk. 

Eject disk button. Ejects the current disk. Unavailable if the disk 
cannot be ejected, such as a hard disk. 

Desktop button. Displays the desktop, which includes all 
mounted disks in the File/folder display box. 

Create new folder button. Creates a new folder and enables you 
to name the folder. 

Cancel button. Cancels the entire copy and open operation; 
returns you to the desktop. 

Save button. Causes the new document to be saved. 
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New document name box. The name of the new document is 
typed and displayed here. 

After the new copy is named and saved, the application program can 
start up with the new copy open and ready to be worked on. 

If you need to change the stationery pad itself, use the Open command 
in the application program. 

o understand fo lders, think of the folders in a filing cabinet. The 
fo lders of the Macintosh interface are designed to imitate the filing 
cabinet and operate in similar ways. 

Both floppy and hard disk users can employ folders, although hard disk 
users need them more. Folders are useful for organizing disks, separat· 
ing applications, documents, and orher icons into logical divisions. 

Defining Folders 
Folders are logical divisions of a disk. That is, the disk is not physically 
divided but rather the items stored in a fo lder are linked by the software 
and are displayed as a group. 

Folders on the Macintosh, like folders in a file cabinet, can hold a group 
of items and can be labeled ro indicate their contents. Folders also can 
contain other folders. 

Nesting folders (putting folders within folders) is a function of the 
Hierarchical File System, introduced about the time of the Macintosh 
Plus computer. On current Macintosh Systems, folders can contain other 
folders, which can contain still other folders, and so on. 

Creating a Folder 

\Vhen you decide to have a folder contain a group of items, you must 
first create the folder. Consider figure 5.37, which shows a group of 
memos created with MacWrite II. 



Fig. 5.37. 
A group of memos. 

TIP: 
In figure 5.37, the 

MacWrite II folder has 
an odd, elongated/ in 
the name. This symbol 

(f) is not an Apple 
standard but has 

become a notation for 
f older. Many people use 

this character to 
shon en folde r names. 
\'<'hen typing a folder 

name, you generate this 
character by holding 
down the option key 

and pressing the F key. 

D Hard Disk 
34 items 35.7 MB in disk 2 .6 MB available 

llJ LJ 
System Folder MacWrite II f 

~ 
~ 

Memo Stationery [i?l 
Gen. Memo Agenda 

New Agenda 

Y/elcome 

¢ 1 

Suppose that you decide to create a folder to group and contain these 
memos. Fo llow these steps: 

1. Select New Folder fmm the File menu . A folder appears on the 
disk as Empty Folder. 

In System 7, the new fo lder is named Untitled rather than Empty. 

2. Type the name of the folder, Memo Folder , and press return. 

A folder name can be any character you want to use up to 31 characters 
and excluding tl1e colon (:). An attempt to type a colon in a fo lder name 
results in a hyphen (-) in me folder's name. 

Use names that help you remember tl1e contents o f the folder. Use 
nan1es like Memos, Memo Folder, Company Memos, Personnel Memos, 
and so on. 

After the folder is created and named, you can drag and store tl1e memos 
to the newly created folder. 
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You can drag the memos onto the Memo Folder icon one at a time or in 
a group. After you drag an icon onto a folder icon, the folder icon 
darkens. Then, after you release the mouse button, the icon is dropped 
into the folder in the same way you drop a paper document into a folder 
in a file cabinet. 

Renaming a Folder 
After you create a folder, you can name a folder. You also can name a 
folder at any time by taking the foUowing steps: 

1. Select the folder by clicking the icon. 

2. Type the new name. 

3. Press return. 

System 7 uses slightly different steps. To open and change a folder's 
name, you must click directly on the name of the folder. A small box 
appears around the name. Then, you may type a new name and press 
return. 

Deleting a Folder 
Deleting a folder is done the same as with any other icon. Use the 
following steps: 

1. Place the mouse pointer on tl1e fo lder. 

2. Press and ho ld the mouse button. 

3. Drag tl1e folder onto the Trash icon; the Trash icon darkens. 

4. Release the mouse button. 

Note that the important difference here is that when you delete a folder, 
you also delete the folder contents. 

Be careful when deleting folders; you may delete more than you 
want. Before deleting a fo lder, consider opening and viewing the 
tolder's contents. 



Fig. 5.38. 
Tlu: Memo Folder's 

contents. 

TIP: 
When a folder icon is 
gray, double-click the 

icon to retrieve the 
window. This feature is 

useful if several open 
folders block the 

window folder you 
want. 

Opening a Folder 
Folders are opened in a manner similar to disk icons. Double-click the 
folder's icon to open a window and display the contents (see fig. 5.38). 

[}] LJ 
$oJs1tm Foldtr Mac'o'rltt II I 

18:11 
~ 

Memo Stationery 

Aqtnda 

G•n. Homo W~lcomt 

This window looks just as other windows look in the Macintosh inter
face. The window has a close box, a zoom box, a grow box, scroll bars, 
and so on. The scroll bars are inactive in the figure because there is 
sufficient room in the window to display all the icons in the folder. 

When you open a folder, the folder's icon grays as the disk icons do. 
This change indicates that the folder is open. 

Viewing a Folder's Contents 
Until now, you viewed the contents of disks and folders by Icon; the 
icons are displayed as full-sized icons. This view usually is sufficient for 
small numbers of icons but can become difficult to use when a folder or 
disk contains large numbers of icons. 

In Chapter 3, you saw how the View menu is used to change the way 
icons are viewed. You now see how useful the View menu is when 
working with folders. 
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Fig. 5.39. 
The author's System folder. 
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In figure 5.39, you see part of the contents ofthe System Folder on a 
Mac Classic's hard disk. 

rn 
~ 

rn 
~ 

rn 
~ 

finder Multifinder finder Startup Sy s tem Clipboard file :>crapbook file 

rn 
~ 

rn 
~ 

DA Handler Backgrounder Easy Access General Keyboard Key Layout 

: : . ~ : : : ! 1 ·: : : : 
. : : : 

You can see the large number of icons in this folder and can tell by the 
right scroll bar that more are contained in the folder but not displayed. 
Even if the window were stretched to take up the entire Mac Classic 
screen, you could not see the entire contents of the folder. 

Finding a single icon in the midst of many can be a chore. Here, the View 
menu comes in handy. 

Viewing by Small leon 

The first option you may consider is the View by Small leon option in the 
View menu. figure 5.40 shows the System Folder viewed by small icon at 
full screen size. 

Now almost all of the icons are visible. However, this view may be even 
more difficult to choose single icons from. At this point, the text views in 
the View menu become useful. 

Viewing by Name 

Choosing the View by Name option results in a display similar to that 
shown in figure 5.41. 



Fig. 5.40. ~;;~o~~~~~~~~~~s~y~s~te~m~Fo~l~d!er~~~~~~~~~ji0~= 
Viewing by small icon. 67 items 36,7091< in disk 2 ,6S6K available 

F=~~====~~====~~======~======~~~~ 
~ Findtr !!il MultiFinder ~ Ftndor Startup !!il Sy stem !!il Clipboard F IQ 
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~::::~~.:v;::fs~~:~::t;::: :::ageVriler ~::~~:::::r i~::::~i~~ ~~~~~ 
~ C•pturo I! MacroMiker ~Personal Laser'rlr ltor SC ~ LO Applo Ta ~ ·~~:! 
~ lm•goVriler ljSuitcast..., II rllJDA Booster ' \I acoine"' v l .O. I i i::; 

JSPortltion IN IT liJ Disinfoohnt IN IT ~Word Settings (4) Jli'l 
~ CN Profs LJTransl•tors !!!9oos Mount or t:n!Font 1 LJExtensions '!',i 

~;~:::: ~::::;,::! ~::·;::cos ::::::::7.• Add;~:rrent DA !il~~ 
iil lntC• lc Data ~Disinfec t ant Profs ~Dvorak Startup CD Font 2 :y• 

CIJISm•rtScrap (1)\lirusDtttctivt"'t:n!Z•pfDingb•ts 12 ~MacroMakor Help ~ 

D Disinfectant IN IT 

D \I acoine ... v 1.0.1 

D AppleTalk lmage'rlrlter 

D Backgrounder 

D Basic Fonts 

D Boomorang 

D Boomer~ Holp 

D Boomerong Profs 

D Brlghtnus 

D Capture 

D CN Profs 

[J Claris 

D Claris Fonts 

D Clipboard File 

D Close\llow 

D CornpuServe Addrusts 

91 

SK Startup docum•nt Thu, Ju14, 1991 II :27 

12K Control Panel doc ... Tue, Oct 3, 1989 10 :48 

43K Chooser document Sat, Apr 30, 1988 12:00 

SK Systom documtnt Sal , Apr 30 , 1988 12:00 

19SK Font / DAMovtr d ... Sat ,Jun22, 1991 13:53 

57K Control Panel doc... Mon, Jul 2, 1990 22 :33 

28K Boomerang document Men, Jan 29, 1990 5:40 

I OK Boomorang document Men, J u18, 1991 I I :41 

8K Control Panel doc ... Tue, Sop 4 , 1990 12:00 

9K Control Panel doo ... Tue, J u1 2, 1991 12:09 

2K Information Manl. .. Fri, Jun 2 1, 199 1 22 :37 

folder Frl, Jun 2 1, 1991 17 :40 

7K Mac'l(rite II docu.. . Thu, Jul 4 , 1991 11 :32 

BK Systom document Mon, Jul 8, 1991 11 :54 

20K Control Panel doc ... Mon, Jul 8 , 1991 I I :41 

4K N•vig•tordocument Sun, Ju17, 1991 14 :45 

This view gives you an orderly, alphabetical listing of the icons (the 
Disinfectant and Vaccine icon names are preceded by a space and 
therefore ordered at the top of the window) . You also are told the size of 
the icon in the kind of document and when the document was last 
changed. 
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TIP: 
Leave the System Folder 

set to View By name 
because you can more 

easily locate a single 
icon when icons are 

sorted alphabetically. 

Viewing by Date. Size. and Kind 
The View by Date, by Size, and by Kind options result in the same basic 
display, but the icons arc sorted in order of d1e date the documents were 
last changed, their size, or their kind, respectively. 

The System Folder of System 7 users is o rganized differently and is less 
likely to become so jumbled as under System 6. However, the preceding 
comments apply to all full folders, not just the System Folder. 

Viewing by label 
System 7 users have additional options for viewing the contents of a 
folder or disk. The View menu also contains a by Label option. Using this 
option results in a text display similar tO the by Name and other selec
tions, bur the icons are sorted by the labels you applied (see fig. 5.42) 
and then alphabetically within label groups. labeling an icon is covered 
in Chapter 3. 

Fig. 5.42. ~~D~~~~~~~~~~E~D~o~c~s ~~~~~~~~~~~t!l~!! 
Viewing by Label. Nam. Sizo Kind 1..!!!!1 Lu i Modifitd 
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D PICTNOTE.NOT('o'ord4) 2K Microsoft \!'ord do ... MacC1ass ... Sun , Ju1 7 , 199 1 , 8:27 P~I! I' i 
D PRINTING .NOT (Vord4) 20K Microsoft \!'ord do ... MaeC1us ... Sun, Ju17, 1991,8:28 P~ i:{ 
D Rtsumt 9K Microsoft Word do ... Pt r sona1 Sun, Ocl7 , 1990,9:25 P ii\ij, 
D Chapltr 1 7K Microsoft Word do ... Projtcl 1 Sal , Jun 22, 1991, 1 :18 'iJ!i 
D Chaplor 2 18K Microsoft 'rlord do ... Projt ol 1 Sat, Jun 22, 1991, I :19 !U• 
D Chapltr 3 SI K Microsoft 'rtord do ... Projtcl 1 Sat, Jun 22, 1991' 1 :21 u_,; 
D Chapter 4 48K Micr osoft 'rlord do .. . Project I Sat , J un 22, 1991, 1 :22 F i:lifi 
D Chapltr xx ( le~latt) 2K Microsofl 'rtord do ... Projtcl1 Sat , Jun 22, 1991, 1 :22 F :ti: 
D Olossary 2K Microsofl 'rtord do ... Projtcl 1 Sat , Jun 22, 1991, 1 :18 F i,i!', 
D Introduction 13K Microsoft Vord do ... Projtcl I Sal , Jun 22, 1991, I :23 Iii/ I 
D Misc. 7K Microsoft \'lord do. .. Projtol 2 Sal, J un 22, 1991, I :37 

D Outlint 12K Microsoft Word do ... Projtcl 2 S.l, Jun 22, 1991, I :24 ~ 
D Window nolts 3K Microsoft Word do ... Projtol 2 s . t, J un 22, 1991 ' I :18 

D Word nolos 3K Microsoft Word do ... Projtol 2 Sal , Jun 22, 1991, I :23 0 
¢ 1 I I 'ii.'II.IIHH !;'! li!lifi!HL! iifH:II'il ,, i i~!PH~1 HI! ill!ii 'IHH l'l i:'iiii>IH!ii lfi kUilliiH lri!rl HV!Hi•11: !!Hlii I~ 121 

rn System 7, after you view a folder's (or a disk's) contents in a te>..'t view, 
such as by Name or by Label, you can switch to another text view 
without using the View menu . rf you d ick on the column heading 
(Name, Size, Kind, etc.), d1e window is resorted in d1e selected order. 



Additional Views are available in System 7. Chapter 8 covers how you 
access these Views and how you may customize the labels in the Label 
menu. 

Cleaning Up the Window 
For those who prefer viewing their folder contents in icons, two options 
are worth knowing. After a folder window is open, use the Clean Up 
Window command in the Special me nu to organize the icons in the 
folder's window. 

In System 6, if you want to straighten up only a few of the icons, select 
them and select the same command. (After icons are selected, the 
command changes to read Clean Up Selection.) For some reason, this 
feature is no longer available in System 7. 

System 6 also provides a Clean Up command that straightens all the 
icons in the window, removing them all then placing them-one by 
one-in orderly positions. To perform this action, hold down the Option 
key before selecting the Special menu. The Clean Up Window command 
becomes Clean Up. Select this command. 

System 7 provides a variation on the System 6 Clean Up command that 
enables you to sort icons by the same criteria that the text views use. To 
organize icons in alphabetical name order, perform the following steps: 

1. Choose by Name from the View menu. 

2. Choose by Icon from the View menu. 

3. Press and hold the option key. 

4. Choose Clean Up by Name from the Special menu. 

The icons are then o rganized in alphabetical name order. You can use 
any of die text orders (by Size, by Kind, or by Label) by selecting the view 
in step 1. When you hold down the option key and select the Special 
menu, the Clean Up command changes according to the last text view 
shown (Clean Up by Size, Clean Up by Kind, or Clean Up by Label). 

Closing a Folder 
To close a folder, click in die folder's dose box (the small box in the 
upper left comer of the window) o r choose the Close Window command 
from the .File menu. 
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Fig. 5.43. 

After you close a folder, the folder remembers this view. The folder 
window appears in this view when next opened. 

Nes~ng Folders 
As stated in a previous section, folders can contain more than just 
documents and appllcations; folders can contain other folders. If you 
have a large number of icons in one folder, you may want to nest some 
folders within a main folder to further organize the documents and 
applications. 

Apple changed the System Folder in System 7 to help guard against the 
confusing proliferation of icons within the folder. Figure 5.43 shows the 
contents of the new System Folder. 

System 7 Disk 
The System Folder in 16 items 10.7MB in disk 8.1 MB available 

System 7. !=== = = = = === =================;==! 
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~0 System Folder 

Sys tem Folder 
15 items 1 0 .7 MB in disk 8.1 MB available 

m 
Sy stem W Startup Items (O I Control Panels 

[!g) Apple Me.nu Items I'R:: I E~=-~-~~!ns LJ 
Finder ~ Preferences LkJ ... .J Clar~s 
~ dtJ J Clipboard I!J Claris Fonts li!Uill 

Scr apbook File ~?? Disinfectant Prefs ~t:J Word Setl~;~gs (4) 

Boomerang Help Boomerang Prefs {} 

¢ 1 

In the preceding figure, you can see how the contents of d1e System 
Folder a re divided into groups: Apple Menu Items, Startup Items, 
Extensions, Control Panels, and Preferences; the Claris folder applies to 
Claris products, such as MacWrite n. This organization is easier to deal 
with than the System Folder of System 6. 

The folders in the System Folder are special, and you can see that they 
carry symbols to note that these folders differ from the average folder. 
However, you can use me same idea of nesting folders to organize your 
icons. 



Fig. 5.44. 
Nested Memo folders. 

TIP: 
When working with 

folders, you can close 
the current folder when 

you open a folder 
nested within it. To 
perform this action, 

hold down the option 
key when you double

click a folder icon. 

Figure 5.44 shows Memo Folder, subdivided into sLx folders each for 
different memos. 

Hard Disk: 
30 items 35.9 MB in disk 2 .5 MB available 

LiJ CJ m& System Folder Mac'tfrite II f 
D Memo Folder ~L 
6 items 35.9 MB in dis k 2 .5 MB available 

CJ CJ CJ 
Q 

Stationery General Memos Financial Memos 

CJ CJ CJ 
Agendas Project 1 Memos Project 2 Memos 

~ 
¢ 1 1¢ 12l 

You can nest folders, for example, by opening the Memo Folder and 
then creating as many folders as you need by using the New Folder 
command. You then drag the memos to the new folders according to the 
categories you created. 

You can then further subdivide any of the new folders by opening them 
and using the same process to create folders within. You can carry on 
this process, nesting folders within folders, to any depth you need. Of 
course, if you create roo many folders, you reach a point where the 
nesting becomes more confusing than helpful. 

When using nested folders, you may reach a point where you see far too 
many folders on the screen. Rather d1an closing each folder by clicking 
on the close box, hold down the Option key and click in the close box of 
any folder window. All open windows dose. 

Using Folders To Organize Icons 
Different approaches can be used in organizing icons with folders. Some 
experimentation is called for to learn which is best for you. 

Chapter 5 
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One way you can organize icons is to create a folder for each application 
program as well as folders for each category of work you do. Figure 5.45 
shows such an organization. Within each work folder you can further 
subdivide work by chapters, projeC£, or another logical division you 
need. 

Fig. 5.45. ~-Eo~~~~~~~~]H~a~rd~Di~s~l< ~~~~~~~~0~ 
One method of folder 30 items 36 MB in disk 

organization. 
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2.3 MB available 

LJ LJ 
Mac Write II f MS Word f 

LJ 
Comm f 

LJ 
MacL ink I AFE f 

LJ 
Games f 

0 

! 
@] LJ 

System Folder Book tex t f 
LJ 

Figur es f 
LJ 
Memo f 

LJ 
Mise f 

¢ 1 

This kind of organization enables you to quickly locate an application 
when you need it. The grouping of projects can help you keep these 
documents from becoming scattered and hard to locate. Remember d1at 
when you double-click on a document, the Mac Classic searches for the 
application itself. You do not need to group documents wid1 the 
applications dlat created them. Group them in ways consistent wid1 your 
work habits. 

You may prefer to place all applications in one folder or place sets of 
applications into general folders. You may want to do this and dlen set 
this folder to View by Kind so that the applications are placed at the top 
of the text listing. Such an organization may result in folders that 
resemble Comm J, shown in figure 5.46. Although dlis figure shows a 
System 7 folder, the comments apply to both systems. 

The application programs and associated files of this folder are related to 
communications (for using a modem to connect with other computers, 
see Chapter 13). Even in a text view, such as dle view shown in figure 
5.46, you can double-click on Lhe applications to start them. You must 
double-dick on the small icon to dle left of the application program 
name. 



Fig. 5.46. 
A sample communications 

program folder. 

=o Comm f 0~ 
r~ame Size- Kind Labol Last Modi fied 

<$1 Amorica On lin• 1 .0 222K application prO<Jr am Communi. .. Mon, Oct 2 , 1989, 1 :20 P~ 0 
<$1 E• tractor 30K applicaUon program Utility Tu•, Ju124 , 1990, 4 :17 P 

<$1 Information Manager 755K application program Communi. .. Fri, Oct 5, 1990, 2:51 PM 

<$1 Micr oPhone"" 165K application program Communi.. Thu, Ju19, 1987,5 :52 PM 

<$1 Nav i<)ator 481K application program Communi. .. Tue, Oct2, 1990,6:56 PI" 

<$1 Unpit I BK application program Utility Thu, Oct 2, 1986, 11:04 P 

D Mail l K America On liM 1.0 ... - Sun , Ju17, 1991 ,3 :52 Pi" 

D Cll1 Holp 23K Information Manag... - Thu, Oct4 , 1990, 1 :11 P~ 

D CIS l OK MicroPhone-'" docu . .. - Sat , Ju16, 1991, 11 :19 P O 

¢ 1 ¢121 

This kind of organization results in folders, such as Word Processing, 
Graphics, Communications, and so on with the appropriate application 
programs (and auxiliary files) stored within each folder. These work 
folders group documents according to how you work. 

Moving an Icon to Another Folder 
As you develop folder organization, you may need to move icons from 
one folder to the next; This operation is easy. 

Suppose that you have a document you decide to move from one folder 
to the next; use the following steps: 

1. Place the mouse pointer on the document (or other icon) to be 
moved. 

2. Press and hold the mouse button. 

3. Drag the icon onto the desired folder (see fig. 5.47). The folder 
icon darkens. 

4. Release the mouse button. 

In figure 5.47, the icon is removed from the General Memos folder and 
placed in the Financial Memos folder. This kind of a transfer requires 
that the destination folder be visible and the source folder be open. You 
may open both folders and then drag the icon between the two win
dows. You can drag groups of icons between folders. Any icon within a 
folder may be moved to another in this manner. 
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Fig. 5.47. 
Moving the Profit Sharing 

memo. 
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Memof 
6 items 36.1 MB in disk 2 .2 MB available 

, ....... ") 
. 

S tationery General Memos "... .. ,,,_ 

General Memos 
36.1 MB in disk 2.2 MB available 

Welcome New Employee Medical 

Copying an Icon to Another Folder 
You may want ro place a copy of an icon into a different folder without 
removing the original from the first folder. You can perform th is action 
by copying the icon (or icons) from one folder to the next. The steps are 
the same except that you press and hold the option key on the keyboard 
before executing the steps outlined in the previous section. 

If you hold down the option key as you drag an icon from one folder to 
another, the Mac Classic understands that you want to copy- not to 
move-the icon to the folder. You also can select groups of icons and 
then use this option drag to copy the icons to another folder. 

Accessing Folders within Applications 
Now that you understand d1e nesting of folders, you are ready again to 
visit the Open and Save dialog boxes that you saw in earlier parts of d1is 
chapter. Again, MacWrite ll is used in the examples, but the Open and 
Save dialog boxes are defined by the Macintosh System software. The 
basic functions of d1e dialog boxes work the same from program to 
prognun. The System 6 version is discussed first; then System 7 enhance
ments are covered. 



Fig. 5.48. 
The MacWrite II Open 
Document dialog box. 

A typical Open Document dialog box for MacWrite II is shown in figure 
5.48. Note that the folder menu states that the application program has 
the MacWrite II f folder open. The file list box then shows all the 
documents in that folder that can be opened by the application program. 

DRead Me :B =Hard Disk 

Document list - -If--f-

box 

Fig. 5.49. 
The folder menu pops up. 

Show Rll auai lable 

Opening a Folder 

n Open JJ 

( Cancel 1 
Document 
type menu 

The folder menu enables you to choose between nested folders but does 
not display all the folders on the disk. You can, however, display a list of 
nested folders. After you place the mouse pointer on the menu and 
press the mouse button, the menu pops up (see fig. 5.49) and enables 
you to make choices as you do wid1 other menus. 

Open Document 
ll_, ... l'illll I r:.-. I •• 

•ll•a:.rm= Hard Disk lit =Hard Disk 

Driue 

n Open D 
10 ( Cance l 1 

L------------~~ 

Show I Rll auailable I 
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Fig. 5.50. 
The documents and folders 

of the hard disk an: listed. 
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The Mac Write II f folder is not nested in any other folder, so you can 
choose only between the folder and the disk. If you select the disk (Hard 
Disk in the figure), you see the documents and folders usually displayed 
in the disk window (see fig. 5.50). 

Open Document 
.-1 =-H-a_r_d-'-0-is-k-.l 

Cl I nits /Cdeus 
Cl Macoraw II t 
Cl Maclinlc/AFE f 
Cl MacTools® 

Cl Memo f 
Cl Mise t 
Cl Misc. 
Cl MS Word t 

Show l All auallable I 

=Hard Disk 

Driue 

R Open D 
( Cancel ] 

You can scroll to and then select any document or folder in one of two 
ways. Double-click on the name, or click on the name and then click on 
the Open button. 

After you open a folder with either method, you see with a list of the 
documents and folders within the chosen folder. You may then repeat 
the process to move deeper into the nested folders. 

As you move deeper into nested folders, each folder is added to the 
folder menu. Figure 5.51 shows how the folder menu may appear if you 
move deep into a set of nested folders. 

This menu enables you to move instantly to any folder that you pass 
through on the way down to the current folder. Note that the folders are 
listed in the menu in reverse order.july Meeting is within Meeting 
Minutes, which in turn is within General, and so on until you reach the 
Hard Disk level. 



Fig. 5.51. 
The folder menu adds 

levels. 

Open Document ., .. I 
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Using the Keyboard To Open a Folder 

= Hard Disk 
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Driue 

([ Open JJ 

( Cancel J 

You also can perfom1 this action from the keyboard. You can move the 
highlighting band in the list box by pressing the up- or down-arrow key 
on the keyboard. In this way, you may select the folder you want to 
open. After you select the icon, press the return key-or hold down the 
command key (wi th the 0 and ):( symbols) and press the down-arrow 
key- to open the folder. 

To move up one folder level, ho ld down the command key and press the 
up-arrow key. 

You aJso can use the keyboard to select a document to open. Use the up
or down-arrow keys to highlight the desired document and press return. 
This action is the same as double-clicking on the document's name. 

The Save d ialog box works in the same way as the Open dialog box with 
regard to moving in and out of folders. 

One feature found in the Open dialog box that the Save dialog box lacks 
is the capability to select folders and documents by name. You can type 
the first letter (or first few letters) of the folder or document you want to 
select. The highlighting band moves to the fo lder or document whose 
name starts with the letter or letters you type. If you make a mistake 
selecting a fo lder or document this way, pause for a moment and then 
retype the letters. 

Chapter 5 
Working with Documents and Folders 



Fig. 5.52. 
The list box is selec1ed. 
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Understanding System 7 Differences 
Although botl1 dialog boxes work in essentially the same way in Sys-
tem 7, a few differences are worth noting. The most noticeable differ
ence is tl1at tl1e Drive button is replaced by the Desktop button. In 
System 7, the mounted disks are considered to be on the Desktop, along 
wiili all oilier icons iliat also may be present. 

To see a list of mounted disks and desktop documents, click tl1e Desktop 
button or select Desktop from the folder menu. You tl1en can choose a 
disk or document to open in one ofilie following ways: 

• Double-click tl1e name of tlle disk or document. 

• Move the highlighting band up or down with the arrow keys, then 
press return. 

You can use the command-up-arrow key or command-down-arrow key 
combinations to move up or down folder levels. 

In System 7, the Save Document dialog box is changed. Save Document 
also has tlle Desktop button and works in basically tlle same way, but 
now the up- and down-arrow keys work only if the ust box is selected. 
You can tell when t11e list box is selected because the box is outlined by 
a second, darker box (see fig. 5.52). 

0 General Memos 
0 Newsletter 
0 Project 1 Memos 
0 P ect 2 Memos 

Saue current document as: 

I Document2 

c:J Hard Disk 

[ Desktop ) 

([ Open J) 
[ Cancel ] 

In Save Document, you must first press the t.1b key to select the list box. 
Subsequent presses of d1e tab key alternate between selecting tlle list 
box and the document name box. 



Fig. 5.53. 
The folder menu. 

In contrast to the System 6 version, after you select the list box, you can 
type the first letter o r letters of a folder to highlight the folder. Pressing 
return then opens dte folder. The command-up and command-down 
arrow keyboard options work as previously described, regardless of the 
box you select. Using one of these keyboard commands causes the list 
box to be selected just as if you press the tab key. 

Using New Folder Features 
System 7 has new features that apply to folders. One feature is the 
addition to all folder windows of the folder menu you see in the Open 
and Close dialog boxes. 

To access the menu, hold down the command key and click the name of 
the folder in the title bar of d1e window (see fig. 5.53). Move the mouse 
to highlight the folder you want to open and release the mouse button. 
The folder then opens. 

You also can hold down the command and option keys both before 
clicking on the folder menu and choosing a new folder. This action 
causes the new folder to open and the current open folder to close. 

The arrow keys are now active even in the by leon view. Use the up-, 
down-, left-, or right-arrow keys to select a folder (or other icon) in the 
current window. The selected folder (or other icon) can then be opened 
by holding down the command key and pressing the down-arrow key. 
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Fig. 5.54. 
TI1e Memo folder, viewed 

by Name. 
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The command-up arrow combination opens the folder that contains the 
current fo lder window, in the same way as the Save and Close dialog 
boxes. 

Adding the o ptio n key opens the new fo lder (or o ther ico n) while 
closing the previous folder. 

After a folder is selected , you may press the return key to select the 
fo lder's name. You may then type a new name. Press the return key 
again to confirm the new name. 

A welcome change to folders is in the text views. In all the text views, 
you see small triangles to the left of folder names (see fig. 5.54) . Clicking 
a triangle displays the contents of the fo lder. 

;;o Memof E!l~ 
Name Size Kind Label Last Mod 

I> D Agendas 26K folder Mon, Q 
I> D Financial Memos 26K folder Mon, 

I> D Gener al Memos 52K fold•r MonJ 

I> D N• wslett• r 403K fold•r Mon, 
'V D Pr oj•ct 1 M• mos 78K fold• r Mon, 

I> D Financ ial zero K folder Mon, 

'V D General 78K folder Mon, 

I> D Agendas 26K folder Mon, 

I> D M•et ing Minut•s 52K folder Mon, 

I> D Misc . zer o K folde r Mon, 

I> D Specifications zer o K folder Mon, 

I> D Projec t 2 M•mos zero K fold•r Mon, 

I> D Station•ry 26K fold•r Mon, 0 

This folder display is hierarchical; each folder level is indented. You can 
tell by the display o f the figure that the Agendas fo lder is within the 
General fo lder, which in turn is within the Project 1 Memos folder. The 
folders Financial, General, Misc., and Specifications are displayed at the 
same level. AJl fo ur folders are co ntained within Project 1 Memos. 

A downward pointing triangle indicates that a fo lder is open, and a 
rightward pointing triangle indicates a folder is closed . The triangles act 
as toggles: clicking o n a triangle opens or closes a folder. 

An advantage of d1is display is that you can select icons at different levels 
at the same time, which solves an old frustration in the Macintosh world. 
Prio r to System 7, you worked o nly with documents and icons in d1e 



NOTE: 
You can scroll the 

window- and open and 
close folders-by 

clicking on the triangles 
without losing the 

previous selections. 
Remember to continue 
holding down the shift 
key until you complete 

the selections. 

same folder. If you needed to copy icons that resided in different folders 
to a floppy disk, you had to copy the icons from each folder separately. 

With System 7, you can copy all the icons at one time by performing the 
following steps: 

1. Click on the small icon of the first document (or other icon) you 
want to be copied. 

This action highlights (darkens) the first icon. 

2. Press and hold the shift key. 

3. Click on each document (or o ther icon) until you select all the 
desired documents. 

4. Release the shift key. 

5. Place the mouse pointer on any of the selected icons. Remember 
to place the pointer on the small icon, no t the icon name. 

6. Press and hold the mouse button. 

7. Drag the mouse pointer to the destination d isk (or folder). All 
selected icons follow the one you drag. 

8. Release the mouse button. 

Finally, the following keys work in any of the text views: 

Key combination Action 

Up arrow Selects the next icon up 

Down arrow Selects the next icon down 

Command-right arrow Opens the selected folder 

Command-left arrow Closes the selected folder 

Command-option-righ t arrow Opens the selected folder and all 
fo lders within the folder. 

Command-option-left arrow Closes the selected folder and all 
folders within the folder. 

Because so many keyboard controls are available in System 7, you may at 
first find them difficult to remember. Two references are available that 
can help; Appendix 0 at the end of this book summarizes the com
mands, and the Balloon Help menu has a command called Finder 
Shortcuts that, when selected , displays a window that summarizes the 
commands. 
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Chapter Summary 
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n this chapter you learned how documents and folders work on 
the Mac Classic. You learned that documents are the basic unit of 
inlormation storage in the Macintosh world . You saw how docu-

ments are opened, closed, copied, deleted, locked, and unlocked. The 
stationery pad document also was discussed. 

Using folders to divide and store documents and other icons was 
covered. The creating, naming, opening, and closing of folders was 
covered. The Hierarchical Fi le System and nesting folders was explored, 
and also copying and moving icons between folders and accessing 
folders within application programs. Finally, this chapter discussed the 
new fean1res of folders in System 7. 

This chapter completes the first section of the book. You now have a 
good foundation in the operation of the Macintosh System, and you are 
ready to learn how to put this information to work. 
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ofuvare programs are the tools you use to perform work on a 
computer. Each program is designed to handle a specific kind of 
work: word processing, graphics, financial planning, games, disk 

backup, and so on. 

The first part of this book was primarily concerned with the operation of 
the Mac Classic's System software. This chapter discusses the basics of 
working with application sofuvare, including all of the following tasks: 

• Install ing applications on your disk 

• Locking and unlocking the application icon 

• Managing memory 

• Starting applications 

• Exiting applications 

• Printing with application software 

• Working with desk accessories 

For more information on purchasing software, see Chapter 11, "Select
ing System Software," and Chapter 12, "Selecting Application Software." 



Working with Application Programs 

Part II 

n the early days of the Macintosh, only two application programs 
existed. Mac Write was a word processing software suitable for 
letters and memos. MacPaint was a simple painting program that 

used the mouse to create drawings. By contrast, current application 
programs for the Mac are many and varied. 

Defining Application Programs 
Application programs are divided into the following basic categories: 

• Communications 

• Databases 

• Desktop publishing 

• Educational 

• Entertainment 

• Financial 

• Graphics 

• Music 

• Word processing 

Communications software connects computers to each other through a 
modem or network; see Chapter 13 for more details. You can use 
communications software to share info rmation with another Macintosh 
or to log in to a data service, such as CompuServe o r America Online. 

Databases store information, such as mailing lists, client records-even 
compact disk collections-and relay that data to the user through 
queries and printouts. 

Desktop publishing applications create book, magazine, and newsletter 
formats and combine words and graphics to create final copy. 

Educational applications teach subjects ranging from simple (the 
alphabet, fo r example) to complex (foreign languages). 

Entertainment applications consist primarily of games, including 
arcade-style games and text-based electronic novel adventures. 

Financial packages range from personal checkbook management 
packages to extensive spreadsheet and tax applications. 

Putting the Mac Classic To Work 



Graphics programs include applications that draw floor plans, schemat
ics and the like, as well as packages that enable you to paint pictures and 
make illustrations. 

Music applications drive synthesizers, help the user write music, and 
soon. 

Word processors probably are the best known of the applications 
packages. These programs enable you to write novels, compose letters, 
or write reports. Some packages overlap into the desktop publishing 
category and provide graphics and page-layout capability. 

When you purchase an application program for the Macintosh, you 
receive a set of floppy disks containing the application's files as well as a 
manual (or several manuals) explaining how to use the software. 

Installing Applications 
Installation instructions are included with your application program; pay 
careful attention to these instructions. The basic rules for installing 
applications are discussed in this section, but some applications require 
special steps not covered here. 

A few programs arrive copy-protected. These packages require specific 
installation procedures that appear only in the documentation. Consult 
the software manual for further information. 

Installing Applications on Floppy Disks 
To install an application on a floppy disk, you copy the main files to a 
work disk and leave the original disk as a backup. The MacWrite II word 
processing software is used here as an example of installing applications 
on floppy disks. 

MacWrite II consists of three floppy disks. The first disk contains the 
application program and some associated files; the help files are on the 
second disk; and the third disk holds translator files and the thesaurus. 
Because such a large number of files cannot fit on a single floppy disk, 
you must choose some of the files to copy if you wish to create a floppy 
work disk. To decide which files are necessary for the application 
program to function, you must consult the software documentation. 
Figure 6.1 shows the files stored on the MacWrite II disk. 
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Fig. 6.1. '=-o~~~~~~~~BM~a~cw[!l!jri~te~ll~~~~~~~~t!l~ The files on the F 
MacWrite n disk. i 7 items 717K in disk 

F==========~=.=, ====================~~~ 
69K available 

TIP: 
Store your documents 

on the working disk 
with the application. 

You may need to create 
several working copies 

of the application, 
because space on the 

floppy is limited. 

Part II 

lQl 

Main Dictionary 

'~ l ~ 
: ~' -: ......... ! 

MacWrite II 

LJ 

rm·······: 
i()l 
: ............. : 

User Dictionary 

Read Me 

Mac Write II Hyphenation 

Stationery Templates Tutorial 

You need the Main Dictionary and User Dictionary if you want to use 
spell-checking and the Mac\"Xfrite U Hyphenation file if you need hyphen
ation capability. 

The MacWrite II manual indicates that you don 't need the Read Me file, 
the Stationery Templates folder, or the Tutorial folder to create a 
working copy of the program; nor do you need the files from the other 
two MacWrite II disks to create your working copy. 

After selecting the files that you need to create your working copy of the 
application, fo llow these steps to begin the installation process: 

1. Press command-shift-1 to eject your Startup Disk, or choose Eject 
from the File menu . 

2. Insert a blank disk into the disk drive. 

3. Initialize the new disk (ini tializing is covered in Chapter 4) . For 
this example, assign the name Mac\Vrite II work to the new disk. 

4. Eject d1e new disk by pressing command-shift-1. 

; . Lock the original applications disk. 

6. Insert the original applications disk into d1e disk drive. 

7. Double-click the original applications disk to open its icon. 
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Fig. 6.2. 
Copying files to the 

working disk. 

8. Eject the disk by pressing command-shift-1. 

9. Insert the new working disk. 

10. Click the application icon to select it; in this example, dick the 
MacWrite ll icon. The icon is grey because the application disk 
isn't in the drive. 

11. Press and hold the shift key. 

12. Click each icon that you want to copy. For this example, click Main 
Dictionary, User Dictionary, and MacWrite II Hyphenation. 

13. Release the shift key. 

14. Move the mouse pointer to one of the selected icons. 

15. Press and hold the mouse button. 

16. Drag the icon to the working disk icon. The other icons follow, 
and the disk icon darkens, as shown in figure 6.2. 

11.!1 
£ .. £ 

l. .... -.............. .J 

lfmlm:n 
lllli.l!.ill 

Stationorv Ttmpl•t•s 

--~ ------
~- ---~~ 

17. Release the mouse button. The Mac Classic copies the ftles to the 
working disk. While copying, the Mac Classic occasionally may 
eject a disk and ask for another disk by name. 

When the copy is finished, store the originals in a safe place. 
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Fig. 6.3. 
The message that appears 

when you copy from a 
floppy disk to the hard 

disk. 

Part II 

Installing Applications on Hard Disks 
InstaUing an application on a hard disk consists primarily of copying the 
program files from the manufacturer's disk(s) to d1e hard disk. 

Some programs require you to place certain files in particular places on 
the hard disk-for example, in d1e System Folder. Be sure to consult the 
software documentation for specific installation instructions. 

For this example, MacWrire II is the software being copied from floppy 
disks to the hard disk. 

To copy application software from floppy disk(s) to your hard disk, 
follow mese steps: 

1. Insert the main application software disk into d1e floppy d isk 
drive. 

2. Drag the floppy disk icon to d1e hard disk icon. 

3. For System 6 users, the message shown in figure 6.3 appears 
on-screen. Click OK to clear the message. 

This message does not appear in System 7. 

The two disks are different types, so 
the contents of "MacWrite II" will be 
placed in a folder on "Hard Disk". 

fi'loii( iiiiOiiiiKiiiii!iiiiiftJD ( Can eel ) 

4. The Mac copies me floppy disk to a mrget folder on the hard disk 
with the same name as the floppy disk. \Vhen the copy process is 
finished, eject the applications disk by dragging d1e disk icon to 
the Trash icon. 

Move me files on the remaining applications disks separately by selecting 
each file and dragging its icon to the appropriate folder. For mis 
example, the MacWrite H manual smtes that me MacWrite II Help and 
Claris Help System icons should be copied to a folder named Claris in 
the System Folder. 
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Fig. 6.4. 
Preparing to copy the 

Mac\Vrite II Help flies. 

To copy the remaining applications files, follow these steps: 

1. Double-click the System Folder on your hard disk to open it. 

2. Choose the New Folder command from the File menu. 

3. Type the name of the new folder (for example, type Claris) and 
press Enter. 

4. Insert the applications d isk that you want to copy into the floppy 
disk drive; fo r this example, insert the MacWrite II Help d isk. 

5. Double-click the disk icon to open it (see fig. 6.4). 

6. Click the icon fo r the fi rst file you want to copy: in this example, 
the Mac\Vrite II Help icon. 

7. Hold clown the shift key. 

8. Click the icon for each of the additional files you want to copy: 
in d1is example, the Claris Help System icon only. 

9. Release the shift key. 

10. Move the mouse pointer to any of the selected icons. 

11. Press and hold me mouse button. 
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TIP: 
Some applicarion 

programs may nor 
operare properly when 

locked. If you experi· 
ence trouble with an 

application, try 
unlocking ir. 

Fig. 6.5. 
Locking the MacWrire II 

application program. 

Part II 

12. Drag the icons to the new folder (in this example, the Claris 
folder); the folder darkens when the mouse pointer is in position. 

13. Release the mouse button. 

locking and Unlocking Applications 
You may want to lock an application program to prevent its accidental 
deletion or changes to the icon's information displayed with the Get Info 
command (see Chapter 3 fo r more on this command) . To lock a pro
gram, follow these steps: 

1. Click the application's icon. 

2. Choose Get Info from the File menu. 

3. Click the Locked check box (see fig. 6.5). 

Locked~ 

Kind : application 
Size : 460,839 bytu used, 452K on disk 

Yhere : Hard Disk, SCSI 0 

Created : Thu, Sep 28, 1989, 17:00 
Modified : Tue, Jut 9, 199 1, 16:29 

Version : MaoW'rile II 1 .1 v 1 
September 1989 

MaoW'ri\e II 1 . I v 1, September 1989 
© 1989 Claris Corpora\ion 
A 11 Rights Renrved 
5201 Patrick Henry Drive, Santa Clara , CA 
(408) 987-7000 

Suggested Memory S ize (K) : 800 

AppUcatton M emory Size (K) : 800 

4. Close the Info window by clicking the close box. 

The same steps are used to unlock an application program. An applica
tion program must be unlocked to delete the application or to change its 
memory allocation; see the following section, "Changing Memory Size." 
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Fig. 6.6. 
Current memory use 

displayed in the About the 
Macintosh Finder window. 

Changing Memory Size 
Each application program requires a certain amount of memory to run. 
This requirement can range from a few kilobytes to more than l,OOOK; 
remember that a kilobyte is 1,024 characters. Generally, the more 
memory a program has available to run, the faster it is. 

If you have upgraded your Mac Classic's memory (see Chapter 13), you 
may want to add memory space to the applications you use most to 
permit faster operation wid1 more o r larger documents. 

Before adjusting memory size, check the amount of memory you have 
available by selecting About the Macintosh Finder from the Apple menu. 
(In System 7, this item is called About This Macintosh.) This window 
provides information about current memory use (see fig. 6.6 for an 
example). 

D 

Finder version 
System version 

About the Macintosh® FinderrM 

Finder-: 6.1.7 
System: 6.0.7---l 

larr-y, John, Steve, and Br-uce 
(9Apple Computer, Inc. 1983-90 

Installed memory - +-----------.. 

Largest memory block _1=~Tio~t~a~l:,M~e~m::o~r=y=: ==4~,0~9~6~KT!Liair-Egaeisit(Uzn[u~sje[dzBjl]ojc=lc=:=1=,3=2~3-K __ 1 open for use lllJ Mao'w'rite II 800K llh (::::::::::::::::::::::::1 

Memory use of each ';\ SuperPaint 1 .... 1 ,024K 
running application - 1---==--------:.._---l 
and System software !a Finder 256K IIIII[] 

!a System 693K ::::::::;:::::::::::::::::::::::::::;::::1 

The About the Macintosh Finder window (About This Macintosh w indow 
in System 7) indicates the following important facts about the status of 
your system: 

ltem 

Finder 

System 

Total MemO!)' 

Largest Unused Block 

Displays 

Version number of the Finder 

Version number of the System 

Total amount of memory installed in the 
computer 

Size of d1e largest free block of memory 
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TIP: 
Increase memory in 

blocks of 64K to 128K. 
After increasing the 

application's memory, 
see if the program's 

operation improves. If 
not, try increasing the 

memory again. 

Part II 

The window lists each running appllcation and the System software. 
Multi Finder is running, which enables more than one application 
program to run (see Chapter 9). Next to the name of each application 
software is the amount of memory allocated to that program and a 
graphical representation of the use of that memory. The graph in this 
figure shows that MacWrite n is using only half of its BOOK allocated 
memory; with no documents open, the program is idle. 

If you experience slow operation with a program, or you receive an 
insufficient memory warning, check the About the Macintosh Finder 
(or About TI1is Macintosh window) to see the current memory use. In 
general, the graph should show no more th;m 75 percent of the available 
memoty for an application in use. If the memory use is more than 75 
percent, the application is running close to its limit, and you may need 
to allocate more memory. 

To decide how much memory to add, you must consider several issues. 
How much total (system) memory do you have available? Figure 6.6 
shows a free block of 1,323K, but this example comes from a machine 
with total memory of 4 megabytes. On a 2-megabyte machine, running 
MacWrite II would leave about 300K free memory. Obviously, 300K is 
the maxif!lum amount you can add in this case. 

Never use all of your available memory. As your computer runs, 
the System software may need additional memory to perform 
various tasks. If you assign all of the remaining free memory to an 
application program, you may encounter problems with your 
System software. 

If the application is open, close any open files and quit the program 
before attempting to increase the memory allocation. To increase the 
memory size of an application, perform these steps: 

1. Click the application's icon to select it. 

2. Choose Get Info from the File menu. 

3. Place the mouse pointer in the box to the right of Application 
Memory Size (K): at the bottom of the Info window. 

4. Double-dick the box to select it (see fig. 6.7). 
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Fig. 6.7. 
Selecting the Application 

Memory Size (K): box. 

~0 Info 
Locked 0 

MacWr ite II 

Kind : application 
Size : 46 0 ,839 bytes used, 452K on disk 

Vher e : Hard Dis k , SCS I 0 

Cre ated: Thu, Sep 28 , 1989, 17 :00 
ModUied : Tue, Ju19, 199 1, 16 :4 7 

Ve r s ion : Mao\1rite II 1 .1 v 1 
September I 989 

Mao Write II 1 .1 v 1 , September 198 9 
@ 1989 Claris Corporat ion 
All Rights Reser ved 
520 1 Patrick Henry Dr ive, Santa Clara, CA 
(408) 987-70 0 0 

S ugges t e d Me mory S i z e (K) : 8 00 

Applic .. tion Memory Size (K) : i':!olo.JI 

5. Type a number indicating the desired memory size. 

6. Click the close box ro close the Info window. 

Starting Applications 
You can start an application program in more than one way. 

The most common method of starting an application program is to open 
the application, by double-clicking the program icon o r by selecting the 
icon and choosing Open from the File menu. 

A second technique is to open a document created by the program, by 
double-clicking the document icon o r by selecting the document icon 
and choosing Open from the File menu. With this procedure, the 
computer starts the program and opens the document. 

System 7 users can employ a third method by dragging the document 
icon to the progran1 icon and releasing the mouse button. The applica
tion starts with the document open. 

Which procedure you choose depends on your goal for the work 
session. To begin with a new document, use the first method. One of the 
other starting procedures may be more helpful if you want to work with 
an existing document, as these systems start the application and open 
the document in one step. 
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Fig. 6.8. 
The keyboard equivalent of 

the Quit command, ):C·Q. 

Part II 

Quitting Applica~ons 
The procedure for quitting an application is almost universally standard
ized in the Macintosh environment: simply choose Quit from the File 
menu. You can use the keyboard equivalent of the Quit command 
(command-Q) in the application if ):CQ appears to the right of the Quit 
option on the File menu (see fig. 6 .8). 

New 
Open ... 

Close 
Soue 
Soue As ... 
ll<wert I o }ll iH~Il 

OON 
000 

oow 
oos 

Insert Fil e... {) 00 1 

Open Merge Oat o File ..• 
tnu~rt MNIJI~ l:l<!ld... fr :•:1'1 
l'ierge ... 

Page Setup ... 
Pr int... OOP 

Quit OOQ 

A few application packages lack a Quit command; these programs 
usuaUy work in only one window. You can quit programs like these by 
closing d1e application window; click the close box. 

Printing with Applications 
ecause many kinds of printers are available for the Mac Classic 
today, printing is not as simple as when the Image Writer was the 
Macintosh 's only printer. 

This section covers general printing information. Consult the documen
tation fo r your application software and your printer for specific instruc
tions. 
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Fig. 6.9. 
The Page Setup dialog box 

fo r the lmageWriter LQ 
printer. 

Configuring the Page Setup 
With any application program, you must set up the software to work 
correctly with your printer (see Chapter 10 for more information on 
setting up the printer). This step includes configuring the page setup for 
your equipment. 

To configure the page setup, follow these steps: 

1. Choose Page Setup from the File menu. The Page Setup dialog box 
appears. Figure 6.9 shows the dialog box for the Image Writer LQ 
printer. 

lmageWrlter LQ v2.0 n\l;;;;[ =O=K~J) 
Paper: ® US Letter 

0 US Legal 
0 R4 Letter r 
0 International Fanfold ( Cancel ] 

0 Computer Paper 0 Enuelope ( # 1 0) 

Orientation Special Effec ts: 0 No Gaps Between Pages 
® Full Size 

Reductions: 0 33 % Reduction 
0 66 % Reduction 

2. Specify the desired items in the dialog box. For information on 
choosing paper size and special effects, see the next sections. 

3. When the information is correct, click OK. 

You need not reconfigure the page setup for your printer unless you 
switch printers with the Chooser (see Chapter 10). 

Setting Paper Size 
The size of paper you use for printing depends on your printer and your 
document requirements. The fo llowing paper sizes described are 
common, but your printer may not use aU of these sizes (all dimensions 
are in inches, width by length): 

Size Description DimensimJS 

US Letter Standard U.S. letter 81/2 x11 

US Legal Standard U.S. legal 8 1/2 X 14 

A4 Letter European letter 8 1/2 X 11 2/3 

CO/IIi lilieS 
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Fig. 6.10. 
Specifying a paper size for 

the LaserWriter printer. 

Part II 

Size Descrlpilon Dimensions 

B5 Letter Additional European letter 7x 10 

Computer Paper Stan dard computer paper 15 X 11 

Inrernatlonal International size for 

Fanfold computer paper 8 1/4 X 12 

Envelope Standard #10 envelope 9 1/2 X 4 1/8 

To set the paper size, follow these steps: 

1. Choose Page Setup from the File menu. 

2. Click the button next to the desired paper size. 

3. Click OK. 

You can change paper size as often as necessary. 

Apple has added several new paper sizes in System 7 for the LaserWriter 
series of printers. When you select the Tabloid paper size option fro m 
the LaserWriter Page Setup dialog box, a pop-up menu appears, as 
shown in figure 6.10. 

LaserWriter Poge Setup 

Paper : 0 us Letter 0 A4 Letter 
0 US Legal 0 85 letter 

Reduce or lllmll% 
Enl arge: 

Orientation 

7.0 

Ill~ 18] Foster Bltmop Printing? 

The following additional sizes also are available (consult your printer 
manual): 

A3 Tabloid 

Envelope- Center Fed 

Envelope-Edge Fed 

LaserWriter II 85 

Select the desired paper size; then click OK after you finish specifying 
the page setup. 
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Fig. 6.11. 
Page Setup dialog box for a 

LaserWriter printer. 

TIP: 
When you speci fy 

reduction or enlarge-
ment, 100 percent 

prints the image at the 
regular dimensions for 
the chosen paper size. 

To reduce by half, cype 
50. To double the size, 

type 200. 

Using Special Effects 
Special effects include changing the size and orientation of the printed 
page, inverting the image, and so on. This book covers only a few of the 
most popular special effects available with v:trious printers. Consult your 
printer manual for information on the special effects offered by your 
prin ter. 

LaserWriter printers, such as the LaserWriter II NT and LaserWriter II 
NTX, offer many special effects. This section uses the LaserWriter as an 
example to set up special effects on the Mac Classic. When you choose 
Page Setup fo r the LaserWriter, a dialog box appears, similar to the one 
shovvn in fig. 6.11. 

Paper size buttons Reduce or enlarge option 
/ 

FL,;;,a;;,se;;,;r,;W;;,;r~lt;;,;e;;,r,;P,;a~gb;e,;S;,;;e,;t~up~oj/~====:======:=:;5~.2=== n OK Jl 
Paper: ® US Lett~~r 0 Letter 0 Tabloid • 
~.-.. _ _,.nu us Legal 5 Letter ( Cancel ] 

Reduce or 40 "?. Pr inter Effects: 
Enlarge: [81 Font Substitution? 

Orientation [81 TeHt Smoothing? 

[ Opt ions ] 

Help 

U'4J lfRII ~ Graphics Smoothing? 
I i]!j t=:J' 1 1 [81 Faster Bitmap Print ing? J 

Printing oriemation bunons Effects check boxes 

With the Reduce o r Enlarge: option, you enter a number between 25 and 
400 to specify the reduction o r enlargement percentage for the printout 
of your document; minimum size is 25 percent, maximum size is 400 
percent. If your printer's size range is more limited than these param
eters, the dialog box may show only a few options with butrons that you 
can select by cl icking (refer to fig. 6.9). 

The Orientation option appears in almost every Page Setup dialog box, 
regardless of the printer type, but the appear.mce of the buttons may 
vary. In some versions (see fig. 6.9 for an ex:tmple) a printer icon shows 
page orientation in reference ro a printer, but the function is essentially 
the same as the butrons shown in figure 6.11. When you specify oriema
tion, each page of your document is printed in the d irection indicated by 
the selected orientation burton: portrait (upright) or landscape (side
ways). 

The Printer Effects check boxes shown in figure 6.11 usually appear only 
with laser printers. These printers have the following special capabilities 
that affect the way your document appears: 
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Fig. 6.12. 
The L1serWriter Options 

dialog box. 

Part II 

Option 

Font Substitu tion 

Text Smoothing 

Graphics Smoothing 

Faster Bit-map Printing 

Action 

lf the document uses a font that isn't in 
the printer 's memory, substitutes another 
font 

Improves the appearance of the letters on 
the printed page 

Improves the appearance of the graphics 
on the printed page 

Speeds the printing of some graphics and 
text 

Before using the Font Substitution option, consult your printer 
manual for specific information on your printer's fonts. Text 
Smoothing and Graphics Smoothing options provide the best 
printed results, but printing may take longer. Some documents 
will not print with the Faster Bit-map Printing option; if your 
document fails to print, deselect this option. 

lfyou click the Options button, another dialog box appears with further 
options to alter the appearance of your printed document (see fig. 6.12). 

=La=s=e=r=W=r=it-er_.Op=t=io=n=s====----======---=======5=.2== (~[ ~o~K~~D 
Cancel ~ ~~ .. ~ .. ·-.·-·_ ... _ ... _ .... _] o '"' ""'''""'"' 'r J 0 Flip Uertical · . 

0 lnuert lmoge 
0 Precision Dltmap Alignment (4"7. reduction) 
0 Larger Print Area (Fewer Downloadable Fonts) 
0 Unlimited Downloadable Fo nts In a Document 

This special dialog box generally applies only to laser printers, but the 
Page Setup d ialog boxes for some of the newer printers may display a 
few of these options. The LaserWriter offers the following printing 
options: 

Option 

Flip Horizo01al 

Flip Vertical 

Invert lmage 

Action 

Reverses the page left to right 

Reverses the page top to bottom 

Substitutes white for black and black 
fo r white to produce a negative 
image 

Putting the Mac Classic To Work 



Fig. 6.13. 
The Print dialog box for 

the LaserWriter. 

Cover page 

Paper source choices 

Reverse page order 

Option Action 

Precision Bit-map Alignment Reduces the page size by 4 percent 
to create a sharper image 

Larger Print Area Increases the image area on the 
printed page 

Unlimited Downloaded Fonts Enables you to use as many 
downloadable fonts as desired but 
slows printing 

The Larger Print Area option cuts the available memory in the 
printer; you may lose downloaded fonts. With the Invert Image 
option, your printer may use large amounts of toner, and the 
image quality may suffer. If you need to print in reverse, try a small 
test print first. 

Click OK to confirm changes in this dialog box, or select Cancel to 
dismiss the dialog box with no changes. The Page Setup dialog box 
returns. 

Using the Print Command 
The Print command is present in the File menu in all application 
programs that enable printing. When you choose the Print command, a 
dialog box appears. The configuration of the dialog box depends on the 
printer; most dialog boxes are variations of those for l.aserWriter and 
ImageWriter printers (the examples used in this section). Figure 6.13 
shows the Print dialog box for the LaserWriter printer. 

Number of copies Page range 

;======t====~::::::;====;§~' ([ OK B 
Poges: ® Rll 0 From: [ Con eel I 

@ No 0 Firs t Poge 0 Lost Poge [ Help 1 
Poper Source: ® Poper Cossette 0 Monuol Feed 

Print: @ Rll 0 Left 0 Right 

Print in collared order Print left or right pages only 
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The L1serWriter enables the following optio ns: 

Option 

Copies 

Pages 
All 
From 

To 

Cover Page 
No 
First J>age 
Last Page 

Paper Source 
Paper Cassette 
Manual Feed 

Reverse Order Printing 

Collated Copies 

Print 
Left 
Right 
All 

Action 

Number of copies you want to print 

Prints aU pages 
Specifies the beginning 
page to print 
Specifies the ending page 
to print 

No cover page is printed 
First page is printed as a cover page 
Last page is printed as a cover page 

Feeds paper from the paper tray 
Enables you w feed paper by hand 

Prints pages in reverse order 

Collates multiple copies (prints first 
through last pages of each copy in order); 
slows printing considerably 

Prints only left-hand pages 
Prints only right-hand pages 
Prints aU pages 

\Xfhen specifying a page range to print, type the same number in the 
Fro m: and To: boxes to print only that page. 

Because the Reverse Order Printing option prints from the last page 
through the first page, this option may produce your document in the 
correct order, depending o n the feed mechanism of your printer. This 
option slows the printing process. 

The following additional options appear in the LaserWriter Print dialog 
box for System 7 users (see fig. 6 .14): 
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Fig. 6.14. 
The LaserWriter Print 

dialog box for 
System 7 users. 

Color option 

Print destination option 

TIP: 
Laser printers also print 

dots but with greater 
precision and quality. 

Option 

Print 
Black & White 
Color/Grayscale 

Destination 
Printer 
PostScript File 

Action 

Prints in regular black and white 
Prints in color on a PostScript 
color printer, or \Vith gray shading 
on a monochrome PostScript printer 

Prints directly to the printer 
Creates a disk file with the 
PostScript code for your document 

LaserWriter " LaserWri ter" ([ ]) ,;;;;;;;;:;;;;,~~.,;;,;;,;;.;;:.;;,;~~====='=========;~7·0~= Print 
Copies:IIMI Pages: ® Rll 0 From: CJ To: CJ ( Cance l ) 

Couer Page: ®No 0 First Page 0 Last Page 

Paper Source:® Pap er Cassette 0 Manual Feed 

Print: ® Blaclc & White 0 Color/ Grayscale 

Destination: ® Printer 0 PostScriptfJ File 

D Reuer se Order Printing 
D Collated Copies 

Print: ® Rll 0 Left 0 Right 

When you click OK-some System 7 applications use a Print or Save 
button instead of OK-the application sends the document to print and 
posts a message that printing has begun. Some applications provide an 
option to cancel printing by clicking a Cancel button or by pressing 
command-period ():C-.). 

If you use MultiFinder and a LaserWriter printer, you can print in 
background mode. Instead of waiting for the computer to be free after 
the print process is completed, you can continue working on your 
document while the Mac Classic processes the print job. See Chapter 9 
for more information on using MultiFinder and Chapter 10 for details on 
background printing. 

Image\'<'riter printers are dot-matrix printers; they form letters and 
graphics with tiny dots placed on the paper by small heads striking a 
ribbon. The Print dialog box for the fmageWriter LQ is shown in 
figure 6.15. 
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Fig. 6.15. 
The Print dialog box for 

the lmageWriter LQ. 
tmogeWrlter LQ 7 .0 l Print D 

( Cancel ) _,Quality: 

Print Quality/ v Heod Scan: 

Head scan/ v Poge Range: 

/ 
Copies: 

Page range 1/ 

@ Best 0 Foster 0 Draft 

0 Bidirec tional ® Unidirectional 
[ Options J 

0 From: D To: D @ All 

Number of copies/ t:8J Reuerse Order Printing 
0 1: oll ntl~rl 1: O l) it~s 1 Print: @ All 0 left 0 Right 

Part II 

1 
I I 

Print order Print Left/right pages Paper feed options 

Most dot-matrix printers offer the options shown in figure 6.15; non
Apple printers may offer mher options (see your printer manual). As the 
figure shows, many of the printing options are the same as those for the 
LaserWriter. The following options differ: 

Op tion 

Quality 
Best 

Faster 

Draft 

Head Scan 
Bidirectional 

Unid irectional 

ActioN 

Produces high-quality printed 
material suitable for final 
versions of documents 
Produces good-quality printed 
material at a faster speed than 
Best quality 
Produces readable material suitable 
for draft use 

Improves printing speed by printing 
right £O left as well as left to right 
Prints left to right only 

Although bidirectional printing improves printing speed, this 
option can cause alignment problems; letters and graphics may 
not line up properly. 

If you click the Options button, the Paper Path Options dialog box 
appears (see fig. 6.16). The paper path options shown in the figure may 
nor be available for your printer; these options apply to the optional 
paper bins for d1e lmageWriter LQ. 
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Fig. 6.16. Automatic or hand feed 
The Paper Pad1 Options 

dialog box for me 
ImageWriter LQ. lmoge Writer LQ, Paper Path Options i .O n OK )J 

Paper Feed: ® Automatic 0 Hand Feed [ Cancel J 

Sheet Feeder Options: Din I Bin 2 Bin 3 

First page bin option - - First Sheet From: ® 0 
0 

0 
0 Remaining pages bin option - - Remaining Sheets From: ® 

TIP: 
If you need multiple 
copies of your docu· 

ment, print one copy 
from your dot-matrix 

printer; then reproduce 
the document on your 

office copier to save 
time and printer 

ribbon. 

*PLEASE NOTE: Some applications treat each page of a print job as 
the first page. These applications cannot take full oduontage of 
the Sheet Feeder Options. I ns t eod, they print each page from the 
bin you selec t in the First Sheet From option. 

The dialog box contains the following options: 

Option 

Paper Feed 
Automatic 
Hand Feed 

Sheet Feeder Options 
First Sheet From 

Remaining Sheets From: 

Action 

Feeds from the default bin 
Enables you to feed paper by hand 

Specifies the bin for the first 
page of the printed document-for 
example, for letterhead paper 
Specifies the bin for the 
remainder of the document after 
the first page 

If you have more than one paper bin, note the warning in the 
bottom of the dialog box shown in figure 6.16. Many applications 
print each page as if it were the first page and the Remaining 
Sheers From: option may have no effect 

The Mac Classic cannot print in background mode to dot-matrix print
ers; you must wait until the print job is finished before continuing your 
work. 

After you click the Print (or OK) button in the Print dialog box, printing 
begins. 
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Working with Text 

Fig. 6.17. 
A sample lener created in 

Mac\Vritc II. 

Part II 

ost o f the text you produce will come from your application 
software. The Macintosh interface contro ls the basic text options; 
these options are consistent from application to application. 

The procedures in this section apply to aU types of software (applica
tions, u tilities, and System software) that offer text editing capabilities. 
The MacWrite II word processing software is used for the examples in 
this section. 

Inserting Text 

Inserting text is a simple operation. In figure 6.17, the user is writing a 
letter. Notice that, in the first line of the body of the letter, a word is 
missing. The text reads I have to say it 's been an one; the word utzusual 
was left out. 

a File Edi t Font Size Style Formot Spelling Uiew 

~ Document2 

Lynn D. Smythe 
Mesa Inn 
501 Mesa 
Albuquerque, NM 80808 l·l'i 

h 
Danna Doylewltz l:' j.IJ,

1
:' .. 333 Rosie Lane 

Los Angeles, CA 90000 , , 

Do~:::·~" to otyook~ hoW the trip • golog I "'~ ~ ~y <• t.em o~. ~~~: 
Albuquerque is a gorgeous city though I normally don't like desert as much as you- lih 
know-who. He's ready to move here In fact. '1l,h 

Last night had to be the strangest. Made me wonder about the clam that New lf!l 
Mexico Is haunted. May be some truth there I or course, he blamed me. He claimed :!!ll 
that weird thlnqs alwavs happen when I'm around. He's one to tal<! We went to this 0 

To insert a word in the existing document, foiJow these steps: 

1. Move the mouse pointer to a point immediately foiJowing the 
word atz. The mouse pointer becomes an !-beam pointer (also 
caiJed insertion pointer or simply !-beam) , as shown in 
figure 6.18. 
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Rg. 6.18. 
The mouse pointer 

changes to an 1-beam 
pointer. 

TIP: 
When you click the 

mouse pointer on an 
icon name, the 1-beam 

pointer appears. You 
can use the steps for 

inserting text to modifY 
the icon name. 

l-beam insertion pointer 

I 
Justa nooo to let you know how the trip Is going. I have to say l's b~nione. ~~i~; ~ 

Albuquerque Is a gorgeous city though I nonnally don't Ike desert as much as you-
know-who. He's readY to move here in tacl . 

2. Click the mouse button once. The cursor, a vertical bar that 
indicates where a letter will appear when typed, appears at the 
insertion point. 

3. Press the space bar once to insert a space, and then type unusual. 
The typed word appears in the text. 

You can use thjs procedure to insert text anywhere in a document. When 
the mouse pointer changes from an arrow to an !-beam pointer, this 
change indicates that you can insert text at the 1-beam pointer's location. 

Selecting Text 
The !-beam pointer also indicates that you can select text to cut, copy, or 
format. In the same way that you select an icon before performing a 
command with it, you must select text before performing a command. 

To select text, follow these steps: 

1. Place the 1-beam pointer to the immediate left of the first character 
in the text you want to select. 

2. Press and hold the mouse button. 

3. Drag the mouse pointer to the lower right corner of the desired 
text (see fig. 6.19). The text darkens to indicate that it is selected. 

4. Release the mouse button. 

Some shortcuts exist in text selection. Double-clicking a word generally 
selects d1e word. In some applications (for example, MacWrite II) , 
triple-clicking within a line of text selects the line. Some packages use 
quadruple-clicking to select paragraphs. 

No absolute standard exists for multiple-clicldng to select text. Microsoft 
Word, for example, uses a selection bar instead of triple- or quadruple
clicking to select lines and paragraphs. 

Some applications (MacWrite n and Microsoft Word, for example) enable 
text selection from the keyboard. Widl this method, you hold down the 
shift key and use the arrow keys to highlight the text. 
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Rg. 6.1 9. 
Selecting a section of text 

to modify. 

Part II 

• File Edit Font Size Style Formot Spelling Ulew 

Document2 ---~~--
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Danna Doylewilz 
333 Rosie Lane 
Los Angeles, CA 90000 

Dear Danna, 

Removing Text 

Lynn D. Smythe !1 
Mesa Inn 
501 Mesa 
Albuquerque, NM 80808 

wo very differem methods exist for removing text. If you delete 
text, you cannot restore it easily. Text that you cut, however, is 
placed in temporary storage, enabling you to paste the text 

elsewhere. Both methods require that you select the text before per
forming the operation. 

Deleting Text 
Deleting text completely removes the selected text from the computer's 
active memory. Suppose that you want to remove the words in fact from 
the sample letter shown in figure 6.19. To delete text from the docu
ment, follow these steps: 

1. Place the 1-beam pointer immediately after the word bere. 

2. Press and ho ld the mouse button. 

3. Drag the mouse pointer to highlight the words in fact, and stop 
before the period (see fig. 6.20) . 

4. Release the mouse button. 

5. Select the Clear command from the Edit menu or press the delete 
key. The text disappears from the document and is discarded. 
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Fig. 6.20. 
Selecting text for deletion. 

NOTE: 
The Cut command can 

be reversed by selecting 
the Undo command; 

however, any text that 
was in the Clipboard 

prior to the cutting 
process generally is lost 
and replaced by the cut 

selection. 

If you want to restore the text, select the Undo command from the Edit 
menu. Choosing this command reverses your last action. If you select 
Undo immediately after deleting text, the text is restored. 

• File Edit Font Size Style Format Spelling Uiew 

=D Oocument2 

Danna Doylewitz 
333 Rosie Lane 
Los Angeles, CA 90000 

Dear Danna, 

Lynn D. Smythe 
~sa Inn 
501 Mesa 
Albuquerque, Nlv180808 

Justa note to let youknow how the trip Is going. I have to say it's been an one. 
Albuquerque is a gorgeous ely though I normally don't like desert as much as you· 
know·who. He's ready to move here U:: 

Last night had to be the strangest Macle me wonder about the clam that New 
1 
"''' 

Mexico is haunted. May be some truth there! Of course, he blamed me. He clamed !4. 
that weird thinos alwaYS haooen when I'm around. He's one to talk! We went to this K> 
1,;1 Page I 10 I i i ~i !f!!H:iiiii iii!! !.!f!ililii:i~l l 1~i Hill U!i H!:i:HH:ii:HH i'i!Hi:·nnU:i'!Hiii !1Hi i:U !iU!:H iJ!i i ii:i~ 0 121 

Only the last command is reversed with the Undo command. You 
cannot go back two or more changes unless you have a mility 
program, such as Complete Undelete. 

Cutting Text 
Text that you may need to restore later, or that you want to use in 
another part of your document, should be cut rather than deleted. The 
cut text is placed in a temporary storage area called the Clipboard, 
where it is held until you paste it to another location or cut another 
section of text. 

To cut text from a document, follow these steps: 

1. Select the text by dragging the 1-beam through the text with the 
mouse button depressed. 

2. Choose the Cut command from the Edit menu, or press ~-X. The 
text is removed and stored in the Clipboard. 

To place the em text in another location, see the "Pasting Text" section 
later in this chapter. 
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Copying Text 
You can use the Copy command to store text in the clipboard without 
cutting the text from your document. To copy text, follow these steps: 

1. Select the desired text. 

2. Choose the Copy command from the Edit menu, or press ):C-C. 
The text remains in your document but also appears in the 
clipboard. 

Pasting Text 
You can combine the Cur and Copy commands with the Paste command 
to move or copy text. Both the Cut and Copy commands place the 
selected tCJ\.1 in the Clipboard. After text is in the Clipboard, the Paste 
command in the Edit menu darkens to indicate that you can choose that 
command. 

To copy text from the Clipboard to your document, follow these steps: 

1. Place the J-beam pointer where you want the text to appear. 

2. Press the mouse burton once. The cursor appears at the insertion 
point. 

3. Choose the Paste command from the Edit menu, or press ~-V. 
The text in rhe Clipboard appears at the insertion point. 

Because text remains in the Clipboard until you replace it by cutting or 
copying a new selection, you can use the Paste command repeated ly to 
copy the same text to multiple locations. If your application enables you 
to open more than one document at a time, you can use the Paste 
command to copy text to other open documents. 

The Clipboard re tains text even when you switch applications, so you 
can cut or copy text, quit an application, start a new application, and 
paste the contents o f the clipboard into a document wid1in that applica
tion. If you use Multi finder o r System 7, you can switch to another 
application o r start ano ther application by double-clicking. 

You can use the Undo command to reverse the Paste command. 
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Replacing Text 
You can use the Paste command to replace text as well as insert te.xt 
from the Clipboard. The two text items need not be the same size; you 
can replace a word with a paragraph, for example. To replace any 
amount of text with the text in the Clipboard, follow these steps: 

1. Select the text to be replaced. 

2. Choose .Paste from the Edit menu. The text is replaced by the 
contents of the Clipboard. 

In the same way that you rename icons (see Chapter 3) by clicking the 
icon name and typing, you can replace existing text by selecting the text 
and typing new text in its place. 

To replace text with the keyboard, fo lJow these steps: 

1. Select the text that you want to replace. 

2. Type the new text. 

You can use this replacement method to replace a word, for example, by 
double-clicking the word and typing a new word. 

Working with Desk Accessories 
ust as you have various tools on your desk-a calculator, a 
Rolodex file , a thesaurus- you may have the equivalent desk 
accessories on your Mac Classic. 

This section discusses the installation and use of desk accessories in 
general, as well as some specific uses of the desk accessories provided 
with your System software. 

Because early Macintosh equipment ran only one application at a time, 
desk accessories were essential. A user could employ the desk accesso
ries to add a column of figures for a letter without quitting the word 
processing program. 

As Apple moved toward multitasking (running more than one applica
tion at a time), desk accessories became less necessary, but many desk 
accessories were so popular that Apple retained them through System 6. 
In System 7, the familiar desk accessories are almost indistinguishable 
from other applications. 
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Because o f the change in the structure of desk accessories from System 6 
to System 7, the installation and use of desk accessories is noticeably 
different. This section discusses separately the approach of each System 
to desk accessories. 

Many desk accessories are available for the Macintosh. If you need 
guidance in locating a desk accessory for your needs, see Chapters 11 
and 12 of this book. 

Defining Desk Accessories 
Desk accessories (also called DAs) are mini-applications that perform 
only one or two functions, such as calculating or keeping time. Special 
applications such as the Chooser, the Control Panel, and the Find File 
desk accessories are important in your use of d1e Mac Classic. 

The major differences between desk accessories and regular application 
programs are that desk accessories reside in the Apple menu, require a 
special utility to install, and usually have only one menu (if any). With 
the advent of System 7, even these differences are fading away. 

Installing Desk Accessories 
In System 6, insraJLing a desk accessory requires the usc of the Font/DA 
Mover u tility from your Mac Classic's System Additions disk. You must 
install the Font/DA Mover on your hard disk or a floppy disk before 
attempting to use the utility. 

Installation for hard and floppy disk users is essentially the same. Insert 
the disk containing the Font/DA Mover into your floppy disk drive. Drag 
the Font/DA Mover folder icon to your disk icon (if you don't have a hard 
disk, use a blank floppy disk). 

System 7 installation doesn't require or include the Font/DA Mover 
utility. An easy conversion routine is available for moving desk 
accessories to System 7, which is described in a later section. 

Installing Desk Accessories in System 6 
Desk accessories exist in the System icon in your System Folder. By 
placing a desk accessory in the System icon, you cause it to appear in 
the Apple menu and become available for use. 
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TIP: 
The Suitcase n IN IT 
enables you to add 
more than 15 desk 

accessories and to add 
and remove desk 

accessories without 
using Font/DA Mover 

(sec Chapter 11). 

Fig. 6.21. 
The Desk Accessories icon. 

NOTE: 
If you use a floppy disk 

system, eject your 
Starrup Disk and insert 
the disk containing the 
Font/DA Mover Folder 

before beginning the 
installation process. 

The System software limits desk accessories to 15; to add another desk 
accessory, you must remove one. 

Desk accessories use a special icon, an example of which is shown in 
figure 6.21. This icon is called a suitcase. A suitcase can hold more than 
one desk accessory. TI1e suitcase called Desk Accessories in figure 6.21 
holds two DAs (the Notepad and the Puzzle). 

Before running the Font!DA Mover program, copy the suitcase icon(s) 
containing the desired desk accessory(ies) to the same disk and folder as 
the Font/DA mover. This step isn't essential but simplifies the installation 
process. 

§0 Font/DA Mouer Folder = 0 § 
3 i1oms 34 ,960K in disk 4 ,40SK available 

0 
~ 

Font I DA Movor 

rAJ) 00 
Fonts Desk Accossories 

KJ; 
Ql 10 '21 

The installation procedure is the same for all desk accessories; this 
example shows the installation of the Puzzle desk accessory. 

To install a desk accessory, follow these steps: 

1. Double-click the Font/DA Mover Folder to open it. 

2. Double-click the Font/DA Mover icon to start the program. By 
default, the Font/DA Mover displays the fonts in the System file 
(see fig. 6.22). 

If you use a floppy disk system, the Mac Classic may request your 
Startup Disk more than once during this process. 
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Fig. 6.22. 
The Fon!IDA Mover 

window. 

Fig. 6.23. 
Opening a desk accessory 

suitcase. 

Part II 
Putting the Mac Classic To Work 

@ Font 
Mouer 0 Desk Accessory 

Chicago 12 
Courier 9 
Courier I 0 
Courier 12 
Geneua 9 
Geneua I 0 
Geneua 12 

System 
on Hard Disk 
4387K free 

( Close ] 

IQ (.._ __ [_O.:....IH~.! --' 

I' 10 

I [...__.:..:.He;:...;I.::..P_-' 

II ['---'------' . Quit 

3. Click the Desk Accessory button. 

Open ... 

4. Click the Open button. Floppy disk users may need to click Eject 
and insert the disk containing the Font/DA Mover Folder before 
clicking Open. A dialog box appears, as shown in figure 6.23. 

Rl 
c 
c 
c 
Fi 
K 
s 

0 Font 
Mouer 

Ia Font/ DA Mouer Folder I 
D Desk Accessories &1 =Hard Disk 

OriuP. 

Open 

New 

Cancel 



Fig. 6.24. 
A list of desk accessories 

in the open me. 

5. Double-dick the Desk Accessories suitcase name to open the 
suitcase. A list of the desk accessories in the suitcase appears in the 
right list box, as shown in figure 6.24. The Open button becomes a 
Close button. 

0 Font 
® Desk Accessory 

Alarm Clock 
Calculator 
Chooser 
Control Panel 
Find File 
Key Caps 
Scrapbook 

System 
on Hard Disk 
4317K free 

~ [ «Copy « 

Remoue 

991 bytes 
selected 

Help 

Mouer 

Note Pad 

1 Desk Accessories 

[ Close 1 

] I on Hard Disk 
4317K free 

====Q=u=it===1 ( Close 1 

6. Click the desired desk accessory listing (in this example, click 
Puzzle) to select it. 

When you select a desk accessory, the Copy button changes to 
show arrows indicating the direction in which the desk accessory 
will be moved, and the size of the desk accessory appears in the 
center of the dialog box. 

7. Click the Copy button. Jf you use Multi Finder, a warning appears 
indicating that the desk accessory will not appear in your Apple 
menu until you restart your Mac Classic. Click OK to clear the 
message. 

8. Click the Quit button to exit the Font/DA Mover. 

9. If you use MultiFinder, choose the Restart command from the 
Special menu to make the new desk accessory available on the 
Apple menu. 
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Fig. 6.25. 
A confinnation prompt. 

Part II 

Removing Desk Accessories from System 6 
To remove a desk accessory, follow these steps: 

1. Double-click the Fom/DA Mover Folder to open it. 

2. Double-click the Fonl/DA Mover icon to start the program. 

3. Click the Desk Accessory button. 

4. Click the name of the desk accessory that you want to remove in 
the left list box. 

5. Click the Remove button. The Mac Classic asks for confirmation 
that you want to remove the selected item (see fig. 6.25). 

Are you sure you want to 
remoue the selected items? 

( OK n Cancel D 

6. Click OK. The desk accessory is removed. 

7. Click the Quit button. 

Installing Desk Accessories in System 7 
Desk accessory installation probably will be identical to applications 
installation some day. Meanwhile, desk accessories symbolized by the 
suitcase icon must be converted to System 7 with a simple copy proce
dure. 

To convert a desk accessory to System 7, follow these steps: 

1. Copy the desk accessory suitcase icon to your hard disk or startup 
floppy disk. 
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Fig. 6.26. 
An open Desk Accessories 

v.indow. 

2. Double-click the icon to open the window, as shown in fig
ure 6.26. In this example, the file holds two desk accessories: 
Note Pad and Puzzle. 

3. Drag the desired icon (in this case, the Puzzle desk accessory icon) 
to the Disk window. The Mac Classic warns you that you are 
moving the desk accessory. The desk accessory icon d isappears 
from the file window and reappears in the disk window with an 
applications icon (see fig. 6.27). 

After converting the desk accessory, you can treat it as a regular applica
tion; for example, by double-clicking to select it. 

If you want your desk accessories to reside in the Apple menu, follow 
these steps: 

1. Drag the desk accessory icon to the System Folder. The Mac Classic 
displays a warning message about the placement of d1e desk 
accessory (see fig. 6.28). 

2. Click OK. 
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Fig. 6.27. 
The converted Puzzle desk 

accessory icon appears in 
the Disk window. 

Fig. 6.28. 
A warning message about 

the desk accessory. 

Part II 

Desk accessories need to be stored in the 
Rpple Menu I terns folder in order to 
appear in the Rpple menu. Put "Puzzle" 
into the Rpple Menu I terns folder? 

( Cancel ) [ OK ] 

The Apple Menu Items Folder controls the contents of the Apple menu. 
You can place many different kinds of ftles in this folder and thereby in 
the Apple menu. See Chapter 7 for more information on the System 7 
Apple menu. 

Starting Desk Accessories 
System 6 users, as well as System 7 users who install desk accessories in 
the Apple menu, can open a desk accessory by choosing it from the 
Apple menu (see fig. 6.29). 
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Fig. 6.29. 
Choosing a desk accessory 

from the Apple menu. 

• 

Sultcose II 
Rlorm Clock 
Co!cu!otor 
Chooser 
Control Pone! 
Find file 

5J Finder 

-"Ill MocWrlte II 

Lynn D. Smythe 
501 Mesa 
Albuquerque, l'fvl 80808 

know how the lrip is going. I have to say its been an 
is gorgeous city though I normally don't like dessert as 

ready to move here in fact. 
Made me wonder about the clam that New 

Your Apple menu probably differs from the menu shown in figure 6.29. 
The configuration of the menu depends on the desk accessories in
stalled, as well as whether you use System 6 without MultiFinder, 
System 6 with MultiFinder, or System 7. 

fiuitting Desk Accessories 
The most common way to quit a desk accessory is to click the close box 
in the desk accessory's window. Some desk accessories add a menu to 
your menu bar (such as WordFinder, shown in fig. 6.30) with a Close, 
Quit, or Done option. 

If you use MultiFinder, your desk accessories run under the DA Handler, 
which uses a menu bar. To quit a desk accessory in this environment, 
select Quit from the File menu . 

ln System 7, the menu bar is added to the desk accessory in the conver
sion process by the System software. 
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Fig. 6.30. 
The Word Finder menu. 

Fig. 6.31. 
The Alarm Clock 

desk accessory. 

Part II 

I I ii· 

Using Desk Accessories 

Window Automatic 
Window As Dragged 

Covering all o f the desk accessories available is impossible in a book like 
this. This section covers only the desk accessories that come standard 
with the Mac Classic. 

The Key Caps desk accessory also is covered in de tail in the "l)•ping 
Optiona.l Characters" section of Chapter 3; the "Locating Documents" 
sectio n of Chapter 5 discusses the Find File desk accessory, which is 
available on.ly in System 6. 

The Alarm Clock 
The Alarm Clock desk accessory has been around since the original 
Macintosh and hasn' t changed significantly. Many users prefer other 
clock programs-SuperClock, for example, is discussed in Chap-
ter 11-many of which are available from shareware and freeware 
sources. 

To display the Alarm Clock, choose it from the Apple menu. The Alarm 
Clock appears in a small window that displays the time (see fig. 6.31) . 

Close box -l-o._ ____ 1_1_:_3_5_:_4_1 __ ~_-r-.. Control lever 
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Fig. 6.32. 
The expanded Alann Clock 

window. 

Fig. 6.33. 
The alann controls. 

To change the time , date, and alarm setting, click the control lever. The 
window expands, as shown in figure 6.32. 

012:11:37PM! 

1!1 6:30:00 PM 

Set time bunon Se1 alarm bunon 

Set date burton 

The three icons at the bottom of the figure are command buttons. From 
left to right, the buttons control the time, date, and alarm. (In the figure, 
the alarm set button is selected.) 

Setting the time, date, and alarm requires the same basic steps. For 
example, to set the alarm, follow these steps: 

1. Click the alarm set button (d1e right-hand button) to access the 
alarm controls. 

2. Click the hour. The setting control appears (see fig. 6.33). 

D 1 2: 1 2:44 PM ! 
Alarm switch Setting control 

Alann time 

3. Click the up arrow to increase the hour by one or the down arrow 
to decrease by one. If you prefer, you can type the numbers for the 
hour. 

4. If desired, reset the minutes and seconds in the same manner as 
you set the hour. 

;. When the setting is correct, click the alarm switch. The switch flips 
upwards and d1e alarm set button shows a ringing alarm to 
indicate d1at the alarm is set. 

6. Click the control lever to compress the Alarm Clock window. 
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Rg. 6.34. 
The icon that indicates the 

alarm is ringing. 

NOTE: 
The alarm sometimes is 

set in the factory. New 
users are faced with the 

blinking clock before 
they know about the 

Alarm Clock. 

Rg. 6.35. 
The Calculator desk 

accessory. 

Part II 

7. Click the close box to close the desk accessory. 

You can set the time and the date in nearly the same manner as de
scribed here; however, neither the time nor the date requires you to 
activate a switch like the Alarm switch. 

At the specified alarm time, the Mac Classic beeps and displays an icon of 
a ringing alarm clock that blinks in place of the Apple symbol on the 
menu bar (the menu still is active, however) . Figure 6.34 shows the 
alarm clock icon. 

Jb· File Edit Ulew Special 

To turn off the alarm, follow these steps: 

1. Select Alarm Clock from the Apple menu. 

2. Click the contro l lever to expand the Alarm Clock window. 

3. Click the alarm switch to turn off the alarm. 

4. Click the close box to dismiss the desk accessory. 

The Calculator 
A basic four-function calculator is available by selecting Calculator from 
the Apple menu. The Calculator desk accessory appears as shown in 
figure 6.35. 

D Calculator 
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Fig. 6.36. 
The Notepad desk 

accessory. 

To operate the Calculator, you can click the buttons with the mouse or 
use the numeric keypad on your keyboard. The Calculator keys are in 
the same standard anangement as the numeric keypad; the Enter key 
acts as an equals sign ( =). 

You are familiar with the plus (+) and minus(- ) keys, but you may 
wonder about the slash (I) and asterisk (*) keys. The slash (I) indicates 
division, and the asterisk (*) indicates multiplication. 

These same symbols ( +, - , !, *) appear on the regular part of the 
keyboard and can be used. The two row of numbers also can be used. 

When you finish using the Calculator, click the close box to dismiss th is 
desk accessory. 

The Notepad 
The Notepad acts as a scratch pad; it isn't a word processing system and 
has no formatting or printing capability, but it's useful for quick notes to 
yourself. 

The Apple Installer program doesn' t install the Notepad; instead, follow 
the instructions for installing desk accessories earlier in this chapter. 

Choose Notepad from the Apple menu to open the Notepad (see 
t1g. 6.36). The Notepad holds about eight pages of notes; you can access 
different pages by clicking the "buttons" in the lower left corner. The 
Notepad always opens on page one. 

Close boxl~~iii~JN~o~te~P~a~d!Jiiiil 

------1- Text area 

Next page button , 

Previous page bu tton"~~~~~~~~~~~~~~~~~ Page number 
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Fig. 6.37. 

Text placed in the Note Pad is saved automatically. All of the text edit 
functions discussed in this chapter are available for use in the Note Pad. 
Dismiss the Notepad by clicking its close box. 

The Scrapbook 
The Scrapbook is one of the most usefu l desk accessories provided by 
Apple because it stores text and graphics you use frequently. To open 
the Scrapbook, select it from the Apple menu. The Scrapbook appears as 
shown in figure 6.37. 

The Scrapbook desk 

Close box 

Display area -HH-----

Scroll bar 

Current item number mPIC , PICT 

Part II 

Number of items in Scrapbook Item cype 

The Scrapbook employs the familiar close box, as well as a scro ll bar. 
The box on the scroll bar shows the current cursor location; click the 
mouse pointer to the left of the box to move left one item, or tn the right 
of the box to move right one item. You also can drag the scroll box to 
move to an item quicldy. 

The Edit menu offers the fo llowing options when the Scrapbook is open: 
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Option 

Cut 

Copy 

Paste 

Clear 

Action 

Removes d1e displayed item from the Scrapbook, 
copying it to me Clipboard 

Copies the displayed item to me Clipboard 

Copies the contents of the Clipboard to the 
Scrapbook, creating a new entry (existing items 
remain when new ones are added) 

Deletes me displayed item from the Scrapbook 
(does not copy to the;! Clipboard) 

By using the Scrapbook, you can copy a selection from a document to 
the Clipboard, and then open the Scrapbook and use the Paste com
mand to store the selection. When you need the text or graphic again, 
open the Scrapbook, use the scroll bar to display the desired item, 
choose Copy from me Edit menu, close the Scrapbook, and choose Paste 
to insert me selected item in your document. 

Although the Clipboard is a temporary storage area, the scrapbook is 
stored on disk (in the System Folder) and holds items pasted into it until 
such time as you delete them. 

The Puule 

order. 

ike the Alarm Clock, the Puzzle is one of the oldest Macintosh desk 
accessories. The Puzzle is similar to me small plastic puzzles where 
you slide pieces around, attempting to arrange them in some 

You cannot use the Apple Installer to install me Puzzle; instead, follow 
me instructions for installing desk accessories (earlier in this chapter) 
that apply to your System Software. 

Choosing Puzzle from the Apple menu causes me desk accessory to 

appear (see fig. 6.38). To operate the Puzzle, click a tile near the dotted 
open space to move me tile into mat space. The goal is to arrange the 
tiles in numeric order. The Puzzle blinks to indicate success. Scramble 
the tiles again by choosing Clear from the Edit menu. 
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Fig. 6.38. 
The Puzzle desk accessory. 

Chapter Summary 

Part II 

Oddly, this program appears to be the only Apple desk accessory that 
changed berween Systems 6 and 7. The System 7 version presents a 
scrambled apple-unless you choose Clear from the Edit menu-and 
says "Ta dal" when you solve the puzzle. 

You can create your own puzzle by copying a graphic and pasting it with 
the Paste command when the Puzzle is open. Close the Puzzle and 
reopen it to scramble the tiles. 

his chapter discussed application software and the mini-applications 
called desk accessories. You learned how to install, start, and quit 
applications and desk accessories, how to change the memory 

allocation of an application program, and the basics of printing from an 
application. 

This chapter also covered text operations, including how text is inserted, 
copied, cut, and pasted. These basic text functions are common to most 
applications. 

At this point, you have learned the basic skills you need to use the Mac 
Classic. The documentation provided by the manufacturers of your 
equipment and software, as well as the remainder of this and other 
books by Que, can help you learn specific answers to your Mac Classic 
needs. 
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Configuring the 
Mac Classic 

Using Control Panels 

B 0 0 K 

ne feature of the Macinrosh computer that adds to its popularity is 
the capability to customize the computer ro fit each user's work 
habits and personal taste. This chapter presents some of the 

basic configuration options available to you: the capability to alter the 
appearance of the desktop, set the date and time, and change the 
volume level of the speaker. 

This chapter introduces the control panel devices, also called CDEVs 
(pronounced see-devs). These small, software items act, as the name 
implies, as control panels that enable you to alter various settings of the 
System and other software. CDEVs also are explored in Chapter 8, which 
presents how these devices are installed and used. 

The System sofhvare provides you with a basic set of control panel 
devices that you use ro alter the basic settings of the System software. In 
System 6, these devices are accessed through the Control Panel desk 
accessory. Control Panels in System 7 are double-clickable, which means 
you open them as you do any document or application program. 



Fig. 7.1. 
The Control Panel desk 

accessory in System 6. 

Control panels come in great variety. They are evidently one of the most 
popular items for programmers lO write, judging from the sheer number 
of them available. This sectio n discusses the seven most basic, Apple
supplied control panels: General, Brightness, Memory, Mouse, Key
board, Sound, and Startup Device control panels. The Memory CDEV 
exists only in System 7; in System 6, its function is controlled by the 
General CDEV. 

In System 6, you access a control panel by ch oosing the Control Panel 
desk accessory from the Apple menu. When you choose this desk 
accessory, you are presented with a window similar to that o f figure 7.1. 
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Although th is desk accessory looks complicated , the desk accessory itself 
comprises only two parts and two controls of its own: 

Scrolling list shows the icons o f aU the contro l panel devices in 
your System Folder. 

Control panel area displays the controls of the selected contro l 
panel device. 

Close box. Click this lO close the desk accessory. 

Scroll bar is used to scro ll the list if needed; if all CDEVs are 
d isplayed , the scroll bar is white and inactive. 
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Fig. 7.2. 
The Control Panels 
folder in System 7. 

To access any control panel device, scroll to it if it is not visible, and click 
once on its icon. Its controls appear in the control area of the Control 
Panel desk accessory. 

In System 7, functions are different. In the System Folder is a folder 
named Control Panels (see fig. 7.2). You access this folder in the usual 
way: double-click the System Folder, and then double-click the Control 
Panels folder. Alternatively, you can choose Control Panels from the 
Apple menu to open the folder. You then see the icons of each of the 
control panels (see fig. 7.3). 
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To access a control panel, clouble-click on its icon. Its controls then 
appear in a window. This window has a close box that you can click to 
dismiss it. 

Using the General Control Panel 
The General Control Panel determines the settings of the desktop. The 
settings include such specifications as the desktop pattern, the rate at 
which menus blink when selected, the time and date setting, and the 
cursor blink speed. The System 6 version also contains a volume control 
and the RAM cache setting. 
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In System 6, you access the General Control. Panel by selecting the 
Contro( llanel desk accessory and clicking once on the General icon. 
This retrieves the General Control Panel's controls (see fig. 7.4). 

Fig. 7.4. 
The System 6 General 
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Fig. 7.5. 
The General Controls 
window of System 7. 

In System 7, you open the Control Panels folder in the System folder by 
double-clicking; then you double-click the General Controls icon. A 
window opens and displays the controls (see fig. 7.5) . 
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The basic controls are similar to those of System 6, except that several 
controls have been removed from the General Controls panel and 
moved to other CDEVs. 

Changing the Desktop Pattern 
The pattern of the desktop begins in a basic, neutral gray pattern. You 
can alter this by using the Desktop Pattern control in d1e General control 
panel (or General Controls in System 7). The Desktop Pattern control 
(see fig. 7.6) enables you co change the desktOp pattern. 

The Desktop Pattern Move one pattern +_,.~:;JI;~I-EI:=I:3 Move one pattern 
right control. left 

L..----11- Click to set pattern 
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Fig. 7.7. 
The Time and Date Set 

Controls. 
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You can choose from two ways co change the desktop pattern. Click the 
pattern edit box to add or remove dots. The box to the right then shows 
a tiny version of the desktop that displays the resulting pattern. When 
you achieve the desired patte rn, click in the box on the right to set it. 
Unfortunately, you cannot save patterns created in this way. If you 
change the desktop pattern later, your design is lost and must be 
recreated. 

Approximately 38 patterns are available for your use. You dick on the 
left or right arrows at the top of the right box to change the pattern. 
When you see d1e one you want to use, dick the box to set it. The 
background of the deskcop is then redrawn in the selected pattern. 

When finished, click in the close box of the Control Panel desk accessory 
(or General Controls window in System 7) to dismiss the controls. 

Changing the Time and Date 
The Mac Classic has a built-in clock maintained by a battery. After the 
dock is set, the clock should maintain good time and rarely need 
adjustment. The Classic does not need to be plugged in for the clock to 
keep time. The calendar should not need adjustment, but the time will 
need to be reset when daylight savings time begins and ends. 

In the General control panel (General Controls panel in System 7) , you 
find the time and date set contro ls (see fig. 7.7). 
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The figure shows three different versions of the same controls for 
iUustration purposes. The control has three sections. The cop section 
sets the clock's time. The middle sectio n enables you to choose between 
12-hour and 24-hour (also called military or computer) time. The 
bottom sectio n sets the date. 
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To set the time and date, perform the following steps: 

1. Click the hour or minute or second to select it; the hour has been 
selected in the left-hand control in figure 7.7. 

2. Click the up arrow to increase by one or the down arrow to 
decrease by one. 

Or type the number if you are setting the minutes or seconds. You 
must use the arrow controls to set the hour. 

3. You can change the a.m. or p.m. settings in the same way, except 
that you must type only the letter A for a.m. or P for p.m. if you 
use the keyboard method. 

4. Click the clock icon to confirm your setting. 

5. To change to 12- or 24-hour time, cHck on the button next to the 
setting you want to use. In 24-hour mode, 1 to 11 p.m. are 
represented by the numbers 13 through 23. Midnight is consid
ered to be hour zero (0) because it is the beginning of the day. If 
you choose 24-hour time, you do nor use a.m. and p.m. The time 
is set i.n the same way except, of course, that no a.m./p.m. setting 
is available. 

6. You set the date in the same manner that you set the time. Click 
on the day, month, or year setting, and click the up or down arrow 
to increase or decrease by one. You also can type the number from 
the keyboard. Click the calendar icon to confirm your setting. 

7. Close the desk accessory (or window in System 7) if you are 
finished by clicking in the close box, or continue 10 make changes 
to other controls. 

Changing the Speaker Volume 
By now you probably have heard the Mac Classic issue a warning or 
no tify you by beeping. You may have found the beep too loud or too 
soft and want to change its volume. In System 6, you change the sound 
volume by adjusting the GeneraJ control panel or the Sound control 
panel. System 7 uses only the Sound control panel to change the 
volume. 

The Sound control panels in both systems are used to change the beep 
sound. Apple provides several sounds that you can set as your beep 
sound. See the section "Using Sound" later in this chapter for more 
information. 

Chapter 7 
Configuring the Mac Classic 



Fig. 7.8. 
The Speaker Volume 

control. 

Part II 

In System 6, you change the volume of the beep sound by performing 
the following steps: 

1. Choose the Control Panel desk accessory from the Apple menu. 

2. Click on the General control panel (or dick on the Sound control 
panel). You then see the Speaker Volume control (see fig. 7.8). 

Volume levels 

Speaker 
Volume 

The control imitates the sliding volume control that you see on 
many portable radios and tape players. 

3. Drag t11e slider to a new setting. 

The maximum setting is 7 and the lowest is 0, which turns off the 
speaker. \Vhen you use the 0 setting, the beep is replaced by a silent 
flash of t11e menu bar; the menu bar inverts-white turns to black, black 
to white-when the Classic would normaiJy beep. 

The Sound control panel has complete control over the speaker volume 
in System 7. The Speaker Volume contro l is not found in the General 
Controls panel. You use the same basic steps to set the speaker volume, 
except that instead of choosing the Control Panel desk accessory, you 
open the System Folder and the Control Panels folder you fmd there; 
then you double-click the Sound control panel. You then have access to 
the Speaker Volume control. 

Close t11e Control Panel desk accessory for System 6 or the Sound 
control panel window for System 7 by clicking in the window's 
dose box. 
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Fig. 7.9. 
The insertion Point 

Blinking Rate Control. 

Changing the Cursor-Blink Speed 

When you work with text in a Mac Classic application program or the 
System software itself, you see a vertical bar indicating the location that 
text will be inserted when you type. In the computer world, this item is 
usually called the cut'sor but in the Macintosh world is more often 
referred to as the inset'tion point. Regardless of the name, you probably 
have noticed that this bar blinks; you can set the speed at which it blinks 
if you desire. 

Choosing the Control Panel desk accessory and clicking on the General 
control panel (or double-clicking on the General Controls panel in 
System 7), gives you access to the Rate of Insertion Point Blinking 
control (see fig. 7.9). 

Rate of Insertion 
Point Blinking 

.... ~ .... ---+-- Sample insertion point 

I Q @ () 1 Blink speed buttons 

Slow Fast 

This control consists of three buttons: Slow, Medium (the middle, 
unlabeled one), and Fast. A sample insertion point blinks at the speed 
you have chosen. Click on any of the three buttons to choose a speed. 
Close the Control Panel desk accessory (or the General Controls window 
in System 7) by clicking on the close box. 

Changing the Menu-Blink Rate 

When you choose a menu command or other item, the item blinks to 
conftrm your choice. The menu item usually blinks three times. You can 
change this rate to no blinking or between one and three blinks. 

To access the Menu Blinking control, choose the Control Panel desk 
accessory from the Apple menu and click the General control panel (or 
double-click the Gener.tl Controls control panel in System 7) . The Menu 
Blinking control becomes available (see fig. 7.10). 
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Fig. 7.10. 
The Menu Blinking 

Control. 
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Fig. 7.11. 
The Screen Brightness 

control. 
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Choose a menu blink number by clicking on one of the three buttons 
numbered 1, 2, and 3; the menu above the buttons blinks that number 
of times to confirm your choice. You also can turn off menu blinking by 
clicking d1e Off button. 

After you make your choice, close the Control Panel desk accessory (or 
the General Controls panel in System 7) by clicking in the close box of 
the window. 

Using the Brightness Control Panel 
The brightness of the Mac Classic screen is controlled by the Screen 
Brightness control panel rather than the usual hardware knob or slider. 

Choose the Control Panel desk accessory from the Apple menu and click 
the Brightness control panel (or double-click the Brightness control 
panel in System 7). The control becomes available (see fig. 7.11). 

Screoo?n Brightness 
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This control acts much like the Speaker Volume control covered 
previously. To use Screen Brightness, place the mouse pointer on the 
slider and drag it along the control. Move to the left to decrease screen 
brightness, to the right to increase it. 
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Fig. 7.12. 

After setting the screen brightness, close the Control Panel desk acces
sory (or the Brightness control panel in System 7) by clicking in the close 
box of the window. 

Using the Keyboard Control Panel 
The keyboard has three settings concerning the repeat rate of the keys 
and their layout. 

Key 1·epeat rate is a reference to the feature that types a character 
repeatedly when you hold down a key. You can use th is feature to create 
a dividing line of dashes o r a string of periods in tables of contents. The 
speed at which the characters are typed and how long you must hold 
down the key before it is repeated, if at all, is controlled through the 
Keyboard control panel device. 

Key layout controls which character is typed when you press a key. You 
usually use an American Q\VER1Y layout, which is the standard type
writer arrangement of keys. Other arr-.mgements are available through 
various sources. One such arrangement is the Dvorak key layout. 
Dvorak is a key arrangement that places your most often used keys in 
easier reach of your strongest fingers, which reduces the amount of 
movement you must make in typing. 

To access these controls, choose the Control Panel desk accessory from 
the Apple menu and click the Keyboard control panel (or double-click 
the Keyboard control panel in System 7). The control becomes available 
(see fig. 7.12). 
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Fig. 7.13. 
The Mouse controls. 
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The key-repeat rate may be set from Slow to Fast by clicking on the 
desired button. The delay that occurs before the key is repeated may be 
set from Long to Short. Clicking the Off burton prevents the keys from 
being repeated, no matter how long they are held clown. 

To determine the best settings for your use, you must experiment The 
settings shown in figure 7.12 are the defaults set by Apple. 

In the lower part of the window appears a list of keyboard layouts. If you 
have only one, d1is window does not appear because there is nmhing to 
choose. The highlighting band around Electric Dvorak in figure 7.12 
indicates that d1e keyboard is currently using the Dvorak keyboard 
arrangement. Change d1is selection by clicking on any layout you have 
installed. 

After making your selections, close the Control Panel desk accessory (or 
the Keyboard control panel in System 7) by clicking in the close box of 
the window. 

Using the Mouse Control Panel 
When you move the mouse, the mouse pointer responds by moving 
across the screen of the Mac Classic. Now you can adjust the speed of 
the pointer and the response timing of the mouse button. 

To access the mouse controls, choose the Control Panel desk accessory 
from the Apple menu and click the Mouse control panel (or double-click 
the Mouse control panel in System 7). The control becomes available 
(see fig. 7.13). 
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Mouse Tracking, the top section, determines d1e speed at which d1e 
mouse pointer moves in response to me movement of the mouse. The 
first setting, Tablet, is used for graphics tablets o r for making very fi ne 
adjustments in a graphic by using me mouse. At rnis setting, the mouse 
pointer moves at about me same speed as you move the mouse. One of 
me oilier four settings-from Slow to Fast-is usually better suited for 
everyday work. The faster you set me mouse pointer's response, d1e less 
distance you must move d1e mouse to cross the Mac Classic's screen. 
Choose a speed by clicking on one of the four buttons. 

The Double-Click Speed controls determine how quickly you must press 
d1e mouse button fo r the Mac Classic to interpret it as a double-click. 
The left most setting enables you to click more slowly, and the right 
most setting requires d1e double-click to be a rapid succession of button 
presses. 

To determine d1e best settings, you must experiment. Try setting both 
controls to an average speed and see how me mouse feels to you. If you 
find mat me mouse pointer moves too quickly, reduce me tracking 
speed. Conversely, if you find yourself unable to move quickly across the 
screen, increase the mouse tracking speed. 

The middle double-click speed usually is me best all-around speed . If 
you find, however, that the Mac Classic often interprets your double
clicks as two single clicks (a double-clicked icon is selected but does not 
open, fo r example), you may need to decrease d1e double-click speed. 
Conversely, if you find that icons are opening when you mean merely to 
select them, increase your double-click speed setting. 

You may close d1e Control Panel desk accessory (or me Mouse control 
panel in System 7) by clicking in d1e close box of the window. 

Using the Startup Device Control Panel 
Although you should never keep more man one System Folder on any 
one d isk, you may have separate ones fo r separate hard disks. For 
writing rnis book, fo r example, one hard d isk has System 6 installed and 
ano ther has System 7. You probably will not need such a configuration, 
but it does occur occasionally. 

The Mac Classic has a normal search order when it starts. First, the Mac 
checks the floppy drive to see wherner a startup disk is present. Then it 
checks the SCSI bus (see Chapter 4) in order of me SCSI identification 
numbers for a disk drive that contains a System Folder. The first fo lder 
located is me one used. The result is that if you have more man one 
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Fig. 7.14. 
The startup devices 

available. 
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startup device in a second hard disk or a networked disk, the Mac Classic 
always uses the first it finds and never proceeds to any others. 

To change the order, you must use the Startup Device control panel (the 
Startup Disk control panel in System 7). You access this control by 
choosing the Control Panel desk accessory and clicking on the Startup 
Device control panel (or double-clicking the Startup Disk control panel 
in System 7). You are then presented with a window that displays the 
available startup devices (see fig. 7.14). 

-

In figure 7.14, two hard disk icons are displayed. This indicates that both 
have System Folders and can be used at startup. The icon for Hard Disk 
is highlighted, which indicates that it will be used as the startup disk. To 
change this configuration, click once on the other icon to select it. Then 
close the Control Panel desk accessory (or the Startup Disk window in 
System 7) by clicking in the Close box of the window. 

Selecting Restart from the Special menu then causes the Mac Classic to 
shut down and restart from the newly chosen device. The Startup Disk 
takes precedence over the setting of the Startup Device control panel. 
This way, the Mac Classic can be started from a floppy if the selected 
hard disk should ever fail. 
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Using the RAM Cache 
A RAM cache is a part of memo ry set aside for use in accessing your d isk 
drive. As discussed in Chapter 4, disk accessing is conside rably slower in 
RAM cache than for memory chips. A RAM cache stores frequently used 
information in order to reduce the number of times a drive must be 
accessed , thereby speeding up the operation of the computer. 

In System 6, use of the RAM cache is optional and can be turned off. You 
cannot turn off the RAM cache in System 7. You can adjust the size of the 
cache in both Systems. 

To access the RAM Cache conu·o l in System 6, choose the Control Panel 
desk accessory from the Apple menu and click on the General control 
panel device. In System 7, double-dick o n the Memory control panel 
device. Both are shown in figure 7.15. 
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On/Off control 
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QOff 

I Current size -

D Memory 

riD ~···· Disk Cache Cache Size I128K I ¥:~::· Always On 
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Both controls have in common two small arrows that are used to set the 
amount of memory used by the RAM cache. Clicking on the up arrow 
increases the cache size by 32K. Clicking on the down arrow decreases it 
by the same amount. Both controls display the size of the RAM cache in 
K for kilobytes (1024-character blocks). 

The System 6 control has On and Off butto ns. You can leave the cache 
off if you are low on memory o r discove r a program that has trouble 
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Using Sound 

Part II 

operating wi th d1e cache turned on. The latter problem should no 
lo nger occur, and you should leave d1e cache o n unless you simply 
c;mnot spare the memory. 

The cache, as a rule of thumb, should be set to include 32K of memory 
for each megabyte you have Installed in your machine. If you have a 
1-megabyte Mac Classic, for example, set the cache amount to 32K. If 
you have a 2-megabyte Mac Classic, set ilie cache to 64K. 

In System 7, you can click the Use Defaults button and d1e cache size is 
automatically set for your machine's memory size. 

After you make your settings, close the Control Panel desk accessory (or 
the Memory control panel in System 7) by clicking in ilie close box of ilie 
window. 

ound is one of ilie most popular features of ilie Macintosh 
computer. With its capability to handle sound, the Macintosh can 
sing, talk, play show runes, or even make sarcastic remarks. 

This section covers how you change the Alert sound, which is the beep 
the Mac Classic makes to alert you to error conditions or other situations 
that warrant your attention. System 7 users also see how to easily install 
new sounds in d1e System. 

Wiili additional software, you can go so far as to have your Mac Classic 
burp as it ejects its disks, express surprise and dismay at your choice of 
the Shut Down command, or alert you with Star Trek klaxons (see 
Chapter 11) . 

Changing the Alert Sound 
Apple provides several sounds d1at you may choose for your Alert sound. 
Unfortunately, none of them sing, but some interesting sounds have 
been included. 

To change d1e Ale11 sound , System 6 users choose the Control Panel 
desk accessory and dick on the Sound control panel device. System 7 
users double-cl ick on d1e Sound control panel device. In e iilie r case, ilie 
control then becomes available (see fig. 7.16). 
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Rg.7.16. 
The Sound control. Speakt?t" 
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The control shown is for System 6. The only difference between it and 
the one of System 7 is the list of Apple-provided sounds. In System 7, the 
sounds are Droplet, Indigo, Quack, Simple Beep, Sosumi, and Wild Eep. 

To hear a sound, click once on its name in the list. Clicking on a sound 
name also selects it and makes it the current Alert sound. You also can 
drag the Speaker Volume slider to adjust the volume of the Alert sound. 

Close the Control Panel desk accessory (or the Sound control panel in 
System 7) by clicking in the close box of d1e window. 

Adding and Removing Sounds 
System 7 users can add or remove Alert sounds easily and wid10ut 
additional software. System 6 users should consult Chapter 11 for their 
needs. The new System acts more like a folder into which and from 
which you can drag such resources as sounds. 

To add a sound to the System, perform d1e following steps: 

1. Double-click the System Folder to open it. 

2. Double-click the System icon to open it. This icon may take a while 
to open. 

3. The System probably will open in a text view, such as by Kind. You 
can continue in this view, but it might be easier to change the view 
by choosing the by Icon option from the View menu. 

The fonts and sounds are displayed as icons (see fig. 7.17). 
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Fig. 7.17. 
The contents of the 

System icon in System 7. 

Fig. 7.18. 
The sound is being moved. 
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4. Along the lower part of the window- you may have to scroll 
before you can see them-are the sound icons. These icons have a 
picture of a speaker emitting tones to identify them. In a text view, 
they are identified in the Kind column as a sound. 

Drag rhe new sound into the System icon window. 

When you are successfu l, you receive a notice that the move is in 
progress (see fig. 7.18). 

Moue 

I terns remaining to be moued: 

Writing: Droplet 

Stop 

If you attempt to insert a new sound with any application or o ther 
programs running, you receive a warning message (see fig. 7.19) . 
If this happens, simply click d1e OK button, quit any running 
programs, and try to drag d1e icon again. 
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Fig. 7.19. 
The system cannot be 
modified while other 

applications are running. 

The System file cannot be changed while 
programs other than the Finder are open. 
To make changes to the System file, first 
quit all open application programs and 
desk accessories. 

n OK , 

A Stop button is provided to halt the move process, although you must 
be exceedingly fast to use it. 

Removing a sound is the same as the preceding operation except that in 
step 4, you drag the sound out of the System icon window. The same 
restriction on programs running applies and the Move window appears 
as before. 

When finished, close the System icon by clicking in the window's 
close box. 

Using the Set Startup Command 
f you find yourself using the same application programs and 
perhaps the same desk accessories every time you work with your 
Mac Classic, you might want to set these items to start automati· 

cally when you start your Mac Classic. 

In System 6, you use the Set Startup command in the Special menu. If 
you are using only the Finder, only one application program may begin 
at startup. If you are using MultiFinder (see Chapter 9), as many applica
tion programs and desk accessories as your memory can hold may open 
at startup. System 7 has the same capability but accomplishes the process 
with a Startup Items folder. 

System 6 with the Rnder 

To cause any application to begin when you start your Mac Classic, 
perform the following steps: 

1. Select the application program's icon by clicking it once. 
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Fig. 7.20. 
The Set SL1nup dialog box. 
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2. Choose the Set Startup command from the Special menu. The Set 
Starntp dialog box appears (see fig. 7.20). 

3. Click the OK button. 

c::J Start up "Hard Disk" with : 

@ <11 Finder 0 <11 ~<$1 MultiFinder 

Upon st artup , automatically open: 

@ MacWrite II 

0 O~I<HI(~d flmali( ntions mad nf!~ 

0 Finder Only 

( Cancel ) n OK D 

The MacWrite II name appears in the d ialog box because that icon has 
been selected. If you click OK, this setting opens the MacWrite II 
program automatically when the Mac Classic starts. 

To change to another application program, you repeat these steps. To 
cancel this feature and have no applications open at startup, perform the 
following steps: 

1. Choose Set Startup from the Special menu. 

2. Click the button to the left of the Finder On.ly option. 

3. Click the OK button. 

System 6 with MultiRnder 
MultiFinder enables d1e use of more d1an one application program at 
one time (see Chapter 9). Consequendy, d1e Set Startup command can 
open more than one application program at startup and can open your 
most used desk accessories. 

To start more than one application when you start your Mac, perform 
d1e fo llowing steps: 
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Fig. 7.21. 
The Set Stanup window. 

1. Start each application you want opened automatically at startup; 
double-click the icon of each. 

2. Choose each desk accessory you want to open at startup from the 
Apple menu. 

3. Click on the application icon in the upper right corner of the 
screen until the Finder icon appears (see Chapter 9 if this is 
unclear). 

4. Choose the Set Startup command from the Special menu . The 
Opened Applications and DAs option already is selected (see 
fig. 7.21). 

5. Click the OK button. 

~ Start up "Hard Disk" with: 

0 ($! Finder @ ~ ($! ($! Multifinder 

Upon startup, automatically open: 

0 Sei(H t•~11 I h~ms 

@Opened Applications and DAs 

0 Multifinder Only 

( Cancel ) n OK D 

You can use these steps at any time to change the application programs 
or desk accessories that you want to open at startup. 

To cancel the opening of the applications and desk accessories at 
startup, choose the Set Startup command, click the MultiFinder only 
option, and click the OK button. 

Certain documents and their corresponding application programs can be 
opened at sc.mup. To open designated documents, perform these steps: 

1. Select the documents you want to have opened at startup. 

2. Choose the Set Startup command from the Special menu. 

The correct option is chosen automatically for you. 
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3. Click the OK button. 

This command also enables you to switch between the Finder and 
MultiFinder. Refer back to figure 7.21 and you see that the top two 
options of this dialog box are Finder and MultiFinder. Click on the one 
you want to start with, and then click the OK button. Choose the Restart 
command from the Special menu, and the Mac Classic restarts by using 
the option you chose. 

System 7 
System 7 has no Startup command. Instead, you use the Startup Items 
folder in the System Folder. Any item placed in the folder is opened 
automatically when the Mac Classic starts. Disk icons, folders, applica
tions, and anything else that can be opened can be opened at startup by 
using this folder. 

Avoid dragging every folder, application, document, and other 
items you might need into the Startup Items folder. The items will 
then be out of place, and by dragging some icons into the folder, 
you might copy them and unnecessarily use space on your disk. 

The best procedure is to use the new Make Alias command in the File 
menu to create an alias of each item you want to open at startup and 
place the alias i·nto the Startup Items folder. An alias acts exactly as the 
original icon with one exception: when you delete an alias, you do not 
remove the original icon (see Chapter 8). You can think of an alias as a 
copy of an icon that tells the Mac Classic where to find the original. 

To add items to your Startup Items folder, perform the following steps: 

1. Select the icon of the application program, desk accessory, folder, 
or document that you want to open at startup. 

2. Choose the Make Alias command from the File menu. The alias is 
created (see fig. 7.22). 

3. Drag the alias into the Startup Items folder. 
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Fig. 7.22. 
A Mac\Vrite £1 alias. 
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Repeat these steps until you have added all the items you want opened 
at startup. 

To cancel the opening of any item at startup, perfom1 the following 
steps: 

1. Open the Startup Items folder. 

2. Drag the alias to the Trash. 

3. Close the Startup Items folder. 

Because sounds can be double-cl icked in System 7 so that they play 
through the speaker, you can create a startup sound by placing a copy of 
a sound, or- even better-its alias, into the Startup Items folder. 

Using the Apple Menu Items Folder 
n System 7, the Apple menu performs much more than its o riginal 
functions. Previously the home of desk accessories, the Apple 
menu now can hold any item that can be opened, including disk 

icons, folder icons, and applications. 
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NOTE: 
Dragging an alias to the 

Trash does not delete 
the original icon. If you 
placed an original icon 

in the Apple Menu 
Items folder, you 

should not drag the 
item to the Trash. Drag 

it to another part of 
your disk. 
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Anything placed in the Apple menu can be opened by choosing it from 
that menu. This capability enables you to start applications, open 
documents and folders, and retrieve desk accessories by making a quick 
menu choice rather than searching through folders for the icon you must 
double-click. 

An added benefit of the new Apple menu is that you can sort the items in 
the menu in any order you want. 

Installing and Removing Icons 
To add any item to the Apple menu, you place it within the Apple Menu 
Items folder, which you find in the System Folder . Like the Startup Items 
folder, you should avoid dragging every item you want available in the 
Apple menu into this folder. Using aliases is the best approach. 

Small items, such as desk accessories, can be placed in the folder. For 
something as small as the Alarm Clock, for example, the trouble of 
making an alias is not necessary. Simply drag it into the folder. 

For large items or items that you want to remain in their original 
locations, make an alias of them and place the alias in the folder. For 
small items, such as desk accessories, simply drag the icon into the 
folder. 

The alias method of adding items to the Apple menu requires the 
following steps: 

1. Select the icon of the applicatio n program, desk accessory, folder, 
or document that you want to add to the Apple menu. 

2. Choose the Make Alias command from the File menu. The alias is 
created. 

3. Drag the alias into the Apple Menu Items folder. 

Repeat these steps until you have added all the items you want to be 
added to the Apple menu. You can add items at any time and they 
immediately appear in the menu. 

To remove any item from the menu, perform the following steps: 

1. Open the Apple Menu Items folder. 

2. Drag the icon to another part of your disk, or drag the alias to the 
Trash. 

3. Close the Apple Menu Items folder. 
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Table 7.1. 
The Special Soning 

Characters 

The item immediately disappears from the Apple menu. 

Sorting the Apple Menu 
If you drag icons or their aliases into the Apple Menu Items folder, the 
System sorts them in the Apple menu in alphabetical order. You, 
however, may want them to appear in another order. For example, you 
may want often-used applications to appear at the top of the Apple 
menu. Or you may want to group them according to your work habits. 

To alter the order of the items in the Apple menu, you use a set of 
special characters. You can place one or more of these characters at the 
beginning of an alias or icon name to sort items in the Apple menu in 
any order you want. Changing the name of an alias does not change 
the name of the original icon. Table 7.1 shows the set of characters you 
may use. 

< s:pac:@ ce ( o-q ) !JI ( o-7 ) ~ ( o-g ) 
! I w !l ( o-s: ) ~ ( o-0 ) 
« ( o- [ ) = Z ~ (o-r ) 0 ( o-z ) 
"' ( s:o- I ? I 9 ( o-g ) G. ( s:o-/ 
# ?. _ _ _ _ _ _ _ ) _ _ _ _ _ _ _ _ ~ __ (_ q-:~ ~ __ i ___ (_o_-_ 1_ ) __ 
-$ - - . - - - - & ( o-a ) ~ ( s:-5 ) -jo ( o-= ) ., ( o-L ) 

~ A ' ., ( o-5 ) .J' ( o-v ) 
& ce ( o - ' ) { ~ ( o - , ) f (o-f) 
' ( o- I ) B ) ~ ( o- . ) ~ (o-x ) 
' ( s:o- I c: ,.. ¥ ( o-y ) a ( o-j ) 
·( ·-- · · · · ~- · (.;:.e:y ·; · · .:o.:f) · ·f.l- · "(o--m·)· ~ .. - • (c,:..~ Y 
) E ¢ ( o-4 ) ~ ( o-d ) - ( o-- ) 
* f t. ( o-3 ) ~ (o-w ) - ( s:o--
+ G § ( o-5 ) 1T ( o-p ) ( o-/) 
- 0 ( o-o ) • ( o-8 ) J ( o-b ) 

The table is sorted from top to bottom, left to right. For example, an 
icon or alias with a name starting with a space will be at the top of the 
Apple menu. One starting with a division sign will be at the bottom. One 
beginning with a period will precede one beginning v.rith a paragraph 
mark. 
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Fig. 7.23. 
A sample Apple menu 

using sorting characters. 

TIP: 
You do not need to 

leave the word alias 
in an alias name. 

Your entries 
in the Apple menu 

can read, for example, 
MacWrite II instead of 

MacWrite II Alias. 
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In the table, difficult-to-locate characters are followed by a notation in 
parentheses. An o indicates d1at you hold down the option key. An s 
indicates that you hold down me shift key. The notation (so-]) indicates 
that to generate mat character, you hold down d1e shift and option keys 
and press the right bracket key(]). You can consult the Key Caps desk 
accessory for help in locating some of these characters (see me section 
"Using me Keyboard" in Chapter 3). 

Figure 7.23 shows a sample Apple menu. Each item is preceded by a 
character mat determines its order in the menu. The Startup Disk 
control panel device is at the top, which reflects its frequent use. 
Applications are grouped by using d1e plus ( +) symbol and are sorted 
alphabetically within meir group by d1e Mac Classic. Further below and 
off the scrolling menu are infrequently used desk accessories placed at 
the bottom by using a question mark (?) . 

About This Macintosh ... 

~ !Startup Disk 
[g) #Gen era l Control s 
G!l $Scrapbook 
~ ll'Control Panels 
& +Amer ica Online 1.0 
~ •Apple File EHthange 
~ •Macllnlc:Pius/ PC 
I} +MocWrlle II 
i +Microl'hone'M 
~+Microsoft Word 
+ +Nouigotor 
'A. +Superl'alnt 1.1 MS 
rp -Chooser 

~ ? Alarm Clock ... 

Avoid naming your aliases with characters that foUow another in 
table 7.1. If you want to insert something bet\veen t\vo items, you 
might need to rename again. 

Consider the variety of items on the menu . Startup Disk and General 
Controls are contro l panel devices. Scrapbook is a desk accessory and 
Control Panels is a folder. The remaining items are applications and desk 
accessories. Anything you use frequently is a candidate for the Apple 
menu. 

Putting the Mac Classic To Work 



Chapter Summary 
his chapter listed some ways you can personalize your Mac Classic 
to suit your work habits. You learned to alter the desktop pattern, 
change the time and date, adjust the speaker volume, and modify 

the screen brightness. 

You also learned to change the Alert sound, add new sounds, use the 
Set Startup command to open your most used applications, and you 
explored customizing the new Apple menu in System 7. 

The next chapter discusses more complex ways of personalizing your 
Mac Classic. 
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Using Advanced 
Configuration 0 tions 

MIAC 
CLASSIC 
Bl 0 0 K 

his chapter continues Chapter Ts theme: configuring your Mac 
Classic to fit your work habiLS and personal preferences. Some of 
the more advanced options available are covered here. 

Chapter 7 inu·oduces the control panel device, or CDEV, but Chapter 8 
discusses CDEVs in greater depth. Closely related are the !NITs (called 
System Extensions in System 7), which load at startup to configure your 
Mac Classic. Many CDEVs and INITs work;ogether. 

This chapter also discusses System 7 features, including views, labels, 
and aliases. By using views, you have greater control over the display of 
window icons in your windows. Labels enable you to group and orga
nize your icons. You have seen some aspects of aHases, but by the end of 
this chapter you will understand the feature more fully. 

Finally, the basics of the Macintosh networking features are discussed 
o nly briefly because the average home user does not need networking. If 
you use your Mac Classic in a networked environment, spend some time 
with the Apple manuals to gain more information. 



Using CDEVs 

Part II 

ou have seen how CDEVs work to configure your Mac Classic. You 
now should know that the CDEVs supplied with your Mac Classic 
are not the only ones available. A great variety of CDEVs are 

available w enhance your computer. 

Defining CDEVs 
The name of the CDEV, control panel device, defines its purpose. 
CDEVs are small pieces of software dedicated to controlling a particular 
function. These items can be as diverse as the timing and image of a 
screen saver, an alarm clock, a hard disk format protector, a virus
protection system, and other functions. Most come with software 
packages. For example, the MacTools package includes a Mirror CDEV 
that enables you to tailor the settings of the disk format-protection 
feature of that package. 

Many CDEVs exist to control the settings of an INIT. Because IN ITs run 
automatically and invisibly, CDEVs can act as a window into the opera
tion of the TNIT. The SuperCiock CDEV, for example, enables you to set 
the clock's time, the font the time Is displayed in, and other options. 

Installing and Removing CDEVs 
You easily can install and remove CDEVs. On Systems 6 and 7, drag the 
CDEV into your System folder. To remove the CDEV, drag the item back 
out. You don't have to delete a CDEV to cause it to cease to operate. You 
can store the CDEV in a folder on a disk, for example. The CDEV does 
nothing if left out of the System folder. 

If you purchase a software package d1at includes a CDEV and want to 
install the feature, do t11e following: 

1. Insert the disk containing the CDEV. 

2. Double-click the disk icon if necessary to open it. 

3. Drag t11e CDEV to the System folder. 

System 7 users see a notice like the one in figure 8.1. 
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Fig. 8.1. 
The CDEV installation 

notice of System 7. 
Control panels need to be stored in the 
Control Panels folder or they may not 
work: properly. Put "Boomerang" into the 
Control Panels folder? 

( Cancel ) [ OK ] 

System 6 users do not see this notice and don't have to perform 
step 4. 

4. Click the OK button. 

The CDEV is copied into the System folder and, in System 7, into the 
Control Panels folder. 

Reverse your actions to remove a CDEV: 

1. Open the System folder by double-clicking it. 

System 7 users must use step 2, but System 6 users can skip to 
step 3. 

2. Open the Control Panels folder by double-clicking it. 

3. Drag the CDEV out of the folder. 

You can drag the CDEV to the icon of the disk on which the 
System folder resides. This action moves the CDEV to the disk 
window but outside the System folder. 

4. Click the close box of the System folder. 

System 7 users also must perform step;_ 

5. Click the close box of the Control Panels folder. 

Because a CDEV that is outside the System folder does nothing, you can 
store the program anywhere on your disk or drag the CDEV to the Trash. 

Using a CDEV 
In System 6, Apple provides a shell for the CDEVs installed in your 
System folder. This shell is the Control Panel desk accessory. Choose this 
desk accessory from the Apple menu, which brings up a window shown 
in figure 8.2. 
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Fig. 8.2. 
The Control Panel desk 

accessory window in 
System 6. 
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To access a CDEV, scroll to the item and click once on its icon. The 
CDEV's controls appear in the control panel area. 

In System 7, however, the Control Panels folder appears inside the 
System Folder (see fig. 8.3). Double-click the System Folder to open the 
folder, then double-click the Control Panels folder. Alternatively, you can 
choose Control Panels from the Apple menu. You then see the icons of 
each CDEV. 

Double-click on a CDEV's icon to open. The CDEV's controls appear in a 
window, which has a close box that you click to close the window. 

A great variety of CDEVs are available through commercial sources, user 
groups, and on-line services, such as CompuServe. See Chapter 11 for a 
discussion of some you may wish to consider. 

t startup time, your Mac Classic loads and runs INITs, which are 
small utility programs that start when your machine is turned on. 
INIT is a resource code, not an acronym. I NITs can enhance the 

function of your Mac Classic by adding such features as macros for your 
keyboard, where you can combine several steps into one; provide 
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Fig. 8.3. 
The Control Panels folder 

inside the System Folder of 
System 7. 

security by controlling access to your dara; protect your data by guarding 
against viruses; o r monitor the fo rmatting of your hard disk. 
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In System 7, the term INIT has been replaced by System Extension, a 
name that better implies the purpose of these items; to extend the 
functioning of the System software. System Extensions reside in the new 
Extensions folder located in the System Folder (refer to fig. 8.3). Consult 
Chapter 11 for a sample of available I NITs. 

Installing and Removing I NITs 
You install I NITs the same way you install CDEVs: drag them into your 
System folder. After installing, choose Restart from the Special menu 
because !NITs are loaded and run at startup. The !NITs continue to run 
invisibly as long as the Mac Classic is on. 

One example of an INIT is the Disinfectant INIT in figure 8.4. When 
installed, this !NIT presents no windows or controls until a virus is 
detected on a disk inserted in the disk d rive. Then, the INIT presents a 
warning and a series of beeps to notify you of the potential infection. 
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Fig. 8.4. 
The Disinfectant INIT. 

Fig. 8.5. 
The INIT installation notice 

in System 7. 

Part II 

:D Hard Disk er= 
32 items 36,261 K in disk 2,791K available 

rru LJ LJ LJ LJ ~ 
System Folder MacVrite II Memo f Document Folder Mise f Disinfectant INIT 

01 ~ 10 

To install an I NIT, follm.v these steps: 

1. Insert the disk containing the !NIT into the disk drive. 

2. Double-click the disk icon if necessary to open. 

3. Drag the !NIT to the System folder. 

Like CDEVs, System 7 issues a notice here (see fig. 8.5). 

EHtensions need to be stored in the 
EHtensions folder in order to be auailable 
to the Macintosh. Put" Disinfectant INIT" 
into the EHtensions folder? 

~ 

~ 
Q] 

( Cancel ) ( OK ] 

System 7 users then must perform step 4. 

4. Click the OK burton. 

5. Choose Restart from the Special menu to load and run the INIT. 

You should see an icon appear below the Welcome to Macintosh 
message that appears as the Mac Classic starts. Each INIT places an icon 
on-screen to indicate that the INIT is loaded and functioning. 

The fNlT is referred to as an Extension in figure 8.5. In System 7, Apple 
calls !NITs System Extensions because they extend the function of the 
System software. In System 6, I NITs are called Startup Documents. 
Compared to the term startup document, the name extension avoids 
confusion with items that are placed in the Startup Items folder. Al
though INITs are loaded at startup time, they are not installed in the 
Startup items to lder. 
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NOTE: 
Step 5 is important. 

Dragging an IN IT our of 
the System folder (or 
Extensions folder in 
System 7) does not 

cause the I NIT to quit 
running but prevents 

the IN IT from loading 
the next time you start 

the computer. 

This confu sion in terminology occurs because the name INIT comes 
from the software resource d1at creates an INIT internally. Apple is 
attempting to clarify the issue by dropping d1e o ld programmer's term in 
d1e new System 7. 

Removing an I NIT is a simple process, Like removing CDEVs. Follow 
these steps to remove an IN IT: 

1. Open the System folder. 

System 6 users can skip step 2. 

2. Open the Extensions folder. 

3. Drag the lNIT out of the folder to another location on d1e disk. 

Like CDEVs, you can place the INIT anywhere except in the System 
folder (or Extensions folder in System 7). 

4. Close the folder or folders. 

5. Choose Restart from the Special menu. 

Resolving INIT Conflict 
Computer users dread the word incompatibility. Although incompatibil
ity is relatively rare with Macintosh software, the problem does occur. 
Essentially, incompatibility refers to situations where some software 
packages cannot run on the same machine without causing problems. Of 
all the software conflicts in Macintosh software, INITs have probably 
been at the root more than any od1er software item. 

INlTs, as extensions of the System software, are at the heart of your Mac 
Classic's basic functions. This is why INITs can cause so many problems. 

You know quickly when you have an incompatibility problem. After 
installing an I NIT or other software, you may notice that applications 
begin to act strangely or refuse to open at all. Your machine may crash, 
which is a colorful term for a sudden stop. A crash usually is indicated by 
a dialog box containing a small bomb and an error message. 

The worst case of incompatibility is when the Macintosh refuses to start 
at aU. One of the more inconvenient versions of mis problem is when 
the Mac starts but men restarts-repeatedly. 
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In any of these incompatibility cases, try the following procedures: 

• Remove tbe fast installed INTT. Many times the last INlT you 
installed on your Mac Classic is the proverbial straw. If all runs 
well after you remove the INIT, you have found your culprit. 

• Run a virus program, sucb as Disinfectant. In fact, hard disk users 
should keep a disk nearby that has a System folder and Disinfec
tant for cases when the Mac Classic does not start. This disk should 
always remain locked (see Chapter 4) to prevent a virus from 
infecting its contents. 

If the virus program detects a virus present on the hard disk, take 
action to remove the virus. The virus program may be capable of 
repairing the damage, as Disinfectant is. Pay close attention to the 
advice offered by the virus program and its manuals. 

• Use tbe Apple Installer program to replace your System software. 
Sometimes, although rarely now, an application or lNIT can 
damage d1e contents of the System software. Re-installing d1e 
System software can cure the problem. Keep in mind that the 
culprit application or INIT can repeat the damage. 

When problems begin, consider d1e last change made. Usually, if 
you have been running fine and then suddenly encounter prob
lems, the last item installed is the most likely candidate. 

• Cbeck tbe !NIT's manuals or call tbe software company to 
determine whether tbe /NIT conflicts with any otber program. 
Before calling a technical support line of any company, make sure 
to have your information organized. What exactly were you doing 
before the crash? What did you notice? If a box with a bomb 
appeared, what exactly did the box say? Much information can be 
gained from the number or wording in that crash box. Write down 
the contents. What other lNITs do you have? In what o rder do 
their icons appear at startup time? 

You also can try the following steps to rectify compatibility problems: 

1. Remove aiiiNITs from your System folder (or Extensions folder in 
System 7). 

2. Install one INIT. 

3. Choose Restart. 

4. Try the same operation you attempted before the crash. 

5. Repeat steps 2 through 4 for each IN IT. 
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When you perform these steps, install the I NITs in order of importance 
to you. You may discover that your least important !NIT can be left our 
and cure the problem. 

Consider which INlTs may conflict. Do any of your !NITs auempr to 
control or alter the same functions? For instance, some IN!Ts install 
useful menus to help you open applications without double-clicking 
them, as OnCue does. Have you installed another INIT that may be 
trying to install another menu, perhaps in the same location? IN1Ts that 
conflict often are trying to do similar things. 

To avoid such problems, consider the following provisions: 

• Avoid /Nrfs with questionable heritages. Many Macintosh users 
are members of users' groups, which are famous for passing 
around software written by members of their own or another 
group. But what do you know of the programmer's skill? Does the 
INfT have a good or bad reputation? 

Users' groups and on-line services can be great sources for 
inexpensive and useful software. But that software can cause 
many crashes and other problems. However, you e<tn find good 
programs, such as SuperCiock, which is a well-known !NIT with a 
good reputation that places the time and date on your menu bar. 
Ask before you install. 

• Avoid installing !NITs unless you are su1·e you need them. The 
more IN ITs you have, the more likely you encounter conflicts. 

• KeejJ current on hVIT versions. As Apple releases new versions of 
the System software, !NITs can become out of date and lead to 
conflicts and problems. 

• If you have many IN ITs, consider a utility to manage them. 
Chapter 11 discusses some utilities that can help you to manage 
your INlTs by turning them on and off and choosing the order in 
which they load at startup. 

Preventing INIT Start 
In System 7, Apple provides a feature that c;m help with System Exten
sion (INIT) problems. You can prevent aU System Extensions from 
loading by holding down the shift key as your Mac Classic starts. If you 
run into trouble that appears to begin with a System Extension, restart 
the machine and hold down the shift key as the Mac Classic starts. You 
then can remove the suspect System &'tension and try again. 
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Using Views 

Fig. 8.6. 
The Views control panel 

window. 

Straight grid butron 

Staggered grid button 

ith System 7, you have greater control over the way you view icons. 
You can change the font (typeface) used in the display of icon 
nan1es and other text information. The grid used to organize icons 

can be set to the regular, checkerboard style or a newer, staggered 
formation. Icons also can be configured to snap into their proper places 
whenever you move them. 

In the text views, also called list views, such as view by Name and by 
Kind, the small icons you see can be made larger. You also can control 
the information displayed in these views. 

All of these functions are performed by using the new Views control 
panel, which is in your Control Panels folder inside the System folder. 
To access these controls, double-click on the Views control panel icon. 
You then see the window shown in figure 8.6. 

0 Uiews 

J. 
Font for vit>ws: I.__G_e_n_e_u_a ______ .... __.l lgiE) - -t--

,-···Icon Vit>ws ......................... .. .................................................................................................... , 

Font menu 

Font size 

Font size 
menu 

I D D D D @Straight grid i 
0 Always snap to grid -t--t-- Grid snap 

option D D D D 9 St aggt>r ed grid 
. .. ................................... .. .......................... .. ... .................. .... ....... ... ........ ... ....... .. .. ....... ........................ 1 

, .... List Vit>ws .............................................................................................................................. . 

i ($1 ~ ~ [8] Show sizt> i 
! ~ [8] Show kind i 

I ~ Q 9 f8l Show labe 1 j_ 
Icon size buttons ; [8] Show date ! 

List (text) view 
column options 

. d . --{;-j-[8] Calculatt> foldt>r s izt>s 0 Show vers ion l 
Wm ow options : O O ' 1-J-1 Show disk info in ht>ader Show commt>nt~ l 
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;,,.,,,,,,,,,.,,.,.,,.,,,..,.,,,,,,.,,,.,,,.,,.,,.,,..,,,,,,,,,,.,,,,,noooo+""''" "*'""''''''''''''''''""'''"'""''' ''''''''''''''''''''''' .. ''''''J 

The control panel is divided into three sections: the font used in views, 
the icon grid, and the list (text) views options. 
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Fig. 8.7. 
Choosing the 

New York font. 

Changing the View Font 
Any font installed in your system can be used in icon displays. (See 
Chapter 10 for more information on fonts.) The standard font used in 
icon displays is Geneva. Be aware, however, that some fonts display 
better than others. Experiment a little. You always can reset the font to 
the original setting. 

To change the font, fo llow these steps: 

1. Double-click the Views control panel. 

The font pop-up menu appears when you place the mouse pointer 
on the menu and press the mouse button. 

2. Choose the new font from the font menu (see fig. 8.7). 

3. Click the close box to dismiss the control panel window. 

Chicago 
Courier 

Font for views : v' Geneua 
Heluetica 

0 0 

I8J Ca leu late fo lder s izes 

D Show disk info in header 

to grid 

Show size 

18] Show kind 

18] Show labe 1 

18] Show date 

D Show vet"sion 

D Show comments 

The font is updated immediately; you don't have to close the Views 
control panel window to see how your choices work. With that in mind, 
open a window or two, then open the Views control panel. Test a few 
choices to see which font you like best before closing the window. 
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Fig. 8.8. 
A sample font size menu. 

Part II 

You also can leave the window open to make further changes, such as 
font size. To change the font size, choose from the font size pop-up 
menu, or type the size number you want between 6 and 36 and press 
return. 

In the font size menu, some sizes appear in outlined characters, bu t 
otl1ers appear in normal, black characters (see fig. 8.8). The normal 
characters indicate that those font sizes are not installed in your system 
and do not appear well on-screen. In fig. 8.8, font sizes 9 and 11 are not 
installed. 

9 
nm 

Figure 8.9 shows several sample fonts. From left to right, the fonts used 
are Times, New York, and Chicago, all in 10-point size. 

Changing the Icon Grid 
If you have used the Clean Up command o r one of its variations (see 
Chapter 3), you have noticed that the icons align on an invisible grid. 
You also see this grid in action if you hold down the command key while 
dragging an icon; the icon "snaps" to the grid when the mouse button is 
released. 

Some icon names are long enough to overlap when aligned to this grid. 
System 7 addresses this problem by introducing a staggered grid. Fig
ure 8.10 shows a straight grid in the background and a staggered grid in 
the foreground . 
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Fig. 8.9. ~§~O~~~~~]rl!ig~u!ire~s]t~ii~~~jg~~l!! 
Sample font changes. f-:=-==,;;I!!!U~· ===~-===,.;s;;iz;,• ,.;K;;;w;;...~==:;t~aJ 

I> D Ch>p l f~ 93K rolhr 10 
I> D Ch>p l Plc r ~~~O~~~ii~Ifl~glu~re~s~f ~~~~~~0~~~ 
I> D Ch>p 2f~ 
I> D Ct..p 2 PICr I> 
I> D Ct..p 3fie 
I> D Chap 3 PIC! ~ 
I> D Chap 4fii I> 
I> D Chap 4 P!CT I> 
I> DCbp Srii I> 
I> DCbp SP!CT I> 
I> Dcbp 6rii 
I>DCbp6PlCT I> 

¢ L J:!i~! \;i!m~)~I.H ~ 
I> 
I> 

¢ 1 

Size Kind 

D Chap l fig 9)K folder\Q 

D Chap l P!CI ~0 figures f E!]§ 

D Ch ep 2 fig Name Size Kind 
D Ch ap 2P!CI 
D Chap 3 fig I> D Chap 1 fig 93K fo l 0 
D Chap ) PICI I> D Chap 1 PICT 74K fo l 

D Chap 4 fig I> D Cha p 2 f ig I'ISK fol !l:i: 
D Chap 4 PJCT I> D Cha p 2P ICT 11 2K f ol !!,!: 
D Chap 5 fig I> D Chap 3 f ig 683K fo l !i,i: 
D Chap 5 PICT I> D Chap 3 PI CT 336K fo l ,,,, 
D Chap 6 fig I> D Chap 4 fig 273K fol :;,;, 

D Che.o 6PICT I> D Chap 4 PICT 2 12K fo l :i:l 
!l~ ! i!'mJ:i~l~~!iliill I> D Chap s fig 63SK ro t iii~ 

~ ~ ~::: ~ ~ilgCT :~~~ ~: : :1 
I> D Chao 6 PICT 353K fo l 0 

2.6 t1B available 

LJ 
Chap 2 PICT 

Fi gures t 
35.5 MB in di sk 2.6 MB available 

LJ 
LJ Chap 2 fig LJ 

Chap 1 PICT LJ Chap 2 PICT 

LJ Chap 4 fig LJ 
Chap 3 PICT LJ Chap 4 PICT 

LJ Chap 6 fig LJ 
Chap 5 PICT ll Chap 6 PICT 

To switch to either grid, follow these steps: 

1. Double-click the Views control panel. 
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Part II 

2. Click on the Staggered grid option button (or the Straight grid 
option button in System 7). 

3. Close the Views control panel. 

4. Click on the tide bar of the \'Iindow you want to use the new grid 
setting. 

5. Select the Clean Up command from d1e Special menu. 

Unlike d1e font setting, the grid setting does not take effect immediately 
on folders created earlier. You must choose the Clean Up command for 
each window in which you want the setting to apply. The new setting 
applies only to changes made after you choose the grid setting. For 
example, if you create a new folder, the icons align according to the new 
grid setting. 

The Always snap to grid option causes the grid setting you have selected 
to be in effect when you move an icon. Usually, an icon aligns on the 
grid when you perform one of the following tasks: 

• Create a new folder and copy icons to that folder by dragging them 
to the dosed folder icon. 

• Choose the Clean Up command from the Special menu. 

• Hold down the command key while dragging an icon. 

Wid1 the Always snap to grid option turned on, an icon aligns with the 
grid as soon as you release the mouse button. Turn this option on or off 
by clicking in its check box. An X in the box shows that d1e option is on. 

Changing list Views Options 
he list (or text) views have nine options available to control the 
size of the small icons shown in the list view, add infonnation to 
the list, and determine the columns of information displayed. 

Changing leon Size 

The first option involves the three icon size buttons, which control the 
size of the icons to the left of the icon names in the list views. This 
option takes eftect immediately and enables you to see which size is best 
for you. To d1oose a size, click on the button beneath the sample icon in 
d1e Views control panel window. Figure 8.11 shows samples of the three 
settings. 
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Fig. 8.11. 
The effect of the three icon 

size settings. 

m 4J Figures f i 
~ Size Kind . 

!> D Chap I fiQ 93K folder lO 
!> D Chap I PICT iD Flqures t 1:!1" 
!> D Chap 2 fiQ lllim Size Kind 
I> D Chop 2 PICT 

I> CJ IQ I> D Chop 3 fiQ Chop 1 fiQ 93K folder 

I> D Chop 3 PICT I> LJ Chop I PICT 10 Flqures t Em 
!> D Chop 4 f19 I> LJ Chop 2 fiQ ~ Size Kind 
I> D Chop 4 PICT I> LJ Chop 2 PICT 0 
I> D Chop 5 flq I> CJ Chop 3 fiQ I> LJ Chop I fiQ 93K folde 

I> D Chop 5 PICT I> CJ Chop 3 PICT ~· I> D Chop 6 fiQ I> CJ Chop 4 fiQ I> LJ Chop I PICT 74K 
fold• I!.! I> D Chop 6 PICT 

¢ r lv: ~uu ~ ~•wr. !> CJ Chop 4 PICT 

!> CJ Chop 5 fiQ I> LJ Chap 2 fiQ I 45K folde !,ii 
!> CJ Chep 5 PICT II 

I " ......, rh 
< " ' I> LJ Chep 2 PICT 11 2K folcle jJ 

k:> l l l!,; l1"' till HI Jl 
I> LJ Chep 3 ftQ 683K folde j · 

~ 
I¢ U i ii. ft !f' ~l 1! :Uk.Hil!i•liilllrii! I : '·iCH~ '21 .. . . 

The smaller two sizes are probably best. The third is rather unwieldy, 
although the large size gives the advantage of full- sized icons. 

Displaying Folder Size 
One of the most welcome options is the Calculate folder· sizes option. 
Before this option was introduced, users used the Get Info command in 
the File menu to determine the size of a folder. Now, with the new 
option, you can have the folder size displayed in the list (text) views. 

This information is particularly helpful when copying folders to a floppy 
disk because you know whether they will fit in the available space. Also, 
when trying to make room on a full hard disk, you can locate the largest 
space consuming folders. 

To activate this option, click in the check box to the left of Calculate 
folder sizes. The option takes effect immediately, and the sizes of the 
folders in kilobytes are displayed in the Size column of the list view. 

The Mac Classic may slow a bit because the computer calculates folder 
sizes each time you open a fo lder o r disk containing folders. This option 
is slow enough that you actually can see the folder sizes appear as they 
are calculated. 
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Rg. 8.12. 
The Show disk info option. 

Part II 

Displaying Disk Info 

You see that in an icon view, the window tells you how many items 
appear in the window, the amount of total data on the disk, and the 
amount of available space on the disk. You can add this information to 
the header of a list (text) view with the Show d isk info in header o ption. 
Click on the check box to the left of the optio n to activate or turn off the 
option. Figure 8.12 shows a folder window with the Show disk info 
option turned off and a window with the option turned o n. 

1 fig 
(J 1 PICT 
(J Chap 2 fig 
(J Chap 2 PICT 
(J Chap 3 fig 
(J Chap 3 PICT 
(J Chap 4 fig 
(J Chap 4 PICT 

25 items 

Name 

CJ Chap 1 fig 
(J Chap 1 PICT 
(J Chap 2 fig 
(J Chap 2 PICT 

Changing List View Columns 

35.5 MB in disk 

Size Kind 

93K folde r 
74K folder 

145K fol der 
11 2K fol der 
683K fol der 
336K fol der 

The defnult columns used in the list (text) views are Name, Size, Kind , 
Label, and Date (Last modified). Two more also are available: Version 
and Comments. The Versio n o ption adds a column with the application 
program's version number. The Comments option displays the com
ments entered in the Info window (see Chapter 3 concerning the Get 
Info command). 

If you click o n o ne of tl1ese six options on the right , you toggle the 
option, o r switch the option on or off, depending on whether an X 
appears in tl1e check box. 

One column that does not appear on the Views control panel is tl1e 
Name column, which you cannot turn off. You also cannot change the 
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Fig. 8.13. 
A sample list view. 

order in which columns appear. This order is Name, Size, Kind, Label, 
L'lst modified (Date), Version, and Comments. Still, you have consider
able flexibility. A few examples illustrate the point. 

Figure 8.13 shows a folder in list view ordered by Name. ·n1e Show size, 
Show kind, Show version, and Show comments options are checked. 
Figure 8.14 shows the same folder but with the Show kind, Show date, 
and Show comments options selected. 

D MacWrile II Hyphenation 
D Main Dictionary 
D Read Me 

1> 0 Stationery Templates 
I> 0 Tutorial 

D User Dictionary 

application program Release 1 .... 
56K MacWrite II docum ... -

163K document 1 .02 
13K MacWrile II docum ... -
22K folder 

9K folder 
1 K Mal n Di ctionary do ... -

Fig. 8.14. ~l'i~D~~~~~~~~~~:EM~o~c~W~rl~te~ll[i~~~~~~~~~~t!l~~ 
A different configuration. Name Ki nd Lest Modified Comment 

F==~~M~a~cw==ri=te=l=l ========a=p=pl=ic=a\=io=n-p-ro-g-ra=m-T~u~e-,J=u=1=9,=1=9=9=1,=1~7=:1~5==~===M=ac=WT~~ 
D MacWrite II Hyphenation MacWrite II docum ... Fri , Feb 17, 1969, 15:30 
D Main Dictionary document Tue, Jul 16, 1969, 18:00 
D Reed Me MacWrite II docum ... Tue, Oct I 0, 1969, 16:00 

1> 0 Stationery Templates 
I> 0 Tutor ial 

D User Dictionar y 

folder Fri , Mar I 0, 1989, 14:20 
folder Set, Mar 1 I , 1989, 16:42 
Main Dictionary do ... Mon, Jul t 0, 1989, 10:30 

The View menu (see Chapter 3) is altered according to the columns you 
select. The columns you include are added as sort options to the View 
menu. Those you remove from the view also are removed from the 
menu. You then can sort a fo lder or d isk window by any of the six 
columns d1at you include by choosing the Sort option from the View 
menu. (You can refer to the sections "Viewing Folder Contents" in 
Chapter 5 and "The View Menu" in Chapter 3.) 
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Using labels 

1;1 

Part II 

ystem 7 has added the capabHity to label your icons. You may use 
this capability further to organize your icons, search for icons, and 
sort icons. Apple provides seven labels initially: Essential, Hot, In 

Progress, Cook, Personal, Project 1, and Project 2. These may be 
changed to suit your needs. 

Labeling an Icon 
To label an icon, perform the following steps: 

1. Click on the icon to select. 

2. Choose one of the seven labels from the Label menu. 

The labeled icon shows no apparent change in the icon views. In any of 
the text (list) views, the label appears in the Label column if you want 
that column displayed in these views. (See the section "Changing List 
View Options" earlier in this chapter.) 

To remove a label, perform the following steps: 

1. Select the icon by clicking. 

2. Choose None from the Label menu. 

Sorting by Label 
In list (text) view, you can sort icons in order of the labels you have 
assigned d1em by choosing the by Label option in the View menu. You 
also can click the Label column heading in the list view to change the 
sort order. Your icons then are grouped according to the labels assigned 
to them and sorted alphabeticaiJy within label groups (see fig. 8 .15). 

Although the labels do not appear in the two icon views (by Small Icon 
and by Icon) , you may use d1em to sort your icons by performing the 
following steps: 

1. Choose the by Label option from the View menu. 

2. Choose the by Icon (or by Small Icon) option from the View menu. 

3. Press and ho ld the option key. 

4. Choose the Clean Up by Label command from the Special menu. 
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Fig. 8.15. 
Viewing icons by label. 

Fig. 8.16. 
Choosing the label 

search option. 

m Book TeHt t 0~ 
Name Size Kind l abel l ast Modj(jed 

I> I']) Chapters 139K folder Mac Class .. . Thu, Jul 18, 1 ~ 
D PICT notes 2K Microsoft Word do ... Mac Class ... Sun, Jul 7, 19 

I D Prelim Glosser~ 2K Microsoft Word do ... Mac Class ... Sun, Jul 7, 19 

D Print notes 20K Microsoft Word do ... Mac Class ... Sun, Jul 7, 19 
D Cop~righl notice 3K Microsoft Word do ... Project I Sun, J ul 7, I 9 : : 
D Misc. 7K Microsoft Word do ... Project I Sat, J un 22, 1 

li!

1

li 
D Misc. Notes 2K Microsoft Word do ... Project 1 Sat , J un 22, I 
D Outline 12K Microsoft Word do ... Project 1 Sat , Jun 22, I 

D Template 2K Microsoft Word do ... Project 1 Sun, Jul 7, I 9 ''1'1 
D Dediceted 4K Microsoft Word do ... Proj ect 2 Sun, Jul 7, 19 li!!! 
D Introduction 13K Microsoft Word do ... Proj ect 2 Sun, Jul 7, 19 .'! 
D Notes - hide v i ndo"' 3K Microsoft Word do ... Proj ect 2 Sun, Jul 7, 19 4-
D Outline 2 12K Mic ro~uH Word do ... Project 2 Sun J ul 7 19 0 

¢ 1 ;:i!'iil!ii!i!(!"i•-! i!i!i'!:l¢ 121 

The icons are ordered by label, sorted alphabetically within label groups 
left to right, top to bottom. 

Searching by label 
After you have labeled your icons, you may search for icons with a 
particular label. This feature uses the Find command explored in 
Chapter 5. Use the following steps: 

L Choose the Find command from the File menu. 

2. Click the More Choices button to expand the window if necessary. 

3. Choose label from the first menu (see fig. 8.16). 

Find 

Find and sel ect items whose 

./name 
size 
kind 

._I _c_o_n_t_a_in_s ___ ..-__.1 L._ _ _____ _, 

label ~ disks 
date created "" 
date modified 
uersion 
comments 
lo ci< 

D all at once 

Cancel ) n Find )J 
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Fig. 8.17. 
The icons are found. 

Part II 

4. Choose the label you want co search for from extreme right menu, 
which initially reads None. 

5. Click the aU at once optio n. 

6. Choose the search location from the Search menu: on Hard Disk, 
for example. 

7. Click the Find butto n. 

The Mac Classic then searches and selects all icons on the disk 
with the chosen label and displays them in a list view (see 
fig. 8.17). 

0 Hord Disk 

I> 

Name Size Ki nd 
W l.oiiU' 

D ChOS 
• [imm:lm 
D Compatabllty Report 
D Copyright notice 
D Dedicated 
D Int roduction 
D Misc. 
D Misc. Notes 
D Notes - hide window 

UU" 11~ 1 UOU I < YYU I 0 
46K Microsoft Wor rfr 

folder pili 
17K Microsoft Wor ffi 

:::::: 

3K Microsoft Wor mm 
4K Microsoft Wor !'ii!! 

13K Microsoft Wor !1!11! 
7K Microsoft Wor !Jii!: 

~~ ~:~~:::~~ ::~ !!''!, 
D Outli ne 
D Outline 2 

• I@MIU1 : E ~M:l:c~r:o~o~f:t ~w
0

o:~r .1,'.1.,.,1,.,·1 .. ,·, 1,.,.: , .. 

1 

.. a l:mnunr.pgt:JI IJ 2K >J 

• l:mtj1Mt!fi1 20K Microsoft wor !:m: 
D Res considerations 9K Microsoft Wor ~ 
D Template 2K Microsoft Wor 0 

Yo u then can choose the Find command again and set the Search menu 
to the selected items option. This method enables you co search fu rther 
within the icons with the located label. 

If you are working on a project and label each icon accordingly, this use 
o f the Find command can help you locate al l the related icons. You then, 
fo r example, can drag any of the located, selected icons co a disk or 
fo lder to copy them into one place. 
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Changing Available labels 
nitially, the Label menu reads from top to bottom: None, Essen
tial , Hot, In Progress, Cool, Personal, Project 1, and Project 2. You 
can use these labels as described in previous sections or change 

them to bener reflect the work you do. Because you can sort and search 
based on labels, d1ink of labels that will help you group your work. 

Suppose that you regularly create a newsletter. Newsletters are com
posed of text and graphics that may reside in separate documents. You 
may wish to have a Newsletter label that you can apply to the separate 
documents so that you can search for them by using the Find command 
or sort them with the by Label View menu option as described previously 
in this chapter. 

Authors can group separate documents comaining novel chapters with a 
label d1at reflects the novel's title. Otl1er labels might be such items as 
First Draft, Short Story, Submitted, and Revising. Students could use 
labels that reflect courses. Labels such as English 101 and Math 234 
could be used. Alternatively, labels could group by the type of work. 
Essays, Book Reports, Term Papers, and Research Notes are some 
examples. 

You can change any of the labels except None, which is used to remove a 
label as previously described. The other seven labels can be changed to 
suit your needs. The labels must be 31 characters or less and cannot 
contain a colon (:). Attempting to type a colon results in a dash as with 
icon and disk names. 

To change a label, use the following steps: 

1. Open the System Folder by double-clicking. 

2. Open d1e Control Panels folder by double-clicking; you may go 
directly w this folder by choosing Control Panels from d1e Apple 
menu and bypassing step 1. 

3. Open the Labels control panel by double-clicking. The control 
panel window opens. 

4. Select the label you wish to change by double-clicking. 

5. Type the new label (see fig. 8.18). 
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Fig. 8.18. 
Changing the Essential 

label to Newsletter. 

Using Aliases 

Part II 

§0 Labels 

INewsletterl 

IHot ~ 
l1n Progress 

I cool 

I Personal 

!Project 1 

I Project 2 

You may then close the control panel by clicking in the close box, or 
repeat steps 4 and 5 for each label you wish to change. 

If you have previously labeled icons, the icon label will change to reflect 
the new label. In the example shown in the figure, all icons previously 
labeled Essential will now bear the label Newsletter. 

he System 7 introduction of aliasing has addressed an irritating 
problem with the Macintosh. Mter you have accumulated the 
applications you find useful and have stored them neatly in 

folders, you discover that you are repeatedly opening and closing fo lders 
to gain access to them. With aliasing, this nuisance can be solved and 
some new, useful possibilities open up. 

Defining Aliases 
An alias is like a copy of an icon. The entire contents of the icon are not 
copied; only the picture and some info rmation about the icon's location 
are copied. This copy results in a sort of image of the original that is 
smaJI (only about I K) that still operates similarly to the original. 

An alias of an application program, document, folder, or disk can be 
double-clicked as can the original. This method enables you to make 
unlimited cojJies of an icon and place them where you want without 
having to move or fully copy the original. 
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Fig. 8.19. 
The alias is created. 

Think of aliases as icons with maps. When you double-click on one, the 
Mac Classic reads the map, locates the original, and orders the original 
to open. 

Some differences exist between the function of an alias and the original 
icon. When you copy an alias, you do not copy the o riginal; you make 
another alias. lfyou delete an alias, the original is untouched. If you 
change the name of an alias, the name of the original is not affected. 

lf you move an original icon to another disk, the alias cannot find 
the original. You may, however, move d1e original icon anywhere 
on the same disk. 

Although you can make an alias of an alias, this procedure is not 
generally recommended. The map of the second alias leads to the first 
alias, which leads to the original icon. If the middle alias is deleted, the 
second alias cannot find the o riginal icon, even though the original has 
not been touched. 

Creating an Alias 
You can create an alias by following these steps: 

1. Select the icon by clicking. 

2. Choose the Make Alias command from the File menu. 

The alias appears and bears the same name as the original icon and with 
the word alias appended (see fig. 8.19). 

~0 
8 items 

_ ... -., 
!() 
L .... ·-·-

Main Dictionary 

MacWrite II 
36.7MB in disk 1.3 MB availabl e 

Read Me _ ....... , 
10.! 
!.":::::!...! 

User Dictionary 
~:!~U 

MacWri te II Hyphenation 
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Fig. 8.20. 
Alias names appear in 

italics. 

Part II 

The name of an alias always appears in italics except when an alias is 
placed in the Apple Menu Items fo lder. Then the name appears in 
regular fo nt in the Apple menu. Alias names appear in italics even in the 
Open document d ialog box (see fig. 8.20). Documents, Figures, and 
Hard Disk in this figure are aliases. 

I c::J System 7 Di sk ,.. I 
0 DAs 0 c::J System 7 ... 

I 0 Documents 
0 Figures 
0 Games 1 
c::J Hurd Disk 
0 I nit s/Cdeus 

( Desk top ) 

~ ~=~:~':l~er ~ K 
~o __ s~y_s_s_tu_f_f ______________ ~o~ ( 

Selec t ed t ype: 

Formats ... 

Open ll 
Cancel ) 

Dele ting an alias is a simple matter if you follow these steps: 

1. Drag the alias to the Trash. 

2. Choose the Empty Trash command from the Special menu. 

Changing an Alias Name 
You can change the name of an alias to suit you with no effect on the 
o riginal. This feature is great if you use aliases to place items on your 
Apple menu (see Chapter 7). After placing the alias in the Apple Menu 
Items fo lder, you may dele te the word alias fro m its name so that the 
menu listing contains on ly the application name. 

Fo llow these steps to change an alias name: 

1. Select the alias icon by clicking o nce. 
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Fig. 8.21 . 
The Find Original button. 

2. Press the return key. 

These two steps can be replaced by clicking directly on the alias 
name. 

3. Type d1e new name. 

4. Press return. 

Finding the Original of an Alias 
A full or very large hard disk makes it easy to misplace icons. You may 
know the location of an alias but may have forgotten the location of the 
original. The Get Info command can help you. 

To locate the original icon of an alias, perform the following steps: 

1. Click once on the alias to select. 

2. Choose the Get Info command from the File menu. 

A new button, Find Original, appears in the window (see fig. 8.21) . 

3. Click the Find Original button. 

The folder or disk containing the original icon opens. 

K;nd : alias 
Size : 1 K on disk ( 544 by tos usod) 

"'here : Sys tem 7 Disk : Applications : 

Created : Thu, Ju1 1B, 1991 , 12 :36 
Modified : Thu, Ju11B, 1991 , 12 :36 
Originill : Har d Disk : Mac'drito II : Mao'drito 

II 

Comments : 

D locked [ Find Original ) 
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Rg. 8.22. 
An application control 

panel for aliases. 

Part II 

You also can determine the location of the original from the Original 
information line in the window below the Created and Modified lines. 
Disks and folders are separated by a colon (:) in this line. In the figure, 
the original is located on Hard Disk in the folder MacWrite II and is 
named MacWrite II. 

Considering Some Uses of Aliases 
Macintosh users only now have begun exploring the potential uses of -
aliases. You probably can come up with some of your own as you gain 
proficiency with them. Keep in mind that an alias is like a pointer to an 
icon that you may place anywhere you desire. 

The most basic use of aliases is to place application program aliases and 
other icon aliases in the Apple Menu Items folder, as discussed in 
Chapter 7. This method enables you to leave the originals in their folders 
yet gain access to them from the Apple menu. 

Similarly, you can use aliases of the applications and desk accessories 
when placing icons in the Startup Items folder (see Chapter 7). This 
saves you disk space over placing a copy in that folder. 

You can place an alias of your most used application right on the 
desktop to keep the application available always. You then can add 
aliases of the related documents and folders to place them near each 
other and make them readily available. 

One suggested use is to create a·folder called Applications for aliases of 
aU your most used applications. This method creates a kind of "control 
panel" of your own (see fig. 8 .22). Double-clicking any one of the aliases 
causes the application to open. 

-o Applications 0 
4 i tems 11 MBindisk 7.9 MB availa 

~ ' :.-:~ ~ ~ ;%. , 
! ........ . : 

1'/acLin!:Plu.s/PC aliBS /"18C'W'rite llaliBS 

~ ~ 
/"h(:r()S(Jft word 8li8S Super Paint .2. 0 aliBS '0 

¢ 1 1¢ Q] 
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Fig. 8.23. 
The disk is requested. 

One of the most interesting uses of aliases involves the capability to 
make aliases of icons on one disk and place the alias on another. This 
applies to floppy disks, hard disks, and disks that reside on a ftle server 
to which you are connected by a network. When you double-click the 
alias, the System software then searches for and requests the d isk on 
which the original resides. 

One possible use of this can help you to save disk space. If you have a 
hard disk, you eventually will fill it. It seems to be an inevitable rule of 
computing that information grows to fill all available space. 

You may have documents or applications you use infrequently and 
decide to store them on floppy disks. After you move the icons to the 
floppy, you can then make aliases of the icons and store them in a folder 
on your hard disk. This uses far less room than the originals. Then, when 
you double-click one of the icons, d1e Mac Classic prompts you to insert 
the appropriate disk (see fig. 8.23). 

, ....... 
[01[[]1 
t . .. ..: 

Please insert the disk: 

Chap 6 

Cancel 

If you do this, be certain tO label the disk with the name that you gave it 
when you initialized it or the one you later changed it to. The Mac 
Classic will ask for it by disk name, and you will want that name clearly 
written on the disk. 

You may make aliases of floppy disks and store them on your hard disk. 
This is more useful to those connected to a file server (a remote hard 
disk) d1at requires mounting the file server volume through some log-in 
procedure. You can make an alias of the remote volume and then access 
it by double-clicking the alias. 

If you are on a network that uses File Sharing (covered later in this 
chapter and extensively in d1e Apple manuals) , you may actually make an 
alias of your hard disk and store it on a floppy disk. This alias will then 
enable you access to your hard disk from any Macintosh on the network 
that participates in File Sharing. 
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If you habitually group project icons into folders, you can place aliases of 
the applications you use in that project in the folder with the documents. 
Similarly, documents that apply to more than one project are good 
candidates for aliasing. 

Using File Sharing 

Part II 

ill ~ ystem 7 has introduced limited networking to aU users, not just to 
users with special software or dedicated file servers. Hie sharing 
applies only to users whose Mac Classics are hooked up to an 

AppleTalk network containing other Macintoshes running System 7. A 
single user with a Mac Classic at home cannot use me sharing. 

File sharing is useful because it enables networked users to designate 
shared folders. Networked users can then access icons or each other's 
disks without leaving their own machines. Running up and down 
hallways with floppy disks can virtually be eliminated. 

Fully exploring the complicated process of networking exceeds the 
scope of this book. This section mainly gives you an overview. If you 
need the full capabilities of file sharing and networking, refer to the 
manuals that came with your Mac Classic and your System 7 package. 

Also, the program-linking feature is not discussed in this book. Now, no 
applications exist to take advantage of this feature, and the communica
tions protocol required still is being defined. 

Starting and Stopping File Sharing 
Before trying to share files, you must ensure that you are physically 
attached to an active Apple Talk network. Check with your network 
administrator if you are uncertain. 

To start file sharing, double-click the Sharing Setup control panel in the 
Control Panels folder, which is within the System folder. You see the 
controls as shown in figure 8.24. 

Then follow these steps to enable file sharing: 

1. Type your name or the name you want to use on the network. 

2. Press the tab key. 

3. Type a password. Make the password something you remember 
but that others are unlikely to guess. 
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Fig. 8.24. 
The Sharing Serup 

controls. 

§0 Sharing Setup 

LJ File Sharing 
!" .•• status ................................................................................................ ~ 

( Start ) ! File shar ing is off. Click Start to allow other users l 
! to access shared folders . ; 
'····-··············-·········--······················· ...... -.................................................... : 

~ Program Linking 

; .... St<~tus ···································-···························································, 
( Start ) j Program linking is off. Click Start to allow other : 

L~.~~~--~~--~mk .. !.?. .. ~~~--~~-~~-~~--~.:.~.?.~.~~~.: ..... -·········-·--···.i 

4. Press the tab key. 

5. Type a name for your Mac Classic. This name appears on the 
network for other users to see so that they can access your Mac 
Classic's disk. 

6. Click the Start button in the File Sharing section. 

7. Click the close box to dismiss the window. 

To stop file sharing, perform the following steps in the Sharing Setup 
control panel: 

1. Click the Stop button in the File Sharing section. 

You are prompted for a number of minutes to delay before file 
sharing is stopped. 

2. Type a number less than 1000 and press return. 

Or press return. 

If you press return without entering a delay, the file sharing is cur off 
immediately. This can cause problems for a user accessing your shared 
files. You may want to consider a few minutes time to enable that user to 
log off. 
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Fig. 8.25. 
A New User icon is created. 

Part II 

Creating Users and Groups 
You may want to create users and groups to enable others to access the 
folders you want to share. This procedure is not absolutely necessary 
because a default Guest logon exists, but creating users and groups gives 
you greater control over the folders and icons (fiJes) you share. Creating 
a user enables you to define the access of a single individual, but 
creating a group enables you to define that of a group of people. 

To create a user, perform the following steps: 

1. Double-click the Users & Groups control panel in the Control 
Panels folder. 

2. Choose the New User command from the File menu . A New User 
icon is created (see fig. 8.25). 

D Users & Groups E!l 
3 items 11 MB in disk 7.9 MB available 

0 D 
Mark K. Bilbo <Guest> 111&.1 

¢ 1 1¢ 

3. Type a name for the New User icon: the name of the individual 
you are creating a user icon for. 

~ 

~ 
121 

4. Double-click the user icon to open the user window (see fig. 8.26). 

5. Type a password for the user to use when he or she wants to 
access shared folders and icons (files) on your Mac Classic. 

6. Click the window's close box. 

Two options are active in figure 8.26, as indicated by the X in their check 
boxes. By clicking on d1e Allow user to connect check box, you deter
mine whed1er that user can connect to your Mac Classic. An X indicates 
that the user can. ·n1e Allow user to change password option determines 
whether the user can change the password. This box should be left on. 
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F~g. 8.26. 
The user window. 

~0 Shelley 

User P-.ssword : 

U File Shoring 
'~' 

~ A How user to connect 

[81 A How user to change password 

Groups : 

~ Program link:ing 

0 A How user to link t o progr ams 
on this Macintosh 

Define a group of users by performing the following steps: 

1. Double-click the Users & Groups control panel to open. 

2. Choose the New Group command from the File menu . 

3. Type a name for the New Group icon. 

4. Drag the icon of each user that you want to include in the group 
onto the group icon. 

5. Click the close box to dismiss the control panel. 

Sharing Folders 
To share a folder with other users, perform the following steps: 

1. Select the folder by cljcking it once. 

2. Choose the Sharing command from the File menu . 

3. Click the Share this item and its contents option to activate the 
option (see fig. 8.27). 
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Fig. 8.27. 
Sharing a folder. 

Fig. 8.28. 
Choosing the owner 

of d1e folder. 
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Memo Folder 

'a' here : Sy st~m 7 Disk : 

[8] Shar~ this it~m and its cont~nts 

S~e See Make 
Folders Fil~s Changes 

Owner: I Mark K. Bilbo ... I [8] [8] [8] 

User / Group : I <None > ... I [8] [8] [8] 

Ev~ryon~ [8] [8] [8] 

0 Mak~ all curr~ntly ~nclos~d fold~rs lik~ this on~ 

0 Can't be mov~d, renamed or delE.>tE.>d 

4. Choose a user or user group from the User Group pop-up menu 
(see fig. 8.28) . 

D Memo Folder 

LJ 
Yhere: Sy stem 7 Disk : 

[81 Share this item and its contents 

SeE.' See Make 
Folders Files Changes 

Owner: M""'~ ' Ri lhn ... 1:81 1:81 1:81 • <None > 
User /Group: ·············································· 1:81 1:81 1:81 

Que Folks 
1:81 1:81 1:81 The Gang 

.............................................. 
D Make a 11 our Chika s like this one 

0 Can't be mo 
Danna 

E'd 

.Joe ~ 
Kar en 
Mark K. Bilbo 
RosiE' 
Shoo>lley 
Tim 



5. On this menu, set d1e user or user group access privileges. 

The following three options appear to me right of the user or user 
group name: 

See Folders. The user or user group can see the folders stored 
within the shared folder. 

See Files. The user or user group can see the icons (files) stored 
within me folder. 

Make Changes. The user or user group can make changes to the 
folder 's contents. 

An X in the check box makes the privilege active. Click on the 
check box to add or remove d1e X. 

6. Repeat steps 4 and 5 for all users and groups. 

7. Click the Make all currently enclosed folders like mis one option, 
if you want the same options to be applied to any folders wimin 
the selected one. 

8. Click the Can't be moved, renamed or deleted option to protect 
tl1e shared folder. This option is not mandatory but is highly 
suggested. 

9. Click me close box to dismiss the window. 

You may stop a folder from being shared by performing the following 
steps: 

1. Select the folder by clicking it. 

2. Choose the Sharing command from me File menu. 

3. Click d1e Share mis item and its contents check box to deactivate 
the option. 

4. Click the window's close box. 

Monitoring File Sharing 
fyou want to see who is using your sh:u·ed folders, double-click 
the File Sharing Monitor in the Control Panels folder, which is in 
the System folder. You see a window that displays the items you 

have selected for sharing and the users that now are connected to your 
Mac Classic. 
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Chapter Summary 

Part II 

If you want, you can disconnect a user by clicking o nce o n his or her 
name and clicking the Disconnect button. You then have the option of 
entering a time delay before disconnection, or you can press re turn to 
cut the user off im mediately. 

his chapter explored various ways you can configure your Mac 
Classic. The discussion has included the installation, removal, and 
use of CDEVs and !NITs. You learned to use the Views options to 

tailo r your Mac Classic's d isplay of icons. Labeling icons and using aliases 
also has been explored. Finally, basic File Sharing has been in troduced. 

By now you should have a good understanding of the Macintosh system 
and should be ready to consider the capability of the Mac Classic to run 
more than o ne application at the same time, which is d iscussed in 
Chapter 9 . 
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Using 
Multitasking 

MAC 
ClASSIC 
Bl 0 OJ K 

s personal computer power and memory size increase, more and 
more features appear on the microcomputer that were once 
reserved for larger mainframe computers. One of these features is 

the capability of running more than one program at a time. This capabil
ity is called multitasking; the computer performs more than one task at 
a time. 

In the late 1980s, multitasking carne to the Madntosh world in the form 
of the MultiFinder. MultiFinder enhances the Finder part of the System 
Software and enables you to start as many application programs as you 
want, if you have d1e memory to run them all. 

At the same time, MultiFinder enables you to access the desktop at any 
time without quitting the application program in which you are working. 
You can switch freely between running applications (and desk accesso
ries) and even use the Cut, Copy, and Paste commands to move informa
tion between d1e applications. 

With the introduction of System 7, multitasking has come to the Macin
tosh to stay. Rather than using two Finders as System 6 does, System 7 
incorporates the features of the Multil'inder and adds more features in 
the bargain. The section "Working with MultiFinder" addresses 
multitasking in System 6, and "Working with System 7" discusses d1e 
System 7 multitasking environment. 



The only problem you may encounter when using these features is the 
amount of memorr you need. Obviously, if you attempt to run more 
than one application program at a time, you use more memory. In 
general, System 6 users may fmd MultiFinder of limited use on machines 
with less than 2 megabytes of memory. 

System 7 users definitely need 2 or more megabytes of memory. Apple 
recommends at least this much memory before you attempt to use 
System 7, and most users find that 2 megabytes is barely sufficient 
because of the larger size of the System software. 

Fortunately, memory upgrades are relatively inexpensive. If you have 
only 1 or 2 megabytes in your Mac Classic, consider upgrading to the full 
4-megabyte capacity of the machine. Check Chapter 13 for more 
information. 

Working with Multifinder 

Part II 

n System 6, multitasking is accomplished with the MultiFinder 
included with the System software. MultiFinder enhances the 
functioning of the Finder in the System software. The following 

section deals with how to install and use the MultiFinder. 

Installing Multifinder 
If you followed the standard installation procedure discussed in Chap
ter 1, the MultiFinder already is in the System Folder. However, you can 
install MultiFinder, if it is not in the System Folder, by dragging the 
following files into the System l'older on a startup floppy disk or the 
hard disk: 

MultiFinder 

DAHandler 

Backgrounder 

You find these files in the System Folder on the System Startup Disk 
provided by Apple (see fig. 9.1). 
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Fig. 9.1. 
A screen showing the 

Multifinder installation 
process. 

(!2] ~ 
Scrapbook F flt App ltShare 

After the copy procedure is complete, MulriFinder is installed, and you 
are ready to start multitasking. 

Starting Multifinder 
Two ways are available to start MultiFinder. One way enables you ro start 
MultiFinder without restarting the Mac Classic; the other way enables 
you to set MultiFinder to run at startup time. 

'l'o start Mu ltiFinder, take the fo llowing steps: 

1. Open the System Folder by double-clicking d1e folder icon. 

2. Scroll until you see the MultiFinder icon. 

3. Press and hold the command and option keys. 

4. Double-click the MultiFinder icon. 

MultiFinder stares and the MultiFinder icon appears in the far right part 
of the menu bar (see fig. 9.2). This icon appears as a small Macintosh. 
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Rg. 9.2. 
The Multi finder icon 

appears. 

To set Multi Finder to run at startup, perfonn the following steps: 

Rg. 9.3. 
The Set Startup dialog box. 

Part II 
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1. Choose the Set Starrup command from the Special menu. 

2. Click on the MultiFinder option. 

The Start up "Hard Disk" dialog box appears (see fig. 9.3). 

c::::J Start up "Hard Disk" with: 

0~ Finder ®~~~ Multifinder 
.................................................................... ~ ........................................................... .. 

Upon startup, automatically open: 

0 S(~!(H t!~ll I h~ms 

0 Opened Applica tions and DRs 

® Multifinder Only 

( Cancel ) n OK J) 



3. Click the OK button. 

4. Choose the Restart command from the Special menu. 

MultiFinder starts and the icon appears in the menu bar. 

Running Applications with MultiFinder 
After you install and start MultiFinder, you are free to begin multitasking. 
You may notice only a few differences between using MultiFinder and 
the Finder. 

An important difference you may notice is that in MultiFinder, when you 
start an application program or desk accessory, the Finder desktop does 
not disappear. The Finder Desktop may, at times, be covered by the 
windows of an application but can be seen if you move the windows. 
This difference may at first seem confusing but this operational differ
ence is an advantage. 

Starting Applications 
ith MultiFinder running, you no longer need to quit an application 
to start another. Instead, you can stan as many applications as you 
want. Stan applications as usual by double-clicking on the icons. 

To stan an additional application, you may need to move the windows 
of open applications to access the icons. For more information, see the 
following section on switching between applications. 

Because you can start applications only if you have sufficient memory, 
you may run out of memory before you start all the desired applications. 
Two messages may appear when this happens depending on how much 
memory you have left. 

Figure 9. 4 shows one of the two warning messages that you may 
encounter when free memory is low. This warning tells you that the 
available memory is less than the recommended amount tO run the 
application program. However, this message indicates that enough 
memory is available to attempt running the program. If you wish to do 
so, click the OK button. 
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Fig. 9.4. 
The low memory warning 

dialog box. 

Fig. 9.5. 
The dialog box that 

announces an application 
cannot be started. 

Part II 

There is not enough memory to open 
"MacWrite II" (BOOK needed, 6 74K 
auailable). Do you want to open it 
using the auailable memory? 

( Cancel J 

Running an application program with low memory isn't recom
mended. The available memory may not be enough for the 
application program to execute quickly o r with all functions 
available. Some programs crash if the full amount of memory is 
not available. 

Unfortunately, the only way to determine whether the available memory 
is sufficient to run the program is to click the OK button and see 
whether the application functions. Take this step at your own risk. 

The recommended procedure now is to click the Cancel button, quit 
one or more applications to free more memory, and then start the 
application with which you want to work. 

You also may receive the warning in figure 9.5 when starting an applica
tion program. Here, insufficient memory remains to launch, or start, the 
application. You must click the OK button, quit one or more other 
applications, and then try to start the desired application. 

n OK D 

Sorry, I can't launch "MacWrite II " . 
Most likely there is not enough 
memory auailable. 
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Fig. 9.6. 
Examples of icons that 

indicate tl1e foreground 
application. 

To check the available memory and the amount of memo1y an applica
tion program requires, see the section "Checking Available Memory" 
later in this chapter. 

Switching between Applications 

After you start several applications, you may want to switch between 
applications. Occasionally, you also may want to access the Finder 
Desktop. 1\vo ways are available to perform this action. 

You must first understand the icon in the right side of the menu bar. You 
already know that the System software places the image of a Macintosh 
in the menu bar when MultiFinder is started. This icon also changes to 
indicate which application is currently running and is, therefore, the 
foreground task. Only one application at a time is the foreground task; 
all o ther programs are in the background. Figure 9.6 shows you some 
examples of how the menu bar changes when different applications are 
in the foreground. 

• File Edit Font Si ze Style Format Spelling Uiew I} 

• File Edit Uiew Special 5I 

• File Edit Scan Disinfect Protect @ 

• File Edit Options Uiew Draw Transform Font TeH t 'A. 

The four difierent menu bars and icons, from top to bottom, are 
MacWrite 11, the Finder, Disinfectant, and SuperPaint. These icons are 
small versions of the icons on tl1e disk, which are the icons you double
click to start applications. 

Besides telling you which application is in the foreground, this icon 
enables you to switch among applications or to the Finder. To switch, 
click the icon. Each time you click the icon, you bring a d ifferent 
application into the foreground. 

When MultiFinder is running, the Finder, which manages the desktop, is 
treated as an application and can be in the foreground or background. 
You can access the desktop by clicking until the Finder is in tl1e fore
ground, as indicated by the Finger icon in the menu bar. 
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Fig. 9.7. 
Several applications are 

added to the Apple menu 
when MultiFinder is 

running. 

Part II 

You also can switch directly to an applicatio n or to the Finder by 
selecting the application or t11e finder from the Apple menu. When 
MultiFinder is running, the Apple menu lengtl1ens because all running 
applications (foreground and background) are appended to the end of 
me Apple menu (see fig. 9.7) . 

... 
Calculator 
Chooser 
Control Panel 
find File 
Key Caps 
Note Pad 
NumberCrunch 
Puzz le 
Scrapbook 
SmartScrap 'M 
Word finder® • 

~finder 

vi} MacWrite II 

1\. SuperPaint 2.0 

About Multifinder. .. 

You can see in figure 9.7 t11at the MacWrite II application has a check 
mark beside the appended name in me Apple menu. The check mark 
indicates that MacWrite II is the fo reground application. To switch 
anomer application or the Finder to me foreground, select the 
application's name from the Apple menu. 

The About Multi finder co mmand presents you wim a small window that 
shows me version number and author informatio n for MultiFinder. To 
dismiss mis message, click o n the window. 

Anomer way to switch between applications is to click any visible part 
of t11e desired application's window. When MultiFinder is running, me 
windows and icons of me running applications are always on the screen. 
Note that t11e window of the foreground application may be obscured by 
the windows of other applications; you may have to move these win
dows to see other windows or icons. 
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Fig. 9.8. 
A screen showing IWO 

applications and the Finder 
running. 

finder desktop disk 
window 

Mac\'frite II document 
window 

This stacking of application programs can lead to a cluttered screen and 
may be confusing at first. Figure 9.8 shows how the screen appears if the 
applications SuperPaint and MacWrite II are running. 

LJ 
Documtnt F old<r Mise J 

MacWrite II,Version 1.1 
oris"' Help System file (MacWrile® II Hel p disk) i s referred to on 

A'ii-1-41e 14 of t he lnst tJI/tJtifln ond New Feotures Guideos Claris Help. The 
t name is the Clar ts Help System. As explfllned in the t nstt~lla tton 

e, the Cl art s Hel p System fi l e and the MocWrtte II Help file must be 
ailed In the same folder (Ci aris folder or System Fo lder ) to use the 

ri s He I p System. 

In the figure, SuperPa.int is in the foreground and, therefore, the menu 
bar contains SuperPaint commands. Behind the SuperPaint palettes 
(controls) , you can see part of the Hard Disk window. Behind the Hard 
Disk window, you see a MacWrite II document window. 

In this example, you can switch to the Finder by clicking the Hard Disk 
window, or you can switch to Mac\Vrite II by clicking in the Mac Write II 
document window. Depending on the window you click, the program 
associated with the window becomes the foreground application, the 
window is brought forward, and the menu bar changes to reflect the 
foreground application. 

In this example, clicking on the haru uisk window does not enable you 
to see the rest of the desktop-the Trash and disk icons are not visible
because the MacWrite 11 window covers most of the screen and obscures 
d1e desktop. 

To choose an application, take one of the following actions: 

• Click the obscuring window, or use one of the other two methods 
to uncover the application to which the window belongs. Close 
the window. 
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• Move the window by dragging the title bar. 

• Shrink the window by dragging the size box of the window. 

You now can see and use the desktop. If you are unfamiJiar with moving 
and resizing windows, refer to Chapter 3. 

Quitting Applications 
To quit any one applicatio n, choose the Quit command from the 
application's File menu. You aJso can quit all applications by using tl1e 
Shutdown command in t11e Special menu. Perform tl1e following steps: 

1. Switch to me Finder. 

2 . Choose tl1e Shutdown command from the Special menu. 

This procedure has me effect of issuing a Quit command to each 
appHcation before the Mac Classic shuts down. You are prompted to 
save your work in aH applications tl1at have nonsaved documents. 

Checking Available Memory 
You may need to determine how much frec memory is available to see 
whemer you can start another application. You can find me amount of 
free memory by using the About the Finder command in me Apple 
menu, as shown in the following steps: 

1. Switch to me Finder. 

2. From me Apple menu, choose me About the Finder command. 

This procedure displays a window tl1at shows the current memory use 
and available memory (see fig. 9.9). 

In figure 9.9, you can see that currently 1,710K (or 1.710 megabytes) is 
available. You can merefore start any application that runs in tllis 
amount of memory or less. 

Starting an application that requires all available memory is not 
wise because tl1e application may crash, run slowly, or not 
function properly. System software and other applications periodi
cally request additio naJ memory. This problem usually is not 
disastrous. However, you may receive o ut of memory warnings, 
and some commands won't run. 
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Available memory 

You can check the amount of memory an application requires to run by 
using the Get Info command in the File menu. See Chapter 3 for more 
information about this command. When Multifinder is running, Get Info 
doesn't tell you the memory requirements of a running application 
program. This information, however, is contained in the About the 
Finder window; the "Changing Application Program Memory Size" 
section in Chapter 3 also contains more information about this window. 

Adjusting Memory Use 

Other than having more memory installed (see Chapter 13), the follow
ing methods are available for gaining additional working memory: 

• Quit one or more applications or desk accessories. 

• Reduce the memory use of one or more applications. 

• Reduce the size of or tum off the RAM cache. 

The first method is the most obvious and is done by choosing the Quit 
command from the File menu of the application you want to quit. You 
can tell how much memory is freed by using the About the Finder 
command in the Apple menu, which is discussed in the preceding 
section. 

Reduce application memory only if you previously increased the 
memory, discussed in the section "Changing Application Program 
Memory Size" in Chapter 6. Reducing application program memory size 
below the recommended level in the Info window is not a good idea. 
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The section "Using the RAM Cache" in Chapter 7 describes and explains 
how to use the RAM cache. Reducing the amount of memory in (or 
turning off entirely) the RAM cache completely reduces the amount 
of memory required b)' the System software and increases the amount of 
memory available bur at a cost of some speed. 

Using Desk Accessories 
hen MultiFinder is running, desk accessories behave in a different 
way than they do under Finder. This difference is because of the 
DA Handler in the System Folder. 

When you select a desk accessory from the Apple menu and Multi Finder 
is running, the DA Handler starts and opens the desk accessory. AJI open 
desk accessories are grouped under the DA Handler (and you see the DA 
Handler's icon in the menu bar). 

Under MultiFinder, aU desk accessories have a File and Edit menu 
besides any menus specific to the desk accessory. The File menu of the 
DA Handler contains only two commands: 

Close. Closes the front-most (or the active) desk accessory, leaving 
aU other desk accessories open. 

Quit. Quits d1e DA Handler, which effectively closes all open desk 
accessories at one time. 

The Edit menu of the DA Handler has the standard Undo, Cut, Copy, 
Paste, and Clear commands. Most, but not all, desk accessories respond 
to these commands. 

Configuring Multifinder With Set Startup 
When you are using MultiFinder, the Set Startup command can open 
more than one application program at startup and also open frequently 
used desk accessories. 

To use Set Startup, perform the following steps: 

1. Starr each application you want to open at startup by double
clicking the icon of each application. 

2. Choose each desk accessory you want ro open at startup from the 
Apple menu. 

3. Switch to the Finder. 
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Fig. 9.10. 
The Set Startup dialog box. 

4. Choose the Set Startup command from the Special menu. The 
Opened Applications and DA option is already selected (see 
fig. 9.10). 

5. Click the OK button. 

c=J Start up "Hard Disk" with: 

0 ~ Finder ® <$1<$1<$1 Multi finder 

Upon startup, automatically open: 

0 Sei(H h>tl I tf~ms 

® Opened Applications and Dfls 

0 Multifinder Only 

( Cancel ) R OK n 

You can take these steps at any time to change the application programs 
or desk accessories that you want to open at startup. 

You can cancel the opening of the applications and desk accessories at 
startup by choosing the Set Startup command, clicking the MultiFinder 
only option, and clicking the OK button. 

You also can open certain documents at startup and, consequently, the 
corresponding application programs. To open a document at startup, 
perform the following steps: 

1. Select the documents you want to have opened at startup. 

2. From the Special menu, choose the Set Startup command. 

The correct option is chosen for you. 

3 . Click the OK button. 

This comm and also enables you to switch between the Finder and 
MultiFinder. Figure 9.10 shows that the top two options of this dialog 
are Finder and MultiFinder. Click the option you want to start with, and 
then click the OK button. From the Special menu, select the Restart 
command. The Mac Classic restarts and uses the option you chose. 
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ith the advent of System 7, Apple incorporates multitasking 
directly into the System software. The MultiFinder of System 6 no 
longer exists separately, and the System software is permanently 

configured to run mo re than o ne application at a time. 

lf you previously used MultiFinder or if you have read the MultiFinder 
sectio n, a great deal of this material may be familiar. Some significant 
changes were made, however, in application switching and configuring 
for automatic application startup. A new feature also was added that 
enables you to hide application windows and reduce screen clutter. 

Again, memory is a paramo unt concern. Apple recommends that you 
have at least 2 megabytes of memO!)' before attempting to use System 7. 
Experience shows that for truly productive work, you need at least 3 if 
not the full 4 megabytes that the Mac Classic can be expanded to. See 
Chapter 13 for more information about adding memory. 

Because multitasking is built in the System software, System 7 requires 
no special installation beyond using the Apple Installe r, which was 
covered in Chapter 1. 

Running Applications with System 7 
Similar to the Multifinder of System 6, when you start an application in 
System 7, the desktop and windows of otl1er applications do not 
disappear. The windows remain open and available to you. The only 
exception is that when a dialog box, such as the Open or Save dialog 
boxes, are o n the screen, you must respond befo re proceeding. 

Starting Applications 
The main methods of starting (or launching) an application remain t11e 
same in System 7 . The double-d ick still is tl1e most common actio n. 
Refer to the sectio n "Starting and Quitting Application Programs" in 
Chapter 6 for more information. 

To double-dick an application the icon must be visible, so you need to 
switch to the Finder. Switching Applicatio ns is covered in tllC following 
section. 

You can avo id switching to tile Finder befo re you start an application by 
using the Apple menu, which is available at all times. If you install your 
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Fig. 9.11. 
Memory is low warning in 

System 7. 

Fig. 9.12. 
Not enough memory is 

available. 

most-used applications in this menu, you can select from these applica
tions at any time. See the section "Using the Apple Menu Items Folder" 
in Chapter 7 for more information about installing applications in d1e 
Apple menu. 

Because all currently running applications stay in the Mac Classic's 
memory, you may encounter situations where you run low on memory. 
System 7 warns you about this condition (see fig. 9.11) . 

"MacWrite II" prefers BOOK of memory. 
716K is auailable. Do you want to open it 
using the auailable memory? 

( Cancel ) R OK D 

When you encounter a dialog box similar to the one shown in fig-
ure 9.11, you can continue by clicking the OK bunon. The application 
then starts. Running an application with low memory, however, can 
result in slow operation and the inability to use all the application's 
features. 

Clicking Cancel prevents the application from starting and enables you 
to quit other applications or desk accessories to free more memory. 

Sometimes, not enough memory is available to start an application. If 
this situation occurs, System 7 warns you of d1e condition and suggests 
closing windows or quitting applications to free more memory (see 
fig. 9.12). 

There is not enough memory to open 
"Nauigator" (750K needed, 716K 
auailable). Closing windows or quitting 
application programs can mal<e more 
memory auailable. 

( OK D 
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When this dialog box appears, the only course of action is to click the 
OK button and attempt to free more memory. Consult the sections 
"Checking Memory Use" and "Adjusting Memory Use" for information 
about monitoring memory usage. 

Switching Applications 

After starting the desired applications, you can switch among them. The 
application or Finder that is active is considered to be in the foreground. 
Other applications are in the background. Only one application, desk 
accessory, or the Finder may be in the foreground at any time. 

The background applications, however, are still active. Some applica
tions can perform work in the background while you work with another 
application in the foreground. Whether an application can work in the 
background depends on the application's design. Check the documenta
tion supplied with the software to determine whether an application can 
work in the background. 

To switch to another application, which brings another program to the 
foreground, choose its name from the Application Switching menu in 
the right side of the menu bar. This menu appears initially as a small 
Macintosh but changes to the icon of the foreground application when 
you switch applications. 

The Application Switching menu lists aU the applications and desk 
accessories you are running and also the Finder. To switch to any 
application (or to the Finder), select the name from the menu (see 
fig. 9.13). 

Hide Finder 
Hide Others 
Show fiJI 

~ $Scrapbook 
?Alarm Clock 
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Fig. 9.14. 
Overlapping appl.ication 

windows. 

Scrapbook desk 
accessory 

The check mark in the menu indicates the current foreground appHca
tion. When you switch to an application, the menu bar changes to 
contain the application's commands, and any windows belonging to 
the selected application are brought forward. 

As you work with applications and switch among them, often the 
applications' windows overlap. Figure 9.14 shows an example of this 
overlapping. 

Application Switching menu 

SuperPainr palertes I 

P ICT 

Gl enn, Ste. 21 
Cll 9009 

13) 555- 12 1 

MacWritc 11 window 

Clicking on windows provides you with ano ther way of switching 
applications. Click on a visible window and the application to which it 
belongs becomes the fo reground application. 

One change from Systems 6 to 7 is that clicking on the desktop brings 
the Finder to the foreground (in addition to clicking on any desktop 
icon or window). 

If the icon of a running application is visible, double-click the icon to 
bring the application into the background, although the icon is grayed 
and appears unavailable. You also c;tn drag a document icon onto the 
application icon to open rhe document and, at the same time, bring the 
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Hiding other applications. 
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application into the foregro und. Double-clicking a document created by 
a running application aJso opens d1e document and brings me applica
tion to the foreground. Note that d1is may nor work with all applications. 

Finally, if an application or desk accessory is installed in the Apple menu 
(see the section "Using the Apple Menu Items Folder" in Chapter 7), 
choosing a running application from mat menu moves d1e application to 
the foreground. 

Hiding Application Windows 
With a number of applications running, the screen may become Littered 
wim windows. Fortunately, the Application Switching menu p rovides 
commands that help alleviate this clutter. These commands are shown in 
the fo llowing listing: 

Hide (foreground application). The first command in the menu 
changes according to the foreground application. Choosing mis 
option hides d1e windows of the foreground application and 
switches to the next visible applicatio n. 

Hide Others. Hides the windows o f all other applications and me 
Finder. If you use this command, the first Hide command becomes 
unavailable because no od1er applications are visible. 

Show All. Causes me windows of aJl running applications (and me 
Finder Desktop) to become visible. 

Figure 9.15 shows the menu option of hiding all applicatio ns other man 
the foreground o ne. 

~ $Scrapbook 
~ ?Alarm Clock 
@ID Finder 

MacWrite II 
SuperPaint 2.0 
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The first command reads Hide MacWrite II because the MacWrite II 
application is in the fo reground. You also can see that the Application 
Switching menu is represented by the MacWrite 11 icon and that a check 
mark is to the left of the MacWrite II icon in the application list. 

After hiding aU but the foreground application, choosing another 
application from the Application Switching menu causes the new 
program window to appear and remain even after you switch to another 
application. You must choose the Hide Others command again to hide 
the windO\vs of the now-visible application. 

Ouitting Applications 

You may quit the fo reground application by choosing Quit from this 
application 's File menu. Quining one application does not affect the 
other running applications. 

You may quit all running applications at one time by taking the following 
steps: 

1. Choose the Finder from the Application Switching menu. 

2. Select the Shut Down command. 

All applications shut down. Lf you have not saved your work to disk, the 
applications now prompt you to do so. After all applications and desk 
accessories quit, the Mac Classic shuts down. 

Checking Memory Use 

To determine whether you have enough unused memory to run an 
application, choose the About This Macintosh command in the Apple 
menu. The Finder must be in the foreground for this command to 
work. When selected, the About This Macintosh window appears (see 
fig. 9.16). 

The About This Macintosh window shows a listing of each running 
application and the amount of memory used by each application. The 
System software's memory use and the memory use of each running 
desk accessory also are shown. The amount of available memory is 
displayed as the Largest Unused Block. This number determines the 
size of the application that you can start. 
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0 About This Macintosh 0 

~ System Softvare 7.0 . 
Macintos h Classic @ Apple Computer, Inc. 1983-1 991 

T ota 1 Memory : 4 ,096K La rge st Unus ed Block: I 2,1 OOK I 
~ $Scrapbook 20K I 
~ ? Alarm Clock 20K I 
~ Super P aint 2 .0 700K I 

~ System Software 1 ,248K 

To detem1ine how much memory an application uses when open, 
perform the following steps: 

1. Select the application by clicking on the application's icon. 

2. Choose the Get Info command from the File menu. The Info 
window opens (see fig. 9.17). 

~0 MacWr ite II Info 

Mac'w'rite II 

Kind : application program 
S ize: 452K on disk ( 460,839 bytes used) 

'w'here: Hard Disk: Mac'w'rite II : 
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Ve r s i on : Mac'w'rite II 1 .1 v 1 

September 1989 
Comments : 

Mac'w'rite 111 .1v 1, September 1989 
@ 1989 Claris Corpor ation 
All Rights Reserved 
5201 Patrick Henry Drive, Santa Clara , C A 
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<> 
~ 

, .... Memory ···································"'··""···::-.. -1--Minimum memory 
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:. .............................................................. ,_,,,; 

required 
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In the Info box, you can see that, if opened, MacWrite II needs BOOK to 
run, which is shown in the Current size number in the Memory section 
of the window. 

Adjusting Memory Use 

Other than physically installing more memory (see Chapter 13 for more 
information) , only a few methods are available to increase unused 
memory in the Mac Classic. These methods include the following 
actions: 

• Quit one or more applications or desk accessories. 

• Reduce the memory use of one or more applications. 

• Reduce the size of the RAM cache. 

The first method is done in the usual way. Choose the Quit command 
from the File menu of the application you want to quit. Note that you 
can tell how much memory is freed by using the About This Macintosh 
command menu as discussed in the previous section. 

Reducing application memory is recommended only if you previously 
increased memory (see the section "Changing Application Program 
Memory Size" in Chapter 3). Do not reduce application program 
memory size below the recommended level in the Info window. 

The section "Using the RAM Cache" in Chapter 7 describes and explains 
how to use the RAM cache. Reducing the amount of memory in the RAl\1 
cache reduces the amount of memory required by the System software 
and increases the amount of available memory but at the cost of some 
speed. The smallest amount of memory that you can set the RAM cache 
to use is 32K. Apple recommends a 32K RAM cache for each megabyte of 
RAM installed in the Mac Classic. If possible, try to stay with this recom
mendation. 

Using Background Copying 
ne fearure Apple added to the Finder in System 7 is the capability 
of copying icons in the background. If you are copying a large 
number of icons, this feature can enable you to work in open 

applications during the copy process. 

Remember that you cannot start applications while icons are copying. 
Copying icons keeps the Finder busy and unavailable for starting 
applications. 
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To use background icon copying, perform the following steps: 

1. Start the applications in which you want to work. 

2. Switch to the Finder. 

3. Drag the icons to copy to the target destination. 

4. From d1e Application Switching menu, select ilie desired 
application. 

You may work wiili any application oilier than the Finder while copying 
the icons. You may notice a slight slowing in the speed an application 
runs because the Finder is occupied wiili the copy process. 

Configuring with the Startup Items fillder 
In the System Folder of System 7, you see a Startup Items folder. LiteraUy 
every item placed in the folder is opened when ilie Mac Classic starts up. 
Disk icons, folders, applications, and anything else you can open may be 
opened at startup by using this fo lder. 

Dragging every folder, application, document, and me like into the 
Startup Items folder is no t a good idea. Not only will iliese 
elements be out of place, dragging some icons into the folder also 
copies me elements to anomer part of the hard disk and therefore 
uses unnecessary room on d1e disk. 

The best procedure is to use the new Make Alias command in the File 
menu to create an alias of each item you want to open at startup and 
tl1en to place each alias in the Startup Items folder (see ilie section 
"Using Aliases" in Chapter 8). 

To add items to the Startup Items fo lder, perform the following steps: 

1. Select the icon of the application program, desk accessory, folder, 
document, or oilier icon tl1at you want to open at startup. 

2. Choose the Make Alias command from the File menu. The alias is 
created (see fig. 9.18). 

3. Drag ilie alias icon intO the Startup Items folder. 

Repeat these steps until you add aU d1e items you want opened at 
startup. 
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To cancel the opening of an item at startup, perform the following steps: 

1. Open the Startup Items folder. 

2. Drag the alias to the Trash. 

3. Close the Startup Items folder. 

An interesting possibility that arises in System 7 is that you can double
click and play sounds through the speaker. You then can create a startup 
sound by placing a copy of a sound-Dr bener, the sound's alias-in the 
Startup Items folder. 

his chapter covered the capability of the Mac Classic to run more 
than one application program at a time. You learned how System 
6 uses the MultiFinder to accomplish multitasking, and you 

lt:arned that System 7 has multitasking built in. 

Starting and quitting applications and application memory use issues in 
multitasking were discussed. You also learned to configure the System 
software to start multiple applications at startup time. 
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If you read the entire chapter, you now understand the di.ffercnce 
between foreground and background, and you explored how applica
tions may be switched between these two states. 

Finally, you learned to usc the System 7 features of hiding application 
windows and copying icons in the background. 

Multitasking also is covered in the following chapter, where the capabil
ity of certain printer drivers to print in the background is discussed. 
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n the early days of Macintosh, owners got detailed instructions for 
setting up and using a printer. After all, only one printer existed for 
the Macintosh then. Today, because so many printers are on the 

market, no author can anticipate which printer you may own to be able 
to write comprehensive instructions for you. 

Some basics, however, can be covered here. The types of printers and 
how you connect them to the Mac Classic are covered briefly in this 
chapter, but you still must consult your printer manual. This chapter 
explores the installation and use of printer drivers, fonts, and the 
process of background printing available for some printe rs. For informa
tion on printing from within a specific application, refer to Chapter 6. 

You can hook printers to the Mac in three basic ways. You can determine 
which method your printer uses by examining the included cable and 
the instruction manual. 



NOTE: 
When you hook or 

disconnect any 
equipment to the Mac 
Classic, the computer 
should be turned off. 

Part II 

The three hookup methods follow: 

• Serial. The ImageWriter and other low-cost printers, such as the 
StyleWriter, generally use this method. Serial printers include a 
cable that looks similar to the one that connects your keyboard to 
the Mac Classic. 

• SCSI. Many lower-cost laser printers, such as the Personal 
LaserWriter SC, use this method. These printers include a thick 
cable with large, fiat connectors on the ends. 

• AppleTalk. The higher-cost, more advanced laser printers use this 
method. AppleTalk printers, such as the l..aserWriter II NTX, use 
two small boxes and a cable with round connectors on each end to 
run between the boxes. Each box is for the printer and the 
computer. 

Connecting Serial Printers 
hen you set up a serial printer, first plug one end of the cable into 
the printer port on the back of the Mac Classic. A small image of a 
printer is beneath the printer port. The printer has a similar port 

on back where you plug the other end of the cable. 

After you connect the printer, you must choose the appropriate printer 
driver, which is covered later in this chapter. 

Connecting SCSI Printers 
SCSI printers use a thick cable with flat connectors at the ends. This 
cable connects to the Small Computer System Interface (SCSI), through 
which data transfers at high speed. 

Connecting SCSI devices to your Macintosh can become compli
cated. If you do not understand the process, check your Macintosh 
reference manual included with your Mac Classic and the manual 
included with your printer. If all else fails, call your dealer for help. 

If you improperly connect SCSI devices, such as printers, to your 
Mac Classic, you risk harming the computer and the printer. 
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Preparing Your SCSI Printer 
his book cannot fully cover two important steps, termination and 
identification numbers, because of the various ways you can 
conneCl different printers. 

First, be certain that the SCSI bus is properly terminated. If you attach 
only the printer to the SCSI port of your Mac Classic, that device must 
have a terminator. Proper termination is important because it reduces 
the amount of electrical noise in the SCSI connection. 

Many printers and other SCSI devices have internal terminators. If the 
terminator is not internal, which is rare today, you must use the small 
terminaror that comes with the printer. The device looks like a cable 
connector without the cable. 

Check the printer manual to determine how to use the terminator. 
Usually, the terminator attaches to one SCSI port behind the printer, and 
the other SCSI port is used to attach the cable. 

If you attach more than one SCSI device to your Mac Classic, the rules 
grow more complicated. Check the manual of each device to determine 
the termination method, then carefully read your Macintosh reference 
manual, which has a chapter on expanding your system and discusses 
the various SCSI termination schemes. 

You also must worry about the SCSI ID number. Each SCSI device needs 
a unique number to identify itself to the Macintosh. The Mac Classic has 
an SCSI lD number of 7, which is the highest and most important. If 
your Mac Classic has an internal hard disk drive, then that drive has an 
ID number of 0. Neither ID number should be used by any other SCSI 
device attached to your Mac Classic. 

SCSI ID numbers are set in various ways. You may see a small number 
on the back of your printer with a push button nearby. This button may 
be recessed and must be pressed with a pen or other such item. Some 
printers have thumb switches to turn or switches to rotate- sometimes 
with a special tool-instead of a button. 

Most printers and other SCSI devices come preset to an acceptable ID 
number. If your printer is set to any number from 1 to 6 and you have 
no other SCSI device set to the same number, you do not have to worry. 

If the printer is set to 0 or 7 or is set to the same number as another SCSI 
device you have, such as an external hard drive, you must change the ID 
number. Check your printer manual for instructions on how to change 
the number. 
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Attaching the Printer Cable 
he SCSI port on d1e back of the Mac Classic is located toward the 
middle. Its unique trapezoid shape makes the port me only place 
to attach an SCSI cable. 

Some SCSI cables have d ifferent connecto r sizes on eiilier end. Hold the 
cable connector d ose to the port to match d1e port's size. 

Be certain mat you have me cable connector turned to match me 
orientation of the port. Gently push-don 't fo rce-me connector into 
the port. If d1e connector does not go in easily, you may have me 
connector upside down or may be trying to attach me connector to the 
wrong port. 

After you push d1e cable connector aU me way in, turn the two cylindri
cal protrusions on d1e cable connector clockwise with your fingers to 
screw me connector onto the port; some connectors use screws and may 
require a screwdriver. The screws are meant only to hold the cable onto 
the Mac Classic, not to bolt me connector down. 

Usually, you push me oilier end of the cable into a pore behind the 
printer, then use metal fasteners that hold me connector in place. 

Your printer most likely has two SCSI po rts. Either port should work for 
this connection, unless you have attached a terminato r to one. In iliis 
case, attach me cable to the oilier port. Check your printer manual to 
verify d1at d1is procedure is correct for your printer. 

After connecting me printer, choose the appropriate printer driver, 
which is covered later. 

Connecting Apple Talk Printers 
AppleTalk printers, such as me LaserWriter II NTX, use two small boxes 
with short cables attached to iliem (see fig. 10.1). These boxes, called 
AppleTalk or LocalTalk connector boxes, attach to me Mac Classic and 
d1e printer. A cable runs between iliem. 

If you do not have two of these boxes, contact your dealer. You must 
have both boxes and the cable to connect your printer. 

Behind your printer you should find a small, round po rt into which the 
short cord of d1e connector box plugs. Connect one box to this port. 
The other box should be connected to the printer port of your Mac 
Classic. The cable then runs between d1e two boxes (see fig. 10.2). 
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Fig. 1 0.1. 
An Apple Talk 

connector box. 

Fig. 10.2. 
Connecting an 

AppleTalk printer. 
g -..... 

• • 

D I 
I c I - I • 

Figure 10.2 iUustrates the basic idea of the Apple Talk boxes. The ports of 
the printer and the Mac Classic are located on the backs of the machines, 
not on top. 

Each Apple Talk box has two ports that function identically. You can use 
either port to connect the cable between them. 

After connecting the printer, choose the correct printer driver. 

Chapter 10 
Working with Printers and Fonts · 



Using Printer Drivers 

Part II 

fter attaching your printer to the Mac Classic, you must tell the 
System software which printer }'OU are using so that the correct 
printer driver can be selected. This section focuses on whether 

you have the correct printer driver, how to select printer drivers, and 
how to instaiJ printer drivers fo r non-Apple printers. 

Defining Printer Drivers 
When Apple defined the way the Macintosh communicates with printers, 
the company decided to create a standard method to simplify printer 
usage. Although simplify is a relative term, the Macintosh world has 
avoided the massive problem of printer incompatibility that exists in the 
IBM PC world. 

Each printer has a unique piece of software called a printer driver, 
which tells the computer how to communicate with the printer. The 
driver translates the print commands issued by the Mac Classic into 
instructions that contro l o r drive the printer. 

You do not have to worry about how printer drivers work. Instead, be 
certain that you install the correct driver, then select that d river. After 
you finish those steps, you can forget that printer drivers even exist. 

If Apple makes your printer, the Apple fnstt'lller puts the proper driver 
on your startup disk (hard or floppy). However, if you have a printer 
from another company, such as Hewlett-Packard, you must install the 
printer driver before you proceed with this section. See your printer 
manual and a section titled "Installing Other Printer Drivers" later in this 
chapter. 

Using the Chooser 
After installing the printer drivers, you must tell the Mac Classic which 
printer you are using so that the computer can call on ti1e correct primer 
driver. You need to perfo rm this procedure only once unless you have 
more than one printer and switch between ti1em. 

Even if you do not have a printer, you may '1\rish to choose a printer 
driver. You might do this if you are working on a document that will 
later be printed on a Macintosh connected to a printer. Choosing the 
driver fo r the printer on which ti1e document is to be printed ensures 
that the document's formatting conforms to that printer. 
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Fig. 1 0.3. 
The Chooser. 

Before you use a primer for the first time, or if you must switch printers, 
you must choose that printer and its driver through the Chooser desk 
accessory. 

Choosing the Chooser desk accessory from the Apple menu brings the 
item on-screen (see fig. 10.3). In the Chooser, you see icons of the 
printer drivers installed in your System Folder. 

Port or i\pplcTalk selection 

D Chooser 

5. ~ 
AppleTalk 1.. . lmage\Vr iter 

Printer dri\'ers -

~ ::r s 
Laser\Vriter LQ Apple T a 1... 

~ IJ 
LO lmage\'/r ... Personal L<1 ... 

IJ ~ 
Personal L.. . S tyle\1riter 0 

User Name: 

0 Active 
AppleTalk @Inactive 

I 3.6 
I 

ApplcTalk controls 

I 

If you do not see the icon for your printer, you may have more printer 
drivers than the Chooser window can display. Place the mouse pointer 
in the small arrow at the lower right of the Chooser window, and press 
the mouse bunon a few times. If the icon for your printer still does not 
appear, the driver may not be installed. See the section "Installing Other 
Printer Drivers" later in this chapter. 

After you find the icon for your printer's driver, click the icon. One of 
two messages appears here, depending on your printer type. 

Choosing a Serial Printer 
If you choose a serial printer, such as a Style Writer, you receive an 
informative message concerning the Page Setup, as in fig. 10.4 (see 
Chapter 6 for more on Page Setup) . Click the Continue button. 
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Fig. 1 0.4. 
A Page Setup message for a 

serial printer. 

Fig. 10.5. 
The printer port selection 

buttons appear. 

Part II 

Be sure to choose Page Setup and 
confirm the settings so that the 
application can format documents 
correctly for the StyleWriter. 

n Continue J) 

You then see the printer port selection buttons in d1e Chooser. One 
appears with a printer icon; the other appears with a telephone icon 
(see fig. 105). 

~ 
Apple Talk 1... Image Writer 

<2]~ 
:::J[ ::r. 

Laser\'/riter LQ AppleTal... 

~ g 
LQ lmage\\'r ... Persona 1 La ... 

Personal L. .. 

Chooser 

Select a printer port: 

User Name: 

AppleTal k 
0 Acti ve 
@ Inacti ve 

3.6 

Click the icon that represents d1e port on the back of the Mac Classic 
to which you connected your printer; usually, this is the printer pore 
represented by the small printer icon. Then dick the close box to 

dismiss the Chooser. Your printer is ready to be used. 

Putting the Mac Classic To Work 



Fig. 1 0.6. 
A Page Setup message for 

an SCSI printer. 

Fig. 10.7. 
Verifying AppleTalk 

connection. 

Choosing an SCSI Printer 
If you choose a SCSI printer, such as a Personal LaserWriter SC, you 
receive an informative message concerning Page Setup (see fig. 10.6) . 
Page Setup is discussed further in Chapter 6 . Click the Continue button, 
then close the Chooser by clicking its close box. Now you are finished. 

Be sure to choose Page Setup and 
confirm the settings so that the 
application can for mat documents 
correctly for the Personal 
laserWriter SC. 

n Continue J 

Choosing an Apple Talk Printer 
Selecting a l.aserWriter, such as the LaserWriter II NTX, or other 
AppleTalk printer results in a message concerning activating AppleTalk 
(see fig. 10.7). Click the OK button to activate AppleTalk and dismiss the 
dialog box. You then see an informative message concerning the Page 
Setup (see fig. 10.8). 

l aserWriter requires AppleTal k. 
Please make sure that you are 
connected to an AppleTalk 
network. 

K OK ll [ Cancel J 
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Fig. 10.8. 
The Page Setup message 

for AppleTalk printers. 

Part II 

Be sure to choose Page Setup and 
confirm the settings so that the 
application can format documents 
correctly for the laserWriter. 

n Continue D 

More information on Page Setup can be found in Chapter 6. Click the 
Continue button, then close the Chooser by clicking in the close box. 
Your printer is ready for use. 

Installing Other Printer Drivers 
fyour printer is not an Apple Computer printer, the Apple 
Installer program has not installed the printer driver. Also, if you 
followed a different installation procedure than the one outlined 

in this book, the driver for your Apple printer may not be installed. 

First, you must locate the disk that contains your printer driver. In the 
case of Apple printers, this now is the System Additions disk (or the 
Printing disk in System 7). For non-Apple printers, consult the manual to 
determine the exact disk. 

The example given is for Apple printers, but the same basic steps are 
followed for other printers. Your printer manual contains more informa
tion. Follow these steps: 

1. Inserc the System Additions disk or other disk containing the 
printer driver. 

Floppy-disk drive users first must eject the Startup disk by holding 
down the shift and command keys, then pressing the 1 key. 

2. Double-click the disk icon to open. 

You should see the printer driver icon or a folder related to 
printing (see fig. 10.9) . 
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Fig. 10.9. 
The System Additions 

disk window. 

Fig. 10.10. 
Sample printer 

driver icons. 

LJ LJ 
Applt Flit Exchango Foldor Font /DA Movor Foldor 

LJ LJ 
MacroMaltfr FolMr Printing Fold•r 

LJ 
Applt Color 

ClosoVItv 

3. Double-click the Printing Folder. 

You then see d1e printer driver icons (see fig. 10.10). 

Printin Folder 
I ,274K in disk 

A 
AppleTalk lmageWriter lmago\t'r lltr LO ApploTalk lmago'o'rllfr 

Lutr 'w'rittr l anr Prtp 

~ 
Personal Laser'r'riter SC Pr iniMonilor 
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Fig. 10.11. 
System 7 printer drivers 

belong in the 
Extensions folder. 

Using Fonts 

Part II 

If you use a non-Apple disk, you may not have to perform the last 
step. Your disk may contain the driver for your printer but no 
folders. Figure 10.10 should have an icon similar to the figures on 
your disk. Usually the printer driver icon is named after your 
printer and looks something like the printer. 

4. Drag the printer driver icon to the System Folder. 

System 7 users receive a message like the one in figure 10.11. 

EHtensions need to be stored in the 
EHtensions folder in order to be auailable 
to the Macintosh. Put "laserWriter" into 
the EHtensions folder? 

( Cancel ) ( OK » 

5. Click the OK button to continue. 

You then can eject the disk containing the printer drivers. Then you 
must choose the printer driver with the Chooser, as discussed in the 
preceding section. 

ants, an integral part of computer printing, are at once wonderful 
inventions and the terror of the Macintosh world. They are 
wonderful because of the beauty of type they enable you to have. 

Fonts also are terrors because they are probably the most complicated 
part of the Macintosh. 

Don't let the complexity deter you. Although a full explanation of fonts 
and typefaces is beyond the scope of this book, you should gain enough 
of a basic understanding to enable you to experiment with fonts on your 
own. Your best understanding of how to use fonts comes from such 
e..xperimentation. 
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Defining Fonts 
A font basically is defined as a collection of all characters of any given 
typeface and size. A typeface is a design style of characters- letters, 
numbers, symbols-independent of size or style attributes, such as bold 
or italics. 

You are more familiar with fonts than you think. When you read a 
newspaper or a book, you probably notice that the letters are not the 
same from one to the ne"··t. Publication editors choose a typeface that 
suits the style and look they want to achieve. They d1en can choose a 
font from that typeface that is a particular size or has a particular 
attribute, such as bold or italics. 

With the Mac Classic, as other Macintosh computers, you too can have a 
set of fonts from different typefaces that you may use to produce 
documents. Several fonts come with your Mac Classic and are installed 
by d1e Apple Installer program; see Chapter 1 for more information on 
the Installer and Chapter 11 for information on fonts included with your 
Mac Classic. 

You must understand two kinds of fonts if you use System 6 and an 
additional one that has been introduced wid1 System 7. These are screen 
fonts, printer fonts, and the TrueType font. 

The screen fon t, also called a bit-mapped font, handles the characters on 
your Mac Classic screen. When you type, the Mac Classic consults the 
currently selected font and uses that font's character set to draw each 
letter, number, or symbol. You install these fonts in your system with the 
Font/DA Mover program, which also is used to install desk accessories. 

The printer font is used for the characters on a printer, usually a laser 
printer. Dot-matrix and inkjet printers use screen fonts, unless you have 
a utility, such as the Adobe Type Manager or System T s TrueType fonts. 
This category includes the famous PostScript font, which has been and 
may well continue to be the standard high quality font in the Macintosh 
world. 

Apple and Microsoft jo intly developed the True Type font to address one 
problem discussed here. The difference beL ween the screen font and 
printer font can lead to problems in document design. What you see 
on-screen is not necessarily what you print. TrueType eliminates the use 
of separate screen and printer fonts. 

Fonts are measured in points; one point is approximately 1/72 of an 
inch. The New York typeface in 12-point size, for example, measures 
about 1/6 of an inch taU. 
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Part II 

Font point sizes in the Macintosh world are not exact by typogra
pher standards. If you create documents you intend to take to a 
service fo r printing, you may want to take samples and consult the 
service to determine how your documents will appear when 
printed. 

Choosing Fonts 
Whether you need only screen fonts or can use PostScript printer fonts 
and True Type fonts depends on the type of printer and system software 
you have. You must consult your printer's manual for more info rmation. 

Earlier, this chapter classifies printers according to their method of 
hooking up to the Mac Classic. Now, they must be divided again but 
along the lines of their printing method. The two categories are not 
necessarily related. The method used to hook up a printer is determined 
by the way it communicates with the Macintosh. The printing method is 
determined by the way the printer creates characters and graphics on 
paper. The Macintosh world enables the four following basic printing 
methods: 

• Dot-matrix. Printing is accomplished by placing small dots on the 
page that correspond to the dots on the Mac Classic's screen. The 
LQ ImageWriter is one such printer . 

• Quick.Draw. This printing method uses the Macintosh screen 
drawing routines collectively called QuickDraw to print. Printers 
using this method, such as the Personal LaserWriter SC, may or 
may not be laser printers. 

• PostScript. This method uses the PostScript language to describe 
a font to the printer, telling which font to use and how to d raw the 
font on the page. Usually laser printers, such as the LaserWriter 11 
NT and NTX, fall in this category. 

• TrueType. Printers using this method use the TrueType fon t 
information to draw the font's characters. The StyleWriter and 
Personal LaserWriter LS are examples of such printers. 

Fonts on Dot-Matrix and OuickDraw Printers 
Dot-matrix (includ ing inkjet) and QuickDraw printers use screen fonts. 
The exception to this rule is when you have the Adobe Type Manager 
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(see Chapter 11), which uses PostScript fonts for printing on these 
printers. 

If you have a dot-matrLx or Quick.Draw printer, make sure you have all of 
the font sizes you want ro use installed in your system. Lf, for example, 
you have only 12-point Helvetica installed and try to print Helvetica in 
18-point size, the Mac Classic tries to enlarge the 12-point size, which 
results in jagged letters. 

Quick.Draw printers also need font sizes four times the desired print size 
installed. To print 12-point Helvetica, you need 48-point Helvetica 
installed. Installing fonts is discussed later in this chapter. Chapter 11 
discusses fonts included with and available for the Mac Classic. 

PostScript Fonts on PostScript Printers 
ostScript printers usually have built-in fonts, which generally are 
the fastest and best looking fonts to use on documents. Check 
your printer manual to determine which, if any, fonts are built into 

your printer. You can use other types of fonrs, however, with PostScript 
printers. 

Fonts can be added to your printer's memory by a process called 
downloading. Check your printer manual to see ·whether this option is 
available to you. 

\XIhen you issue the Print command to a PostScript printer, the printer 
driver asks the printer whether the fonts used in your document are 
available in the printer's memory. If they are, as the built-in fonts always 
are, printing proceeds. 

If you have used a screen font in your document and no corresponding 
printer font is in the printer's memory, the printer driver then searches 
for a corresponding printer font in your System Folder (or Extensions 
folder). If one is found, the font is downloaded (sent) ro the printer, and 
printing proceeds. 

If a printer font is not present, the printer driver may try to substitute a 
built-in font for the one in your document. Times is substituted for New 
York, Helvetica for Geneva, and Courier for Monaco. This substitute may 
have unexpected results and you can usually change this option. (See 
Chapter 6 for an example.) 

Finally, if all else fails, the screen version of the font is sent to the 
printer, generally resulting in the lowest quali ty of printing. 
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Part II 

PostScript and True Type Fonts on PostScript Printers 
PostScript printers use PostScript or True Type printer fonts (if you have 
both). The application program used to print your document decides 
whether to print with the PostScript version of a font or the True Type 
version. If you have, for example, a Helvetica PostScript printer font and 
a Helvetica TrueType font installed, the application chooses which to use 
in printing. Check your application manual to determjne how the 
application works. 

If you use PostScript fonts, be sure to have screen and printer versions 
installed . You may use TrueType fonts with these primers and then only 
have to worry about installing the single font. However, a different 
problem can occur . Some older PostScript laser printers have insufficient 
memory to print TrueType fonts at their best. Check your printer manual 
for more information, or consult your dealer. 

Also, generally you need System 7 to use True Type fonts. Apple is 
expected to provide an !NIT so that you can use True Type fonts in 
System 6. Check with your dealer to determine whether this INIT is 
available to you. 

For the best font results, follow these rules: 

• Install the screen and print~r v~rsions of .PostScript fonts to use for 
your documents. 

• Install the screen version of the fonts built into your printer to use. 

• Install and use True Type fonts, if they are available to you. 

Fonts on True Type Printers 
When using a True'I'ype printer, you achieve your best printing by using 
TrueType fonts. For other fonts, the screen versions are sent to the 
printer and may result in less than desirable quality. PostScript fonts may 
be used with these printers if you have the Adobe Type Manager (see 
chapter 11). If you have ATM, you should install the screen and printer 
version of each font. 

All System 7 users can use TrueType fonts (installed by the Apple 
Installer program). System 6 users must check with their dealer to 
determine whether they want to use TrueType. 
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Fig. 10.12. 
Sample printer and 

screen fonts. 

Installing and Removing Fonts in System 6 
The two types of fonts used in System 6 are the screen font and the 
printer font. Usually, the printer font is PostScript but not always. The 
same installation procedures, however, apply. 

Screen and printer fonts have different icons to help you identify them. 
Figure 10.12 shows a sample of printer and screen fonts. 

§0 Garamond Font 
6 items 

Garamlig GaramBol Gar amBollta Garamliglta 

rAJ) rAJ) 
Gar amond Plain Gar amond Other 

Printer font icons may vary a bit in appearanu:: but generally use the 
stylized A. Screen fonts generally appear as suitcases (like desk accesso
ries do) with the letter A on them. The font shown is the Garamond 
fam ily by Adobe, which is an excellent font used by many book 
publishers. 

Installing and Removing Screen Fonts 
To install and remove screen fonts, you must copy the Font/DA Mover 
Folder from your System Additions disk to your hard or floppy startup 
disk. 

Installing a screen font requires the following steps: 

1. Double-dick the Font/DA Mover icon to start the program. 

The Font/DA Mover window appears (see fig. 10.13) . 
On the left side, the scrolling list shows the names and sizes of 
fonts installed in the system. The Font/DA Mover program opens 
the system and selects the Font option. 
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Rg. 10.13. 
The Font/DA Mover 

window. 

Part II 
Putting the Mac Classic To Work 

@Font 
0 Desk Accessory 

Chicago 12 
Courier 9 
Courier 10 
Courier 12 
Geneua 9 
Geneua 10 
Geneua 12 

System 
on Hard Disk 
4026K free 

[ Close ] 

Help 

Quit 

Mouer 

2. Click the Open button on the right side. 

Open ... 

You see the standard Open dialog box, which enables you to 
switch and eject disks and open icons. 

Q 

3. Double-click the name of the font suitcase icon containing the 
screen fonr(s) you want to install. 

The right window fills with the fonts contained in the font suitcase 
icon you open (see fig. 10.14). 

The name of the font suitcase is displayed beneath the window to 
help you tell whjch window displays which fonts. 

4. Click the font you want to install in the system. 

The Copy button becomes avaHable, and arrows appear to indicate 
the direction the font is copied. 

5. Click the Copy button. 

If you use the MultiFinder utility program, you receive a notice 
that installed fonts may nor appear in application menus until you 
restart your Macintosh. Click OK in this dialog box. 



Fig. 10.14. 
The Garamond plain fonts. 

6. Click the Quit button. 

Or repeat steps 4 and 5. 

@ Font 
0 Desk Access o r y 

Chicago 12 
Ge n e ua 9 
Ge n e ua I 0 
Ge n e ua 12 
Geneua 14 
Helue ti c a 9 
Heluetlc a I o 

Sys t e m 
on Hard Di sk 
3867K fre e 

( Close 

~ 

II 

,I 

l~ elp 

Quit 

Mouer 

Gara mond 9 
Garamond I o 
Garamond II 
Garamond 1 2 
Garamond 14 
Garamond 18 
Garamond 2 4 

Garamond Pla in 
on Ha rd Olsk 
3867K free 

Close 

Q 

You can move more than o ne fonr at once from within the fo nt suitcase 
by shift-clicking the o nes you want to move: ho ld down the shift key and 
click on each font you want copied into your system. Clicking the copy 
button then moves all the selected fonts a t o nce. 

Fonts canno t be removed from the System while you run MultiFinder. 
You must choose the Finder o ption in the Set Startup command o f the 
Special menu, then choose Restart before trying to remove fonts. Fo nts 
are removed by using the following steps: 

I. Click o n the font in the left window, the window above the word 
System. 

2. Click the Remove butto n. 

The Font/DA Mover asks whether you are certain you want to 
remove the font. 

3. Click the OK button. 

Then you may proceed to remove o ther fonts or install fonts as you 
want. You may use shift-clicking to select more than one font to be 
removed. \Vhen you are finished , click d1e Quit button. 

Chicago 12, Geneva 9 , Geneva 12, and Monaco 9 cannot be removed 
from d1e system. The system uses d1ese fo nts to create the desktop 
display. Fo nt/DA Mover does not remove them even if you select them. 
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TIP: 
PostScript printer fonts 

reportedly don't work if 
stored in the Extensions 
folder. If you encounter 

trouble, try dragging 
the fonts out ofthe 

Extensions folder and 
leaving them in the 

System Folder. 

Part II 

Installing and Removing Printer Fonts 
The process of Installing and removing printer fonts is much easier than 
installing and removing screen fonts. To install printer fonts, drag the 
printer font icon(s) from the disk supplied by the font manufacturer to 
the System Folder. 

To remove printer fonts, follow these steps: 

1. Double-click the System Folder. 

2. Drag the printer font icon(s) out of the folder to the Trash or to 
another part of your disk, such as a folder. 

A PostScript printer font instead can be installed in the memory of many 
laser printers or other PostScript printers. PostScript font installation, 
done by a process called downloading, Is covered later in this chapter. 

Installing and Removing Fonts in System 7 
Installing fonts has become easier in System 7 than in earlier versions. 
The Font/DA Mover program has been eliminated, and font installation 
and removal, regardless of the font's type, has been reduced to a few 
simple steps. 

The font icons in System 7 have changed slightly (see fig. 10.15). You can 
instal.l screen fonts stored in the older suitcase icon with the following 
installation steps. Remember, however, that the system changes the icon 
into the System 7 version for the screen font and separates the fonts out 
into individual icons. You don' t see this change unless you open the 
System icon in the System Folder. 

The rules for which types of fonts you install are the same. If you use 
PostScript, you must install both the screen and printer font. To use a 
TrueType font or a regular screen font, install the desired font. 

Nothing otl1er tl1an the Finder can run while you make changes to the 
system. You must quit any running applications and desk accessories 
before trying to install or remove screen and TrueType fonts. This does 
not apply, however, to installing PostScript printer fonts. Follow these 
steps to install a font: 

1. Drag the font to the closed System Folder so that the system can 
decide where to locate the font. 

The system copies Screen and TrueType fonts into the System icon 
and copies PostScript fonts into the Extensions folder. \'<'hen you 
drag a font to the System Folder, you are notified of this copying 
process. 
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Rg. 10.15. 
The font icons in System 7. 

2. Click the OK button in the message dialog box. 

PostScript printer 
font 

Bit·mapped screen 
font in System 6 

PostScript screen font 
or bit-mapped screen 

fonr in System 7 

Truel'ype fom 

Garamlig 

G1JJ 
Garamond Plain 

~ 
Courier 9 

~ 
Geneva 

To remove a screen font or TrueType font, follow these steps: 

1. Double·click the System Folder to open. 

2. Double·click the System icon to open. 

The icon may mke a moment to open. The System icon acts like a 
folder. You can change the View option if you want to whatever 
setting helps you identify the fonts you want to remove. 

3. Drag the font icon out of the system. 

Drag the icon to another part of your disk or to the Trash. 

To remove a PostScript printer font, follow these steps: 

1. Double-click the System Folder to open. 

2. Double-click the Extensions folder to open. 

3. Drag the font icon to another part of the disk. 

Previewing Fonts in System 7 
System 7 enables you to preview a screen or TrueType font. For a 
preview, double-click on the font's icon. Figure 10.16 shows the result· 
ing window for two fonts. At left is the Geneva True Type font; at right is 
the Geneva 14 screen font. 

Chapter 10 
Working with Printers and Fonts 



Fig. 10.16. 
Previewing foms. 
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You cannot preview PostScript printer fonts this way because they apply 
only to printers and cannot display o n-screen. 

Using Background Printing 

Part II 

ackground printing refers to the capability of a printer driver to 
store a document being printed in a disk ftle. The ftle is then sent 
to your printer as quickly as it can process the information. The 

advantage of this approach is that you can continue to do work while a 
document is being printed. 

Background printing can o nly be clone with MultiFinder in System 6 or 
with System 7. Even then, only certain printer drivers are capable o f 
working with background printing. 

You can determine whether your printer driver can use background 
printing by performing the following steps: 

1. Choose the Chooser desk accessory from the Apple menu. 

2. Click your printer's driver. 

If background printing is avai lable to you, the Background Printing 
option appears in the Chooser window (see fig. 10.17). 

3. Usually, the option will appear already activated. If you need, 
however, to turn it o n, click the On button. 
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Fig. 10.17. 
The Background Printing 

option. 
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LO lmage\\'r ... Personal La ... User Name: 

IJ ~ 
~ AppleTal k 
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Personal L. .. Sty le\\'riter 0 Inactive 
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Then you may close the Chooser window by clicking its close box. 

With the Background Printing option on, you will notice that the dialog 
box that informs you that printing is in progress will disappear quickly, 
even before printing is completed. This is because the document has 
been stored or spooled to the disk. You can continue to do work, 
although the document has not yet completed printing. 

While the document is printing, you will notice that a new program has 
started. You will find that PrintMonitor has been added to your Apple 
menu or the Application Menu in System 7 (see fig. 10.18). When 
you choose PrintMonitor from the menu, its window will appear (see 
fig. 10.19). 

The PrintMonitor window has the following sections: 

Printing. Lists the name of the currently printing document and 
the name of the printer on which it is being printed. 

Waiting. A scrolling list of documents waiting to be printed. 

Printing Status. Displays the print status of the current 
document. 

The window has the following two control bunons: 

Cancel Printing. Causes the printing of the current document to 
cease. 
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Rg. 10.18. 
PrintMonitor has been 

added to the Apple menu. 

Rg. 10.19. 
The PrintMonitor window. 

Part II 

Set Print Time. Opens a dialog that enables you to set a time for 
the document to print. 

When you click the Set Print Time button, a dialog box appears (see 
fig. 10.20). 

Current document 

..... 
Chooser 
Contro l Panel 
Find File 
Key Caps 
Note Pad 
NumllerCrunch 
Scrapbook 
SmartScrap '"' 
Word Finder® • 

5I Finder 

About MuiiiFinder ... 

Set Print Time ... 

Current 
printer 

Current 
~~~·~=~~~~~~~~-----------------i documcnt 

print 
status 
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Fig. 10.20. 
The Set Prim Time Set Print Time: 

dialog box. 1r--;-~~-==t-----,-.--,-~ T 
! (i) I 16:2 1 :59 ime to print 

Set .print ti~ ~ L__!!:B/~1!./~9.!..:1 =:1--' --~[;C;a;n;ce;I;J~~~ 

NOTE: 
You can type the time 

for minutes and 
seconds. The hours 

must be set with the up 
and down arrows. 

opt1on ~ Date to print 

Hold printing- --0 Pos tpone Indefinitely [ OK J) 

To set a time for the document to print, perfo rm the following steps: 

1. Click the Set Print Time option button. 

2. Click on the time (hour, minute, or second). Two small arrows 
appear. 

3. Click the up or down arrow to increase o r decrease the time. 

4. Click on the date (month, day, or year) if you want to change the 
date. 

5. Type the new month, day, or year when you wish the document to 
print. 

6 . Click the OK button. 

You can hold a print job indefinitely by performing the following steps: 

1. Click the Postpone Indefinitely button. 

2. Click the OK button. 

When you decide to print the held job, perform the following steps: 

1. Choose PrintMonitor from the Apple menu (or Applications menu 
in System 7). 

2. Click the Set Print Time button. 

3. Click the Set Prim Time option butcon. 

4. Set d1e desired print time if you choose. 

5. Click the OK button. 

The PrintMonitor has some options you may wish to set. These are 
accessed by choosing the Preferences command from the File menu. The 
Preferences dialog box then appears (see fig. 10.21). 

The PrintMonitor Preferences options include the following: 
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Rg. 10.21. 
The PrintMoniror 

Preferences dialog box. 

Show PrintMonitor's window when printing. lf the Yes button 
of this option is clicked, PrintMonitor's window appears as 
printing occurs. If No is clicked, PrintMonitor appears in the menu 
as described but its window does not show unless you choose it. 

When a printing error needs to be reported . When a printing 
error occurs, PrintMonitor can notify you in one of three ways: by 
putting a diamond in the place of the apple in t11e Apple menu, by 
displaying the printer icon shown, or by doing me above and 
displaying an alert dialog box. Click the option you wish to use. 

When a manual feed job starts. Some jobs reCJuire that paper be 
fed into the printer by hand. If tl1is is necessary, PrintMonitor wiU 
take one of the following actions: not notify you, notify you with 
me printer icon, or display an alert in addition to the printer icon. 
Make your d1oice by clicking the button next to the option. 

\X'hen t11e options are set, click the OK button. Click Cancel if you wish 
to close the dialog box without saving any changes you have made. 

Pref erences ... 

Show PrlntMonltor's window when printing: 
@No 0 Ves 

Display window option When a printing error needs to be reported: 

• 0 Only display • In * menu 
Error reporting options 

Manual feed reponing option 

~ • 0 Al so display icon in menu bar 

[Q] ~ • ® Al so display alert 

When a manual feed job starts: 

0 No notification Is gluen 

~ • 0 Display i con in menu bar 

[g ~ • ® Also display a lert 

( Cancel } I?'[ ""'o"""K~D 

Chapter Summary 

Part II 

n mis chapter, you have seen various aspects of printing. This 
chapter discussed hooking up printers and instaiUng and using 
printer drivers. Background printing has also been explored . 

This chapter has given you a basic introduction to using fonts on the Mac 
Classic. You have learned about the different kinds of fonts: screen, 
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PostScript printer, and TrueType. Installing and removing fonts has been 
covered as has determining which kinds of fonts you will need. 

Only the basics of printing have been covered. You still need to do some 
experimenting to gain more understanding of fonts and their use. If you 
need to do much work with fonts, you should consider seeking more 
information about them in your Apple manuals and from o ther books 
that focus on desktop publishing. 
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Selecting S st m 
Software 

his chapter provides a brief overview of the software available to 
you for enhancing your Mac Classic System software. This category 
includes some items that might not be considered strictly System 

software but that are closely related to the basic functioning of the 
computer. Chapter 12 covers application software, such as word 
processors and financial managers. 

The introduction of the new System 7 leaves many users with the 
question of which System software to use. This issue is discussed in this 
chapter, but ultimately you must make the decision based on your 
computing needs. Appendix A, "System 7 Issues," also can help you in 
making this decision. 

Defining System Software 

MAC 
CLASSIC 
B 0 0 K 

System software consists of the items that instruct the Mac Classic in its 
basic functioning. Your System software controls drawing the icons, 
responding to clicks of the mouse, copying icons, and mounting disks. 
You can consider the System software as the housekeeper of your Mac 
Classic. 



The System software consists mainly of the Finder and System but also 
includes printer drivers, lNITs (System Extensions in System 7), desk 
accessories, and o ther software items that are involved in "housekeep
ing" functions. 

When you use the Apple Installer program (see Chapter 1) , the basic, 
necessary System software is installed on your disk. Many other System
related items, however, are provided by Apple or are available from 
other sources. 

For the purposes of this chapter, System software options are defined as 
software that is optio nal but enhances the basic operation of your Mac 
Classic. Such programs offering file- (icon) and disk-management, disk 
backup and recovery, font choices, and font and desk accessory utilities 
are included in this chapter's discussion. 

Comparing System 6 to System 7 
he System 6 package is an excellent choice between the two 
systems. Most of this book is dedicated to exploring how System 6 
works. Many Mac Classic users may elect to remain with System 6 

fo r the following reasons: 
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• System 6 is faster on the Mac Classic. 

System 7 is not inherently slow, but it is a much larger, more 
advanced System and requires more time to perform its functio ns. 

• System 6 is smaller than System 7. 

Because of its advanced features, System 7 requires more memory 
to run. This leaves less space for your applications and desk 
accessories. If you upgrade your Mac Classic to its full 4-megabyte 
capacity (see Chapter 13), this memory requirement is less of a 
problem. System 7 will not run on a 1-megabyte Mac Classic and is 
of limited usefulness on a 2-megabyte version. System 6 functions 
well with these smaller amounts of memory. 

• System 7 is too new. 

At the writing of this book, System 7 had just begun shipping. 
Although System 7 has proven to be relatively bug-free and stable, 
any software release ending in a zero inevitably will have bugs. 
System 6 is at version 6.0.7 at the writing of this book and has 
been stable for quite a while. Some users may elect to wait until 
the bugs have been worked out of System 7 before upgrading. 



NOTE: 
Application-upgrade 
policies vary. Check 
with each software 
company if you are 

considering the move 
to System 7. 

Another concern is that not all applications and desk accessories 
have been upgraded to be compatible with System 7. Many users 
may choose to wait until their most useful and favorite applica
tions and desk accessories work with the new System. 

• Upgrades cost money. 

This is the primary concern for many people. Memory is cheap but 
dues <:ust money to purchase and have installed. The System 7 
upgrade kit costs money. Your applications may require upgrad
ing, which may cost more. 

System 7 does have its advantages, which primarily are the features it 
offers. Many of these features have been covered in this book. Basic 
System 7 features include the following: 

• Fully-configurable Apple menu (see Chapter 7) 

• Icon labeling (see Chapter 8) 

• Powerful, built-in Find command (see Chapter 5) 

• Many new features for working with folders and icons (see 
Chapters 5 and 6 and other parts of this book) 

• Icon aliasing (see Chapter 8) 

• Configurable views of windows (see Chapter 8) 

• Built-in file-sharing capabilities (see Chapter 8) 

• TrueType fonts (see Chapter 10) 

System 7 will offer more power as Apple defines the new Apple Events 
and the l}ublish and Subscribe features, which will enable applications to 
share information and communicate together. 

This book can help you decide whether you want to make the change to 
System 7. Read the sections on System 7 features and consider whether 
they would be helpful to you. Then consider the cost of upgrading your 
memory, System software, and applications. 

Understanding Software Sources 
You can fi nd software in several different sources. Refer to 
Appendix C, "Macintosh Resources," for listings. 
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NOTE: 
Many people are slow 

in paying shareware 
fees. Shareware is 

offered by individuals 
who are not being paid 

by a company. If a 
shareware package is 

useful, the author 
desenres a show of 

appreciation. 

Software sources divide into the foUowing three categories: 

• Commercial sources, such as your dealer, software stores, and 
mail-order houses, offer the latest from commercial manufacturers. 

• On-line services are electronic services that offer many free or 
inexpensive software choices that can be downloaded by the use 
of a modem. Some offer electronic "shopping malls," where you 
can order commercial software. 

• User groups are informal gatherings of Macintosh users that many 
times have coUections of software. These free or inexpensive 
software packages are usuaUy offered by an individual. 

The software offered by on-Line services and user groups falls into the 
two categories of freeware and shareware. Freeware programs are those 
packages an individual has written and distributed but chosen not to 
charge for. Shareware has a price but is usuaUy smaU and only has to be 
paid after a trial period in which you may decide whether you want to 
keep the package. 

Understanding Software Included with Your Mac Classic 

Part Ill 

pple has provided several optional items that you should know 
about. This section mentions them briefly without teaching you the 
details for using them but rather to help you identify them and give 

you a basis for your own exploration. 

File and Disk Management 
Apple includes only one item in the category of file and disk manage
ment: the Apple HD SC Setup program that was discussed in Chapter 4. 
The Apple HD SC Setup program enables you to initialize, update, 
partition, and test your internal Apple hard disk. 

AU but the partition option is covered in Chapter 4. Partitioning is the 
capabil.ity to divide your hard disk into two or more logical disks. The 
sections of your hard disk appear as separate volumes . . Partitioning is 
complicated and best not attempted by the new user. Also, partitioning 
is usually done only for large drives that need to be subdivided. Check 
your Apple manuals and consult your dealer if you believe you need 
partitioning. 
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Backup and Data Recovery 
The Disk First Aid program located on your System Starrup disk can help 
if you encounter a message reporting that a disk is damaged or unread
able. Eject the disk if it is a floppy disk, or start your Mac Classic with a 
backup copy of the System Startup disk if you receive such a message 
about your hard disk. Perform the following steps to use Disk First Aid: 

1. Double-dick the Disk First Aid icon on the System Startup disk. 

2. Click the drive button if necessary to select the defective disk, or 
insert the disk in the floppy disk drive. 

3. Click the Open button. 

4. Click the Start button. 

Disk First Aid informs you of its progress and success. If it fails to repair 
the disk, contact your dealer for more information or consider one of 
the commercially available data recovery packages covered later in this 
section. 

Fonts and Font/DA Utilities 
At this ·writing, the System 6 package (Version 6.0.7) included the 
following screen fonts and corresponding point sizes: 

• Athens 18 

• Cairo 18 

• Chicago 12 

• Courier 9, 10, 12, 14, 18, and 24 

• Geneva 9, 10, 12, 14, 18, 20, and 24 

• Helvetica 10, 12, 14, 18, and 24 

• London 18 

• Los Angeles 12 and 24 

• Mobile 18 

• Monaco 9 and 12 

• New York 9 , 10, 12, 14, 18, 20, and 24 

• Palatino 10, 12, 14, 18, and 24 
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• San Francisco 18 

• Symbol 9, 10, 12, 14, 18, and 24 

• Times 9, 10, 12, 14, 18, and 24 

• Venice 14 

No printer fonts are included. Fo r printer fonts, you need to purchase 
PostScript or contact your dealer for TrueType information. 

The System 6 package also includes the Font/DA Mover program for 
installing and removing fonts as discussed in Chapter 10. 

System 7 includes the following fonts and corresponding point sizes: 

• Athens 18 

• Cairo 18 

• Chicago TrueType 

• Courier 9, 10, 12, 14, 18, and 24 

• Courier TrueType regular and bold 

• Geneva 9, 10, 14, 18, 20, and 24 

• Geneva TrueType regular and italic 

• 1-Ie lvetica 9, 10, 12, 14, 18, and 24 

• 1-Ielvetica TrueType regular and bold 

• London 18 

• Los Angeles 12 and 24 

• Monaco 12 

• Monaco TrueType 

• New York 9, 10, 12, 14, 18, 20, and 24 

• New York True Type regular 

• Palatine 10, 12, 14, 18, and 24 

• San Francisco 18 

• Symbol 9, 10, 12, 14, 18, and 24 

• Symbol Truel'ype regular 

• Times 9, 10, 12, 14, 18, and 24 
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• 
Fig. 11.1. 

The MacroMaker menu. 

• Times TrueType regular, bold, bold italic, and italic 

• Venice 14 

The Apple Inst.1.ller installs a basic set of fonts in your System. Others 
may be included on a Fonts disk or in the Font;DA Mover folder on a 
System Additions disk. Check Chapter 10 for installation of any other 
fonts you may want to use. 

This list of fonts is subject to change. Nor aU may be included in your 
System software package. Contact your dealer for further information. 

Macro Programs 
A macro program enables you to record key presses, mouse movements, 
and mouse clicks to be recalled when a key combination is pressed. The 
Apple System 6 macro recorder is called MacroMaker and is included on 
the System Additions disk. Install MacroMaker by dragging MacroMaker, 
MacroMaker Help, and Macros into your System Folder. Then choose 
Restart from the Special menu . 

MacroMaker is not included in System 7. However, several macro 
programs exist that can be purchased. A sampling of these is found later 
in this chapter. 

MacroMaker installs an additional menu on your menu bar. This menu 
appears as a small cassette (see fig. 11.1). 

MocroMoker 
Stort Recording 

1;1obnl 
(gCopy 
(gCut 
~Poste 

~Undo 

Another File ... 
About MocroMoker ... 

F3 
F2 
F4 
Fl 

Macros can automate such tasks as saving documents in different 
formats, ryping often repeated text, and retrieving frequently used 
graphics from the Scrapbook. Operations requiring several steps can 
be combined into one by using a macro utiliry. 
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Fig. 11.2. 
The MacroMaker window. 
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The MacroMaker menu options include the following: 

• Open MacroMaker opens the MacroMaker window. 

• Star t Recording begins recording your key presses and mouse 
activity. 

• Copy, Cut, Paste, and Undo commands are in the section that 
changes according to the application you use. The macros shown 
in figure 11.1 apply to all applications and the Finder. 

• Another File enables you to choose another macro file. You can 
have as many as you want with differing sets of macros. 

• About MacroMaker displays the version number of MacroMaker 
and the help facility. 

To record a macro, perform the following steps: 

1. Choose the Start Recording command from the MacroMaker 
menu . 

2. Perform the operation you want to be recorded. 

3. Choose the Stop Recording command from the MacroMaker 
menu ; it appears in the same location as Start Recording. The 
MacroMaker window appears (see fig. 11.2). 

4. Type a name fo r the macro, and press tab. 

5. Type any notes you want in the Info box; then press tab. 

6. Hold down the keys you want to assign to this macro: control, 
option, and S, for example. 

Adding Software and Hardware 
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Fig. 11.3. 
Translating an IBM file to 

Macintosh format. 

7. Click the Store button. 

8. Click the close box to dismiss the Macro Maker window. 

See your Macintosh Reference manual for more information on using 
MacroMaker. 

Connectivity 
Included with your Mac Classic is the Apple File Excl1ange program 
located on the Systems Additions disk (the Tidbits disk in System 7). This 
program enables you to initialize disks for use in the IBM PC or in the 
ProDOS Apple II format. You also can use it to translate files to and from 
these machines, although this feature requires the addition of translator 
files. 

You have seen how Apple File Exchange is used to initialize disks (see 
the section "Initializing Floppy Disks" in Chapter 4) . Installation is 
covered in your Macintosh Reference manual. After you purchase and 
install the translators you need, you translate the files by using the 
following steps: 

1. Double-click the Apple File Exchange icon. 

2. Insert the disk containing the file to be translated. 

3. Click on the file to be translated (see fig. 11.3). 

S File Edit Moe to MS- DDS MS- DOS to Moe 

Apple File Euehonge 

I= Hord Disk I I (g) Aten I of 31 

~D~A-go~i~ns=t=f======~--~~~ ~·~·~ij.ijij.ij.iiiiill.~~ 
D AppleShore PDS 1.-=------.,-:------. D ATEN02.DDC 

~~~~~~::::Info ~, t «T:::~:~~~ g ~H~~H~~ 
D DeleteTrocklng i!:i! D ATEND7.DDC 

g ~=:~!~~DB ~.;;:,Iii b~~ ~s g =~~~::~~~ 
D Desktop OF 1l. selected D ATEN l O.OOC 
D Desk top Folder 0 D AlEN t !.DOC 

= llord Disk 

37 19K bytes auai loble 

[ 0JJ<m ]I [ Oriue 

[New Fo lder] [ 1: )<H t 

(g) A t en I of 3 

OK bytes ouailob le 

[ OtH~n ]I [ Drlue 

[New Folder] [ Eject 
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Rg. 1 1.4. 
Choosing a translator. 

4. Click the Translate button. 

If you have more than one translator that can handle the conver
sion, you will be prompted to select the one you want to use (see 
fig. 11.4). 

Lt More than one translator can handle the file 
"ATE NO 1.DOC" which is on the disk "Aten 1 of 
3". Please se lect the one you wish to do the 
translation. 

WordPerfect 5.1 to MacWrite 

' 
lllliTli I :C:U I ~ 111 .. -w ...... l'i IIIII 
WordPerfec t 5.1 to Word 3.0 "t' ( Cancel ) 
WordPerfect 5.1 to Word 4.0 

~ 

~ ~ WordPerfect 5 .1 to WordPfct Mac 1.0 0 Continue 

5. Double-click the translator you want to use. 

The reverse translation is accomplished by clicking on a Macintosh fi le in 
step 3. The Translate button shows the direction of translation by small 
arrows inside it. 

Sampling Available Software 

Part Ill 

his section discusses some of the commercial programs available 
for the Mac Classic that fall general ly into the category of System 
software options. This section is by no means exhaustive but is 

meant as a guide. 

No specific recommendations are made, intended, or implied. The 
programs discussed here are used by the author or rated highly by trade 
magazines tl1at review Macincosh products. For fmther information, you 
should speak w your dealer and other Macintosh users. You might also 
consider one of the two trade publications, MacUser and Macworid, d1at 
review software and hardware for the Macintosh. 

System 7 users should note d1at not all applications and utilities have 
been upgraded to System 7 compatibility. As this situation is constantly 
changing, compatibility is not noted here. Contact the manufacturer for 
information, or check with your dealer. 
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Fig. 11.5. 
The MacTools Optimizer 

window. 

File and Disk Management 
Several types programs are discussed in this section that relate to 
managing your icons (files) and your hard disk. These program types 
include the following: disk optimization, data compression, and file 
finders. 

Disk Optimization 
Disk optimization is discussed in Chapter 4 of this book. Optimization 
sorts the information on your hard disk to reduce the amount of time 
needed to access it. If you own a hard disk, you should consider 
purchasing and periodically using an optimizer. 

I use the MacTools Optimizer, which is included in the MacTools Deluxe 
utility package from Central Point Software. This package also includes a 
disk backup program, security options that enable you to encode and 
password data, partitioning software, data recovery, and other useful 
utilities. 

The MacTools Optimizer is easy to use. From the MacTools Optimizer 
window (see fig. 11.5), you choose the options desired and click the 
Analyze or Optimize buttons. 

MacTools® Optimizer 

Uolume : = System 7 Disk I 

·~ [8] Check For Bad Blocks 

F-::1 _ _ [8] Unfragment Files 
~·liJ [8) Consolidate Free Space 

- [8) Prioritize Applications 

DErose Free Space 
D !:r<1~1~ !:n1in! Bi~k 

n Analyze J) 

50% 

DrtvP Statistics: 
Drive Size: 19732K 
Free Space: 5764K 

Number of Fil .. : 235 
Fragmentation: 5 .11% 

Optimize Statistics : 

(Optimize] 

Number of disk access~ : 350 
Number of blocks to move : 32590 
Amount to move : 16295K 

Help ------------------------------------------------
Hold down the Option key and point to an item on the scr een. A br ief message appears 
explaining the purpose of that item . 
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The Analyze button gives you a report as seen in the sample figure. This 
report tells you the size of the disk, the amount of free space left on the 
disk, and the number of files (icons) contained on it. 

The important number is the Fragmentation. This is the percentage of 
your data that is scattered across the disk rather than in contiguous 
locations. Generally, a disk needs optimjzing when this number passes 5 
percent, as in figure 11.5. 

Many optimizers have the capability to check for problems on your disk 
(Check for Bad Blocks option), place all free space in one location 
(Consolidate Free Space option), and locate your most used applications 
in places where they can be accessed quickly (Prioritize Applications 
option). 

Other optimization options are available. The Norton Utilities for the 
Macintosh package from Symantec includes a hard-disk optimizer. This 
package also contains utilities to recover damaged data and disks as well 
as other useful programs. 

The SUM 11 utility package by Symantec also includes a disk optimizer 
and programs for hard-disk partitioning, backup, and data encryption. 
Encryption enables you to encode data in such a way that only you can 
access it. 

Silverlining by La Cie Ltd. includes a disk optimizer and disk-partition
ing, backup, formatting, and testing utilities. 

One of the most highly rated disk optimizers is DiskExpress 11. 
DiskExpress 11 is not part of a package as the others but comes alone. 
Being solely dedicated to disk optimization, it includes many options, 
such as the capability to transparently optimize and prio ritize your data 
as you work. 

Data Compression 
As you use a hard disk, you inevitably begin to run out of space. To avoid 
this, you can copy data to floppies and delete files from your drive, o r 
you can compress information. 

Several packages can compress your data. One of the most popular is the 
Stuffit Classic shareware program by Aladdin Systems. Because it is 
shareware, you can obtain it from user groups or from such on-line 
services as CompuServe. After trying it for a short period of time, you 
may keep it for a small fee. 

Adding Software and Hardware 



Fig. 11.6. 
A Sruffit Classic archive. 

Stuffit Classic enables you to create archives and store files in a com
pressed version (see fig. 11.6) . Compression rates of as much as one half 
can be achieved. The program enables you to choose multiple files to be 
compressed and stored at one time. 

ATEN02.DOC ( 'o'ord4) 4/8 /9 1 55% 
ATEN03.DOC ( 'o'ord4) II'OBN MS'o'O 13823 4 /8/91 55% 
ATEN04.DOC (Word4) 'o'OBN MS'o'O 179 19 4 /8/91 56% 
A TENDS .DOC (Word4) 'o'OBtl MSWD 22527 4 / 8/91 56% 
ATEN06.DOC ( Word4) 'o'OBII MSWD 13823 4 /8/9 1 5890 
ATEU07 .DOC (Word4) 'o'DBN MSWD 7679 4 /8/9 1 5790 
ATEiiOS.DOC (Vord4) WDB!iMSWD 8 19 1 4/8/9 1 5890 
ATEfi09.DOC (Vord4) WDBN MS'o'O 7679 4/8/9 1 59% 
ATEN1 O.DOC ('o'ord4) WDBN MS'o'O 15359 4/8/9 1 57% 
ATEN11.DOC ('iord4) 'o'OBN MS'o'O 9727 4 /8/9 1 5 5111 
ATEN1 2 .DOC ('o'ord4) 'o'OBN MS'o'O 15871 4 /8/9 1 5 5111 

13.DOC 11775 4 / 8 / 91 5590 

If you plan to use on-line services, such as CompuServe, you should 
purchase Stuffit. Many of the files and applications available on these 
services have been compressed and therefore can be decompressed by 
Stuffit to save time and money when you download, transfer them by 
modem to your computer. 

A more advanced version of the program, Stuffit Deluxe, is available 
through commercial sources. It offers faster speeds and a host of new 
options. 

Compactor by Bill Goodman is another shareware data-compression 
program that is also inexpensive and widely used. As with Stuffit, you 
need Compactor if you plan to download files from on-line services. 

Stuf.fit or Compactor can compress and ;u·chive your data for you to save 
on disk space. But for reducing data on your disk overall, consider 
DiskDoubler by Salient Software. DiskDoubler is an INIT that com
presses the data on your disk as you work to reduce the amount of 
storage space needed. 
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Fig. 11.7. 
The Boomerang menu. 
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File locators 
If you discover that the Find file DA in System 6 or the Find command in 
System 7 is insufficient for your needs, several utilities may be of 
assistance to you. 

Consider CanOpener by Abbott Systems. As opposed to Find File and the 
Find command, CanOpener can search for text strings inside your files 
(icons). 

FindswetJ by Working Soft\vare adds a button to the Open dialog of all 
applications. Clicking on the button retrieves a box that enables you to 
type a search string and locate a file (icon). 

On Location is another powerful, although rather expensive, location 
utility. It is rated as one of the fastest and enables you to view the 
contents of a located document, copy, move, rename, or delete it. 

One of my favorites is Boomerang by Hiroaki Yamamoto of Zeta Soft. 
Boomerang is a shareware utility that adds a menu to the Open and 
Close dialog boxes of aJI applications (see fig. 11.7). Boomerang keeps 
the last folders and files you have used in its menus, which enables you 
to retrieve them without searching your disk. You can add folders or files 
to d1e menus permanently and even attach a command key sequence to 
them. 
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Boomerang includes file searching and the capability to create a new 
folder while the Open or Close dialog box is on the screen. The Re
bound feature automatically reselects your last used file, which is helpful 
if you work with documents stored close to each other or the same one 
repeatedly. 

Boomerang has been upgraded to Super Boomerang and is included in 
the commercial Now Utilities package from Now Software Inc. 

Backup and Data Recovery 
lf you have a hard disk, you should make regular backup copies of your 
data on floppy disk. Despite continuing improvements in hard-disk 
reliability, failures do occur. And if a failure occurs in your system, you 
will need a data-recovery utility handy to attempt reconstruction of your 
most valuable information. 

Backup 

A sample back-up process is presented in Chapter 4. This section 
discusses several backup programs available to you. 

FastBack II from Fifth Generation Systems is one of the most popular 
backup programs available and is designed to be one of the quickest 
backup utilities. Fastback II enables you to do full backups of your entire 
hard disk, incremental backups of only the data that has changed since 
your last backup, or selective backups where you choose the data for 
backup (see fig. 11.8) . Fastback U also has a macro facility to enable you 
to automate backup tasks. 

1-IFS Backup by Personal Computer Peripherals Corporation is also 
worth considering. This incremental backup program has been rated 
quick and reliable and includes virus checking. 

Redux by Microseeds Publishing, Inc., is highly rated and includes a 
scripting language that enables you to automate backup tasks. 

Many utility packages include backup programs. MacTools Backup is an 
example listed in Chapter 4. This backup program is included in the 
MacTools utility package from Central Point Software along with data
recovery, hard-disk partitioning, data-security, and other utilities. 

SUM II from Symantec Corporation also includes a backup utility as well 
as data-recovery, hard-disk partitioning, and hard-disk optimizing 
options. 
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Fig. 11.8. 
Choosing flies for backup 

with FastBack II. 
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Several utilities exist that can help you recover lost dam, whether from a 
hard disk problem or accidental erasure. One of the fi rst utilities you 
might consider is Complete Undelete from Microcom Inc. This u tility 
enables you to restore deleted documents and other files. It's just what 
you need if you realize you should not have put that last icon in the 
Trash. 

Norton Utilities for the Macintosh from Symantec is well known for its 
data-recovery capabilities. Designed to recover data from crashed hard 
disks, it can save the day when things go wrong. Also included in the 
package is a hard-disk optimizer and other useful utilities. 

Also from Symantec is SUM II, the data-recovery abiUties of which are 
rated as excellent. Included in the package are u tilities to backup, 
optimize, and partition your hard disk. 

I use Mirror, which is included in the MacTools package from Central 
Point Software. After you install the utility, Mirror periodically writes a 
backup of your hard d isk's format information to guard against data loss 
in case of a hard-disk crash. The Mirror CDEV enables you to recover 
documents and other icons deleted as far back as the last 120 files (see 
fig. 11.9) . 
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Fig. 11.9. 
Recovering files with 
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Th~ePlle Lis t \iindow displays a list of a ll the deleted files Mirror has r ecorded. 

Rescue also is included in MacTools and can help restore data from 
damaged disks. The program is best when working with disks on which 
Mirror was installed before the crash. If you purchase the MacTools 
package, immediately follow the directions for installing Mirror on your 
hard disk. 

Fonts and Font/DA Utilities 
With the number of fonts and desk accessories now available for the 
Macimosh, a full treatmem of them all would take most of this book. 
However, you may want to know about fonts, desk accessories, font and 
desk accessory managers-especially if you ;u·e working with System 6. 

Fonts 
Chapter 10 cliscusses the three types of fo nts available fo r d1e Macintosh: 
the screen font, the PostScript printer font, and the TrucType printer 
font. Rather than try to d iscuss the many fonts that exist within these 
categories, this section gives you an idea of where to find these fonts. 

Screen fonts are available from a wide variety of sources. Everyday, it 
seems someone sits down and decides to create his o r her own screen 
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font. You can find a wealth of free or inexpensive fonts from user groups 
and on-line sources. And, if you are printing with a dot-matrix or 
QuickDraw printer, these and the fonts that come with your Mac Classic 
may suffice for your needs. 

Fonts from these non-commercial sources may be imperfectly 
created. A hand-made font can crash the System sofrware and force 
you to re-install. Ask other users about their experience with the 
font befo re installing it. 

If you buy a PostScript font, d1e screen font accompanies it. And if you 
purchase TrueType fonts, these fonts are screen and printer fonts. 

PostScript fonts were once solely the domain of Adobe Systems. There 
were, at one time, PostScript fonts called Type 3 fonts . Adobe permitted 
oilier companies to make Type 3 fonts, and it held the superior Type 1 
fonts fo r itself. Since the threat ofTrueType, Adobe has released the 
Type 1 font standard for use by anyone. 

This means that me superior Type 1 PostScript font is becoming avail
able from companies oilier man Adobe. However, Adobe remains the 
primary supplier of high quality PostScript fonts. They now sell several 
inexpensive font sets. You may also w;mt to consider purchasing the 
Adobe Type Manager at me same time. 

One interesting option offered by Adobe is the Adobe Type On Call 
CD-ROM (see Chapter 13). This disk has 950 of Adobe's fonts encoded 
on it. This disk provides you with two printer fonts chosen from a list. 
You also can preview all 950 fonts on screen. To purchase fonts, you call 
a dealer, such as MacWarehouse, and order me font over the phone. You 
receive a code number that unlocks the printer font, which enables you 
to print wiili me font. 

For True Type fonts, you might consider me collections offered by 
Bitstream, who also is an alternative supplier of PostScript fonts. Several 
TrueType font packages are offered by this company. 

Font Utilities 
The primary font utility is Adobe Type Manager offered by Adobe 
Systems and available from a wide variety of mail-o rder, dealers, and 
sofrware stores. This utility combines me PostScript screen and printer 
fonts tO provide a more accurate representation on-screen of how the 

Adding Software and Hardware 



font will print. If you are going to use PostScript fonts, you will want to 
consider this package. 

For achieving special font effects, consider Adobe System's TypeAlign. 
A companion to the Adobe Type Manager, this product enables you to 
create curved type, alter type with perspective or skewing, and several 
orher effects. 

A competing product from Broderbund is TypeStyler, which offers the 
capability to bend, rotate, twist, or achieve orher effects with Type 1 
and 3 PostScript fonts. 

l 'he capability to create and edit your own font is gained with such 
packages as Fontographer by Altsys or FontSrudio by LetraSet. 

If you flnd the need to convert between font types (Type 1, Type 3, and 
TrueType), such utilities as FontMonger by Ares Software or Metamor
phosis Professional by AltSys can fill those needs. 

Font/DA Utilities 
For System 6 users who want to have more control over their Apple 
menu and easily install and remove fonts, two products exist that are 
worth consideration. One is SuitCast: II by Fift h Generation Systems, 
the other is Master)uggler by ALSoft. 

Both products enable you to bypass the use of the Font/DA Mover 
program (covered in the sections "Installing a Desk Accessory'' in 
Chapter 6 and "Installing and Removing Fonts" in Chapter 10). You can 
dynamically install fonts, desk accessories, and sounds and overcome the 
limits of the Apple menu. \Vhich you use is a matter of taste . Both 
products are enormously popular and well regarded in the Macintosh 
world. 

Virus Protec~on 
!though the media have inaccurately presented viruses as a threat 
equal only to 1950s science fiction movies, they are indeed a 
source of problems in the computer world. Evidently some 

Macintosh users have norhing better to do with their time than cause the 
rest of us headaches. You should have at least one good virus-detection 
and prevention package on your Mac Classic. 

Consider Disinfectant by John Norstad of Northwestern University (see 
fig. 11.10). This free program has saved my data more than once and is 

Chapter 11 
Selecting System Software 



Fig. 11.10. 
Checking for viruses with 

Disinfectant. 

Part Ill 

one of the few recommendations I will risk making. Disinfectant is easy 
to use (see the section "A Word on Viruses" in Chapter 4) and includes 
an INlT installed by a menu choice that can catch many viruses when a 
disk is inserted . 
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Disinfectant is available th rough user groups or such on-line services as 
CompuServe. Make certain the version you acquire is the latest because 
the program is updated constantly as new viruses are discovered. At th is 
writing, d1e current versio n is 2.4, and you should not use any earlier 
versio n. 

SAM by Symantec Corporation is rated highly and offers the capability to 
upgrade over modem when new viruses are detected . The included INIT 
Sam Intercept provides ongoing virus protection. 

Virex by Microcom is also worth your co nsideration. Microcom report
edly has a good history of updates and user support. 

Macro Programs 
Although MacroMaker by Apple is included in your System 6 software 
package, you may fi nd it somewhat limiting and if you use System 7, 
MacroMaker is no longer available. In these cases, you may want to 
consider several other macro options. 
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The first is Hot Keys by Keep It Simple Software (KISS). This is a set of 
macros for use with MacroMaker. KISS offers sets for MacWrite II, 
Microsoft Works, and PageMaker at this writing. Others may be available. 

1\vo more powerful macro systems are available. QuicKeys 11 by CE 
Software is one of the most popular and powerful, although it does not 
contain the capability to add conditions to your macros. 

Tempo U Plus by Affinity Microsystems is the old standby. Enom10usly 
powerful macros \'lith conditions and branches can be created. I found 
the latest version incompatible with several software packages and prone 
to crashing my Macintosh System. You may want to verify the utility's 
stability wid1 other users before purchase. 

Connectivity 
Connectivity refers to the capability to share data with other types of 
machines. In this section, only products enabling transfer between 
Macintoshes and IBM PC-compatible machines are addressed. 

MacLink Plus/PC by DataViz is the product I use and endorse whole
heartedly. The number and quality of conversions afforded by the 
product are and have been of great help working in a mixed Mac-PC 
environment. The program enables the option of direct connection by 
cable, by modem, or over a network between Macintoshes and PCs. 
Included is the DOS Mounter by Dyna Communications that enables you 
to initialize, read from , and write to IBM I'C disks in your Mac Classic's 
floppy drive. 

Maclink Plus/PC can convert a single document from a Macintosh word 
processor to ;m IBM PC word processor (see fig. 11.11) or several at one 
time. The reverse conversion also can be accomplished. The program is 
quick and handles a wide variety of document types on both ends of d1e 
computer spectrum. 

Data Viz also enables the translators separately, which you can then use 
with Apple File Exchange or such applications as MacWrite II. 

DOS Mounter by Dyna Communications is also offered separately. This 
product enables you to format IBM PC disks with the same, basic steps 
you perform with Macintosh disks and eliminates the need to use Apple 
File Exchange. IBM PC disks and their contents appear on your desktop 
just as Macintosh disks do. Applications that can convert IBM PC files, 
such as MacWrite II with d1e appropriate translators, can then open and 
save to the disk. 
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Fig. 11.11. 
Converting a document 

with MacLink Plus/PC. 
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A competing product comparable to MacLink Plus/PC is LapLink Mac III , 
which evolved from the IBM PC product of similar name. It is offered by 
Travelling Software and includes the cables to connect your Macintosh 
to an IBM PC. You also can make transfers over networks and modems. 

his chapter discussed the System software and options for the Mac 
Classic. You have considered the differences between Systems 6 
and 7 and weighed their various options. You now have a basis of 

understanding that will enable you to further explore which options are 
best for you. 

This chapter discussed the options included in the System software, and 
you have seen the utilities, fonts, and other items included that can 
enhance your System. 

Finally, a sampling of available software has been explored. Although the 
lists here are by no means exhaustive and are not intended as recom
mendations, you now should have an idea of the options available to 
you. 
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Selecting 
Software 

his chapter is designed to help you choose the application 
software you need to do productive work on your Mac Classic. 
This chapter surveys and considers several popular application 

programs, desk accessories, IN ITs, and CDEVs available to you. 

You also are introduced to the HyperCard application included with 
your Mac Classic. This application is an easy-to-use database that can be 
used to create appointment books, household inventory lists, telephone 
address lists, and other useful items. 

The specific needs of each individual reader of this book are impossible 
to anticipate. Therefore, few specific recommendations are made. 
Instead, this chapter gives you a general understanding of the many 
applications available so that you may find those that best suit your 
needs. 

Understanding Application Software 
The software packages considered in this chapter are primarily applica
tion programs, which are the tools you use to do work on your Mac 
Classic. 

Although the main focus of this chapter is application programs, other 
items are included at times. Also presented are some desk accessories, 
which are small, single-function software packages; a few INITs, which 
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also are called system extensions and start with the System software and 
enhance its functioning; and CDEVs, which are control panel devices 
that enable you to configure the System software and some system 
extensions. 

Chapter 6 is your reference source for information on installing and 
working with application programs and desk accessories. You also can 
consult Chapter 8 for more infonnation on I NITs and CDEVs. 

Types of Application Software 
The categories used in this chapter cover the main types of software 
available to you. This category list is no t exhaustive due to the enormous 
variety of software in the market today but covers d1e main types of 
packages most users will need. The chapter discusses the following 
softv.rare categories: 

Communications. These applications concern connecting your 
Mac Classic to other computers by modem to enable you to access 
on-line computer services. 

Databases. Databases store and manage lists of information, such 
as mailing lists and client records. 

Desktop PubUshing. Applications in this category deal with page 
layout and document design for such items as newsletters and 
adveniscments. 

Educational. Applications that aid reaching are considered in this 
category. 

Entertainment. Computer games and other leisure-time items are 
included in this category. 

Financial. In this category, applications that help you manage and 
plan your money are considered. 

Graphics. Drawing tools and painting applications are included in 
this category. 

Music and Sound. This category includes applications related to 
the creation and playing of music and other sounds. 

Spreadsheets. These packages are designed to enable you to work 
wid1 numbers in a tabular form. Primar ily, they are employed in 
financial planning but have application in areas where numbers 
are tabulated and ot11e1wise manipulated by various formulas. 
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Word Processing. Applications that help you write leners, 
reports, and even books are considered in this category. As 
opposed to desktop publishing, this category is primarily 
concerned with applications that aid in the creation and 
editing of text. 

Memory and System Considerations 

When you purchase software, consider the amount of memory, the type 
of Macintosh you own, and the System software you run. All manufactur· 
ers state the amounts of memory needed to run their software and the 
type of Macintosh and System software version required. You will find 
this on the box or listed in mail·order catalogs. 

Any Software rated for the basic Macintosh systems, including the Mac 
Plus, Mac SE, or the Mac Classic is available to you. Those applications 
requiring a math coprocessor or PMMU chip are not. These two items 
are found on the more advanced Macintosh systems, such as the SE/30 
and the Mac Ilci. 

When you consider a manufacturer's memory requirement statement, 
don't forget that your System software also requires memory space. An 
application program that requires 2 megabytes of memory will not have 
enough room on a 2-megabyte Mac Classic because your System soft
ware requires part of the memory space. Chapters 6 and 9 discuss 
memory use by the System and applications and can aid you in deter
mining how much memory is available for running application pro
grams. 

Differences in System software versions are not usually a problem. Most 
applications were written under earlier versions of the System software 
than the most commonly used due to the lead time inherent in writing 
and distributing software. 

The System software version requirements are usually stated, for 
example, as System 6.0.2 o r higher. You may check your System software 
version by choosing the About the Finder command from your Apple 
menu. 

System 7 users must be careful here. System 7 is such a significant 
change in System software that you must check specifically for System 7 
compatibility. 
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he HyperCard application is included with your Mac Classic. 
You will find a disk labeled HyperCard Program or somed1ing 
similar. The Chapter 6 installation instructions apply to installing 

HyperCard. HyperCard is not installed by d1e Apple Installer program. 

Defining HyperCard 
HyperCard is a unique program d1at can enable average users to create 
applications of meir own. This is done by creating cards that reside in a 
stack. A card can contain text or graphics as well as various kinds of 
controls such as buttons. By linking cards within a stack, you can create a 
kind of database of your own. 

An example of me type of application you can create for yourself is a 
listing of your compact disk or album collection-the example used in 
this chapter. Each card can contain information about me songs on me 
CD or album. Buttons mat you can add provide the capability to move 
from one card to me next. You might create a button that, when clicked, 
moves you to a card containing me words of me song. Or, another 
button might lead to anomer card containing a listing of another CD 
produced by me same artist. 

You can write and edit scripts in me HyperTalk language to add fu nc
tionality to the cards and stacks. This programming language enables 
you to animate graphics, make mathematical calculations, and perform 
a variety of other functions. 

Scripting is beyond the scope of d1is book. If you are interested in 
learning scripting, contact your dealer for the full HyperCard package. 
Many books also are available to aid you in learning to write HyperTalk 
programs to include in your HyperCard stacks. 

If you have no interest in programming, you can still use HyperCard. 
Many nonprogramming Macintosh users have created HyperCard stacks 
to handle personal lists of compact disks or wine, for example. 

You also can purchase or copy from on-line services stacks mat perform 
a variety of functions. Many educational and entertainment stacks exist, 
including one mat plays chess. 
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Rg. 12.1. 
The HyperCard File menu. 

Using HyperCard Menus 
This section gives a brief overview· of HyperCard 's menus. More informa
tion can be found in your HyperCard Basics manual. 

The File Menu 
The HyperCard File menu (see fig. 12.1) contains the fo llowi ng 11 
commands: 

New Stack creates and names a new stack. 

Open Stack opens an existing stack. 

Close Stack closes the current stack. 

Save a Copy saves a copy of the current stack. 

Compact Stack compacts the current stack and reduces disk 
space needed to store it. 

Page Setup retrieves the Page Setup dialog box for your printer 
(see Chapter 10). 

Print Field prints the currently selected Held. 

Print Card prints the card on the screen. 

Print Stack prints the cards of d1e entire stack. 

Print Report enables you to print a report consisting of all the 
cards in a stack. You can choose to include or exclude various 
items from the report. 
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Compact Stacie 

Page Setup .. . 
Print Field .. . 
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Fig. 12.2. 
The Edit menu 
in HyperCard. 

Part Ill 

The Edit Menu 
The Edit menu (see fig. 12.2) changes from time to time depending on 
d1e stack you are in. 
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Commands are added to d1e menu as needed. The five editing com
mands-Undo, Cut, Copy, Paste, and Clear-are covered in me section 
''\Vorking with Text" in Chapter 6. The basic commands of the Edit menu 
in HyperCard include the following: 

Undo rescores d1e last editing change to text or graphics. 

Cut cuts the current selection and p laces it on d1e Clipboard. 

Copy copies me current selection to d1e Clipboard. 

Paste copies me contents of d1e Clipboard to the location of the 
insertion point. 

New Card creates a new card with the same background (buttons, 
fields, etc.) as those of me remainder of the stack. 

Delete Card dele tes the current card from the stack. 

Audio retrieves d1e Audio Palette. 

Audio Help opens a help window that explains me Audio Palette. 
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Fig. 12.3. 
The Go menu 
in HyperCard. 

The Go Menu 
The Go menu (see fig. 12.3) comains commands that help you move 
around stacks. 
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The Go menu commands include the following: 

Back returns you to the last card that was displayed before the 
current one. 

Home returns you to the Home stack. 

Help opens the help system of HyperCard. 

Recent shows a reduced display of the cards you have viewed and 
enables you to choose one to display. 

First moves to the first card of the stack. 

Prev moves to the previous card of the stack. 

Next moves to the next card of the stack. 

Last moves to the last card of the stack. 

Find opens a window in which you may type text for which you 
want to search the cards of the current stack. 

Message opens the Message window in which you may type 
HyperTalk commands. 
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Fig. 12.4. 
The HyperCard scroll 

window. 
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Scroll opens the scrolling window. 

Next Window selects the next open window, if any. 

The scro lling in HyperCard is unlike any other Apple User Interface 
Guideline consistem program. When you choose Scroll, you are pre
sented with a small window. If you move the mouse pointer in this 
window, it turns into a double arrow at the edges of the window (see 
fig. 12.4). 

When the cursor is in thjs state, you may change the size of the current 
card by performing the following steps: 

l. Press and hold the mouse bunon . 

2. Drag the double arrow and move the gray outlined box down, left, 
right, or up. 

You see a band move across the screen. This indicates the location 
of the new edge of the window. 

3. Release tl1e mouse burton. 

The HyperCard screen now appears more like the windows you have 
seen before but still contains no scroll bars. You can then scroll the 
contents of the window by performing the following steps: 

1. Place the mouse pointer in the scro ll window. 

The mouse pointer becomes a hand as in figure 12.5. 

2. Press and hold the mouse button. 

3. Move the gray outline box in the scroll window; the contents of 
the HyperCard card also move. 

Click tl1e close box of the scroll box to close it. 
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Fig. 12.5. 
The mouse poimer 

becomes a hand. 

you to do more with your computer. 
With HyperCard, you c&n use "smart" documents 

called stacks. Stacks can help you do many different 
things-for example, you could use a slack to keep 
track of your appointments, manage your expenses, 
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The Font menu contains a list of the fonts installed in your System (see 
Chapter 10) . You can choose one to use with your typed text in the 
usual way. 

The Style menu enables you to choose various styles to be applied to 
your text. These include Bold, Underline, and Italic. You also can change 
the point size of your text by using this menu. 

Using the Supplied Stacks 
This section discusses the uses of the stacks provided by Apple with your 
HyperCard program. These features include an appointment and 
address book. More information about these and the HyperCard 
program can be found in your HyperCard Basics manual. 

Four stacks have been provided for you to experiment with: an address 
book, an appointment book, your home stack that acts as the central 
stack, and a help stack containing information about using audio with 
HyperCard . After installing the HyperCard program, you should see 
stacks named Addresses With Audio, Appointments With Audio, Home, 
and Audio Help (see fig. 12.6). 
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Fig. 12.6. 
The included 

HyperCard stacks. 

Fig. 12.7. 
The Home stack's 

main card. 

Part Ill 

:o HyperCard ~r 
5 itoms 34 ,4201< in disk 4 ,632K availablo 

~ 

~ ~ 
Hypor Card HomP 

~ ~ ~ 
Addressos \-lith Audio Audio Help Appointments \-lith Audio 

~ 
101 10 '2l 

The Home stack acts as the central stack to which the others are linked. 
The Audio Help stack contains information on adding sound to your 
stacks. This section concerns the uses of the Appointments With Audio 
and Addresses With Audio stacks. Audio is not discussed here except in 
its most basic form. To use the audio feature of the included stacks, you 
must add a sound recorder to your Mac Classic (see Chapter 13). 

To open one of the supplied stacks, perform the following steps: 

1. Double-click the Home stack. The Home stack opens and you see 
its first card (see fig. 12.7). 

5 File Edit Go Font Style 

Welcome to HyperCard 
HyperCard is a unique software tool that allows 

you to do more with your computer. 
With HyperCard, you can use "smar1" documents 

called stacks. Stacks co.n help you do many different 
things--for example, you could use a stack to keep 
track of yourappointments, m an age your expemes, 
learn a new language, or play music from an audio 
compact disc. A few slacks are included here lo get 
you slar1ed. The HY-P-erCard Basics booklet explains 
how to use them. You can obtain additional stacks 
from Apple dealers and user groups. 

( More ) 
®1990 Appl• Computor, Inc. 

Home 
-----·------------

r:R 
B3 

Appolntm•nls vlth Audio 

tmf 
Audio H•lp 
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Fig. 12.8. 
The first card of 

the Appointments 
with Audio stack. 

Three buttons are on the right side of the card. The familiar arrow 
of the mouse pointer will become a hand when over a button. 

2. Click once on the button for the stack you want to use. 

Strangely enough, Apple seems to have violated its own guidelines in 
HyperCard. Although many buttons appear to be icons, you click only 
once to open the card to which they are linked. Resist the impulse to 
double-dick while using HyperCard. 

Using the Appointments Stack 

To use the Appointments stack, click once on the button labeled 
Appointments with Audio in the Home stack. You are then presented 
with the first card of this stack (see fig. 12.8). Several buttons are in this 
stack. 

Monday-July 29, 1991 
7 ·-- - -----·---·--·--···---------. 1 -----·------·------------. 

30 -------------------------·. 
~~-~~--~--~--------·--·----··----·· 

30 ---------------·-----·--·----·· 
-------------------·· 

8 -----------· 2 -----------· 

--------------·--··------·------·. 
30 -------------------·-----·-·····. 

-----·----·---------·----------·· 
30 --·-----------···---------·---·· 

-·----------·---·----·---·---- -·--·. ·--···---··-·------·-··----·---·-··-----· 
12 --·-··--·-·---------·-. b ·------···--------···---·----· -----------· 
30 ---·-----·--------· 

30 

Open Addresses stack Open I lome stack 

These buttons perform the following functions : 

Change month or day. Click once to move to an earlier month or 
day (left arrow buttons) or a later month or day (right arrow 
buttons) . 
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Fig. 12.9. 
Cards must be added for 

the current day. 

Part Ill 

Find. Click once to open a dialog box that enables you to type text 
you want to search for. 

Show Notes opens a window in which you may type notes, click 
once to open, then again to dose. 

Go To Today moves to the card of the current date when clicked. 

Addresses. Click once to open the Addresses with Audio stack 

Home. Click once to open the Home stack. 

The calendar in the upper right corner should display the current month 
with the current day in bold type. If it does not, perform the following 
steps: 

1. Click the Go To Today button. You may receive a message such as 
the one in figure 12.9. 

There Is no Appointments cord for 
Wednesdoy, July 31, 1991. Rdd cords to 
include Wednesdoy, July 31, 1991? 

Conce1 n OK ~ n 

2. Click the OK button, or you may press the return key. 

The card for d1e current date appears; this may take some time to 
happen when you first click d1is button. 

You may then add your appointments for today by using the following 
steps: 

1. Click on the line next to the time for your first appointment. The 
cursor moves to the line next to the time. 

2. Type the text of the appointment (see fig. 12.10). 

3. Click next to the time of your next appointment. 

4. Repeat steps 2 and 3 as needed. 

To locate an appointment, you use the Find button and perform the 
following steps: 

1. Click once on the Find button. The Find dialog box appears (see 
fig. 12.11)' 
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Fig. 12.10. 
Adding a 2 p.m. 

appointment on July 31. 

Fig. 12.11. 
The Find dialog box. 

Wednesday, July 31, 1991 
7 ·------.. ------------------·· 1 ---------------------··--·--·-=1 ·--------------·-----·. -------------------··---. 

:10 ________________ .. 30 -----------------· 

s ::i~i!i:Q.Vf"-:::::::::::=~ 2 E!.!i!!i9::;t::::..-::=::::::~ 
·----------------·· 

:10 ·-------------·------------·. 

9 :B:tl:Cwi9:.;1i~~~9~~:::::::::::::::-~: 

--------------------· 
30 ---------------------· 

-------·---------------·--··---·. 
3 ---------------·-------------· 

I 2 3 4 :S II 7 
8 9 10 I I 12 13 14 

IS 16 17 18 19 20 2 1 
22 23 24 25 26 27 28 
29 30 3 1 

................................... -.................. _,~~~ 
3o ---------------------·---.. I 

oOoW ______ WWMWWOHWM-WHOOWOoOWMOMMwOoO-o 0 

30 ·-----------------------·---· . 

10 ::Et:~:9:m:t!i~:::::::::=::::: ~ -----·---------------·--·---· 
4 ----------------------- --· 

·--------------·· 
:10 ·---------------------·. 

-------------·---· 
30 ------------- --------· 

·--------------·· 
11 ·---------------------. 5 ----------------------· ---------------------·. _________ ,. __________ _ 
30 ----------------------.. :10 ------------------------· 

12 =~~:~I!i:::::~::::::::::::::: ~ -----·-------·---·····--·--·---·---· b _ .. , ................................. _____ , __ , ........... . 
·····---·--·---------·---··----·--·--··-·· ···---·--·-----·---···--··---·--·--·····--·-· 

:10 ...................................................................... . 30 ... - ..................................................... ............ . 

Show Notes I 
GoToToday I 

1V7/90 to 7/31/91 

2. Type the text-all or part of what you want to locate. 

3. Click the OK button, or press the remrn key. 

What t eHt do you want to find? 

I Call QUE 

n OK ~ J] ( Cancel 

To enter notes for the day, perform the fo llowing steps: 

1. Click the Show Notes button. The no tes window replaces the 
appointments window (see fig. 12.12). 

2. Type the notes. 

3. Click the Hide Notes button to rerum to the appointments display. 

To print your appointment schedule, perform d1e following steps: 

1. Choose the Print Report command from the File menu. 

2. Click the Print button. 

To return to the Home stack, dick the Home button. 
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Fig. 12.12. 
Notes for Wednesday, 

July 31, 1991. 

Fig. 12.13. 
The first card of the 

Addresses stack. 

Part Ill 

• File Edit Go Font Style Utilities 

Wednesday, July 31, 1991 
Remember to confi rm Comdex reservcUons. 
Check w1th John cbout E- mcil syst em 
1nstellcllon. 

Using the Addresses Stack 

July 1991 
0 MT W TFSS 

12 3 4 56 7 
e 9 10 11 12 13 14 

15 16 17 1e 19 20 2 1 
22 23 24 25 26 27 28 
29 30 31 

0 

Find ... 

HldeNole9 

Go To Today 

1V7190 to 7r.lV91 

~ 
Addrtsns 

Clicking the Addresses With Audio button in the Home stack or the 
Addresses button in the Appointments With Audio stack opens the 
Addresses With Audio stack and displays the first card of that stack 
(see fig. 12.13). 

~1oYe left Move right 

Name 

Company 

Telephone . .. ... _ .. _., ___ ., ___ , ......... _ .. _ .. _ .. , ... _ .. _ .. , ... _ .. , ... ,_ 

• 
v ............. -........... -...... .............................. -........ ~~ 

Go LO appoimments stack Go to home stack 
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NOTE: 
The arrow keys on the 

keyboard and the tab 
key do not work as you 

might expect. The tab 
key moves you between 

columns. The left- and 
right-arrow keys move 

you to earlier and later 
days. The up- and 

down-arrow keys move 
through the calendar in 

a way associated with 
the way the day cards 

are linked and are not 
particularly helpful. 

Fig. 12.14. 
Confirming that you want 

to delete a card. 

Some sample addresses and phone numbers have been included in this 
stack. 

To add an address to this stack, perform the following steps: 

1. Click the New Card bunon. A new card is created and the cursor 
appears in the Name field. 

2. Type the name. 

3. Press the tab key. 

4. Type the company name. 

5. Press the tab key. 

Continue typing the Street, City & State, Zip Code, and Telephone fields. 
Pressing return moves to the next field. 

You can then click the New Card button to create another card. 

The cards are linked together in a circle. The first card is linked to the 
last. When you click the move left or right buttons, you move one card at 
a time until you reach the flfSt or last card; the next click then takes you 
to the last or first card and you can continue through. 

To remove a card, perform the following steps: 

1. Move to the card you want to remove by using the move left or 
right buttons. 

2. Click the Delete Card button. You are prompted for confirmation 
(see fig. 12.14). 

Dele te this address cord? 

Cancel OK 

3. Click the OK button. 

To find a specific address, perform the following steps: 

1. Click the Find button. 

2. Type any part of the address in the Find dialog box. 

3. Click the OK button, or press the return key. 
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Fig. 12.15. 
Sorting the addresses by 
Name from the Utilities 

menu. 

Fig. 12.16. 
The Son Preferences 

window. 

Part Ill 

You can son the list by name, company, city, state, or zip code. To do so, 
select the desired sort order from the Utilities menu (see fig. 12.15). 

Sort by Compan 
Sort by City 
Sort by St ate 
Sort by Zip Code 

Print Addresses 
Import TeMt ... 
EMport TeMt.. . 

./ Addresses 
Stacl< Oueruiew 
Sort Preferences 
Marl< Cards 

You can set the name sorting method by choosing Sort Preferences from 
the Utilities menu. This retrieves the window shown in figure 12.16. 

To indicate how the stack will sort names, complete items 1 and 2 . 

1. How did you enter the names 
in this stack? 

® First name first 

0 Last nam e first 

2. When sorting the stack by nam e: 

0 Sort by fire! name 

@ Sort by last name 

.. E~~mp.l.~.; ...... ·-·············· 
Bill Atkinson 
Marg~ Boots 
Sar ah Clark 
J~rom~ Domur at 
Jeffr~y H~rman 

Avril Hodg•s 
Mik~ Holm 
J im Palm~r 

Eric Quakenbush 
Robin Shank 

Return to Addresses ~~ 
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Fig. 12.17. 
The Notes window. 

If you entered the names first name first, as in Michael Cohen, click the 
First name first button. If you entered the last name first, as in Cohen, 
Michael, click the Last name first button. 

To sort names by the first name, click the Sort by first name button. To 
sort by last name, click the Sort by last name button. 

To return to the addresses, click the Return to Addresses button. 

You can enter notes about the address by clicking the Show Notes 
button. This opens a window in which you may type any notes you want 
(see fig. 12.17). 

.P.., .. !.}'!1n .. ~m;y,!b& ....................................................................... . 

. ~Jn~~J..9..~Z ... --····-··-· .. ·--·······-·······--······ ... ·········-· 

Hours are 10am-1pm, 3pm-7pm PST 
Find ... 

See also, D. Doylewitz: Hide Notes 

New Card 

Delete Card 

Click the Hide Notes button, which takes the place of the Show Notes 
button, to close the nates window. 

To print mailing labels, an address book, or a name and address list, 
perform the following steps: 

1. Choose the Print Report command from the File menu. 

2. Choose the report type you want to use (see fig. 12.18). 
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Fig. 12.18. 
Choosing a Name and 

Address list report. 

Part Ill 

c fil<l Ed it~ " Repor t ill!N [lng Labels" 

= Moiling Labels ~ All cords ([ Print ... I] r= 
Address Book D Morked cords 

order: ~~ 
( Cancel I 

~ "" 

c::n::Jt::J -- -

CJCJCJ 0 0' ~· ' ~~ 0 HH~O~ 0 FIHed height 

c:Jc::Jc::J ® Dynamic height 

.II I I Dlm""'"" I• " "" ll 
11 .. I _I Ulew : 0.562 

II II I ® Morglns lr'"':l 0 Size 0.875 I· 0.500 
T 0 Spacing o:;~o 

Header: !li'ile:l~ liDICI ------------------------------
II 

3. Click the Print button. 

To return to the Home stack, click the Home button. To open the 
Appointments stack, click the Appointments button. 

Working with Stacks 
The full capabilities of HyperCard are much to great to cover in this 
book. However, a small example of creating your own stack can give 
you some idea of what can be done with this application. 

I 

'fl 

Consider creating a simple stack that lists your CD, album, or tape 
collection. Each card will contain information about a single CD, list the 
songs or music on each track, and miscellaneous information you wam 
to include. 

Before creating this stack, perform the following steps to enable the 
scripting features in HyperCard: 

1. Double-dick the Home stack. 

If you are already in HyperCard, choose the Home command from 
the Go menu. 

2. Choose the Message command from the Go menu. The message 
box appears (see fig. 12.19). 

Adding Software and Hardware 



Fig. 12.20. 
The Preferences window. 

3. Type set user/eve! to 5. 

4. Press rerum. 

5. Click the close box of the message box. 

6. Press the left-arrow key once. The Preferences window appears 
(see fig. 12.20) . 

Preferences Home 
Your Nome: .......... ·----·-··---·---·-----·--·--··--.. ---·-··--............ . 

Entf'r .and @d1t tex t in fields. 0 Arrov Keys in Text 

Explore st acks but makr no chang~s. 

7. Choose the Message command from the Go menu. 

8. Type magic. 

9. Press rerum. 

10. Click the close box of the Message window. 

More user levels have appeared. The Scripting level is the most 
powerful and enables you to access the scripts of the objects in 
HyperCard. 

11. Press the right-arrow key to rerum to the Home stack. 

You are ready to begin creating and editing your own stacks. 
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Fig. 12.21. 
The Save dialog box in 

HyperCard. 

Creating a New Stack 

To create the new stack, perform the following steps: 

1. Choose the New Stack command from the File menu. The Save 
dialog box appears (see fig. 12.21). 

I eil Hypercard I 
D Ht l tlrt.>s~ •~s WiH1 fludio P=! 
D Ht>t>olntmt~ n ts With ... 
D HutHu lh~I J> 

D Honw 
•. lhiJH~r t: nnl 

New stock nome: 
I CD list 

0 Copy current background 
0 Open stock in new window 

= liard Disk 

H New il 
Cancel J 

I Cord size: !standard 9" 

1-512 ,., 

i' 
I 

2. Type the name of the stack, CD list, in this example. 

3. Click the New button. 

You "Will be presented with a screen that is blank except for the presence 
of the menu bar. This is the beginning of your new stack. 

Creating a Background 

The background comprises the items that are copied to each new card 
created. To begin creating your background, choose the New Back
ground command from the Objects menu. The menu bar is surrounded 
with dots to indicate that you are editing the background of all the cards 
(see fig. 12.22). 

Fig.12.22. ·· ., ··rita· ·rlilt . "rio · roois· · olljecls· ·rtirii · siyta· · · · · · · · · · · · · · · · · · · i':: 
The menu bar changes. 
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The first thing you should do is change the pattern of the background to 
something other than glaring white. Do so with the following steps: 

1. Choose the Paint Bucket paint tool from the Tools menu (see 
fig. 12.23). A Patterns menu appears and the mouse cursor nuns 
into a bucket. 
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Fig. 12.23. 
Choosing the Paint Bucket 

tool. 

2. Choose a pattern from the Patterns menu. 

3. Move the bucket cursor into the white area of the background, and 
dick the mouse button. 

The area fills with the chosen pattern. If you do not like the pattern you 
chose, choose the Undo command and repeat steps 2 and 3 to use a 
different pattern. 

Adding a Field 
You can add a field to enable you to type information into the card. To 
do this, perform the following steps: 

1. Choose the New Field command from the Objects menu. The new 
field will appear (see fig. 12.24). The field is surrounded by a 
moving, dashed line. This indicates that you may change its size by 
use of the mouse. 

2. Place the mouse pointer on the upper left comer of the field. 

3. Press and hold the mouse pointer. 

4. Drag the field corner until it is close to the edge of the screen. 

5. Drag the lower right corner until it is about an inch from the right 
of the screen. 

This gives you some room to type information into the field. You can 
move the field around the screen by dragging it. Place the mouse pointer 
in the center to do this. Several options that are not covered here can be 
viewed and changed by choosing the Field Info command from the 
Objects menu. You may want to experiment with these options. 
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Fig. 12.24. 
The new field appears. 
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Adding a Button 
From the sections on the supplied stacks, you have seen that buttons 
enable you to move from card to card. You c;u1 add buttons to your 
cards as well by using the following steps: 

1. Choose the New Button command from the Objects menu. The 
button appears (see fig. 12.25). 

2. Drag the button to the desired location; in this example, move it 
off the now white field and to the lower right corner of the screen. 

3. Repeat steps 1 and 2 until three buttons are stacked to the right of 
the screen (see fig. 12.26) . 

You can then change the names of the buttons by performing the 
fo llowing steps: 

1. Choose the button tool from the Tools menu. This tool is in the 
center of the top three tool icons imd has an icon of a button on it. 

2. Double-click the fust New Button. The Button Info dialog box 
appears (see fig. 12.27). 
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Fig. 12.25. 
The new button appears. 

Fig. 12.26. 
Adding bunons ro the 

background card . 
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Rg. 12.27. 
The Bunon Info 

dialog box. 

Rg. 12.28. 
The Link ro window. 
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Button Nome: I Neut Cord 
~----------------~ 

Bkgnd button number: 3 

Bkgnd button 10: 4" 
181 Show Nome 
D Auto Hi lite 
181 Shored llllite 

[ Icon ... J 

[ Effect ... ] 

[ LlnkTo ... J 

Style: 
0 Transparent 
0 Opaque 
0 Rectangle 
0 Shadow 
® Round Rect 
0 Check DoH 
0 Radio Button 

[ Script ... J t OK l) [ Cancel 

3. Type the new name, Next Card, in this example. 

4. Click the OK button. 

5. Repeat steps 4 through 6 for the next New Button; name it 
Previous Card. 

The third button is treated somewhat d ifferently with the following 
steps: 

1. Double-dick the last New Button. 

2. Type the name Home. 

3. Click the LinkTo button. The Link to window appears (see 
fig. 12.28). 

i!Dimi!mm::mm:mami!mm:m:m:mm:m!imi!!i!ii!i!ii!!i!ii!iii!!i!ii i!!mmmmm::m:m:::::gmg:: 

Linl< to: 

This Card ) ( This Stack: ) ( Cancel 

4. Choose the Home command from the Go menu. The Link to 
window stays on the screen. 

5. \Vhen the Home stack appears, click the l11is Card button. You are 
returned to the card you were working with. 

6 . Choose the Background command from the Edit menu. The menu 
bar returns to normal. 

Adding Software and Hardware 



Fig. 12.29. 
A sample card wid1 

information. 

7. Choose the Hand tool at the top left of the Tools menu . 

You have completed the background for your stack and are ready to 
begin adding information and cards. 

Adding lnfonnation 
To acid information to the first card of your new stack, simply click in the 
field area, which is the white rectangle, and type. You can choose a font 
from the Font menu and a point size or style for the text from the Style 
menu before typing. A sample card is shown in figure 12.29. 

Track I : The End of the Innocence 
k 2: How Bad Do You Want It? 

ck 3: I Will Not Go Quietly 
Track 4: The Last Worth less Evening 
Track 5: New Vor k Minute 
Track 6: Shangrt- La 
Track 7: Little Tin God 
Track B: Glmme What You Got 
Track 9: If Dir t Were Dollars 
Track I 0: The Hearl of the Matter 

The next section tells you how to add cards and make the Next Card and 
Previous Card buttons active. 

Adding Cards 

With the background set and the first card completed, you are ready to 
add cards to your stack Perform the following steps: 

1. Choose the New Card command from the Edit menu. 

2. Type the information you want to add. 
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3. Choose the Button wol from the Tools menu-the middle one on 
the top row. 

4. Double-click the Previous Card button. The Button Info window 
opens. 

; . Click the LinkTo button. The Link to window opens. 

6. Choose the Prev command from the Go menu. The previous card 
appears. 

7. Click the This Card button in the Link to window. You are 
returned to the second card. 

This process links the Previous Card button to the first card you created. 
When you click Previous Card, it will take you to that card. You can then 
link the first card w the current one by using the following steps: 

1. Choose the Prev command from the Go menu. 

2. Choose the Button tool from the Tools menu, if you have not 
already done so. 

3. Double-click the Next Card button. 

4. Click the Link to button. 

5. Choose the Next command from the Go menu. 

6. Click the This Card button in d1e Link to window. 

Choose d1e Hand tool to test your buttons. 

Editing a Stack 
Editing a stack can be done by adding cards, fields, and buttons, as you 
have seen in the previous section. You also can use the Edit menu to 
Cut, Copy, Paste, Clear, and Delete items. Remember that you must first 
select the corresponding button (Butwn tool for buttons, Field tool for 
fields) then click on the item to select it before the Edit menu will show 
the commands related to that item. 

The Edit menu also contains d1e commands to delete cards as well as 
create new ones. 

To make changes to the card background in a stack, you must choose 
the Background command from the Edit menu . After making changes 
to the background, choose the Background command again to resume 
working with cards. Changes made to the background affect all cards in 
the stack. 
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For buttons, the Button Info dialog box contains some effects you may 
want to try. Clicking the Effect button in this window presents you with 
a scrolling list of varying effects, such as iris close, dissolve, and venetian 
blinds. These effects occur when the button is clicked. Try these to see 
which effects you like. 

Several icons you may want to add to your buttons are displayed if you 
click on the Icon button in the Button Info dialog box. Click one in the 
scrolling list and click the OK button, and it is p laced in your button. 
The Button Info dialog box also has some options that change the 
appearance of the button itself. 

Buttons can be transparent. You can use this effect to place buttons over 
your text. You can add, for example, a button that enables you to click 
the song name and move to a card with the words, writers, or o ther 
information. You can place a transparem button on the singer's name to 
move you to his or her other CDs or albums. 

Choosing the Field tool from d1e Tools menu then double-clicking a 
field presents you with d1e Field Info dialog box. Here you can change 
the general appearance of a field or click the Fom button to change the 
font used in d1e field. 

Many possibilities exist. Don't be afraid to experiment. Do remember, 
however, that HyperCard does not have a Revert to Saved command. 
Before experimenting with a stack you like, choose the Save a Copy 
command from the File menu and create a backup copy. 

Reviewing Available Software 
he clays when Macintosh software could be reviewed in a single 
issue of a magazine are long gone. Now, magazines must reduce 
short capsule reviews to the top 1,000 software packages. 

Likewise, this section cannot cover all the possibilities available to you. 
Instead, a small sampling is presented to present the types of software 
you may want to consider for your Mac Classic. 

Check with your dealer, other users, and magazine reviews for fu rther 
information. See Appendix C, "Macintosh Resources." 
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Communications 

Communications packages enable you to connect with other computers 
via a modem (see Chapter 13). Communications packages fall roughly 
into CWQ categories: the general-use termimtl program and programs 
dedicated to a single on-line service. 

Two of the top tenninal emulation programs are MicroPhone II by 
Software Ventures Inc. and WhiteKnight by FreeSoft Company. Calling 
them terminal emulation programs is something of a misnomer because 
both have evolved far beyond their simple beginnings. Both programs 
enable you to log on to other computers, communicate with them, and 
transfer files becween them. 

MicroPhone II is perhaps the more sophisticated and more expensive of 
the cwo. The program provides extensive scripting that enables you to 
automate many on-line tasks. 

WhiteKnight is the descendant of the well-known Red Ryder shareware 
program. WhiteKnight is highly popular, although some users complain 
about its interfnce being difficult to use. 

You might also consider SmartCom II by Hayes Microcomputer Prod
ucts, the creators of the industry standard Hayes modem. Less powerful 
than some, SmartCom n is relatively inexpensive and easy to use. 

If you are interested in one of the larger on-line services, you should 
consider Navigator for CompuServe o r the package provided when you 
sign on to America Online. 

To gain access to CompuServe, you purchase a membership kit from a 
dealer, mail-order company, or CompuServe directly. This kit provides 
you with the information you need to log on to and sign up for the 
CompuServe info rmation service. You then gain access to the bulletin 
boards, newspapers, magazines, stock quotes, interacth•e games, and 
much more. 

The CompuServe Navigator program automates much of the work of 
logging on, acquiring your electronic mail, posting and retrieving forum 
or bulletin board messages, and downloading program and other 
information (see fig. 12.30). 

It is not necessary to have Navigator to access CompuServe, but the 
program can save you quite a bit of money. CompuServe charges an 
hourly rate based on the speed of your modem: the higher the speed, 
the higher the hourly charge. The rate, however, does not rise in 
proportion to the speed. In the long run, it is cheaper to use the fastest 
modem available to you. 
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Fig. 12.30. 
Using Navigator to 

compose a message. 

Fig. 12.31. 
Writing a message on 

America Online. 

One of the competing services, America Online , provides you with the 
package necessary to use its service (see fig. 12.31). 

To: MociJay 

Subj: I The Book 

F l ie: [==~~~~~~~~~=:=~~~~:~:~~==] 
So for the nex t b 

Sond Lator 
I 

S•nd Now 

S/ 6 The Apple Menu 
S/7 Fonts in 7.0 
S/ 8 M iscelloneous 
S/ 9 Compotlbility 
Sl I o Publish/ Subscribe 
Sl I I File Shoring / Ne ts 
S/ 12 The HELP!!! Section 
S/ 13 

0 Return Receipt 
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The program can be somewhat stubborn when you first set up and the 
service is slow in response, but the program is easy to use. America 
Online offers fewer services than CompuServe but costs much less. 

The GEnie info rmatio n system offers no communications package of its 
own at this writing. You can use MicroPhone II, WhiteKnight, or any 
similar package to access its services. 

Databases 
Databases store, link, manage, and report information. If your needs are 
to manage client records, mailing lists, or something similar, you should 
consider a database. 

At the top of the line are such packages as 4th Dimension by ACIUS and 
Double Helix by Odesta Corp. Both require a hard drive to use, and both 
are rather expensive. You should consult a dealer before taking the 
plunge with products of this size and power. They may run slowly on the 
Mac Classic. 

For those famiHar with dBASE III o n the IBM PC, FoxBASE+/Mac is a 
good option to consider. This package provides dBASE III+ emulation, 
which enables you to run programs and access databases created with 
the widespread dBASE Lll+ application. foxBASE+/Mac requires a hard 
disk and is fairly high priced. 

Several smaller, less expensive packages exist for the user who does not 
have a large volume of information to handle. DAtabase by Baseline and 
TouchBase by After Hours Software are two examples of good low-end 
packages. 

For handling picture-orientated data, Filevision IV is offered by TSP 
Software. 

Desktop Publishing 
This category covers page layout and design programs. If you are 
considering creating newsletters, manuals, or other printed materials, 
consider programs from this section. 

Aldus PageMaker is perhaps the best known program in this category. It 
is rather expensive but is very powerful and has become somewhat of a 
standard. Aldus states that it wiU run on any machine from the Mac Plus 
o n (thus including the Mac Classic) d1at has a hard drive. At the same 
time, you may want to find a dealer where you can "try before you buy" 
to see how quickly the progr:tm works on a Classic. 
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Several templates, which are defined and formatted page layouts, exist 
for PageMaker, including Layouts by Postcraft International and PDQ! by 
PAR Publishing. 

QuarkXPress by Quark Inc. is another powerful program designed to run 
on machines from the Mac Plus on up. Two megabytes of memory 
minimum and a hard disk are required for this program. 

For the budget minded, Publish It! Easy by Timeworks Inc. or Ready, Set, 
Go! by Letraset USA are worth considering. 

Visual presentations can be created by using PowerPoint by Microsoft o r 
Persuasion by Aldus. Because the Mac Classic does not yet have color, 
however, presentations might best be left to the colo r Macintoshes. 

Educational 
The number of products that act as teaching companions is quite large. 
Only a few programs can even be mentioned in the space of this book. 

For preschool children, Alphabet Blocks by Bright Star Technology 
teaches the letters and sounds of the alphabet. Reader Rabbit by The 
Learning Co. works with 4- to 8-year-olds on reading fundamentals. The 
Playroom by Broderbund Software covers basic concepts, such as telling 
time, counting, and spell ing. Math is explored in such programs as 
KidsMath and NumberMaze by Great Wave Software. 

If you need to learn to type, consider Mavis Beacon Teaches Typing by 
Software Toolworks or Type! by Broderbund Software. 

History is explored in the educational game Where in Time is Carmen 
Sandiego? by Broderbund Software. This popular game is fourth in a 
series, all of which are highly popular and quite educational. Point of 
View by Scholastic Software covers American History. 

Interactive Physics by Knowledge Revolution and Physics by Broderbund 
both teach physics through animated experiments. A related product, 
Voyages by Carina Software, is a desktop planetarium that teaches 
astronomy. 

To learn foreign languages, such companies as Penton Overseas Inc. 
offer packages that teach Spanish, French, German, Italian, and many 
others. 

SAT packages are offered by Spinnaker Educational Software and 
SrudyWare. The latter also has packages for the ACT, GMAT, GRE, and 
LSAT tests. 
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For learning the Macintosh and Macintosh software, consider the 
offerings from such companies as Personal Training Systems, Individual 
Software, and Voice & Video. These companies have far too many 
packages co list here but include such packages as teaching programs 
and videos for the Macintosh, Microsoft Word, and PageMaker. 

Entertainment 

The entertainment category covers a vast number of games co amuse and 
relax you after working with your Mac Classic. 

Chess lovers may want to consider Chessmaster 2000 by Software 
Toolworks. It enables two- and three-dimensional boards and actually 
responds vocally to your moves. Sargon 4 by Spinnaker offers several 
levels of play and can coach newcomers with a novice mode. 

The ever popular Terris and the new Welltris, both imported from the 
USSR, are offered by Holobyte. These arcade-style games have been 
known to keep many users glued to the Macintosh screen into the late 
hours of the night. 

Two old standbys, Crystal Quest by Casady & Greene and Dark Castle by 
Aldus, have been popular for many years in the Macintosh world. Both 
are animated arcade-style games. 

Flight simulacor buffs might want to look into Falcon by Holobyte, which 
simulates an F-16 dog fight. 

For the more thought-provoking, slower-paced games, consider Balance 
of Power and Balance of the Planet by Accolade. In the first, you are 
responsible for maintaining peace in a bipolar or multipolar world while 
increasing your country's influence; the game is a bit dated with current 
events but engaging, nonetheless. In the second game, your responsibil
ity is saving the em~ronment from destruction. 

Financial 
One of the best uses of your Mac Classic is to balance your budget and 
control your finances. After aU, with all that power on your desk, the 
least you can do is use it to save money. 

Managing Your Money by Meca Ventures has become perhaps the most 
popular software package in the area of personal finance. The program 
enables you to create budgets, define categories of expenses and 
income, and produce several reports. 
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The midrange is occupied by MacMoney by Survivor Software and 
Dollars and Sense by Software Toolworks. Both track your financial 
transactions and offer various reports to help you keep watch on your 
money. 

The least expensive packages are Quicken by Intuit and Checkwriter II 
by Aatrix Software. Both are primarily checkbook management programs 
that offer only limited reporting capabilities. 

You also should consider MaclnTax by Softview. This program helps you 
fill out your tax forms and will even print the completed forms on a laser 
printer. Many personal finance packages are now designed to work with 
MaclnTax to reduce your tax-time headaches. 

Graphics 
Graphics programs divide into two basic subcategories. Drawing 
programs work with objects, such as squares, circles, and lines, and 
painting programs work with the individual dots on the screen. The lines 
between them are blurring now as programs become more powerful. 

Canvas by Deneba Software is an example of a powerful program that 
does both drawing and painting. It offers such features as Bezier curves, 
skewing, perspective, and autotracing. 

Super Paint by Silicon Beach is one of my favorites. The screen shots in 
this book were edited by using this combination draw and paint pro
gram. The program is easy to use but powerful enough to be used by at 
least one graphic artist I know. 

MacDraw by Claris is an object-oriented drawing program that is well 
suited for such things as small architectural drawings and presentations. 

For the artistic, programs such as Studio/1 by Electronic Arts may be 
worth considering. This program includes the capability to create flip 
frame animation. 

The most powerful and expensive programs are Freehand by Aldus 
Corp. and Illustrator by Adobe. Both are o riented towards the profes
sional artist and require quite a bit of memory to run-at least two 
megabytes. You also should have a hard disk. Both are PostScript 
packages for producing high-quality art on PostScript laser printers. 
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Music 
Music programs in this category enable you to create musical scores or 
work to drive electronic instruments through a MLDI or both. lf you are 
interested in such endeavors, you should speak with other users to 
determine the best products. 

Encore ;md NoteWriter fl by Passport Designs, Finale by Coda Music 
Software, and Professional Composer by Mark of the Unicorn are 
available for composing and scoring music. Professional Composer can 
export to Performer by the same company to play the scored music 
d1rough a MIDI interface. 

EZ Vision by Opcode Systems is reported to be a lower-cost, easy-to-use 
MlDI package that might be considered by beginners. For those who 
simply like to play around, jam Session by Broderbund might be a good 
choice. 

Users who are more serious about using the Mac Classic for music 
should consider Cue by Opcode Systems. This package is geared to 
creating fum scores. 

Beyond by Dr. T's Music Software Inc., ConcertWare+ MIDI by 
GreatWave Software, and Master Tracks PRO 4 by Passport Designs are 
d1ree packages used with a MIDI interface, hardware that hooks to MIDI 
synthesizers, to sequence and record music. 

For d10se who want to learn to make music with a Mac, Listen by Imaja 
teaches piano keyboards and guitar fret boards. Perceive by Coda Music 
Software is geared primarily for the school environment but is re latively 
inexpensive and might be considered for the serious student. Practica 
Musica byArs Nova Software uses an interactive game and practice 
approach to learning music theory and ear training. 

Spreadsheets 
lf you need to create tables of numbers and tabulate them according to 
various fo rmulas, you need a spreadsheet program. These application 
programs enable you to enter numbers in columns and rows, then 
manipulate d1em according to formulas you design. Many also offer 
reporting and graphing capabilities. 

The most po pular Macintosh spreadsheet is Excel by Microsoft. The 
program offers powerful search and replace features and enables you to 
create links bet\veen documents in order d1at information in them can 
be updated when another document is changed. Excel also enables 
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customizing of menus, matrix math, statistical functions, macros, 
outlining, and style sheets. 

Another high-end program is FuU Impact by Ashton-Tate. This program 
offers global search and replace features, programmable buttons, three
dimensional charting, and can read and write Excel spreadsheets . 

• 
Informix offers the high-e nd program WingZ, which features three-
dimensional graphing, custom macros, and extensive menu, function, 
and option customizing through the use of the Hyperscript language. 

For the user with simpler needs, MacCalc is offered by Bravo Techno
logies. Works by Microsoft is also easy to use and less expensive. Neither 
would be weU suited to extensive business needs but are good for the 
average user who wishes to evaluate finances or other numeric data and 
experiment with changing various values within the information to view 
results. 

Word Processing 
In the word processing field, you have many choices, and your selection 
will depend on the amount of power you need and the amount of 
money you are willing to spend. Word processing packages aid you in 
creating and editing text documents. Many offer graphics and text 
formatting capabilities. They are used for various kinds of writing 
ranging from personal letters to novels. 

In the lower-cost category, WriteNow by T/Maker is a good choice. The 
program comes with a large thesaurus and is easy to learn and use. 
T/Maker is, at this writing, bundling the program with a grammar
checking program. 

At a slightly more expensive price is MacWrite ll by Claris . This rewrite of 
the first Macintosh word processor startled me in its quality. For the 
average user, it is an excellent choice because it is easy to learn and use 
yet powerful. It includes speU checking, a thesaurus, and the capability 
to create multiple columns. Claris is now creating a more advanced, 
feature-enhanced version of the program to be called MacWrite Pro. 

The most popular word processor on the Macintosh is Microsoft Word 
4.0. After a complete redesign, this program actually is beginning to look 
Like it belongs on a Macintosh instead of an IBM PC. Despite its difficult 
interface and weU-hidden commands, Word still has to be one of the 
most powerful and flexible word processors on the Macintosh to date. 
If you need style sheets, tables, and powerful formatting, Word is worth 
consideration. 
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Nisus by Paragon Computing is orien ted to users who need control over 
long documents. Although Microsoft Word appears co be migrating into 
the deskcop publishing category, Nisus is aimed at text editing. By 
borrowing the grep (General Regular Expressions Processor) text-editing 
concept from the UNrx world, the program offers some of the most 
complex search-and-replace functions seen in a word processor. It also 
offers extensive macros. 

WordPerfect by WordPerfect Corp is the Macintosh implementation of 
the dominant IBM PC word processor. This program is powerful but 
suffers from a development staff not well versed in the Macintosh way 
and can be difficult to use. 

his chapter introduced you to application software for the Mac 
Classic and discussed the basics of the included HyperCard 
program, including creating, using, and editing stacks. 

You also received a brief survey of the available software that you might 
consider fo r your Mac Classic. More investigation is called for before 
purchasing software. You should check such magazines as Mac User and 
Macworld fo r their reviews and consider books written about the 
application to determine its suitability for your needs. 

Money-back guarantees are becoming more common in the Macintosh 
world. You should purchase from dealers and mail-order houses that 
offer a money-back return policy if a package does not live up to its 
reviews and brochures. 
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he time may come when you fmd you need something extra for 
your Mac Classic. Perhaps you find yourself receiving too many 
out-of-memory messages; your hard disk is reaching its limits; you 

tire of swapping dozens of disks; or you tire of the mouse and wonder 
whether a better device exists. 

You can consider many hardware options for expanding your Mac 
Classic. These options range from quick, inexpensive memory additions 
to CD-ROM drives that give you access to hundreds of megabytes of 
information. 

This chapter discusses hardware in general terms to give you an under
standing of what your options are rather than recommending specific 
items. 

Your dealer is a good source for hardware. Many dealers are com
petitive in price even with mail-order houses. A good dealer also can 
help you select the best hardware and help you with setup and potential 
problems. 

If you are on a budget, mail o rder is a good alternative. Remember, 
however, that many mail-order companies offer no support if you 
encounter problems. You should check with other users to determine 
their experiences with a particular mail-order house. 
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For computer tasks where you need a component only for a short period 
of time, dealers in many larger cities and some mail-order companies 
o ffer rental agreements. 

ecause of the creativity of hardware manufacturers, more hard
ware and types of hardware hit the market continually. To keep 
yourself up-w-date, consider subscribing to one of the major 

Macintosh magazines (see Appendix C, "Macintosh Resources"). 

The fo llowing are basic hardware items you can add to your Mac Classic: 

• Additional drives. This category includes e.uernal floppy d isk 
d rives, internal and external hard disk drives, and the more 
advanced optical (CO-ROM and WORM) and tape drives, which 
usually are used for backing up hard disks. 

• Keyboards. A wide variety of keyboards exist for all Macintosh 
computers. 

• Mem ory upgrades. This category includes items you can use to 
add memory to your Mac Classic. 

• Pointing devices. The mouse is not the only device you can use 
fo r pointing at items on-screen. You may want to consider one of 
the alternatives. 

• Modems and fax modem s. These items help you to communicate 
with the outside world. Modems can link you to on-line services 
and bulle tin boards, and fax modems can add the capability of 
sending and receiving faxes on your Mac Classic. 

• Printers. You can choose from an abundance of printer types. The 
different types of laser printers alone could fill this book. 

• Scanners. For users who want to impo1t art, pictures, and even 
large amounts of text, a scanner is a useful addition. 

• Sound recorders. The Mac Classic has no built-in microphone. To 
take advantage of the spreading use of sound, you may want to 
consider adding a sound-input device. 

• Useful accessories. You can choose items to help you cut screen 
glare, raise your Mac Classic to a comfortable level, or even have a 
"pocket" for storing your mouse. 
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Additional Drives 
This diverse category includes external floppy disk drives, hard disks, 
CD-ROMs, WORMs, and optical drives. All items add more storage or 
information-accessing capacity to your Macintosh. 

Floppy Disk Drives 
lf you use a Mac Classic with a floppy disk drive only or find yourself 
swapping disks when copying them, you may want to consider an 
external floppy disk drive. Because prices of hard disk drives have 
dropped, fewer external floppy drives exist but you still can buy them 
relatively inexpensively. External floppy disk drives attach quickly to the 
floppy disk drive port behind your Mac Classic and need special software 
only for special formats. The drives come in one of the five following 
formats: 

• BOOK. The least expensive external drive stores only BOOK on each 
disk. This drive does not use high-density disks. 

• 1.4 megabyte. Also called 1.44 megabyte (with megabyte often 
abbreviated as M or MB), this drive can use high-density disks, just 
like the internal floppy drive of your Mac Classic. 

• 2.4 megabyte. At least one company provides a drive that can 
store almost nvice as much on high-density disks. If you use this 
nonstandard format, however, you cannot share the d isks with 
anyone who does not have the same drive from the same com
pany. This drive usually is used to back up a hard disk. 

• MS-DOS 360K 5 1/4-inch. This type of drive adds the capability to 
fom1at, read from, and write to the o lder standard IBM PC disks. 
The drive, however, requires special software that may or may not 
come with the disk drive. 

• MS-DOS 1.2 megabyte 5 1/2-inch. This drive can format, read 
from, and write to the newer high-density IBM PC disks but 
requires special software. 

Hard Disk Drives 
Hard disk drives can be internal or external. lf you want an internal hard 
disk installed in your Mac Classic, see your dealer. Trying to install a 
hard disk drive yourself can be dangerous to you and your Mac Classic 
and voids your Apple warranty. 

Chapter 13 
Expanding Your Mac Classic 



Part Ill 

You easily can add an external hard disk drive by plugging one into the 
SCSI port behind your Mac Classic. Floppy drive-only users also may find 
this route less expensive than having an internal hard disk installed . 

The following sections deal with several features you must consider 
when choosing a hard disk drive. 

Capacity 
Hard-disk capacity ranges from as little as 20 megabytes to as much as 1 
gigabyte (1 billion bytes). The amount you choose depends on your 
needs. Most users today find a 40-megabyte drive to be the minimum 
they can live with comfortably. 

If you add a second hard disk, consider how quickly you filled the first. A 
second drive probably should have as much capacity if not more than 
the flrst internal drive. The 60-megabyte to 100-megabyte drives are 
worth consideration. 

Although hard disk capacity is advertised in round numbers, such as 
20-megabyte, 30-megabyte, and 40-megabyte, no disk gives you full 
capacity. Formatting and invisible maintenance files require disk space. 
Determine how much the disk actually delivers when formatted. Many 
magazines te ll you actual capacity after formatting. 

SCSI Termination and 10 Selection 
SCSI stands for Small Computer System Interface, a st:mdard, high-speed 
method used to connect devices to microcomputers like the Mac Classic. 
SCSI is now tl1e dominant system used to connect hard disks to the 
Macintosh computer. 

When you add SCSI devices to your Mac Classic, you must deal with 
termination. Termination reduces the occurrence of electrical noise in 
SCSI connections. An SCSI chain must have termination in some form. 
Determine how easily you can change the termination of the hard disk. 
Using a plug or switch is easy to change. Internal termination is a 
problem tl1at o ften can require you to open the drive case and move 
jumpers or make some other adjustment. 

Each SCSI device must have a unique number. Using an external switch, 
such as a thumb or rotary switch, to set the number is the most conve
nient method. DIP (Dual In-line Package) switches can be inconvenient 
but are preferred to drives using software to set numbers. 
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Seek Time 
Seek time is the amount of time the disk uses to locate a requested item 
of data. lf you see 40ms (milliseconds), for example, this figure indicates 
that the drive requires 40 milliseconds (thousandths of a second) to 
locate information. The lower the number, the faster the disk drive. Seek 
times now range from the lower to middle teens to as much as 90ms. 
The 20-40ms range is average. 

The faster a drive is, the more the drive costs. You must decide whether 
the speed is worth the money. 

Other Considerations 
You also should consider the length of the warranty offered, whether the 
company offers telephone support and data recovery in case of prob
lems, and whether the drive will fit on your desk. 

Many drives come with software of various types. Check to see whether 
the drive comes with software for backing up data. Ask whether any 
utilities are offered. 

Don't forget to check the length of the supplied cable. SCSI cables are 
not cheap. lf you must place the drive some distance from your Mac 
Classic and only a short cable is supplied, you may need to buy a 
separate SCSI cable. 

CD-ROM Drives 
These optical drives read information by using a laser. They cannot store 
information but can give you access to a large number of fonts, graphics, 
and o ther information. Whole encyclopedias are available now on 
CD-ROM. 

CD-ROM drives are much slower than a typical hard disk. To run, they 
also require special software, which usually comes with the disk drive. 
You may want to consult magazines and other users to see whether the 
software is easy to use. 

Although the prices of these drives continue to fall, many of the disks 
themselves are· expensive. Besides pricing the drive, you should check 
the prices of the disks you are interested in before purchasing a CD-ROM 
drive. 
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WORM Drives 
The Write Once Read Many (WORM) drive enables you to write only 
once to any part of the disk. Because a laser burns tiny holes of data into 
the disk, information can be deleted but never truly erased. When a disk 
is full, you must use another. 

Because you cannot erase the disks, these drives are best for archiving 
and backup. They offer high capacity and can store enormous amounts 
of information-in the range of 600 megabytes per disk. 

&asable Optical Drives 
These extremely high capacity drives offer the capability to erase and 
store information. Extremely high in price-usually more than three 
times the Classic itself-they are slow compared to a regular hard disk. 

The storage capacity is enormous, however, and ranges in the area of 
600 megabytes. Consider erasable optical drives only if you have large 
amounts of data you must work with. 

Keyboards 

Although the keyboard that comes with the Mac Classic is well designed, 
some people may want to consider one of the larger, third-party key
boards. 

Choosing a keyboard is basically a matter of taste. The best approach is 
to buy from a store where you can try out a keyboard or find another 
user who is willing to let you try his or her keyboard. 

Many keyboards come with function keys that the Macintosh does not 
take advantage of. By using a macro program, which many keyboards 
now come with, you can assign these keys many useful tasks. 

One keyboard by DataDesk enables you to customize. You can arrange 
key modules, such as the function keys and numeric keypad, as you 
want. 

Be certain dm the keyboard is an ADB (Apple Desktop Bus) keyboard. 
The few non-ADB keyboards, for older Macintoshes, don't work with the 
Mac Classic. 
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Memory Upgrades 
The Mac Classic comes with 1 megabyte or 2 megabytes of memory but 
has the capability to use as much as 4 megabytes of memory. As inexpen
sive as memory is today, you should consider upgrading your Mac 
Classic's memory first. 

Memory in the Macintosh world comes in SIMMs, or single in-line 
memory modules, which plug into your computer to add memory. 
SIMMs usually are rated by capacity (1 megabyte, 2 megabytes, 4 
megabytes, and up) and speed in nanoseconds (ns, or billionths of a 
second). The Mac Classic uses d1e 100-ns, ! -megabyte SIMMs. 

For a !-megabyte Mac Classic, you can add a memory card containing 
one or three !-megabyte SJMMS. The 2-megabyte Mac Classics come with 
a memory card containing one 1-megabyte SIMM. This card has two slots 
to which you may add two !-megabyte SIMMs. 

Many mail-order companies offer instructions, tools, and videos to help 
you upgrade memory yourself. Although the task is quite easy, you still 
face some risk. Opening the cover of your Mac Classic voids the Apple 
warranty. Having a dealer upgrade the memory may cost more, but you 
keep your warranty. 

Modems and Faxes 
To communicate with the outside world, consider a modem or a fax
modem combination. These devices give you the capability to access on
line services and bulletin boards or to send and receive faxes with your 
Mac Classic. 

Modems 
The primary concern with a modem is speed. Speed is measured in 
baud, which represents the number of bits that the modem can send per 
second (bps, or bits per second). 

Standard modems work at 1200 or 2400 baud, but 4800 and 9600 baud 
modems also are available. The fas ter the modem, the more expensive. 

If you use an on-line service, such as CompuServe, the faster your 
modem is, the higher the hourly rate is. That rate, however, does not rise 
proportionally, which means that using a modem that is twice as fast 
does not cost t\vice as much. If you plan to use CompuServe often, the 
higher-speed, higher-cost modems actually save you money over me 
long-term. 
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Most modems these days are Hayes-compatible, which means they use a 
standardized set of commands. Following this standard makes modems 
easier to use and less difficult to configure to your communications 
software. 

Many modems also come with communications software, which can save 
you money because you don't need to buy separate communications 
software. Chapter 12 discusses some of the communications software 
available for use with modems. 

Fax Modems 
Faxing has come to the Macintosh world in the form of fax modems. 
Usually you find that a 2400 baud modem is combined with a 9600 baud 
Group 3 fax, which is the most common fax standard. If you think you 
eventually may need both devices, consider a combined unit rather than 
purchasing a modem separately . 

You have two choices in this area: fax modems that send only or those 
that send and receive. If you don't want to receive faxes, a modem that 
only sends faxes saves you money. 

All fax modems come with software. You may want to consult magazines 
to determine the ease of use and quality of the fax modem. 

Pointing Devices 
Several companies offer replacements fo r the mouse. Some companies 
even offer features not found in the Apple-supplied mouse. You may 
want to investigate one of these alternatives to replace an older mouse 
or to take advantage of a unique feature. 

The mouse is no longer the only device you mn use to point to items on
screen. Perhaps the most popular mouse alternative is the trackball, but 
other devices are available, including touch pads, touch screens, and 
mouse pens. 

Like keyboards, any mouse or alternative that is ADB (Apple Desktop 
Bus) compatible can be used with your Mac Classic. 

Mice 
Although some mice merely replace the Apple mouse, a few offer unique 
features. Smaller mice are easier to manipulate. Others offer higher 
resolution, such as 300 dpi (dots per inch). The higher the resolution, 
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the greater the control you have over the mouse pointer on-screen. 
Users who work with graphics may want to use a higher-resolution 
mouse. At least one mouse connects to your Mac Classic with an infrared 
light rather than a cord. 

Trackballs 
The trackball looks like an upside-down mouse, because the ball is on 
top rather than on bottom. Usually your palm or fingers rest on the 
ball, and the trackball remains stationary, which reduces the amount of 
necessary hand movement The thumb or other finger presses the 
buttons, which usually are located on the sides. 

Other Pointing Devices 
You may want to consider several other devices, including a graphics 
tablet. This tablet enables you to draw on a surface while the drawing is 
translated into movements on the Mac Classic screen. A related device, 
the digitizing tablet, enables you to trace pictures and other items into 
graphics software. 

You can substitute your finger for the mouse with a touch screen, also 
know as touch-sensitive display or touch pad. Other items, such as pen
like mice and joysticks, can be considered, depending on your needs. 

Printers 
Printers fall into three basic categories, depending on the method they 
use to place images on paper: dot-matrix, inkjet, and laser. 

Resolution determines a printer's print quality. Resolution is expressed 
in the number of dots the printer can place in each inch on the page. 
Numbers range from 72 dpi (dots per inch), which is the resolution of 
your Mac Classic screen, to highs of 1,000 dpi or more. The higher this 
number is, the more a printer is capable of high-quality printing. 

You also may want to review Chapter 10 for more information on 
printers. 

Dot-Matrix 
All printers actually form images by placing dots on paper. Dot-matrix 
refers to printers that use a mechanical solenoid that strikes an ink 
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ribbon to create those dots. The Image Writer II and LQ are examples of 
dot-matrix printers. 

Dot-matrix printers tend to be noisy and are no longer as much of a 
bargain as they once were. However, they are the only printers that can 
handle such multipart forms as invoices. 

These printers usually have fairly low resolution; the print quality is not 
as good as that of Inkjet and laser printers. With prices falling on the 
o ther printers, you may find that dot-matrix is no longer the best route. 

Inkjet 

Inkjet printers spray ink on the paper to create printed images. They can 
produce resolutions that rival laser printers but are usually much slower. 
Inkjet printers also do nor use PostScript and, therefore, do not provide 
the quality of PostScript laser printers. 

Some inkjet printers, such as the Style Writer from Apple, can handle the 
new True Type font standard. This capability improves the quality of text 
but does nothing for graphics. 

Because they rely on the QuickDraw routines in the Macintosh ROM, 
inkjet printers often are called QuickDraw printers. This term differenti
ates inkjet printers and some laser printers from PostScript printers that 
use the PostScript language to create text and graphics. 

The biggest drawback of Inkjet printing is that the print may have a 
tendency to smear. You should look at printing samples before purchas
ing such a printer. However, inkjet printers are good choices because 
they provide high-quality printing at a low price. 

laser Printers 

Laser printers are quickly becoming the printers of choice, because they 
offer high-quality printing and good to excellent speed depending on 
the model. These printers fall into two categories: PostScript printers, 
including PostScript clones, and non-PostScript printers that use 
QuickDraw and may use True Type. 

PostScript Printers 
PostScript printers are the highest quality printers for the Macintosh. 
They produce the best quality text and graphics. If you plan to do many 
graphics, consider one of these printers because they work better and 
faster. 
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PostScript clones, many far cheaper than the original, have appeared on 
the market. They may represent a good choice, but some clones poorly 
imitate PostScript. Pay close attention to magazine reviews to determine 
whether the printer actually can handle your documents. 

Many non-PostScript printers have optional upgrades to PostScript. This 
way, you can purchase the printer and add PostScript at a later date. 

Non-PostScript Printers 
These printers use the Macintosh's QuickDraw routines and, in some 
cases, TrueType in printing your documents. The print quality may not 
be as good as a PostScript printer but may be suitable for your needs. 

If you do more text than graphics, you may want to consider one of 
these printers. You can improve text quality by using True Type, which is 
built into some printers, including the Personal Laser LS from Apple, or 
Adobe Systems ATM, which enables you to use PostScript fonts. 

Some non-PostScript printers offer upgrades to PostScript. Check to be 
certain that the upgrade price is not too high. In the long run, buying a 
PostScript printer first may make more sense if the upgrade price is wo 
high. 

Scanners 
Scanners input text and graphics directly into your Macintosh. Some 
scanners work like a photocopy machine: you place the document on a 
glass plate, and the image is scanned into the Macintosh. Hand-held 
scanners are passed over the document, usually more than once. 

If you find that you need to input large amounts of text from printed 
documents or want to work with photographs and other illustrations, a 
scanner may be for you. Scanners, however, do not scan text perfectly. 
You must edit carefully to catch errors. 

Pay careful attention to magazine reviews of the software that comes 
with a scanner as well as the scanner's performance. You also must ask 
your dealer whether the scanner stores documents compatible with your 
software. 

Sound Recorders 
Chapter 12 shows how to use the supplied HyperCard stacks called 
Appointments With Audio and Addresses With Audio. Although you can 
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use these stacks without sound, you may want to add sound capability. 
You may want to mke advantage of the applications now appearing that 
use sound fo r annotation and other purposes. 

Chapter 12 does not discuss sound because the Mac Classic has no built
in recorder. At least two companies, however, manufacture sound 
recorders that you can add to your Mac Classic. 

FaraHon offers the MacRecorder Sound System 2.0, which includes the 
hardware and software you need to record sound on your Mac Classic, 
including the interfaces to add sound to HyperCard stacks. Because the 
size of sound files can be quite large, you may want a hard disk on your 
Mac Classic to handle the system. 

Articulate Systems has Voice Link with Voice Record that can add sound 
and music. The company recommends 2 megabytes of memory and a 
hard disk for the system. 

Articulate Systems also offers the Voice Navigator U. Although it is rather 
expensive, th is system enables you to issue spoken commands to your 
Mac Classic and acts as a sound recorder. 

Useful Accessories 
You can choose many accessories to protect your Mac Classic and make 
working with the computer more pleasant and productive. Because so 
many of these accessories exist, listing them all is almost impossible, but 
this section discusses a few interesting devices. 

One of the most imporunt accessories is a power surge protector. 
Although these devices cannot protect your Mac Classic from direct 
lightning strikes, d1ey can protect against the common, erratic power 
surges from utility companies. During a dlUnderstorm, your best 
protection is to unplug the Mac Classic. Lightning strikes can damage a 
computer that is off but still plugged in. 

If you live in an area where brownouts o r blackouts are common, you 
may need an uninterruptable power supply. Such units offer protection 
against power drops and power surges. They also provide a power 
backup to enable you to shut down safely in a power outage. 

If you find that you need to transport your Mac Classic, many padded 
can ying cases are available. Although they cannot protect against strong 
jolts, they can help reduce the effect of the accidental bump. Most cases 
also offer pockets in which you can carry disks and od1er items. 
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Chapter Summary 

For extra protection against dust, inexpensive dust covers are available 
and are recommended for all users, especially those in desert areas. 

To reduce fatigue when you work with your Mac Classic for extended 
periods of time, try raising the screen to eye level with a monitor stand. 
Some stands offer additional storage areas for keyboard, mouse, and 
o ther desktop items to help reclaim lost desk space. Some desks 
designed for Macintosh users also enable you to adjust the hdght of the 
Mac Classic and the keyboard to make them more comfortable to use. 

Glare screens help to reduce eyestrain. You also can buy wrist pads if 
you type for long periods of time. 

his chapter presented a broad overview of some of the many 
hardware options available for your Mac Classic. For more 
information, consult magazines, your dealer, or other users. 

You now know how to add storage space with external floppy and hard 
disk drives. This chapter presented possible memory upgrades and 
keyboard and mouse alternatives. You learned to add modems and fax 
modems so you can communicate with the outside world. The chapter 
discussed the different types of printers available, scanners, sound 
recorders, and miscellaneous accessories. 

Now you should have a good basis fo r understanding and using your 
Mac Classic so that you can upgrade, add software, and buy accessories 
to give you more power and enjoyment. 
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ystem 7 represents a major advance in the operating system of the 
Macintosh. However, because System 7 encompasses such major 
changes, several issues must be considered carefully before 

making the transition. 

When changing to System 7, you must consider the three following 
questions: 

1. Do you have enough memory to effectively run System 7? 

Although System 7 officially runs in 2 megabytes of memory, this 
is not really enough space to use it productively. The best 
configuration is to upgrade your Mac Classic wits full, 4 mega
bytes capacity (see Chapter 13) , especially because purchasing 
memory is relatively inexpensive these days. 

2. Do you bave hard disk space? 

Apple does not recommend- nor do !- attempting to run 
System 7 from a floppy-disk system. If you do not have a hard 
disk, you should not upgrade to System 7. 

3 . Are your applications compatible with System 7? 

Due to the major change in the System software, many applica
tions are not yet compatible with the new version. The System 7 
upgrade package is relatively inexpensive, but upgrading all your 
software packages can be very expensive. 



Fig. A.l. 
Checking software 

compatibility. 

Apple provides a Compatibility Checker HyperCard stack that you may 
acquire from your dealer, on-line setvices, user groups, or the System 7 
Personal Upgrade kit. This stack checks the software on your hard disk 
and tells whether you need to upgrade the software. 

To run the compatibility checker, you need HyperCard 2.0. To check the 
compatibility of your software, perform the following steps: 

1. Double-click the Compatibility Checker stack icon on disk. 

2. Click the Start Checking button (see fig. A.l). 

Checking compatibil ity of "Hard Disk" 

To cancel, type Command- period. 

appear in your · report 

We urge you to follow any recommendations listed in your 
compatibility report Although Apple cannot guarantee that your 
repottwill identify all compatibility problems, we are confident 
that it will aid you in a smooth transition to System 7. 

To continue, click Statt Checking, below. 

The program checks the software on your d isk for compatibility 
with System 7. Special attention is paid to the items in the System 
Folder. If items are found in your System Folder that may cause 
problems with System 7, these will be listed (see fig. A.2). 

3. Click the Move Items button. 

The items listed are moved to a new folder called May Not Work 
With System 7. You should allow the program to move d1ese. 

The program then will produce a report similar to the one shown 
in figure A.3. 

4. You can click the Print Report button, or click the Save Report 
button. 

5. If you click the Save Report button, click the Save button that 
appears in the dialog box. 



Fig. A.2. 
Items with potential 

compatibility problems are 
listed. 

Fig. A.3. 
The compatibility report. 

Attention: Potential Problems With System Folder Items 

The programs listed below are stored in the System Folderofyourstattup disk. 
They may cause problems after you install System 7. For your convenience, these 
items can be moved into a new folder called "May Not Work With System 7." 

To move the items, dick Move Items. Otherwise, click Don't Move Items. 

Boomerang 
Capture 
Mirror 
SuperCioclc ! 

Compatibili1y Report 

Checked 

Disinfectant 
laserWr i ler Font Uti I . 
MacL I nkP I u s/PC 
MIcrosof t llord 
SuperPoint 
Appl e File Exchange 
TeachTex t 
Di s infectant !NIT 

4 item(s) to be moved from the System 
Folder on the disk "Hard Disk • 

Uers ion S to t us Notes 

2.4 Compatib l e Hard Disk 
7 .D Compatible Hard Disk 
S. DO Compatib l e Hard Disk 
4 . D Cor~patible Hard Disk 
2 .Do Compatible Hard Disk 
7 . D Compatible Systet> 7 Disk 
7 . D Compatib I e Systet> 7 Di sk 
2.4 Compatible Hard Oisk 
I. D. I Compa tible Hard D isk 
1.2. D Compa tib le Hard Disk 
I .D Mas tl y comp . Hard Disk 
2 .0v2 Mas tl y COIIp . A I Hard Disk 
2 .D l'los tl y cor~p . Hard Di sk 

Mos tl y COinp . Hard Di sk 
Mas tl y camp . 

After you receive the report, you will know approximately what upgrades 
you need. The report uses the following statements to indicate compat
ibility status: 

Compatible indicates that the developer of the product claims 
and is certain that the product is fully compatible with System 7. 
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Mostly comp. indicates d1at the product may work with System 7, 
but you should refer to ilie codes in ilie Notes column for more 
information. 

Must upgrade indicates that, according to d1e developer, ilie 
product must be upgraded to run with System 7. 

Not avail. indicates d1at compatibility information was not made 
available to Apple by the developer. 

The Notes column contains the following codes d1at give you more 
information: 

AD. This product does not work with 32-bit addressing. This 
warning is not applicable to the Mac Classic. 

CD. You should contact the developer for information about a 
compatible version. 

FR. A free upgrade is available from d1e developer. 

FS. The product does not work with file sharing. If you have 
rurned on file sharing, rurn it off before using the program. 
If you are not using file sharing, this warning does not apply. 

MO. This product has been moved into ilie folder called May Not 
Work With System 7. Contact the developer for compatibility 
information. 

RI. The product should be replaced by the copy on d1e System 7 
installation disks; usually applies to utility programs. 

TI. The product does not support TrueType fonts larger than 
127 points. 

UN. With System 7, the product is not necessary; Font/DA Mover, 
for example. 

UP. You can receive a compatible version of iliis product from 
dealers, on-line services, or user groups. 

UR. Ald10ugh iliis version of this product is basically compatible 
wid1 System 7, the developer encourages you to upgrade to a more 
recent version. 

VM. This product does not work with virrual memory. The Mac 
Classic does not have virrual memory, and iliis warning does not 
apply. 



The informacion provided is not a guarantee. Apple relies on the 
developer of each product to inform them of the compatibility of the 
product. 

The last section of the report provides you with a listing of phone 
numbers where you may reach the developers of the known products 
for further information. 
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s with any computer, at some time something may go wrong with 
your Mac Classic. The best advice to follow is not to panic when 
you have a problem. Most problems are minor and easily solved. 

You can take steps to avoid or minimize problems. First and foremost is 
to pay careful attention to the guidelines about d1e location and care of 
your Mac Classic and disks. Your hardware and software are fragile, and 
you should be cautious. 

Always, always keep backups. When you purchase software, you 
should use the original disk only to make a copy of it to use, whemer 
on your hard disk or on another floppy. By following this procedure, 
your original disks always are safe if your floppy disks are damaged or 
your hard disk crashes. 

Protect your machine from unstable power sources. One common 
problem is d1e stability of d1e voltage levels connected to your machine 
from the power company. If you notice your lights flickering or 
dimming frequendy, you may want to notify the utility company and 
investigate a line filter or an uninterruptable power supply to protect 
your Macintosh and other computer equipment. These items are not 
cheap but will protect your equipment if y9u live in an area mat has an 
unstable power flow. 



Possible Problems 

Guard against virus contamination. To protect your software, you 
should acquire and regularly use a virus protection utility (see 
Chapter 4). 

You also should rebuild your desktop once eacb montb. You rebuild 
your desktop by holding down the command and option keys when the 
Mac Classic starts. Follow th is procedure for each Starrup Disk you have, 
whether hard d isk or floppy disk. Rebuilding the desktop causes the 
System software to perform some maintenance work on the file that 
tracks your icons. In System 6, comments entered in the Get Info 
window are deleted by this process. 

Do not plug or unplug any cables wben the Mac Classic or any otber 
peripberal device is turned on. Especially do not plug in or unplug the 
ADB cables connecting the keyboard and mouse to the Mac Classic. Lf 
you do so, you risk damaging the chips inside the machine. 

The fo llowing section lists some problems and suggests ways of dealing 
·with d1em. 

Problem: 71Je screen is dark. 

Check the power cord. It may have worked itself loose from the oudet or 
the Mac Classic. 

Be certain that the outlet acntally is providing power. Perhaps a breaker 
has tripped; if so, consider hil'ing an electrician to determine why. 

Turn off the Mac Classic, and turn it on again. 

If none of the preceding steps work, contact your dealer. 

Problem: The desktop does not appear. 

Wlhen the Mac Classic is first turned on, you see one of two icons. If you 
do not have a hard disk, you see a disk with a question mark. The Mac 
Classic is asking for a Startup Disk. If you have a hard disk or after you 
insert the floppy Startup Disk, you see a Mac icon with a smiling face. 

If you see a Mac icon with a sad face or a disk with an X in it, the Mac 
Classic is indicating that it cannot use d1e Startup Disk, whed1er hard or 
floppy. This means that something is wrong with the System Folder on 
that disk. 

Floppy disk users should perform the following steps: 

1. Start the Mac by using a different Startup Disk. 



2. Insert the defective Startup Disk, and trash the System Folder. 

3. Copy a System Folder to the disk, o r use the Apple .Installer to 
place it on the disk 

If d1e disk fails again, the disk may be physically defective and no longer 
useful. 

Hard disk users should perform the following steps: 

1. Insert a floppy Startup Disk 

2. If d1e h:u·d disk icon appears on the desktop, then use the Apple 
Installer to again install the System Software. 

If the hard disk icon does not appear, then shut down the Mac 
Classic, turn off the h:u·d disk if it is an external, and turn on both 
again. 

3. If the preceding step does not work, d1en use the Apple HD SC 
Setup program or d1e utility that came with the hard disk to test 
the hard disk 

4. If the hard disk fails the test, contact the dealer. If it passes, then 
use the Apple HD SC Setup progr:un o r the utility that c:une with 
the hard disk to install or update d1e driver. 

The Apple HO SC Setup program has an Update button fo r this purpose. 
For other utilities, check the manual that came with the progr:un. 

You aJso may have a conflict in SCSI ID numbers if you have more than 
one SCSI device attached to your Mac Classic. You cannot use the 
numbers 0 o r 7 tor any device attached tO the Mac Classic. No two 
devices can have the same number. 

If none of the preceding steps work, contact the dealer. 

Problem: A disk with a flasbing question rnat·k appears on-screen. 

If you have a floppy-disk-only Mac Classic, you simply need to insert a 
Startup Disk. If you have a hard d isk o r have inserted a disk and the icon 
persists, however, the computer may have failed its initial startup 
diagnostic. You also may he:u· a tone when d1is condition occurs. 

The Mac Classic tests itself when it is turned on. You may no tice that the 
screen remains dim for a while before brightening and d isplaying icons. 
This is when the testing occurs. Failure of d1e testing is indicated by a 
tone or refusal to start. 

Try turning the Mac Classic off, waiting about 10 seconds, then turning it 
on again. If these steps do not work, contact d1e dealer. 
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Problem: Tbe mouse does not work or it works erratically. 

Be cenain that the ADB cables are tight; shut down the Mac Classic 
before plugging or unplugging these cables. 

Clean the mouse. Turn the mouse over and you will see a small ring that 
can be turned around the mouse ball. This ring opens d1e mouse so that 
you can remove the ball. Apple mice have three rollers that rest against 
the ball. Clean these rollers with a cotton swab moistened with alcohol. 
Clean the ball with a soft cloth. 

T1y a different Startup Disk. If another Startup Disk works, you should 
replace the System software on the other disk. 

Problem: Tbe keyboard does not work. 

Be certain that you can type during the current function. Perhaps d1e 
active window does no t enable typing. Click where you wish to type to 
place the blinking insertion point. 

Be certain that the ADB cables are tight; shut down the Mac Classic 
before you test cables. 

Try another Startup Disk. If another Startup Disk works, you may need 
to replace the System Folder on the first disk. 

If none of the preceding steps work, contact your dealer. 

Problem: 1be floppy disk wifl not eject. 

Try holding down the shift and command keys and pressing the one (1) 
key. 

Shut down and turn off the Mac Classic. Turn it on after about 10 
seconds, and hold down the mouse button as the machine starts. 

If all else fai ls, turn off the machine and unplug d1e power cord. 
Straighten a paper clip and carefully push it in the small hole to the right 
of the floppy drive. Do this gendy and push straight forward. The disk 
should pop out. 

Sometimes the label of a disk can come loose and cause a disk to jam in 
the drive. This can become a serious problem. Do not insert a disk with a 
loose label into the disk drive. 

If none of the preceding steps work, contact your dealer. 

Problem: A dialog box appears with a small bomb in it. 

Congratulations, you have just had your first disk crash. The best attempt 
to explain a disk crash comes from Chris Espinosa, one of the original 
Mac experts. 



Imagine a car at the side of the road, smashed into a tree. What hap
pened? You know it crashed, but why? A detailed investigation may 
reveal the answer or it may not. The passersby will never know. A disk 
crash occurs because something went wrong. The Mac Classic could no 
longer figure out what it was supposed to do. 

The first thing you should do in the case of a crash is to write down 
exactly what you were doing: the steps you were performing when the 
crash occurred; the application you were using; the other applications 
that were running; the names of the INITs, or System Extensions as they 
are called in System 7, that you have installed; and the exact text in the 
bomb box. 

You can then report the problem to the developers of the application 
you were running when the crash occurred. They may have some 
suggestions as to why it occurred and how to avoid or correct it. 

You also can try replacing the program with a fresh copy from the 
original disk, which you have, of course, stored safely away, and con
tinue. Try the same steps that led to the crash and see what happens. A 
bug tl1at can be duplicated has the greatest chance of being corrected. 

Another suggestion is to replace the System Folder with a fresh copy. 
Sometimes the System software itself can become corrupted by errant 
software and should be replaced. 

Technical support is like detective work where you cannot go to the 
scene of the crime. A support representative may ask seemingly inappro
priate questions. Answer everything. Tell them everything you can think 
of concerning the crash and your Mac Classic's configuration. You 
should sit at your Mac Classic when you call your technical support 
representative. 

Problem: The mouse pointer freezes. 

This is another form of a disk crash. No matter how much you move the 
mouse, the pointer will not budge. 

Be certain that the ADB cable has not come loose. 

Check that the surface you are moving the mouse on is actually turning 
the mouse ball; slick desks may not enable the mouse to roll. 

If you are using System 7, press the command, option, and esc keys. 
Then immediately save as much work as you can and resta.rt. 

If you are using System 6, try saving with a keyboard command, such as 
command-S, then turn the Mac Classic off and back on again after about 
10 seconds. 
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U the problem occurs again, try installing d1e System software or 
replacing it with a backup copy. U all else fails and the problem appears 
to be associated with a particular application, check the preceding 
problem, A dialog box appears with a small bomb in it, and contact the 
developer. 

Problem: The printer will not print. 

Be certain that the proper printer driver and port, if applicable, are 
chosen in the Chooser. Look at the back of d1e Mac Classic to be certain 
that the port you are choosing is the one the printer is acntally plugged 
into. 

Determine whether the cables are connected tightly. 

Check tl1at the printer is on-line. Most printers have a button or otl1er 
control that disable them from printing. You easily can leave d1is set to 
the off-line position. 

If you have an SCSI printer, be certain that the SCSI ID number does not 
conflict with another device; no two may have the same number, and the 
numbers 0 and 7 cannot be used. Turn everything off before changing 
SCSI lD numbers. 

Problem: The fonts used by the printer are not what you expected. 

You may have the Font Substitution option on in the Print Setup dialog 
box. A laser printer using Apple's LaserWriter printer driver will substi
tute fonts in certain cases. These substitutions include: Times for New 
York, Helvetica for Geneva, and Courier for Monaco. 

You may have a PostScript printer font and a TrueType printer font 
installed with the same name. Check your application manual to see 
which it chooses in this case. Remove the one you do not want to use. 

You may be using a QuickDraw printer. Fonts may not print as well on 
these printers as you want, unless you are using the Adobe Type 
Manager with PostScript fonts or TrueType fonts. 

Problem: Control panel settings change without warning. 

Control panel settings are maintained by a small battery in the Mac 
Classic. Check with your dealer about replacing the battery. 

Problem: A previously JunctionitJg disk, when inserted, causes the 
message This is not a Macintosh disk to appear. 

The disk fo rmat or other basic information has been corrupted in some 
way. The dialog box offers the option to initialize the disk. If you have 
been using d1e d isk, do not click d1e initialize button; initializing will 



erase the information on the disk. This information may be recoverable 
despite the warning message. 

Click the Eject button. Use the Apple-supplied Disk First Aid utility to 
attempt to repair the disk. If Disk First Aid fails, try one of the utilities 
discussed in Chapter 11. 

Hard disk users may see this message concerning their hard disk. Never 
use the initialize option. Instead, use a floppy Startup Disk and a utility, 
such as Disk First Aid or one of the commercially available ones, to 
attempt to repair the disk's information. 

If the preceding steps fail or you need help, contact your dealer. 

Possible System 7 Problems 
The following problems are specific to System 7. 

Problem: Nothing or only some items are in the Apple menu. 

Be certain that the Apple Menu Items folder is in the System Folder. 

Open the Apple Menu Items folder to be certain that everything you 
want is present. 

Problem: You double-click an alias and nothing happens, or you 
receive a message. 

The original icon may have been moved from one volume to another. 
Delete the alias and create a new one. 

You created an alias of an alias then deleted the middle one. This is like 
creating a chain then breaking the middle link. Make aliases of original 
icons only. 

To find the original of an alias, select the alias by clicking it once and 
choosing the Get Info command from the File menu. Then click the Find 
Original button. 
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his appendix contains a sampling of resources available to you 
from which you may gain infonnation about and supplies for your 
Mac Classic. Included are the address and phone numbers of 

Apple Computer; several of the top on-line services, including their 
rates at this writing; addresses for locating a user group in your area; 
addresses for the two top national Macintosh magazines; book sources; 
and some of the major mail-order companies. 

This listing is by no means complete but will give you a starting point. 
All information is correct at this writing but is subject to change. Call or 
write the company for current rates and other information. 

Apple does not offer direct support to users except in limited cases; 
some support is offered for purchasers of the System 7 upgrade 
package and information comes with that package, for example. Usually 
you need to contact your dealer for system support. 

Apple Computer 
50525 Mariani Avenue 
Cupertino, CA 95014 



On-Line Services 

For the dealer nearest you: 1-800-538-9696 
For education sales nearest you: 1-800-732-3131, 

extension 450 for K-12 
extension 430 for college and university 

For customer service: 1-800-776-2333 

n-line systems provide a variety of info rmation and services. On 
many services, CompuServe particularly, you can communicate 
with the developers of software packages and other users who use 

systems similar to your own. You also can purchase products, play 
games, o r communicate with others on many noncomputer topics. 

America OnLine is a good, inexpensive system, although its services are 
no t as extensive as CompuServe. The communications software is easy to 
use and free. 

America OnLine 
8619 Westwood Center Drive 
Vienna, VA 22182 
1-800-827-6364 

$5.95 monthly, includes 1-hour connect time 
$5.00 per hour, evenings and weekends; $10.00 prime time 

CompuServe was the first full-blown information service. Currently, the 
system serves approximately 835,000 users . Forums, which are message 
boards, cover topics as diverse as literature and sailing. Many of the 
larger software houses have fo rums of their own where you can find 
assistance with using your software, learn about upgrades, and place 
orders. 

The only drawback is that CompuServe is expensive to use. Mac Classic 
owners should purchase the Navigacor program from CompuServe o r a 
dealer to help reduce costs. 

CompuServe Information Service 
P.O. Box 20212 
Columbus, OH 43220 
1-800-848-8199 

S39.95 sign-up fee includes $25 usage credit; $12.50 per hour at 1200 
and 2400 baud; higher costs with higher-speed modems 



User Groups 

GEnie is a smaller service than CompuServe but is popular. The monthly 
charge covers unlimited non-prime time use, evenings and weekends, 
and access to services except the bulletin boards, which are charged 
separately. Any communications package can be used with the service, 
but one designed specifically for GEnie is being developed and may be 
available by the time you read this book. 

GEnie 
General Electric Information Services 
41 N. Washington Street 
Rockville, MD 20850 
1-800-638-9636 

S4.95 monthly; $6.00 per hour evenings (6 p .m.-8 p.m.) and weekends; 
Sl 8.00 per hour otherwise for access to bulletin boards 

ser groups consist of people sharing a common interest in the 
Macintosh computer. You can gain valuable information and enjoy 
the company of od1ers who are discovering new ways to put the 

Mac Classic to work. Your dealer can give you more information about 
user groups in your area, or you can call 1-800-538-9696. 

You also can contact the two fo llowing national user groups: 

BMUG (Berkeley .Macintosh User Group) 
1442-A Walnut Street #62 
Berkeley, CA 94709 
(415) 549-2684 

BCS-Mac (Boston Computer Society) 
48 Grove St. 
Sommerville, MA 02144 
(617) 625-7080 

BCS is the world's largest network of information and support fo r 
personal computer users. A one-year, regular membership is currendy 
S39. If you join BCS-Mac, you wiJl have access to the following services: 

• Tbe Active Window, a user-group magazine reporting on the 
Macintosh industry from members ' points of view. 

• Electmnic bulletin board with nine public lines. You can get help 
with Mac problems and download software from the BCS public 
domain collection. 
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Magazines 

Books 

• Telepbone hotline volunteers who will answer questions about 
Macintosh programs. 

• Software Excbange Libraty of the BCS is documented in a 300-
page catalog of shareware and public domain programs available 
from user groups. 

hose of magazines are dedicated to the Macintosh; two are large 
and nationally distributed . 

MacUser is my favorite. The magazine is highly informative and enter
taining. MacUser's only drawback is a tendency toward a cheerleader's 
boosterism for the Macintosh, which is typical behavior of many Mac 
fans, including myself. 

MacUser 
P.O. Box 56986 
Boulder, CO 80321 
1-800-627-2247 

MacUser's forum on CompuServe is reached by typing GO ZMAC. 

Macworld is the second major Macintosh magazine. 

Macworld 
P.O. Box 54529 
Boulder, CO 80322 
1-800-234-1038 

Macworld has a forum on America OnLine. 

ue Corporation is one of the main publishers of books about the 
Macintosh and Macintosh software. A wide variety of books is 
available to help you get more from your Mac Classic. Que's books 

are widely available at well-stocked bookstores. A card for ordering 
Que's catalog should be in the back of this book, or you may contact 
them at: 

Que Corporation 
11711 N. College Ave. 
Carmel, IN 46032 
1-800-428-5331 



Mail Order 

The technicaJly minded aJso may want to consider books directly from 
Apple. The Apple TechnicaJ Library comprises the official set of technical 
manuals. They are published by Addison-Wesley and are available at 
many book and computer stores. 

ail-order companies have become o ne of the quickest and least 
expensive ways to purchase software. Most companies now offer 
overnight service fo r a very reasonable fee. These companies 

cannot replace the personaJ help of a dealer, but if you know what you 
want and want to save money, a mail-order company is the way to go. 

MacConnection accepts orders 24-hours a day, except 5:30p.m. Satur
day to 8:00a.m. Monday, Eastern Standard Time. The company's most 
distinguishing feature-in addition to service and overnight delivery-is 
a strong commitment to the environment; they even have a compost 
heap behind their building. If you order green, MacConnection is your 
source. 

MacConnection 
14 Mill Street 
Marlow, NH 03456 
1-800-800-2222 

MacWarehouse has been my software source for some time, although 
MacConnection's push for recycling may switch my loyalties. In any case, 
MacWarehouse has always been prompt, courteous, and inexpensive, 
and they receive orders 24-hours a day. 

MacWarehouse 
1690 Oak Street 
P.O. Box 3031 
Lakewood, NJ 08701 
1-800-255-6227 

The following two companies are other prominent mail-order houses. 

MacZone 
18005 NE 68th St., Suite AllO 
Redmond, WA 98052 
1-800-2 48-0800 
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MacZone receives orders 24-hours a day. 

MacA venue 
12303 Technology Boulevard 
Austin, 1X 78727 
1-800-395-6221 
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any commands can be executed from the keyboard. This appendix 
lists those commands and various shortcuts in the Macintosh 
interf-ace. 

A number seven in parentheses (7) next to a command indicates that 
the keyboard shortcut applies only to System 7 or that the command 
exists only in that syste m. A number six in parentheses (6) indicates a 
System 6-onJy command. All other commands relate to bod1 systems. 

Multiple key actions or key and mouse actions are indicated by the key 
name fo llowed by another key name or mouse action separated by a 
hyphen. For example, command-N means hold the command key down 
and press the letter N key. Option-choose Clean Up means hold down 
the option key while choosing the Clean Up command wid1 the mouse. 

Create new folder 

Open selected icon 

Print selected icon from Finder 

Close active window 

Get information about selected icon 

Command-N 

Command-O 

Command-P (7) 

Command-W 

Command-I 



Duplicate selected icon Command-O 

Put away selected icon Command-Y 
(ejects selected disk in 
System 7) 

Eject selected disk Command-E 
(in Special menu in 
System 7) 

Find Command-F (7) 

Find again Command-G (7) 

Edit Menu 
Undo last command Command-Z 

Cm selection Command-X 

Copy selection Command-C 

Paste from Clipboard Command-V 

Select all items in window Command-A 

Special Menu 
Eject selected disk Command-E 

(in File menu in System 6) 

Windows 
To close all Finder windows Option-click close box of 

any o ne window 

To move an inactive window Command-drag the title bar 

To open folder and close Option-double-click 
containing folder the folder to be opened 

To make desktop active Command-shift-up-arrow 
key (7) 

Access title bar folder menu Command-click name (7) 



Views 

Ejecting Disks 

Printing Control 

Open folder enclosing current 
open folder 

Zoom window to screen size 

Command-up-arrow key (7) 

Option-d ick zoom box (7) 

The following System 7 commands work only in text Qist) views: 

Change view Click view name (7) 

Expand selected fo lder 

Collapse selected folder 

Expand all folders in selected folder 

Collapse all folders in selected 
folder 

Eject selected disk 

Eject disk from internal drive 

Eject disk from external drive 

Eject disk from second external drive 

Cancel printing 

Save current screen to disk 

Print current window on Image Writer 

Print screen on lmageWriter 

Command-right-arrow 
key (7) 

Command-left-arrow 
key (7) 

Command-option-right
arrow key (7) 

Command-option-left
arrow key (7) 

Command-E 

Command-shift-1 

Command-shift-2 

Command-shift-0 

Command-period (.) 
(does not work with 
background printing) 

Command-shift-3 

Command-shift-4 

Caps lock-command-shift-4 
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Icons 
Select icon 

Select next icon 

Select previous icon 

Select icon to left 

Select icon to right 

Select icon above 

Select icon below 

Select several icons 

Open selected icon name for 
editing 

Open selected icon 

To align icons 

To clean up selected icons 

To sort icons 

Reverse snap to grid setting 

Type first letters of 
name (7) 

Tab (7) (in alphabetic 
order) 

Shift-tab (7) (in alphabetic 
order) 

Left-arrow key (7) (icon 
views only) 

Right-arrow key (7) (icon 
views only) 

Up-arrow key (7) (any 
view) 

Down-arrow key (7) (any 
view) 

Shift-click icons 

Press return (7) (press 
return again when finished 
typing) 

Command-down-arrow 
key (7) 

Option-choose Clean Up 
from the Special menu 

Shift-choose Clean Up 
from Special menu (7) 

Option-choose Clean Up 
(sort order is last text 
view chosen) from Special 
menu (7) 

Command-drag icon (7) 



Miscellaneous 
Rebuild desktop 

Avoid Trash warning dialog box 

Avoid Trash warning dialog box 

Turn off all extensions 

Skip internal hard disk at startup 

Unfreeze program 

Command-option at startup 
or floppy disk insert 

Option-drag to Trash (6) 

Option-choose Empty 
Trash from Special 
menu (7) 

Shift at startup (7) 

Command-option-shift
delete 

Command-option-esc (7) 
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3 1/2-inch disk. A hard-shell , plastic-encased magnetic medium for the 
storage ofinformation; stores from 400K to as much as 1.4 
megabytes. 

Active application. The application program currently being used. With 
the System 6 Mu lti Finder and System 7, more than one application 
can run at the same time. The active application is indicated by its 
icon in the right side of the menu bar and a check mark next to its 
name in the Apple me nu of System 6 or the Application menu in 
System 7. 

Active window. The front-most window, indicated by the title bar 
containing a series of lines in it. 

Alarm Clock. A desk accessory that displays the time, date, and has an 
alarm clock setting. 

Alert box. A dialog box that appears to display a warning or error 
message. 

Alias. An icon that represents another icon. Double-clicking or otherwise 
opening an alias, opens the original icon. Moving, renaming, 
deleting, and copying affects only the alias. 

Apple menu. The menu in the upper-left corner ofthe Macintosh 
screen . Contains desk accessories in System 6; contains user 
defined items in System 7. See a/so Apple Menu Items folder and 
Font/DA Mover. 

Apple Desktop Bus (ADB). The circuitry used to connect input devices, 
such as the keyboard, mouse, and graphics tablets to the Mac 
Classic and mher Macintosh computers. The Mac Classic has one 
ADB port on the back marked by a branching icon. 
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Apple HD SC Setup. A utility program provided by Apple that is used in 
preparing an Apple hard disk for use. 

Apple Menu Items folder. The location of items to be displayed in the 
Apple menu in System 7. The folder is located in the System 
Folder. 

AppleTalk. The Apple network communications protocol. 

Application program. A software program consisting of a series of 
instructions coded for a computer. Performs a specific task, such 
as word processing, database management, or financial-records 
keeping. 

Application menu. The System 7-only menu in the upper-right corner 
of the screen listing the running application programs and desk 
accessories. Used to choose between programs and DAs. Also has 
the options of hiding windows of applications. 

Back up. To make a copy of information in case of disk failure or other 
problems. 

Background printing. The capability to store printing on a hard drive 
and enable the user to continue working as the printer is sent 
information. See a/so Print Monitor. 

Balloon Help menu. The menu that activates the System 7-only help 
system. The user then places the mouse pointer on an item and a 
balloon appears with text that explains that item's function. The 
menu appears as a balloon with a question mark(?) inside. 

Balloon. A small window that looks like the balloon blurbs seen in 
newspaper comics; used by Balloon Help in System 7. 

Baud. A rate of transmission speed equal to one bit per second (bps). 
1200 baud indicates that the device transmits 1200 bits each 
second. See also bps. 

Bit. A single digit, one or zero, used in the base 2 number system and by 
computers. See also Byte. 

Bit map. A series of bits that represents a character or graphic image. 
Each bit represents black or white. 

Bit-mapped character. One letter, number, or symbol drawn with bits 
representing black or white. 

Bit-mapped font. A single size font in which the characters are drawn 
with single bits representing black or white. See also PostScript, 
Printer font, Screen font, and TrueType. 



bps. Bits per second; used in describing the transmission speed of a 
modem or other data communication hardware. 

Buffer. An area in memory used to temporarily store information. 

Bug. A computer term used to refer to problems in software. See also 
Crash. 

Bus. Circuits that move information within a computer. 

Button. In the Macintosh system, ovals or circles that can be clicked with 
the mouse in imitation of pushing them to set desired conditions, 
initiate commands, or respond to requests. 

Byte. A flxed number ofbits representing information, such as a 
character or number. A byte consists of eight bits. 

Cache. An area of memory where information is stored temporarily in 
anticipation of the computer's needs to speed operations. See also 
RAM cache. 

Calculator. A desk accessory that acts as a small, four function calcula
tor. Supplied by Apple. 

Cancel button. Clicking this button causes the current operation to 
cease. 

CDEV. See Control panel device. 

CD-ROM. An optical disk that is read by using a laser beam, usually of 
very high capacity-about 650 megabytes presently. See also 
WORM disk and Erasable optical disk. 

Central processing unit (CPU). The main chip in a computer that does 
the actual calculations and processing of information. The Mac 
Classic uses a Motorola 68000 microprocessor for its CPU. 

Character. A symbol that carries information, such as a letter, number, 
period, or dash. 

Check box. A small square that switches from on to off and vice versa 
when clicked; used to set options. 

Chip. See Integrated circuit. 

Choose. To drag the mouse pointer through a menu then release the 
button when the black, highlighting band is on the desired 
command. 

Chooser. A desk accessory that enables the selection of a printer or 
other device attached to the Mac Classic and other Macintoshes. 
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Clear. A command in the Edit menu. Deletes the currendy selected item 
when chosen. 

Click. To place the mouse pointer on an item and press the mouse 
bunon once. 

Clipboard. An area of temporary storage. A selected item is placed here 
when the Cut or Copy command in the Edit menu is chosen. Items 
on the Clipboard are placed in your document when the Paste 
command in the Edit menu is chosen. 

Close box. A small square in the upper-left corner of a window that, 
when clicked, closes the window. 

Command. A choice from a menu that causes the computer to perform 
an operation. 

Command-click. To hold down the command key, indicated by the four 
leaf clover and Apple symbols, while clicking. See also Click. 

Communication protocol. A definition of the signals used by comput
ers to transmit information. SeealsoAppleTalk. 

Configuration. A particular setting of a program's options. 

Control panel device (CDEV). A small software item that is accessed 
through the Control Jlanel in System 6 or by double-clicking it in 
System 7. Used to control various Macintosh or o ther software 
features. 

Control Panel. The desk accessory in System 6 that enables access to 
control panel devices. Found in the Apple menu. 

Control Pane ls folder. A folder in the System Folder of System 7 that 
contains control panel devices. 

Copy. A command in the Edit menu that transfers a copy of the selected 
item to the clipboard without disturbing the selected item. 

Copy protection. A software or hardware scheme that prevents the 
copying of a software application. 

CPU. See Central processing unit. 

Crash. A computer term referring to the sudden failure of software. See 
also Bug. 

Current application. See Active application. 

Current startup disk. The disk containing the System software that was 
used to start the Macintosh. 



Cursor. See Insertion point. 

Cut. A command in the Edit menu that causes the current selection to be 
removed and placed on the Clipboard. 

Cut and paste. To remove text or graphics from one location and 
transfer them to another. See also Copy, Cut, Edit menu, Paste. 

Data. The computer term for information. 

Data disk. Adiskcontaining information but usually no application or 
System software. 

Default. A configuration or setting of one or more options automatically 
set by the software. 

Deselect. To cause an item to no longer be selected, usually by clicking 
elsewhere with the mouse. 

Desk accessory. A small software application that resides in the Apple 
menu in System 6 and anywhere in System 7. Usually performs 
one function as opposed to the many performed by application 
programs. 

Desktop. The work area in the Macintosh interface. 

Desktop button. A button that , when clicked, displays the contents of 
the desktop including mounted disks. 

Dialog box. A form of a window that enables only certain operations to 
be performed. 

Dimmed. See Grayed. 

Directory. A listing of the contents of a disk; the form of the listing is 
controlled through the View menu . 

Disk. A circular item coated with a magnetic material used to store 
information in a computer. Disks usually are enclosed in a plastic 
casing-as in floppy disks- ora box containing the drive mecha
nism-as in hard disks. 

Disk capacity. The amount of information a disk can store. In the 
Macintosh world, this is 400K, BOOK, or 1.4 megabytes for floppy 
disks and from 20 megabytes to more than a gigabyte for hard 
disks. 

Disk drive. The mechanism that reads from and writes to a disk. 

Disk First Aid. A utility program provided by Apple that performs some 
repairs to damaged disks-damaged in the sense that the informa
tion on the disk is corrupted; nothing can repair a physically 
damaged disk. 
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Dismount. To close the connection to a disk. See also Mount. 

Document. An icon containing information you create by using an 
application program, such as text, graphics, or a spreadsheet. 

Dot matrix. A device that draws on paper by placing dots of ink on the 
page. Used primarily to indicate printers that use a mechanical 
solenoid that strikes an ink ribbon; although all printers place dots 
on the page by some process. 

Double-click. To place the mouse pointer and press the mouse button 
twice quickly. 

Double-density disk. A disk that stores information twice as densely as 
its now extinct predecessor. Presently the standard disk but rapidly 
being supplanted by the high-density disk. 

Double-sided disk. A disk that uses both sides of its magnetic medium . 
Currently the magnetic medium disk standard. 

Download. To transfer information from another computer to yours 
over a modem. See also Upload. 

Drag. To place the mouse pointer, press and hold the mouse button, 
and move the mouse . 

Driver. An item of software that tells a computer how ro communicate 
with another device, such as a printer. 

Edit menu. The third menu in the menu bar; contains items related to 
editing text and graphics. 

Eject. To cause a disk to pop out of a disk drive. 

Erasable optical disk. An optical disk that can be erased and reused 
several times; usually of very high capacity-presently about 650 
megabytes. 

Error message. A notation of a problem with software or an improper 
user operation. 

Extensions. Items of software that enhance the operation of the System 
software. See also Extensions folder and IN ITs. 

Extensions folder. The System 7 folder, contained in the System Folder, 
in which are stored system extensions; also called extensions and 
IN ITs. 

File. A collection of data stored on a disk. Represented in the Macintosh 
interface by an icon . 



File menu. The second menu on the menu bar; contains commands 
related to documents. 

File sharing. To enable othe r users on a network access to files on your 
hard disk and vice versa. 

Find File. A desk accessory provided by Apple that locates documents 
and other icons on your disk. 

Finder. Part of the System software that controls the desktop and 
manages icons and disks. 

Floppy disk. A small capacity, removable disk. Named floppy due tO the 
flexibility of the internal magnetic medium. See also 3 1/2-inch 
disk and Disk capacity. 

Folder. An icon that exists to group and contain other icons. Looks 
similar to an office manila file folder. 

Font. A collection ofletters, numbers, and symbols grouped under one 
name and of a partjcular style. 

Font/DA Mover. The System 6-only utility that places desk accessories 
on the Apple menu and fonts in the System. 

Format. See Initialize. 

Gigabyte.l ,073,741,824 bytes. Roughly one billion bytes. 

Grayed. A command or icon that is dim in appearance to indicate that it 
is unavailable or in use. 

Grow box. See Size box. 

Hard disk. A high-capacity d isk. Named hard because of the rigidness of 
the magnetic media. See also Disk capacity. 

Hardware. The physical components of a computer system. 

Hierarchical file system. The capability of the Macintosh system tO 
store folders within folders by nesting them. Two different folders 
can contain identically named items without causing conflict. 

High-density disk. A floppy disk capable of storing 1.4 megabytes of 
informatio n when initialized by the MacintOsh computer. 

Highlighted. Darkened to indicate selection. 

HyperCard. An application program provided by Apple that enables you 
to create a kind of database by linking together cards in a stack. 

1-beam pointer. The vertical bar that looks like the capital letter I. Used 
to place the insertion point. 
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IBM PC. The computer type created by International Business Machines. 

Icon. A small graphic used to represent something. 

Initialize . To prepare a disk for use by organizing its surface. 

INITs.Addit io ns to the System software that enhance its functionali ty. 
Called System Extensions in System 7 . 

Insertion point. The blinking, vertical bar that indicates where text or 
graphics wiU be placed in respo nse to typ ing on the keyboard or 
using the Paste command in the Edit me nu . Also called the cursor. 

Installe r. A program, such as the Apple Installer, that stores software on 
a d isk. 

Integrated circuit. A small device made o f silicon that processes 
e lectrical signals. 

Inte rface. The manner in which a computer communicates with a 
human. The Macintosh uses a Graphical User Interface (G UI) 
based on icons. The IBM PC uses a Command Line Interpreter 
(CLI) that requires the typing o f text commands. 

K. See Kilobyte. 

Key Caps. A desk accessory provided by Apple that d isplays the chante· 
te rs that can be typed on the keyboard. 

Keyboard equivalent. A key combinatio n that can be pressed to cause a 
command to execute . Indicated in a menu by a command sym
bol-the four-leaf clover- and a letter, number, o r other symbo l. 

Kilobyte. 1,024 bytes of informatio n. Roughly 1,000 bytes. 

Label m e nu. The fifth menu in System 7; used to assign labels to icons. 

Labels . The System 7 capability to associate a user-defined name with an 
icon. 

Laser p rinte r . A device that places toner ink o n paper by using a laser 
beam. 

Launch . To start an application or o ther program. 

Local Talk. The cables fo r connecting Macintosh computers and other 
devices to create a network. See also AppleTalk. 

Lock. To p revent a d isk or icon from being changed. 

Magnetic m edium. Material that can be written to and read from by the 
use o f magnetism. Computer disks and tape are examples. 



Megabyte (MB or M). 1,048,576 bytes. Roughly one millio n bytes. 

Memory. The circuitry used by a computer to store and run programs. 
See also SIMM. 

Menu. A collection of commands under a heading. Located primarily in 
the menu bar but also other places in pop-up menus. 

Menu bar. The bar across the top of the Macintosh screen that contains 
the menus. 

Modem. A device that transmits and receives information over phone 
lines. 

Modem port. The port on the back of the Mac Classic labeled with a 
telephone handset icon. Used to connect a modem or other 
devices to the computer. 

Monitor.See Video monitor. 

Mount. To establish a connection with a disk volume to access its 
contents. The System software mounts a hard disk at startup and a 
floppy disk when inserted in the disk drive. When the icon 
appears, the disk is mounted. See also Dismount. 

Mouse. A small pointing device that usually rolls over a flat surface and 
has one or more buttons. 

Mouse button. A button on a mouse that can be pressed to cause 
action. 

Mouse Keys. An Easy Access feature that enables you to use the numeric 
keypad to perform the mouse functions. 

MS-DOS. Microsoft Disk Operating System. A command line interpreter 
operating system based on the old CP/M operating system. 

MultiFinder. The multitasking capability of System 6. Does not exist in 
System 7 as multitasking; rather is incorporated into the System 
software. 

Multitasking. The capability of a computer to run more than one 
program at the same time. 

Nested folder. A folder within a folder; this organization can be 
repeated multiple times. See also Hierarchical file system. 

Network. An electrical connection between computers and other 
devices that enables communication between them. 

Note Pad. A desk accessory provided by Apple that enables you to write 
and store short notes. 
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Numeric keypad. The number and math keys grouped on the right side 
ofthe keyboard. 

OK button. An oval button used confirm a command or respond to a 
request by clicking it. 

Open. To start an application or other program or display the contents 
of a document. See also Launch. 

Open button. Button that, when clicked , causes the selected document 
to be displayed in a window or processed in some way. 

Operating system. The basic software instructions that enable a 
computer to do routine tasks, such as accessing disk drives, 
displaying text and graphics, and responding to keyboard and 
mouse input. 

Optical disk. A disk on which the contents are encoded and read by a 
laser light. See also Magnetic medium. 

Option-click. To hold down the option key while clicking. 

Paste. A command in the Edit menu that causes the contents of the 
Clipboard to be inserted into the document at the insertion point. 

Peripheral. Any device attached to a computer, such as printers , 
external hard disks, and modems. 

PICT. A standard form of storing graphics in a document. 

Pixel. A single dot on a computer screen. Images are made on a com
puter screen by UJrning these on and off. 

Pointer. Any device that enables you to indicate items an a screen. May 
be a mouse, light pen, or even a finger, if the computer screen is 
so equipped. 

Pop-up menu. A menu that appears to spring upwards rather than pull 
down. Pop-up menus are contained in shaded boxes in the 
Macintosh interface. 

Port. An outlet that enables connection to other devices. The Mac 
Classic has six of these on the back: phone port, printer port, SCSI 
port, external floppy disk port, sound port, and ADB port. 

PostScript. A language created by Adobe that is used to mathematically 
describe text and graphics in a document. The word is also used to 
describe items compatible with this method, as in PostScript 
printer. 

Print monitor. An item of software that controls background printing. 



Printer driver. A type of driver specifically for printers. See also Driver. 

Printer font. A font used exclusively for priming; does not display on 
the screen. 

Processor. An integrated circuit that interprets software instructions and 
performs commands accordingly. 

Program. A series of instructions encoded in a numerical language that 
instructs a computer how to perform certain functions. See also 
Software. 

Pull-down menu. A menu that appears to drop down when selected. 
Contains commands that may be chosen by dragging. 

QuickDraw. The Macintosh graphics system built into the operating 
system. Also used to indicate printers and other devices that use 
this system. 

RAM. See Random-access memory. 

RAM cache. A section of memory that is used to temporarily store 
information in anticipation of a computer's needs in order to 
speed operations. 

Random-access memory (RAM). Memory that can be accessed by 
providing a numerical address to indicate a location within the 
memory. Some early computer systems had memory that needed 
to be accessed sequemially; therefore, the term evolved to 
differentiate between the t\vo systems. Currently applied to refer 
to memory that can be written to as well as read from and gener
ally loses its contents when power is removed. 

Read-only memory (ROM). Memory that can only be read not written 
to. Used mainly to store the operating system of a computer, 
because read·only memory retains its contents when power is 
removed. 

Resource. An item stored in a file used by the Macintosh to perform 
work. The basic descriptions ofwindows, buttons, and fonts are 
stored as resources. 

ROM. See Read-only memory. 

Save. To cause the contents of the computer's memory to be written to a 
disk. 

Save button. Button that, when clicked, causes the document currently 
in memory to be stored on a disk. 
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Scanning order . The order in which the Macintosh computer looks for 
a disk containing a System Folder in order to start. The Macintosh 
checks the floppy drive fi rst , the internal hard disk, then exte rnal 
SCSI devices in order of their number from 7 to 0. 

Scrapbook. A desk accessory provided by Apple that enables long
term storage of graphics and text. Sounds can also be stored in 
System 7. 

Screen font. A fo nt used for placing text on the screen. Used also by 
QuickDraw printers for placing text on paper. 

Scroll. To cause the contents of a window to move in order to d isplay 
bidden parts. 

SCSI. See Small Computer System Interface . 

SCSI chain. Having more than one SCSI device linked together by 
cables. 

SCSI device. Any device using the SCSI standard to communicate 
information. 

SCSI ID number. A number that uniquely identifies a SCSI device. Eight 
numbers, from 0 to 7, are used. 0 is reserved fo r the internal , 
Apple hard disk and 7 for the Macintosh Itself. 

SCSI port. An outlet that enables a device to connect to o ther SCSI 
devices. 

SCSI terminator. A device that reduces transmission noise on a SCSI 
chain. 

Select. To indicate an item to which a command applies. On the 
Macintosh, this usually is done by clicking the item with the 
mouse. 

Selection. An item or group of items that has been selected. 

Serial p ort. An outlet and associated circuitry that transmits info rmation 
one bit at a time. The phone and printer ports on the Mac Classic 
are examples. 

Shift-click. To hold down the shift key while clicking. 

Shift-d rag. To hold down t11e shift key while dragging. 

SIMM. See Single In-line Memory Module. 

Single In -line Memory Module. A unit of memory that comprises a 
small circuit board and several in tegrated circuits. 



Size box. The box in a window; usually in the lower-right corner, that 
enables changing the size of the window by dragging. Sometimes 
called the grow box. 

Small Computer System Interface. A standard method of communica
tion by cable used to transmit information between computer 
devices. 

Software. A generic term referring to any item containing instructions 
encoded fora computer. 

Startup disk. A disk containing a System Folder and contents used to 
start the Macintosh computer. May be a floppy or hard disk. 

Startup Items folder. In System 7, a folder in the System Folder in 
which items or aliases of items are placed to open when the 
Macintosh starts. 

Stationery pads. Documents that create a copy of themselves for use 
whe n double-clicked rather than opening their original contents. 

System. The icon that contains the most basic of instructions for the 
Macintosh. Also contains fonts , sounds, and other resources. 

System 6. The sixth major rewrite of the operating system of the 
Macintosh computer. Currently the most wide-spread version, 
although System 7 will eventually replace it. Refers to all the 
software that works together to perform the Macintosh's basic 
functions. 

System 7. The seventh and newest rewrite of the System software. 
Refers to all the software that works together to perform the 
Macintosh's basic functions. 

System Folder. The folder that contains the System software. 

System software. The set of icons that contain the instructions that 
enable the Macintosh to perform its basic functions. 

Terminator. See SCSI terminator. 

Title bar. The top parr of a window containing its name title or tide. 
Usually contains the close box and zoom box if applicable. Lines in 
this bar indicate that the window is active. 

Trackball. A substitute fora mouse that remains stationary while a ball 
on top is rolled. 

Trash. The icon in which items to be deleted are placed. Looks like a 
trash can. 
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True Type. The Apple-Microsoft language used to mathematically 
describe fonts. Also refers to items, such as fonts and printers, that 
use this language. See also PostScrit>t. 

Unlock. To enable a disk or icon to be deleted or changed. 

Upload. To transmit information to another computer usually by 
modem. 

User group . A collection of individuals that share an interest in a 
compu ter system and meet to discuss software and hardware. 

User interface. See Interface. 

Utility program. A program that performs basic operations, such as disk 
data repair, installation, and other maintenance tasks. 

Version.A number used to indicate rewrites and revisions of software . 
In general, the first digit indicates major rewrites, and digits and 
letters to the right of the decimal point indicate minor changes 
and bug corrections. 

Video monitor. The screen that a computer uses to display information. 

Virus. A malicious item of software that spreads from disk to disk. 

Volume. A generic term referring to a disk o r subdivision of same. 

Window. An item drawn on a computer screen that contains 
information. 

WORM disk (Write Once Read Many). An optical disk that enables only 
a one-time write of information but many reads of it. 

Write. To store information to memory o r a disk. 

Zoom box. A box usually in the upper-rightcornerofa window that, 
when clicked, causes the window to rapidly change size. 



Index 
Symbols 

;):( command-key shortcut, 190 
400K disks, 93 
400K drive, 93 
4th Dimension (Acius), 3BB 
BOOK disks, 93 
BOOK drives, 93 

A 

About This Macintosh command, 
301-303 

ACT packages 
(Spinnaker Educational 

Software) , 3B9 
(StudyWare), 3B9 

ADB (Apple Desktop Bus), 14 
Addresses stack, 372-376 
Addresses With Audio stack, 36B 
Adobe Type Mananger (Adobe 

Systems) , 355 
Alarm Clock desk accessory, 

214-2 16 
Aldus I'ageMaker, 3B8 
Alert sounds, 236-237 

aliases, 73, 270 
creating, 271-272 
deleting, 272 
errors, 421 
functions, 274-276 
locating original icon of, 

273-274 
renaming, 272 

aliasing, 270 
Alphabet Blocks (Bright Start 

Technology), 3B9 
America Online, 3B7, 424 

document icon, 125 
Apple File Exchange program, 345 

installing, 102-104 
Apple l-ID SC Setup program, 340 
Apple Installer, 14 

resolving INIT incompatibili
ties, 256 

Apple menu, 3B, 70, 244 
About This Macintosh 

command, 301-303 
installing icons, 244-245 
Items folder aliases, 274 
Macintosh Finder, 187-1B8 
missing menu items, 421 
removing icons, 244-245 
sorting items within, 245-246 

AppleTalk printers, 310-311 
choosing, 315 
hookup, 307 

Application 
icons, 46 
menu, 79 

Hide Finder command, 80 
Hide Others command, 80 
Show All command, 80 

application programs, 359 
adjusting memory size, 

1B7-189 
categories, 180, 360 
installing, 181 

on floppy disks, 18 1-183 
on hard disks, 184-186 

locking, l 86 
memory considerations, 361 
printing with, 190-192, 

195-199 
primer special effects, 

193-195 
starting, 189 
system considerations, 361 
unlocking, 186 
versus desk accessories, 206 

Appointmems stack, 369-3 71 



Appointments With Audio srack, 
368 

arrow keys, 82 
Audio Help stack, 368 

8 

Background command, 384 
background printing, 328·332 
backups, software, 415 
Balance of Power (Accolade) , 390 
Balance of the Planet (Accolade) , 

390 
Balloon Help menu, 78 
baud, 40I 
BCS-Mac (Boston Compurer 

Society) user group, 425 
Software Exchange Library, 426 
Tbe Ac/ive \Vindow user-group 

magazine, 425 
Beyond (Dr. T's Music Software 

Inc.), 392 
bit-mapped fonts , see screen fonts 
bomb, on-screen, 418-419 
Boomerang (Hiroaki Yamamoto of 

Zeta Soft) , 350 
Brightness control panel, 230 

c 
Calculator desk accessory, 70, 

216·217 
CanOpener (Abbott Systems), 350 
Canvas (Deneba Software), 39 1 
Caps lock key, 81 
CD-ROM drives, 399 
CDEVs, 77, 221 

accessing, 251 
installing, 250·251 
removing, 250·251 
shell, 251 

CDEVs (control panel devices), 
250 

check boxes, 54 
Checkwriter li (AAtrix Software), 

391 

Index 

Chessmaster 2000 (Software 
Toolworks) , 390 

Chooser desk accessory, 313 
clamping voltage, 11 
Clean Up command, 77 
Clean Up Window command, 163 
Clear command, 74, 202, 384 
clicking, 42 
dose box, 34 
Close command, 61, 72, 132 
Close Window command, 163 
dosing 

disk icons, 34 
documents, 132 
folders, 163 
windows, 61 

command key, 82 
commands 

Clean Up, 77 
Clear, 74 
Close, 61, 72 
Copy, 74 
Cut, 74 
Duplicate, 31, 50, 72 
Eject, 25, 72 
Empty Trash, 33, 78 
Erase Disk, 78 
Find, 73 
Find Again, 73 
Get Info, 52·54, 72 
Hide Finder, 80 
Hide Others, 80 
Make Alias, 73 
New Folder, 30, 71 
Open, 71 
Page Setup, 72 
Paste, 74 
Print, 72 
Print Directory, 72 
Put Away, 72 
Restart, 78 
Select All, 74 
selecting 

from menus, 65,68 
with keyboard, 82 

Set Startup, 78 

Sharing, 73 
Show All, 80 
Show Clipboard, 74 
Shut Down, 36, 78 
unavailable, 65 
Undo, 74 

communic.1tions application 
programs, 180, 360, 386·388 

Compatibility Checker liyperCard 
stack, 410-413 

Complete Undelete (Microcom 
Inc.), 352 

compressing data, 348 
CompuServe, 424 
ConcertWare+ MIDI (Grcat\XIave 

Software), 392 
connectivity, 357 
control key, 82 
control panel devices, see CDEVs 
control panels, 221-223 

Brightness control panel, 230 
changing settings, 420 
General Control Panel, 223 

Desktop Pancrn control, 
225 

Menu Blinking control, 230 
Rate of Insertion Point 

Blinking control, 229 
setting date and time, 

226-227 
Sound Control panel, 

227-228 
Keyboard control panel, 231 
Mouse control panel, 232 
Startup Device control panel, 

233 
Views control panel, 258 

font displayed, changing, 
259·260 

icon grid, changing, 
261-262 

list views, changing, 
262-265 

Copy command, 74, 204, 384 
copying 

documents, 135 
to another disk, 136 



floppy disks, 105 
between, 109-110 
contents to hard disks, 

106-107 
folders, 31 
icons, 50 

from hard to floppy disk, 51 
in background in System 7, 

303-304 
to another folder, 168 

text, 204 
CPU (central processing unit) , 13 
CRT (cathode ray tube), 12 
Crystal Quest (Casady & Greene) , 

390 
cursor, 201, 229 
Cut command, 74, 203, 384 
cutting text, 203 
cylinders, 94 

0 

DA Handler, 213, 294 
Dark Castle (Aldus) , 390 
DAs, see desk accessories 
data, 124 

compressing, 348 
recovery utilties, 351-352 

DAtabase (Baseline) , 388 
database application programs, 

180, 360, 388 
date and time, seHing, 226-227 
Delete command, 384 
delete key, 82 
deleting 

aliases, 272 
documents, 138 
folders, 33, 158 
icons, 54 

from Apple menu, 244-245 
text, 202 

desk accessories, 38, 68, 205-206 
Alarm Clock, 214-216 
Calculator, 70, 216-217 
Chooser, 313 

converting to System 7, 
210-212 

Find File, 139-143 
installing, 206-209 
Key Caps, 84-86 
Notepad , 217 
Puzzle, 219-220 
quitting, 213 
removing, 210 
running under MultiFinder, 

294 
Scrapbook, 218-2 19 
starting, 212 
versus application programs, 

206 
desktop, J 5, 37 

icons, 39-41 
menu bar, 38 
not appearing, 416-417 
pattern, 225 
rebuilding, 416 
work area, 38 

Desktop Pattern control , 225 
desktop publishing application 

programs, 180, 360, 388 
digitizing tablelS, 403 
DIP (Dual In-line Package), 398 
Disinfectant Oohn Norstad) , 121, 

355 
INIT,253 

Disk Doubler (Salient Software), 
349 

Disk Express 11 , 348 
Disk First Aid program, 341 
disks 

400K, 93 
800K, 93 
backups, 415 
copying documents to, 136 
cylinders, 94 
disk management, 340 
displaying disk information, 

264 
double-sided, 24 

formaHing, 99-100 
ejecting, 35 
encryption, 348 

fLXed , see hard 
flashing question mark, 417 
floppy, 92 

copying, LOS 
copying between, 109-110 
copying contents to hard 

disks, 106-107 
copying icons to, from hard 

disks, 51 
copying when containing 

System Folder, 107-109 
double-sided, 92-94 
drives, 397 
ejecting, 97-99 
formalS, 94 
formatting, 94, 99-101 
high-density, 92-94 
inserting, 97·99 
installing application 

programs on, 181-183 
installing System software 

for floppy drive users, 
17-21 

locking, 110-11 1 
not ejecting, 418 
protecting, 96 
renaming, 105 
single-sided, 92-94 

formalS, 95 
hard, 112-113 

backing up, 116-117 
copying floppy disk's 

contents to hard disks, 
106-107 

copying icons from, to 

floppy d isks, 51 
drives, 397-400 
formatting, 114-116 
fragmentation, 117-120 
installing application 

programs on, 184-186 
installing System software 

for floppy drive users, 21 
protecting, 113-114 
SCSI, 113 

high-density floppy, formatting, 
100-101 
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disks continued 
icons, 39 

closing, 34 
opening, 28 

initializing, 26 
medium, 91 
mounted, 98 
off-line storage, 91 
optimization, 347 
size, 92 
System Additions, 14 
System Startup, 14-1 5 
tracks, 94 

Document icons, 47 
documents, 123-124 

changing inro stationery pad, 
153, 156 

dosing, 132 
copying, 135 

te!.:t, 204 
to another disk, 136 

created by System software/ 
application programs, 124 

cutting text, 203 
deleting, 138 
dragging (opening), 130 
inserting 11!.,1, 200-201 
locking, 138-139 
opening, 126-132 
pasting text, 204 
replacing text, 205 
saving, 134-135 
searching for, 139-153 
selecting text, 201 
stationery, 125 
swapping, 110 
template, 153, 156 
unlocking, 138-139 

Dollars and Sense (Monugr.un 

Software), 391 
DOS Mounter (Dyna Communica

tions) , 357 
dot-matrix 

printers, 197, 404 
printing method, 320-321 

Double Helix (Odesta Corp.) , 388 

Index 

double-clicking, 28, 44 
document's icon, 127-128 

double-sided disks, 24 
floppy disks, 92-94 

formatting, 99-100 
downloading fonts, 321 
dragging, 42 

documents (opening), 130 
drives 

400K, 93 
BOOK, 93 
adding to system, 396-400 
CO-ROM, 399 
erasable optical, 400 
Write Once Read Many 

(WORM), 400 
Duplicate command, 31, 50, 

72, 135 
duplicating icons, 50 
dust covers, 407 

E 

Easy Access feature, 86-89 
Edit menu, 38, 73-74 

Background command, 384 
Clear command, 74, 202, 384 
Copy command, 74, 204, 384 
Cut command, 74, 203, 384 
Delete command, 384 
HyperCard, 364 
New Card command, 383 
options when Scrapbook open, 

218 
Past command, 204 
Paste command, 74, 384 
Select All command, 74 
Show Clipboard command, 74 
Undo command, 74, 202 

editing stacks, 384-385 
educational application programs, 

180,360,389 
Eject command, 25, 72 
ejecting 

disks, 35 
floppy disks, 97-99 

electronic bulletin board, 425 
Empty Trash command, 33, 78, 

138,272 
Encore (Passport Designs), 392 
encryption, disks, 348 
Engelhart, Douglas, 2 
entertainment application 

programs, 180, 360, 390 
erasable optical drives, 400 
Erase Disk command, 78 
escape key, 82 
Excel (Microsoft), 392 
EZ Vision (Opcode Systems), 392 

F 

Falcon (Holobyte), 390 
FastBack II (Fifth Generation 

Systems), 351 
fax modems, 396, 402 
file management, 340 
File menu, 25, 38, 70, 73 

Close command, 61, 72, 132 
Close Window command, 163 
Duplicate command, 31, 50, 

72,135 
Eject command, 72 
Find Again command, 73, 145 
Find command, 73, 143, 

267-268 
pop-u p menus, 145-150, 

153 
Get Info command, 52-54, 72, 

127, 273-274, 293 
HyperCard, 363 
Make Alias command, 73, 

242-243, 271 
New Folder command, 30, 71, 

156-158 
New Stack command, 378 
New User command, 278 
Open command, 71, 128-130, 

189 
Page Setup command, 72, 

L91-193 
Print command, 72, 195-199 



Print Directory command, 72 
Put Away command, 72 
Quit command, 190, 292, 301 
Sharing command, 73, 279-281 

file sharing, 276 
creating users/groups, 278-279 
monitoring, 282 
sharing folders, 279-281 
starting, 276-277 

fLles 
searching for, 350 
translator, 345 

Filevision IV (fSP Software), 388 
Finale (Coda Music Software), 392 
financial application programs, 

180, 360, 390 
Find Again command, 73, 145 
Find command, 73, 143, 267-268 

pop-up menus, 145-150, 153 
Find File desk accessory, 139-143 

commands, 142 
Finder, 187-188 
Finder menus, 68 

Apple, 70 
Application, 79 
Balloon Help, 78 
Edit, 73-74 
File, 70, 73 
Label, 76 
Special, n-78 
View, 74 

Finder versus MultiFinder, 287 
Findswell (Working Software), 350 
ftxed disks, see hard disks 
floppy disks, 92 

copying, 105 
between, 109-110 
containing S}rstem Folder. 

107-109 
contents to hard disks, 

106-107 
icons to, from hard disks, 51 

double-sided, 92-94 
drives, 397 
ejecting, 97-99 
formats, 94 
formatting, 94, 99 

high-density, 92-94 
inserting, 97-99 
installing · 

application programs on, 
181-183 

System software for floppy 
drive users, 17-21 

locking, 110-111 
not ejecting, 418 
protecting, 96 
renaming, 105 
single-sided, 92-94 

folders, 156 
accessing within applications, 

169 
Apple Menu Items, aliases, 274 
closing, 163 

multiple folders, 165 
copying, 31 

icons to, 168 
creating, 29, 156-158 
deleting, 33, 158 
displaying folder size, 263 
moving icons between, 167 
nesting, 156, 164-165 
opening, 159, 169-171 
organizing icons, 165-167 
renaming, 158 
sharing in ftle sharing, 279-281 
Smrt-up Items 

aliases, 274 
configuring for System 7, 

304-305 
System 7 features, 172-175 
viewing, 160-163 

Font menu HyperCard, 367 
Font!DA Mover utility, 206-212 
Fonrographer (Altsys) , 355 
fonts, 319 

available 
with System 6, 341-342 
with System 7, 342-343 

bit-mapped, see screen 
changing, 259-260 
downloading, 321 
expected fonts not printing, 

420 

insmlling 
on System 6, 323-325 
on System 7, 326-327 

on TrueType printers, 322 
PostScript on PostScript 

printers, 321-322 
previewing in System 7, 327 
printer, 319 
removing from System 6, 

323-326 
screen, 319 
System software options, 

353·355 
TrueType, 319 

on PostScript printers, 322 
Type 1, 354 
Type 3, 354 

foreground msk, 289 
foreign language application 

programs (Penton Overseas Inc), 
389 

formats, 94-95 
formatting, 26, 94 

floppy disks, 94, 99 
double-sided, 99-100 
high-density, 100-101 

hard disks, 114-116 
forums, 424 
FoxBASE+/M.ac, 388 
fragmentation, 117-120 
Freehand (Aldus Corp.), 391 
freeware programs, 340 
Full Impact (Ashton-'I'ate) , 393 

G 

General Control Panel, 223 
Desktop Pattern control, 225 
Menu Blinking control, 230 
Rate of Insertion Point Blinking 

control, 229 
setting date and time, 226-227 
Sound control panel, 227-228 

GEnie, 388, 425 
Get Info command, 52-54, 72, 

127, 273-274, 293 
glare screens, 407 
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GMAT packages 
(Spinnaker Educational 

Software), 389 
(StudyWare) , 389 

Go menu 
HyperCard, 365-366 
!'rev command, 384 

graphical user interface (GUT) , 3 
graphics application programs, 

181, 360,391 
graphics tablets, 403 
GRE packages 

(Spinnaker Educational 
Sofi:Ware) , 389 

(StudyWare), 389 
grep (General Regular Expressions 

Processor), 394 
groups (file sharing), 278-279 

H 

hard disks, 112-113 
backing up, 116-117 
copying icons from, to floppy 

disks, 51 
drives, 397-400 
formatting, 114-116 
fragmentation, 117-120 
installing 

application programs on, 
184-186 

System software for floppy 
drive users, 21 

partitioning, 340 
protecting, 113-114 
seek time, 399 

hard drive, 13 
hardware, 11 

sources for purchasing, 395 
types 

accessories, 396, 406 
drives, 396-400 
fax modems, 396, 402 
keyboards, 396,400 
memory upgrades, 396, 401 
modems, 396, 401 

Index 

mouse alternatives, 396, 
402-403 

primers, 396, 403-405 
scanners, 396, 405 
sound-input devices, 396, 

406 
HFS Backup (l'ersonal Computer 

Corporation) , 351 
Hide Finder command, 80 
Hide Others command, 80 
hiding program windows (System 

7), 300 
hierarchical menus, 67 
high-density floppy disks, 92-94 

formatting, 100-101 
Home stack, 368 
Hot Keys (Keep It Simple 

Software), 356 
HyperCard, 362 

adding 
buttons to stacks, 380-383 
cards, 383 
fields, 379 
information to stacks, 383 

Addresses stack, 372-376 
Addresses With Audio stack, 

368 
Appointments stack, 369-371 
Appointments Wid1 Audio 

stack, 368 
Audio Help stack, 368 
creating 

background, 378 
new stacks, 3 78 
stacks, 376-378 

editing stacks, 384-385 
Home stack, 368 
HyperTalk language, 362 
installing, 362 
menus, 363 

Edit, 364 
File, 363 
Font, 367 
Go, 365, 366 
Style, 367 

opening supplied stacks, 368 

scripting features, 376 
1-lyperTalk language, 362 

1-beam pointer, 200 
icon grid, changing, 261-262 
icons, 39-41 

America Online document, 125 
application, 46 
changing icon size, 263 
compiling information about, 

52-54 
copying, 50 

background icons in System 
7, 303-304 

from hard to floppy disk, 51 
to another folder, 168 

deleting, 54 
disk, 39 

closing, 34 
opening, 28 

document, 47 
double-clicking document's 

icon, 127-128 
duplicating, 50 
installing in Apple menu, 

244-245 
labeling, 77, 266 
locating original of aliases, 

273-274 
moving, 42 

to anod1er folder, 167 
MS Word document, 125 
naming, 48-49 
opening, 44 
organizing with folders, 

165-167 
protecting, 54 
removing from Apple menu, 

244-245 
searching fo r labeled icons, 

267-268 
selecting, 42-43 
sorting labeled icons, 266 
Startup Disk, 25 



Stid.')' Keys, 87 
suitcase, 206 
System, 48 
Trash, 33, 40, 138 

deleting folders, 158 
ejecting disks, 97 
emptying, 57 
retrieving items from, 56 

identification numbers, 309 
Illustrator (Adobe) , 391 
ImageWriter printers, 197 

options, 198·199 
incompatibility, 255 
Informix, 393 
initializing, see formaning 
INn 's, 68, 252 

Disinfectant, 253 
incompatiblity conflicts, 

255·257 
installing, 253·257 
managing with utilities, 257 
removing, 253-256 
starting, 257 
versions, 257 

inkjet printers, 404 
inserting 

floppy disks, 97-99 
text, 200-201 

insertion point, 229 
insertion pointer, 200 
installing 

Apple File Exchange Folder, 
102- 104 

application programs, 181 
on floppy disks, 181-183 
on hard disks, 184-186 

CDEVs, 250-251 
desk accessories, 206-209 
fonts 

on System 6, 323·326 
on System 7, 326-327 

HyperCard, 362 
icons from Apple menu, 

244-245 
INITs, 253-257 

MultiFinder, 284 
o ther printer drivers, 316-318 
System 7, 21 
System software, 14 

for floppy drive users, 17-21 
for hard drive users, 21 

Institute of Electrical and 
Electronics Engineers (IEEE), 10 

Interactive Physics (Knowledge 
Revolution), 389 

J-K 

Jam Session (Broderbund), 392 
Kay, Alan, 2 
Key Caps desk accessory, 84-86 
keyboards, 8 1-82, 396, 400 

ejecting disks, 97 
operating poorly, 418 
selecting commands, 82 
viewing special characters, 

84-85 
Keyboard control panel, 231 
keys 

layout, 231 
repeat rate, 231 

KidsMath (Great Wave Software) , 
389 

kilobytes, 187 

L 

L'lbel menu, 39, 76, 269-270 
labeling icons, 77, 266 
labels, changing tides, 269-270 
L'lplink Mac II (Travelling 

Software) , 358 
laser printers, 404 
L'lserWriter printer options, 196 
layout (keys), 231 
LetraSet (FontStudio), 355 
Licklider, J.C.R, 2 
list views 

changing, 262-265 
columns, 264 

Listen (lmaja), 392 
locking 

application programs, 186 
documents, 138-139 
floppy disks, 110-111 

LSAT packages 
(Sp innaker Educational 

Software), 389 
(StudyWare), 389 

M 

Mac Tools Optimizer (Central 
Point Software), 347 

MacCalc (Bravo Technologies) , 

393 
MacDraw (Claris), 391 
MaclnTax (Softview) , 391 
Maclink Plus/PC (Data Viz), 357 
MacMoney (Survivor Software) , 

391 
MacRecorder Sound System 2.0 

(Farallon), 406 
macro programs, 343-345, 356 
MacroMaker, 343-345 
Mac Tools (Central Point Soft· 

ware) , 352 
MacTools Backup (Central Point 

Software), 351 
MacUser magazine, 346, 426 
Macworld magazine, 346, 426 
MacWrite II (Claris) , 393 
MacWrite Pro (Claris), 393 
magnetic medium, 91 
mail-order companies, 427 
Make Alias command, 73, 242-243, 

271 
Man-Computer Symbiosis, 2 
Managing Your Money (Meca 

Ventures) , 390 
Master Tracks PRO 4 (Passport 

Designs) , 392 
Masterjuggler (AJSoft) , 355 
Mavis Beacon Teaches Typing 

(Software Toolworks), 389 
megabytes, 29 
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Jt available, 

working memory 
inder, 293·294 

'301-303 
Cles, 396, 401 

ar, 38 
u Blinking control, 230 

enus, 64, 80 
adjusting blinking rate 

confirming menu choice, 230 
Apple, 38, 70, 244 

About This Macintosh 
command, 301-303 

Finder, 187·188 
installing icons, 244-245 
missing menu items, 421 
removing icons, 244-245 
sorting items within, 

245-246 
Application, 79 

Hide Finder command, 80 
Hide Others command, 80 
Show All command, 80 

Balloon Help, 78 
Edit, 38, 73·74 

Background command, 384 
Clear command, 74, 202, 

384 
Copy command, 74, 204, 

384 
Cut command, 74, 203, 384 
Delete command, 384 
New Card command, 383 
options when Scrapbook 

open,218 
Past command, 204 
Paste command, 74, 384 
Select All command, 74 

Index 

Show Clipboard command, 
74 

Undo command, 74, 202 
e jecting disks, 97 
File, 25, 38, 70,73 

Close command, 61, 72, 132 
Close Window command, 

163 
Duplicate command, 31, 

50, 72, 135 
Eject command, 72 
Find Again command, 73, 

145 
Find command, 73, 143-150, 

153, 267-268 
Get Info command, 52-54, 

72, 127, 273-274, 293 
Make Alias command, 73, 

242-243, 271 
New Folder command, 30, 

71, 156-1 58 
New Stack command, 378 
New User command, 278 
Open command, 71, 128· 

130, 189 
Page Setup command, 72, 

191·193 
Prim command, 72, 

195·199 
Print Directory command, 72 
Put Away command, 72 
Quit command, 190, 292, 

301 
Sharing command, 73, 

279·281 
Finde r menus, 68 

Apple menu, 70 
Application menu, 79 
Balloon Help menu, 78 
Edit menu, 73-74 
File menu, 70, 73 
Label menu, 76 
Special menu, 77·78 
View menu, 74 

Go (Prev command), 384 
hierarchical, 67 

HyperCard, 363 
Label, 39, 76, 269-270 
Objects 

New Background com· 
mand, 378·379 

New Bunon command, 
380-383 

New Field command, 379 
scrolling, 66 
Search, 150, 153 
selecting commands, 65, 68 
Special, 39, 77-78 

Clean Up command, 77 
Clean Up Window 

command, 163 
Empty Trash command, 33, 

78, 138, 272 
Erase Disk command, 78 
lkstart command, 78 
Set Startup command, 78, 

239, 242, 294-295 
Shut Down command, 36, 

78 
unavailable commands, 65 
View, 39, 74, 160, 163 

mice, 402 
MicroPhone 11 (Software Ventures 

Inc.), 386 
Microsoft Word 4.0, 393 

document icon, 125 
modems, 401 

fa.x modems, 396, 402 
monitor stand, 407 
mounted disks, 98 
mouse, 12, 41 

adjusting speed/response time, 
232 

alcernatives to, 396, 402-403 
clicking, 42 
connecting, 14 
double-clicking, 28, 44 
dragging, 42 
operating poorly, 418 
pointer, 25,41 

freezing in place, 419 
shift-clicking, 43 



Mouse control panel , 232 
moving 

icons, 42 
to another folder, 167 

windows, 59 
MultiFinder, 283-284 

checking available memory, 292 
DA Handler, 294 
gaining more working 

memory, 293-294 
installing, 284 
quining programs, 292 
running desk accessories 

under, 294 
scarting, 285 

mult iple application at 
startup, 294-295 

programs, 287 
switching between programs, 

289-292 
versus Finder, 287 

multiple folders , closing, 165 
multitasking, 283 

System 6, 284 
System 7, 296 

music application programs, 181, 

360,392 

N 

naming icons, 48-49 
nanoseconds, 11 
Navigator (CompuServe), 386 
nesting folders, 156, 164-165 
New Background command, 

378-379 
New Bunon command, 380-383 
New Card command, 383 
New Fields command, 379 
New Folder command, 30, 71, 

156-158 
New Stack command, 378 
New User command, 278 
Nisus (Paragon Computing), 394 
Norton Utilities (Symantec), 348, 

352 

Notepad desk accessory, 217 
Note\'\1riter II (Passport Designs), 

392 
NumberMaze (GreatWave 

Software) , 389 

0 

Objects me nu 
New Background command, 

378-379 
New Button command, 

380-383 
New Field command, 379 

off-line storage, 91 
OnCue (Opcode Systems) , 392 
on-line services System software 

source, 340 
Open command, 71, 128-130, 189 
opening 

disk icons, 28 
documents, 126-132 
folders, 159, 169-171 
icons, 44 
multiple programs at startup, 

294-295 
supplied HyperCard stacks, 368 

optimization, disks, 347 
Optimizer, l18-120 
option drag key combination, 168 
option key, 82 

p 

padded carrying cases, 406 
Page Setup command, 72, 191-193 
Palo Alto Research Center (PARC), 2 
partitioning. 340 
Past command, 204 
Paste command, 74, 384 
pasting text, 204 
Perceive (Coda Music Software), 

392 
Persuasion (Aldus), 389 
l'hysics (Broderbund) , 389 

Playroom (Broderbund Soft 
389 

Point of View (Scholastic Soft
ware), 389 

points, 319 
pop-up menus (Find window), 

145-150, 153 
PostScript 

printers, 4 05 
fonts on, 321-322 

printing method, 320 
power 

cord, connecting, 14 
strips, 10 
supply, 13 
surge protectors, 10, 406 

PowerPoint (Microsoft), 389 
Practica Musica (Ars Nova 

Software), 392 
Prev command, 384 
previewing fonts in System 7, 327 
Print command, 72, 195-199 
Print Directory command, 72 
printers, 396, 403-405 

choosing widl Chooser desk 
accessory, 3 13-315 

connecting, 307 
AppleTalk printers, 310-311 
SCSI printers, 308-310 
serial printers, 308 

dot-matrix, 197, 404 
drivers, installing, 316-318 
fonts , 319 

expected, not printing, 420 
installing on System 6, 326 
removing on System 6, 326 

ImageWriters, 197 
options, 198-199 

inkjet, 404 
laser, 404 
LaserWriter options, 196 
no n-PostScript, 405 
PostScript, 405 
printe r drivers, 312 
resolution, 403 
special effects, 193-I 95 

l11dex 



,ects, 

/'ser (Mark of 
2 

rams 
·ng up, 415 

eeware, 340 
hiding program windows in 

System 7, 300 
macros, 343-345, 356 
opening multiple programs at 

startup, 294-295 
quiuing 

in MultiFinder, 292 
in System 7, 301 

running with System 7, 296 
shareware, 340 
starting 

with M.ultiFinder, 287 
with System 7, 296 

switching between 
with MultiFinder, 289-292 
with System 7, 298-300 

terminal emulation, 386 
protecting 

computer, 415-416 
Mac Classic, 9-11 

floppy disks, 96 
hard disks, 113-114 
icons, 54 

Publish It! Easy (Timeworks Inc.) , 
389 

Put Away command, 72 
Puzzle desk accessory, 219-220 

(l 

QuarkX:l'ress (Quark Inc.), 389 
Que Corporation, 427 

Index 

QuickDraw printing me thod, 
320-321 

Quicken (lnruit), 391 
QuicKeys U (CE Software), 357 
Quit command, 190, 292, 301 
quitting 

desk accessories, 213 
programs, 190 

in Multil'inder, 292 
in System 7, 301 

QWERTY-keys layout, 12 

R 

Rage of Insertion Point Blinking 
control, 229 

RAM cache, 235, 303 
see also memory 

Reader Rabbit (The Learning Co.), 
389 

Ready, Set, Go! (l.etraset USA), 389 
rebuilding desktop, 416 
Redu.x (Microseeds Publishing, 

Inc.) , 351 
removing fon ts on System 6, 

323-326 
renaming 

aliases, 272 
floppy disks, 105 
folders, 158 

repeat rate (keys), 231 
replacing text, 205 
resolution (printers) , 403 
Restart command, 78 
return key, 82 
RFI (Radio Frequency Interfer

ence), 10 

s 
SAM (Symamec Corporation) , 356 
Sargon 4 (Spinnaker), 390 
SAT packages 
(Spinnaker Educational Software), 

389 
(StudyWare), 389 

saving documents, 134-135 
scanners, 396, 405 
Scrapbook desk accessory, 

218-219 
screens, 12 

dark, correcting, 416 
fon ts, 319 

installing on System 6, 
323-325 

removing from System 6, 
325 

scripting, 386 
features (HyperCard), 376 

scripts, 362 
scroll 

bars, inactive, 62 
box, 64 

scrolling 
continuously, 63 
menus, 66 
windows, 62 

SCSI, 11 3, 398 
hard disks, 113 
printers, 308-310 

choosing, 315 
SCSL printer hookup, 307 
Search menu, 150, 153 
searching for 

documents, 139-153 
files, 350 
icons, 267-268 

seek time, 399 
Select All command, 74 
serial primers 

choosing, 313 
connecting, 308 
hookup, 307 

Set Startup command, 78, 239, 
242, 294-295 

shareware programs, 340 
Sharing command, 73, 279-281 
Shift key, 81 
shift-clicking, 43 
Show AU command, 80 
Show Clipboard command, 74 
Shut Down command, 36, 78 



Stick·y Keys, 87 
suitcase, 206 
System, 48 
Trash, 33, 40, 138 

deleting folders , 158 
ejecting disks, 97 
emptying, 57 
retrieving items from, 56 

identification numbers, 309 
Illustrator (Adobe) , 391 
lmageWriter printers, 197 

options, 198·199 
incompatibility, 255 
JnformLx, 393 
initializing, see formatting 
JNITs, 68, 252 

Disinfectant, 253 
incompatiblity conflicts, 

255-257 
installing, 253·257 
managing with utilities, 257 
removing, 253·256 
starting, 257 
versions, 257 

inkjet printers, 404 
insening 

floppy disks, 97·99 
text, 200-201 

insenion point, 229 
insenion pointer, 200 
installing 

Apple File Exchange Folder, 
102-104 

application programs, 181 
on floppy disks, 181·183 
on hard disks, 184-186 

CDEVs, 250-251 
desk accessories, 206-209 
fonts 

on System 6, 323-326 
on System 7, 326-327 

HyperCard, 362 
icons from Apple menu, 

244-245 
!NITs, 253-257 

MultiFinder, 284 
other printe r drivers, 316-318 
System 7, 21 
System software, 14 

for floppy drive users, 17-21 
for hard drive users, 21 

lnstirute of Electrical and 
Electronics Engineers (1EEE) , 10 

Interactive Physics (Knowledge 
Revolution), 389 

J-K 

j am Session (Brode rbund) , 392 
Kay, Alan, 2 
Key Caps desk accessory, 84-86 
keyboards, 81-82, 396, 400 

ejecting disks, 97 
operating poorly, 418 
selecting commands, 82 
viewing special characters, 

84-85 
Keyboard control panel, 231 
keys 

layout, 231 
repeat rate, 231 

KidsMath (Great Wave Software), 
389 

kilobytes, 187 

l 

Label menu, 39, 76, 269-270 
labeling icons, 77, 266 
labels, changing titles, 269-270 
L1pLink Mac II (Travelling 

Software), 358 
laser printers, 404 
LaserWriter printer options, 196 
layout (keys), 231 
LetraSet (FontSrudio) , 355 
Licklider, j.C.R, 2 
l.ist views 

changing, 262-265 
columns, 264 

Listen (lmaja), 392 
locking 

application programs, 186 
documents, 138·139 
floppy disks, 110-111 

LSAT packages 
(Spinnaker Educational 

Software), 389 
(StudyWare), 389 

M 

Mac Tools Optimi.zer (Central 
Point Software) , 347 

MacCalc (Bravo Technologies) , 

393 
MacDraw (Claris) , 391 
MaclnTax (Softview), 391 
Mac Link Plus!PC (Data Viz) , 357 
Mac.Money (Survivor Software), 

391 
MacRecorder Sound System 2.0 

(Farallon), 406 
macro programs, 343-345, 356 
Macro.Maker, 343-345 
MacTools (Central Point Soft· 

ware) , 352 
MacTools Backup (Central Point 

Software), 351 
MacUser magazine, 346, 426 
Macworld magazine , 346, 426 
MacWrite 11 (Claris) , 393 
MacWrite Pro (Claris), 393 
magnetic medium, 91 
mail-order companies, 427 
Make Alias command, 73, 242-243, 

271 
Man-Computer Symbiosis, 2 
Managing Your Money (Meca 

Ventures), 390 
Master Tracks PRO 4 (Passpon 

Designs), 392 
Masterjuggler (A!Soft), 355 
Mavis Beacon Teaches Typing 

(Software Toolworks), 389 
megabytes, 29 
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memory, 13, 91 
application programs, 187-189 
checking amour available while 

in Multifinder, 292 
considering when buying 

application software, 361 
determining amout available, 

187-188 
gaining more working memory 

for MultiFinder, 293-294 
System 7, 301-303 
upgrades, 396, 401 

menu bar, 38 
Menu Blinking control, 230 
menus, 64, 80 

adjusting blinking rate 
confirming menu choice, 230 

Apple, 38, 70, 244 
About This Macintosh 

command, 301-303 
Finder, 187-188 
installing icons, 244-245 
missing menu items, 421 
removing icons, 244-245 
sorting items within, 

245-246 
Application, 79 

Hide Finder command, 80 
Hide Others command, 80 
Show All command, 80 

Balloon Help, 78 
Edit, 38, 73-74 

Background command, 384 
Clear command, 74, 202, 

384 
Copy command, 74, 204, 

384 
Cut command, 74, 203, 384 
Delete command, 384 
New Card command, 383 
options when Scrapbook 

open, 218 
Past command, 204 
Paste command, 74, 384 
Select AU command, 74 

Index 

Show Clipboard command, 
74 

Undo command, 74, 202 
ejecting disks, 97 
File, 25,38, 70, 73 

Close command, 61, 72, 132 
Close Window command, 

163 
Dupl.icate command, 31, 

50, 72, 135 
Eject command, 72 
Find Again command, 73, 

145 
Find command, 73, 143-150, 

153, 267-268 
Get Info command, 52-54, 

72, 127, 273-274, 293 
Make Alias command, 73, 

242-243, 271 
New Folder command, 30, 

71, 156-158 
New Stack command, 378 
New User command, 278 
Open command, 71, 128-

130, 189 
Page Setup command, 72, 

191-193 
Print command, 72, 

195-199 
Print DirectOJ:Y command, 72 
Put Away command, 72 
Quit command, 190, 292, 

301 
Sharing command, 73, 

279-281 
Finder menus, 68 

Apple menu, 70 
Application menu, 79 
Balloon Help menu, 78 
Edit menu, 73-74 
File menu, 70, 73 
Label menu, 76 
Special menu, 77-78 
View menu, 74 

Go (Prev command) , 384 
hierarchical, 67 

HyperCard, 363 
Label, 39, 76, 269-270 
Objects 

New Background com
mand, 378-379 

New Bunon command, 
380-383 

New Field command, 379 
scrolling, 66 
Search , 150, 153 
selecting commands, 65, 68 
Special, 39, 77-78 

Clean Up command, 77 
Clean Up Window 

command, 163 
Empty Trash command, 33, 

78, 138, 272 
Erase Disk command, 78 
Restart command, 78 
Set Startup command, 78, 

239, 242, 294-295 
Shut Down command, 36, 

78 
unavailable commands, 65 
View, 39, 74, 160, 163 

mice, 402 
MicroPhone II (Software Ventures 

Inc.), 386 
Microsoft Word 4.0, 393 

document icon, 125 
modems, 401 

fax modems, 396, 402 
monitor stand, 407 
mounted disks, 98 
mouse, 12, 41 

adjusting speed/response time, 
232 

alternatives to, 396, 402-403 
clicking, 42 
connecting, 14 
double-clicking, 28, 44 
dragging, 42 
operating poorly, 418 
pointer, 25, 41 

freezing in place, 419 
shift-clicking, 43 



Mouse control panel, 232 
moving 

icons, 42 
to another folder, 167 

windows, 59 
MultiFinder, 283-284 

checking available memory, 292 
DA Handler, 294 
gaining more working 

memory, 293·294 
installing, 284 
quitting programs, 292 
running desk accessories 

under, 294 
starting, 285 

multiple application at 
startup, 294-295 

programs, 287 
switching between programs, 

289-292 
versus Finder, 287 

multiple folders, closing, 165 
multitasking, 283 

System 6, 284 
System 7, 296 

music application programs, 181 , 
360,392 

N 

naming icons, 48-49 
nanoseconds, 11 
Navigator (CompuServe) , 386 
nesting folders, 156, 164-165 
New Background command, 

378-379 
New Button command, 380·383 
New Card command, 383 
New Fields command, 3 79 
New Folder command, 30, 71, 

156·158 
New Stack command, 378 
New User command, 278 
Nisus (Paragon Computing), 394 
Norton Utilities (Symantec), 348, 

352 

Notepad desk accessory, 217 
NoteWriter II {l'assport Designs), 

392 
NumberMaze (GreatWave 

Software), 389 

0 

Objects menu 
New Background command, 

378·379 
New Button command, 

380-383 
New Field command, 379 

off-line storage, 91 
OnCue (Opcode Systems}, 392 
on-line services System software 

source, 340 
Open command, 71, 128·130, 189 
opening 

disk icons, 28 
documents, 126-132 
folders, 159, 169-171 
icons, 44 
multiple progmms at startup, 

294-295 
supplied HyperCard stacks, 368 

optimization, disks, 347 
Optimizer, 118-120 
option drag key combination, 168 
option key, 82 

p 

padded carrying cases, 406 
Page Setup command, 72, 191-193 
Palo Alto Research Center (!'ARC), 2 
partitioning, 340 
Past command, 204 
Paste command, 74, 384 
pasting text, 204 
Perceive (Coda Music Software), 

392 
Persuasion (Aldus), 389 
Physics (Broderbund) , 389 

Playroom (Broderbund Software), 
389 

Point of View (Scholastic Soft
ware), 389 

points, 319 
pop-up menus (Find window), 

145-150, 153 
PostScript 

printers, 405 
fonts on, 321-322 

printing method, 320 
power 

cord , connecting, 14 
strips, 10 
supply, 13 
surge protectors, 10, 406 

PowerPoint (Microsoft) , 389 
Practica Musica (Ars Nova 

Software) , 392 
Prev command, 384 
previewing fonts in System 7, 327 
Print command, 72, 195-199 
Print Directory command, 72 
printers, 396, 403·405 

choosing with Chooser desk 
accessory, 313·315 

connecting, 307 
AppleTalk printers, 310-311 
SCSI printers, 308-310 
serial printers, 308 

dot-matrix, 197, 404 
drivers, installing, 316-318 
fon ts, 319 

expected, not printing, 420 
installing on System 6, 326 
removing on System 6, 326 

ImageWriters, 197 
options, 198-199 

inkjet, 404 
laser, 404 
laserWriter options, 196 
non-PostScript, 405 
PostScript, 405 
printer drivers, 312 
resolution, 403 
special effects, 193·195 
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printing 
background, 328-332 
methods, 320-322 
with application programs, 

190-192, 195-199 
printer special effects, 

193-195 
Professional Composer (Mark of 

the Unicorn), 392 
programs 

application, see application 
programs 

backing up, 415 
freeware, 340 
hiding program windows in 

System 7, 300 
macros, 343-345, 356 
opening multiple programs at 

startup, 294-295 
quitting 

in Multifinder, 292 
in System 7, 301 

running with System 7, 296 
shareware, 340 
starting 

with MultiFinder, 287 
with System 7, 296 

switching between 
with MultiFinder, 289-292 
with System 7, 298-300 

terminal emulation, 386 
protecting 

computer, 415-416 
Mac Classic, 9-11 

floppy d isks, 96 
hard disks, 113-114 
icons, 54 

Publish It! Easy (Timeworks Inc.), 
389 

Put Away command, 72 
Puzzle desk accessory, 219-220 

0 

QuarkXPress (Quark Inc.), 389 
Que Corporation, 427 

Index 

Quick.Draw printing method, 
320-321 

Quicken (Intuit) , 391 
QuicKeys ll (CE Software), 357 
Quit command, 190, 292, 301 
quitting 

desk accessories, 213 
programs, 190 

in Multifinder, 292 
in System 7, 301 

QWERTY-keys layout, 12 

R 

Rage of Insertion Point Blinking 
control, 229 

RAM cache, 235, 303 
see also memory 

Reader Rabbit (The Learning Co.), 
389 

Ready, Set, Go! (l.etraset USA), 389 
rebuilding desktop, 416 
Redux (Microseeds Publishing, 

Inc.), 351 
removing fonts on System 6, 

323-326 
renaming 

aliases, 272 
floppy disks, 105 
folders, 158 

repeat rate (keys), 231 
replacing text, 205 
resolution (printers), 403 
Restart command, 78 
return key, 82 
RFI (Radio Frequency Interfer

ence) , 10 

s 
SAM (Symantec Corporation), 356 
Sargon 4 (Spinnaker), 390 
SAT packages 
(Spinnaker Educational Software), 

389 
(StudyWare), 389 

saving documents, 134-135 
scanners, 396, 405 
Scrapbook desk accessory, 

218-219 
screens, 12 

dark, correcting, 416 
fonts, 319 

installing on System 6, 
323-325 

removing from System 6, 
325 

scripting, 386 
features (HyperCard), 376 

scripts, 362 
scroll 

bars, inactive, 62 
box,64 

scrolling 
continuously, 63 
menus, 66 
windows, 62 

SCSI, 113, 398 
hard disks, 113 
printers, 308-310 

choosing, 315 
SCSL printer hookup, 307 
Search menu, 150, 153 
searching for 

documents, 139-153 
ftles, 350 
icons, 267-268 

seek time, 399 
Select All command, 74 
serial printers 

choosing, 313 
conneccing, 308 
hookup, 307 

Set Startup command, 78, 239, 
242, 294-295 

shareware programs, 340 
Sharing command, 73, 279-281 
Shift key, 81 
shift-clicking, 43 
Show All command, 80 
Show Clipboard command, 74 
Shut Down command, 36, 78 



shutting down Mac Classic, 36 
signatures (documents), 127 
silicon chips, 91 
Silverlining (La Cie Ltd.) , 348 
SIMMs (single in-line memory 

modules) , 401 
single-sided floppy disks, 92-94 
Sketchpad program, 2 
small bomb dialog box, 418-419 
Smal.l Computer System Interface, 

see SCSI 
Smalltalk computer language, 2 
SmartCom Il (Hayes Microcom

puter Products), 386 
software, see programs 
sorting 

items within Apple menu, 
245-246 

labeled icons, 266 
Sound control panel, 227-228 
sound-input devices, 396, 406 
sounds, 236 

Alert sound, 236-237 
speaker volume, 227-228 
special 

characters, viewing, 84-85 
effects with printers, 193-195 

Special menu, 39, 77-78 
Clean Up command, 77 
Clean Up Window comman d, 

163 
Empty Trash command, 78, 

138, 272 
Erase Disk command, 78 
Restart command, 78 
Set Startup command, 78, 239, 

242, 294-295 
Shut Down command, 36, 78 

spikes, 10 
spreadsheet software , 360, 392 
stacks 

adding 
buttons, 380-383 
cards, 383 
fie lds, 379 
information, 383 

creating, 376-378 
background, 378-379 

editing, 384-385 
Start-up Items folder aliases, 274 
starting 

application programs, 189 
desk accessories, 212 
file sharing, 276-277 
IN ITs, 257 
Mac Classic, 23, 26 
Multifinder, 285 
programs 

with Multif inder, 287 
,·vith System 7, 296 

Startup Device control panel, 233 
Startup Disk 

creating, 14, 17 
icon,25 

Startup Items folder, coufiguring 
for System 7, 304-305 

statio nery, 125 
changing documents into 

stationery pads, 153, 156 
sticky keys feature, 86 
Sticky Keys icon, 87 
Srudio/1 (Electronic Arts), 391 
Sruffit Classic shareware (A.laddin 

Systems), 348 
Style menu (HyperCard) , 367 
suitcase icon, 206 
SuitCase ll (Fifth Generation 

Systems), 355 
SUM II (Symantec Corporation) , 

348, 351-352 
SuperDrives, 12, 93 
SuperPaint (Silicon Beach), 391 
System 

Additions disk, 14 
Extensions, see lNITs 
Folder 

copying flop py disks 
containing, 107-109 

window, 58-59 
icons, 48 
software , 337, 346-347 

checking, 105-106 

commercial System 
softw;u·e sources, 340 

documems created by, 124 
fonts, 353-354 
installing, 14, 17-21 

sources, 340 
Stam1p disk, 14-15 

switching 
between programs, 289-292 

with System 7, 298-300 
Sutherland , Ivan, 2 

System 6 
fonts available, 341-342 
installing fo nts, 323-326 
multitasking, 284 
removing desk accessories, 210 
removing fonts, 323-326 
versus System 7, 6, 338-339 

System 7 
adjusting memory usage. 303 
Apple menu, 244-246 
checking available memory, 

301-303 
configuring Startup !terns 

folder, 304-305 
converting desk accessories to, 

210-212 
copying icons in background, 

303-304 
direct support, 423 
folders, 172-175 
fonts available, 342-343 
hiding program windows, 300 
icon, 6 
installing, 21 
install ing fonts, 326-327 
multitasking, 296 
previewing fonts, 327 
quitting programs, 301 
running programs with, 296 
switching between programs, 

298-300 
System Extensions, see I NITs 
upgrading to, 409-410 
versus System 6, 6, 338-339 
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T 
template documents, 153, 156 
Tempo II Plus (Affinity 

MicroS)•stems) , 357 
te nninal emulation programs, 386 
termination, 398 

numbers, 309 
Tetris (Holobyte), 390 
text 

copying, 204 
cutting, 203 
deleting, 202 
inserting, 200-201 
pasting, 204 
replacing, 205 
selecting, 201 

This is not a Macintosh disk, error 
message, 421 

time and date, setting, 226-227 
title bars, 28 
toggles, 174 
touch screens, 403 
TouchBase (After 1-lours}, 388 
trackballs, 403 
tracks, 94 
translator files, 345 
Trash icon, 33, 40, 138 

deleting fo lders, 158 
ejecting disks, 97 
emptying, 57 
retrieving items from, 56 

True Type 
fonts, 319 

on PostScript printers, 322 
printers 

fonts on, 322 
printing method , 320 

Type 1 fonts, 354 
Type 3 fonts, 354 
Type! (Broderbund Somvare), 389 
typeface, 319 
TypeStyler (Broderbund), 355 
typical response time, 11 

Index 

u 
unavailable commands, 65 
Undo command, 74, 202 
uninterru ptable power supply, 

406 
unlocking 

application programs, 186 
documents, 138-139 

upgrading to System 7, 409-410 
user group System somvare 

source, 340 
user groups, 425 
users (file sharing}, 278-279 
utilities 

r ont/DA Mover, 206-212 
managing INITs, 257 

v 
View menu, 39, 74, 160, L63 
viewing folders, 160, 163 
Views control panel, 258 

font displayed, changing, 
259-260 

icon grid , changing, 261-262 
list views, changing, 262-265 

Virex (Microcom), 356 
viruses, 120-122, 416 

protection from, 355 
running to remove incompat

ibility problems, 256 
Voice Link (Articulate Systems) , 

406 
Voice Navigator II (Articulate 

Systems), 406 
Voyages (Carina Software), 389 

W-Z 
Welltris (Holobyte}, 390 
Where in Time is Cannen 

Sandiego? (Broderbund 
Software), 389 

WhiteKnight (FreeSoft Company), 
386 

windows 
closing, 61 
moving, 59 
scrolling, 62 
sizing, 60 
System Folder, 58-59 

word processor application 
programs, 181, 361, 393 

WordPerfect (WordPerfect Corp), 
394 

work area (desktop}, 38 
Works (Microsoft), 393 
wrist pads, 407 
Write Once Read Many (WORM) 

drive, 400 
write-protecting d isks, see locking 

disks 
WriteNow (!"/Maker}, 393 
X-Y Position Indicator for a 

Display System, 2 



Free Catalog! · 
Mail us this registrat ion form today. 
a nd we 'II send you a free caw log 
featuring Que' s complete line of 
be st-selling books. 
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ZIP 

Pfeose check the Oflpmprittte mt~ll'<'l'l· : 

I. Where did you buy your Que book? 
0 Bookstore (name: ) 
0 Computer store (name: ___ ) 
0 Catalog (name: ) 
0 Direct from Que 

0 Other: ---------

2. How many computer book~ do you 
buy a year'! 
0 I or IC!>S 
0 2-5 
0 6-10 
0 More than 10 

J . How many Que book' do you own '? 
0 1 
0 2-5 
0 6-10 
0 More than 10 

4. How lo ng have you been u' ing 
thi s software? 
0 Less than 6 mont hs 
0 6 months to I year 
0 1-J years 
0 More than 3 years 

5. What influenced your purchase 
of th is Que book? 
0 Personal recommendat io n 
0 Advert isement 
0 In-store d isplay 
0 Price 
0 Que catalog 
0 Que mai ling 
0 Que' s reputation 
0 Other: --- -----
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6. How wou ld you rate the overall 
content of the book'! 
0 Very good 
0 Good 
0 Satistitctory 
0 Poor 

7 . What do you like be.11 about thi~ 
Que book? 

8. What do you like fea.11 about thi' 
Que book? 

9 . Did you buy thi' book with your 
personal fund''! 
0 Yes 0 No 

I 0 . Please feel free to li \ t any other 
com'men" you may have about 
thi!> Que book. 

. Order Your Que Books Today! 
N.1111t: --- --------------------------

T11k 

1u .11r 71P 

Phiii!C'NII ( 

Order :--Jo. Titk· 

Method of Payment: 
Check 0 tPbt,c cndo,c in cnvclupc. t 

Charge My: VISA 0 MastaCard 0 
American E~pre~' 0 

Qty. Prin: lillal 

You ca n FAX your order to 1-3 I 7-57.3-2583. Or call 1-800-428-5331 , ext. ORDR to 11rdcr direct. Suhtntal 
Please add $2.50 pert itlc for shipping and handling. Shipping & Hand ling 
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MftC® ClftSSIC 
BOOM 

Now you can put Classic results on command with 
Que's Mac Classic Book! This complete beginner's 
tutorial and reference takes you inside the Mac 
Classic so you can get more out of it. 

All the essentials are covered. After clear installation 
and set up instructions, you learn step-by-step how 
to navigate the Mac's functional and friendly inter
face. You are shown the basics of the Macintosh 
desktop, mouse, windows, and menus-and then 
discover how to put the Mac to work. Que's Mac 
Classic Book explores the basics of installing and 
using different software packages and tailoring your 
Mac to suit your needs. As you advance, you learn 
to tackle such jobs as using multitasking, setting up 
and installing a printer, and adding fonts to your sys
tem . Plus, the book devotes an entire section to the 
best software and hardware available. Excellent 
advice enables you to consider the options and 
lets you choose which software is best for your 
Mac Classic. 

Great Macintosh performance is fast and easy with 
Que's Mac Classic Book! 
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